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HOOFDSTUK 1

Inleiding

Dit document is de officiële gebruikershandleiding van QGIS. De software en hardware beschreven in dit doc-
ument zijn in de meeste gevallen geregistreerde handelsmerken waarop wetgeving bestaat. QGIS is uitgebracht
onder de GNU General Public Licentie. Vind meer informatie op de website van QGIS http://www.qgis.org.

De gebruikte details, data, resultaten enz. in dit document zijn geschreven en gecontroleerd met de beste kennis
en inzet voorhanden van auteurs en uitgevers. Toch kunnen er inhoudelijk fouten voorkomen.

Op alle data kan er daarom geen rechten ontleent worden, noch zijn er garanties voor afgegeven. De auteurs,
redacteuren en uitgevers hebben geen enkele verantwoordelijkheid voor fouten en gevolgen die dit kan hebben.
Men is altijd welkom om ons te wijzen op mogelijke fouten.

Dit document is gemaakt met reStructuredText. De broncode in de vorm van reST broncode is beschikbaar
via github en via internet als HTML en PDF via http://www.qgis.org/en/docs/. Ook kunnen er vertaalde ver-
sies van dit document in verschillende formaten gedownload worden van het documentatie gedeelte van het
QGIS project. Voor meer informatie over hoe je kunt bijdragen aan dit document en de vertaling ervan, bezoek:
http://www.qgis.org/wiki/.

Koppelingen in dit Document

Dit document bevat interne en externe koppelingen. Door een interne koppeling te selecteren zul je naar een ander
gedeelte van het document springen, bij het selecteren van een externe koppeling wordt een internet adres geopend.
Interne en externe koppelingen worden blauw weergegeven en worden door de standaardbrowser afgehandeld. In
HTML vorm worden beide koppelingen identiek weergegeven.

Auteurs en redactie van de Gebruikers-, Installatie- en Ontwikkelhandleiding:

Copyright (c) 2004 - 2014 QGIS Ontwikkelingsteam

Internet: http://www.qgis.org

Licentie van dit of document

Iedereen heeft het recht om dit document te kopiëren, verspreiden en aan te passen onder de voorwaarden van de
GNU Free Documentation License, Version 1.3 of een latere versie gepubliceerd door de Free Software Founda-
tion; De Voor- en achterkant en de inhoudelijke indeling van het document dient gelijk te blijven. Een kopie van
de licentie is toegevoegd in Appendix GNU Free Documentation License.

.
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HOOFDSTUK 2

Conventies

Hier worden een aantal uniforme stijlen beschreven die gebruikt worden in deze handleiding.

2.1 Conventies GUI

De GUI conventie-stijlen zijn bedoeld om de vertoning in de GUI zo goed mogelijk na te bootsen. Zodoende kan
een gebruiker snel binnen de QGIS applicatie vinden wat er in de handleiding getoond wordt.

• Menu opties: Kaartlagen → Rasterlaag Toevoegen... of Beeld → Werkbalken → Digitaliseren

• Knop in werkbalk: Rasterlaag Toevoegen

• Knop in dialoog: [Opslaan als standaard]

• Dialoogvenster titel: Laag Eigenschappen

• Tabblad: Algemeen

• Aanvinkvak: (Her)teken

• Keuzerondje: Postgis SRID EPSG ID

• Selecteer een numerieke waarde:

• Selecteer een alphanumerieke waarde:

• Blader naar een bestand:

• Selecteer een kleur:

• Schuiver:

• Tekst invoer:

Een schaduw geeft aan dat het om een aanklikbaar GUI-component gaat.

2.2 Conventies Tekst of Toetsenbord

De handleiding bevat ook stijlen voor teksten, toetsenbordcommando’s en codes waarmee verschillende zaken,
zoals klassen en functies, worden aangegeven. Deze komt niet overeen met de werkelijke vertoning van tekst of
code binnen QGIS.

• Hyperlinks: http://qgis.org

• Toetsencombinaties: De snelkoppeling Ctrl+B betekent, houd de Ctrl-toets ingedrukt en druk op de B-
toets.

5

http://qgis.org


QGIS User Guide, Release 2.2

• Bestandsnaam: lakes.shp

• Naam van een klasse: NewLayer

• Functie: classFactory

• Server: myhost.nl

• Invoer door gebruiker: qgis --help

Regels met programmacode wordt getoond in een lettertype met vaste breedte:

PROJCS["NAD_1927_Albers",
GEOGCS["GCS_North_American_1927",

2.3 Platform-specifieke instructies

Meerdere aanwijzigen voor verschillende platformen kunnen worden opgenomen binnen 1 regel tekst: Selecteer

Bestand → Afsluiten QGIS → Afsluiten om QGIS af te sluiten. Dit betekent dat onder de besturingssyste-
men Linux, Unix en Windows, je eerst het menu Bestand moet kiezen en daarna Afsluiten, maar onder Macintosh
OS X je eerst het menu QGIS opent en daarna Afsluiten.

Grotere teksten kunnen als lijst zijn opgemaakt:

• Doe dit

• Doe dat

• Doe iets anders

of als paragrafen:

Doe dit en dit en dit. Doe daarna dit en dit en dit ,en dit en dit en dit, en dit en dit en dit en dit.

Doe dat. Doe daarna dat en dat en dat, en dat en dat en dat, en dat en dat en dat, en dat en dat en dat, en dat en
dat en dat.

Schermvoorbeelden in de handleiding zijn gemaakt op verschillende platforms; het platform wordt aangegeven
door de platform-icoontjes achter de beschrijving van de afbeelding.

.
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HOOFDSTUK 3

Voorwoord

Welkom in de wondere wereld van Geografische Informatie Systemen (GIS)!

QGIS is een Open Source Geografisch Informatie Systeem. Het project is ontstaan in mei 2002 en werd in juni
2002 als project op SourceForge geplaatst. De belangrijkste doelstelling van QGIS is om GIS beschikbaar en
betaalbaar te maken voor iedereen met toegang tot een computer. Op dit moment is QGIS beschikbaar voor
Windows, OS X en diverse op Unix/Linux gebaseerde systemen. QGIS is ontwikkeld gebruik makende van de Qt
toolkit (http://qt.digia.com) en C++. Hierdoor heeft QGIS een toegankelijke en prettige uitstraling (GUI) en werkt
het soepel en snel.

QGIS is een eenvoudig te gebruiken GIS met uitgebreide functionaliteit voor het werken met geografische data
en kaarten. In het begin was QGIS enkel een viewer maar momenteel ondersteund QGIS een grote hoeveelheid
raster en vector formaten en is het in staat om met een geavanceerde plugin architectuur snel nieuwe functies en
formaten te ondersteunen.

QGIS is vrijgegeven onder de GNU Public License (GPL). Deze licentie staat iedereen toe om de broncode te
bekijken en te bewerken en garandeert de vrije beschikbaarheid van GIS software die door iedereen kan worden
aangepast of uitgebreid. Een actuele versie van de licentie dient te zijn meegeleverd met elke kopie van QGIS. De
licentie is ook te lezen in Bijlage GNU General Public License.

Tip: Meest recente Documentatie
De laatste versie van dit document kan altijd gevonden worden in het documentatie gedeelte van de QGIS web-
pagina op http://www.qgis.org/nl/docs/

.
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Functionaliteit

QGIS biedt veel algemene GIS functionaliteit middels standaard funtionaliteit en plugins. Bij deze een kort
overzicht van functionaliteit onderverdeeld over zes categorieën gevolgd door een eerste verkenning van het geïn-
tegreerde Python console.

4.1 Bekijken van data

Men kan een groot aantal veelgebruikte vector- en rasterformaten in verschillende coördinatensystemen inlezen,
bekijken en over elkaar heen leggen, zonder dat men deze eerst moet omzetten naar een intern of ander veelge-
bruikt formaat. Ondersteunde formaten zijn:

• Toegang tot spatiale tabellen en views uit databases zoals PostGIS, SpatiaLite en MS SQL Spatial, Or-
acle Spatial, vector formaten ondersteund door de OGR functie bibliotheek, waaronder ESRI shapefiles,
MapInfo, SDTS, GML en vele andere, zie Werken met Vector Data.

• Raster- en afbeeldingsformaten ondersteund door de functie bibliotheek GDAL (Geospatial Data Abstrac-
tion Library), waaronder GeoTiff, ERDAS IMG, ArcInfo ASCII GRID, JPEG, PNG en vele andere, zie
Werken met Raster data.

• GRASS raster en vector formaten vanuit de GRASS database (location/mapset), zie Integratie van GRASS
GIS.

• Spatiale data die via internet services wordt aangeboden waaronder de OGC-compliant webservices WMS,
WMTS, WCS, WFS en WFS-T, zie Werken met OGC Data.

• OpenStreetMap data. See section plugins_osm.

4.2 Bevragen van gegevens en het maken van kaarten

Men kan kaarten maken en interactief spatiale gegevens bevragen via een gebruiksvriendelijke interface. Handige
tools die dit ondersteunen zijn o.a.:

• QGIS browser

• Gelijktijdige CRS-transformatie

• DB Manager

• Layouter manager

• Overzichtskaart

• Favoriete plaatsen (Spatial Bookmarks)

• Annotatie tools

• Identificeren/Selecteren van objecten

9
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• Bewerk/Bekijk/Zoek attribuutwaarden van objecten

• Data-gedefinieerd labelen

• Data-gedefinieerde vector en raster symbologie gereedschap

• Atlas kaartcompositie met gridlijnen als laag

• Noordpijl, schaalbalk en copyright label voor kaarten

• Ondersteuning voor het opslaan en weer inladen van projecten

4.3 Creeer, bewerk, beheer en exporteer data

Je kunt vector en raster kaartlagen aanmaken, bewerken, onderhouden en exporteren in en naar verschillende
formaten. QGIS biedt o.a. het volgende:

• Digitaliseergereedschap voor OGR ondersteunde vector formaten en GRASS vector kaartlagen

• Creeer en bewerk shapefiles en GRASS vector lagen

• Georeferencer plugin voor het georefereren van afbeeldingen als luchtfoto’s en satelietbeelden

• GPS tools om GPS informatie van/naar GPX formaat te importeren/exporteren. Er is ook ondersteuning
om andere GPS formaten te converteren naar GPX en direct te kunnen lezen/schrijven naar GPS apparaten.
(onder Linux, is usb: toegevoegd aan de lijst van ondersteunde GPS toestellen)

• Bekijk en bewerk gegevens van OpenStreetMap

• Maak spatiale database tabellen aan vanuit shape-bestanden met de DB Manager plugin

• Verbeterde ondersteuning van spatiale database tabellen

• Gereedschap voor het beheren van vector attributen tabellen

• Sla screenshots op als gegeorefereerde afbeeldingen

4.4 Analyseer data

Men kan verschillende spatiale analyses uitvoeren op spatiale databases en andere door OGR ondersteunde for-
maten. QGIS biedt momenteel gereedschap voor vectoranalyse, sampling, geoprocessing, geometrie en database-
beheer. Men kan ook de geïntegreerde GRASS tools gebruiken, die de volledige set van meer dan 400 modules
van GRASS functionaliteit bevat (zie Integratie van GRASS GIS). Of gebruik de Processing Plugin die QGIS
voorziet in een krachtig geospatiaal analyse framework waarmee eigen en derde partijen algoritmes kunnen wor-
den aangeroepen vanuit QGIS zoals GDAL, SAGA, GRASS, fTools en meer (zie Introductie).

4.5 Publiceer kaarten op het Internet

QGIS kan gebruikt worden als WMS, WMTS, WMS-C of WFS en WFS-T client, en als een WMS, WCS of
WFS server (zie Werken met OGC Data). Aanvullend kun je data exporteren en publiceren op het internet via een
webserver met daarop geïnstalleerd UMN MapServer of GeoServer.

4.6 Het uitbreiden van de QGIS functionaliteit met plugins

QGIS kan aangepast worden aan jouw speciale behoeften door gebruik te maken van de plugin architecture en
functiebibliotheken waarmee men zelf plugins kan maken. Men kan hiermee zelfs nieuwe GIS applicaties maken
met C++ of Python!

10 Hoofdstuk 4. Functionaliteit
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4.6.1 Standaard Plugins

Standaard Plugins zijn:

1. Coordinaat Prikker (Vastleggen coordinaten van lokatie muisaanwijzer in verschillende CRS)

2. DB Manager (voor het uitwisselen, bewerken en bekijken van kaartlagen en tabellen; uitvoeren van SQL
queries)

3. Diagram overlay (Het plaatsen van diagrammen in vectorlagen)

4. Dxf2Shp Converter (Converteert DXF naar Shape-bestanden)

5. eVIS (Visualiseer gebeurtenissen door toevoegen van foto’s)

6. fTools (Analyseren en beheren/bewerken van vectorgegevens)

7. GDALTools (Integreer GDAL Tools in QGIS)

8. Georeferencer GDAL (Het toevoegen van een georeferentie aan rasterkaarten m.b.v. GDAL)

9. GPS gereedschap (Voor het laden en importeren van GPS-data)

10. GRASS (GRASS GIS integratie)

11. Heatmap (Genereer raster heatmap/hittekaart vanuit puntgegevens)

12. Interpolatie-plugin (interpoleert op basis van vectorpunten)

13. Offline Editing (Offline wijzigen en synchroniseren met database toestaan)

14. Ondersteuning voor Oracle Spatial GeoRaster

15. Processing (voorheen SEXTANTE)

16. Raster Terrain Analyse plugin (Terrein analyses gebaseerd op Raster)

17. Road Graph Plugin (Netwerk analyse voor het bepalen van de kortste route)

18. Spatiale Query Plugin

19. SPIT (Importeer Shapebestanden in een PostgreSQL/PostGIS database)

20. SQL Anywhere Plugin (Sla vector lagen op in een SQL Anywhere database)

21. Topology Checker (Vindt topologische fouten in vectorlagen)

22. Zonal statistics plugin (berekent aantal, som, gemiddeld van raster voor elk polygoon van een vector laag)

4.6.2 Externe Python Plugins

QGIS biedt een groeiend aantal externe Python plugins die wordt aangeboden door gebruikers waarmee de QGIS
functionaliteit uitgebreid kan worden. Deze plugins zijn aanwezig in de officiële plugins repository, en deze
kunnen erg eenvoudig gevonden en geinstalleerd worden via de Python Plugin Installer. Zie The Plugins Menus.

4.7 Python Console

Maak gebruik van de geïntegreerde Python console om scripts te schrijven. Deze kan geopend worden via het
menu: Plugins → Python Console. Het console opent als een non-modal utility window. Voor directe interactie
met de QGIS omgeving, is er de variabele :data: qgis.utils.iface die een instantie is van de QgsInterface. Deze
interface biedt toegang tot het kaartbeeld, menu’s, knoppenbalken en andere onderdelen van de QGIS applicatie.

Voor meer informatie over het werken met de Python Console en het programmeren van Py|qg| plugins en appli-
caties, verwijzen we graag naar http://www.qgis.org/html/nl/docs/pyqgis_developer_cookbook/index.html.
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4.8 Bekende problemen

4.8.1 Beperking van aantal geopende bestanden

Wanneer je een QGIS project opent met veel lagen en je weet zeker dat alle kaartlagen goed zijn, maar voor enkele
lagen wordt aangegeven dat deze niet goed zijn, dan heb je te maken met dit probleem. Voor Linux (en andere
besturingssystemen) is er een limiet voor het aantal bestanden wat tegelijkertijd geopend kan worden voor een
proces. Via overerving geld deze beperking voor elk proces. Met het “limit” shell commando kan deze limit
worden gewijzigd voor het huidige shell proces; die limiet zal worden overgedragen op elk proces dat vervolgens
wordt gestart binnen de shell.

Je kunt de huidige ulimit informatie zijn met volgende opdracht

user@host:~$ ulimit -aS

Je kunt het huidig aantal toegestane aantal geopende bestanden per proces zien met het volgende commando in
een console

user@host:~$ ulimit -Sn

Om de limiet voor een bestaande sessie te veranderen, kun je een opdracht geven als

user@host:~$ ulimit -Sn #number_of_allowed_open_files
user@host:~$ ulimit -Sn
user@host:~$ qgis

Repareren voor altijd

Op de meeste Linux systemen, resource beperkingen worden tijdens het inloggen gezet door de “pam_limits”
module volgens de instellingen die zijn opgeslagen in het bestand /etc/security/limits.d/*.conf.
Wanneer je admin rechten hebt (root/sudo), kun je dit configuratie bestand wijzigen, de limiet verhogen, en ver-
volgens opnieuw inloggen om te kijken of dit het probleem oplost.

Meer informatie:

http://www.cyberciti.biz/faq/linux-increase-the-maximum-number-of-open-files/ http://linuxaria.com/article/open-
files-in-linux?lang=en

.
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Nieuw in QGIS 2.2

Please note that this is a release in our ‘cutting edge’ release series. As such, it contains new features and extends
the programmatic interface over QGIS 2.0. We recommend that you use this version over previous releases.

This release includes hundreds of bug fixes and many new features and enhancements that will be described in
this manual. You may also review the visual changelog at http://changelog.linfiniti.com/qgis/version/21/.

5.1 Nieuw voor “projecten”

• Support for measurement in nautical miles: You can now measure distances using nautical miles. To
enable this, use the Settings → Options → Map Tools option panel.

5.2 Nieuw voor “gegevens”

• One-to-many relations support: This release supports the ability to define 1:n relations. The relations are
defined in the project properties dialog. Once relations exist for a layer, a new user interface element in the
form view (e.g., when identifying a feature and opening its form) will list the related entities. This provides
a powerful way to express, for instance, the inspection history on a length of pipeline or road segment.

• DXF Export tool: A new tool for exporting DXFs has been added to the Project menu.

• Paste as new vector layer: It is a common activity in a GIS to create a sub-selection and then to create
a new layer from the selection. In QGIS you can already do Save Selection As to save a layer from your
selection; now, functionality is offered that allows you to create a new file or memory layer from whatever
is in your clipboard. Simply select some features, copy them to your clipboard and then do Edit → Paste
Features As and choose either ‘New Vector Layer’ or ‘New Memory Layer’ from the submenu. The best
part of this new feature is that if you have some Well Known Text (WKT) features in your clipboard from
another app, you can simply paste them into QGIS as a new layer now.

• WMS legend graphic in table of contents and composer: Prior to QGIS 2.2 the WMS data provider was
not able to display a legend in the table of contents’ layer list. Similarly no legend could be displayed in the
map composer. QGIS 2.2 addresses both of these issues.

5.3 Digitising

• Fill ring digitizing tool: This new tool is used to cut holes in polygons and automatically fill them with new
features. If you hold down Ctrl when finalising the feature, the attributes will be taken from the parent
feature.
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5.4 General

• Recent expressions saved: The expression builder will now remember the last 20 used expressions.

• Paste WKT from clipboard: QGIS can now paste and create a new feature based on WKT that is found in
the clipboard. Simply copy some WKT and paste into an editable layer. You can also create a new layer by
selecting Edit → Paste As → New Memory Layer.

5.5 Printvormgeving

• Zebra map border improvements: You can now set the colours of the Zebra border on the map element
in the map composer.

• Element rotation support: Every type of element in the composer can now be rotated, including scale
bars, tables and legends. For example, you can rotate a label on the composition so that it fits into your page
layout better (as illustrated). Resizing of rotated elements has also been improved.

• Composer scale added and ruler improvements: The appearance of rulers has been improved by adjusting
the scale logic and by adding smaller ruler divisions, and by making vertical rulers use rotated text. There is
also a new composer action for hiding/showing rulers. You can now quickly zoom to 100% page scale using
the new Zoom to 100% tool on the toolbar. The composer window now lets you quickly switch the page
scaling via a new scale combobox in the status bar. In addition, a new indicator has been added to show
you the precise pixel position of your cursor. The [Close] and [Help] buttons have been removed from the
bottom of the composer window to give you the maximum amount of screen space for working with your
compositions.

• World file generation: In the composer, you can now create georeferenced maps! Simply ensure that
you choose the correct map element in the Composition tab and then export your map as a PNG file. An
accompanying world file will be written, allowing you to load your exported composition in QGIS as a
raster layer.

• Working with multiple items: Support has been added for moving and resizing multiple items simultane-
ously. You can now hold Shift while resizing to maintain an item’s ratio while resizing, or hold Ctrl
to resize from the item’s centre. These shortcut keys also apply to moving items, so holding Shift while
moving an item constrains the movement to horizontal or vertical movement, and holding Ctrl temporarily
disables item snapping. You can also hold Shift while pressing a cursor key to shift all selected items by
a larger amount.

• Atlas enhancements: You can now preview the individual pages of the map atlas that will be generated in
the composer. While in atlas preview mode, you can output the current page without outputting the entire
atlas. You can also tweak the map extent or scale for each feature while previewing the atlas page. Atlas
map settings have been moved from the atlas panel to the map properties panel, so now, more than one map
can be controlled by the atlas generation. There’s a new option to automatically centre an overview map,
which comes in handy when creating atlas-based maps. More context information is also now available so
that you can adjust your symbology based on whether the feature is the current atlas feature or not.

• Improved item selection: You can now select more than one item by clicking and dragging a box to select
multiple items, and there are shortcuts for adding to a selection (holding Shiftwhile dragging), subtracting
from a selection (holding Ctrl while dragging) and switching to “within” selection mode (holding Alt
while dragging). Shift-clicking an already-selected item will remove it from the selection. There are also
shortcuts and menu items for selecting all items, clearing a selection, and inverting a selection. It’s also now
possible to select items that are hidden below other items by Ctrl-clicking an item, or by using ‘Select Next
Item Above/Below’ in the new composer Edit menu.

• Better navigation of compositions: QGIS 2.2 includes many improvements to help you navigate your
compositions. You can now zoom in or out from a composition by using the mouse scroll wheel. A
dedicated pan tool has been added, which allows you to drag the composition around, and you can also
switch immediately to pan mode by holding the space bar or by holding the mouse scroll wheel. There’s
also a new zoom tool, which allows you to precisely zoom to a specific area of your composition. You can
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also switch to zoom mode at any time by pressing and holding Ctrl-Space and drawing a zoom region on
the composition.

• Improved styling of pages and shapes: You can now control the style of the composition background using
the full range of QGIS’ symbology options. It’s now possible to export compositions with a transparent (or
semi-transparent) background. Shape items (rectangles, triangles and ellipses) can also be styled using the
same options as polygon map layers. You can even style the page background or shapes by using data-
defined settings based on the current atlas feature! There’s also a new option for rounding the corners of
rectangle shapes.

5.6 QGIS Server

• WCS Support added to QGIS Server: QGIS Server already supports various standards, including Web
Map Service (WMS version 1.3.0 and 1.1.1), Web Feature Service (WFS version 1.0.0) and Web Feature
Service with Transaction (WFS-T). With this new release of QGIS, you can now serve raster layers using
the Web Coverage Service (WCS version 1.0.0) standard.

5.7 Symbologie

• Gradient fill support: The new gradient fill feature lets you create better cartography than ever before. The
feature has numerous options providing for great flexibility in how you apply gradients to your features.
These include:

– Two-colour or ramp-based fills

– Canvas- or object-based origin for your gradients

– Gradients originating from the centroid of a feature

– Conical, linear and radial gradient types

– Data-defined options (i.e., to use an expression or a table

column) for all gradient properties

• Label support for palleted rasters: Rasters that use a fixed colour pallette (for instance, a land cover map)
can now have category labels assigned which will be shown in the map legend and in the composer legend.

• Colour ramps can be inverted: A new option has been added to symbology dialogs that deal with colour
ramps to allow you to invert the colour ramp when it is created.

• Copy and Paste in rule-based renderer: In the rule-based renderer, you can now right-click on a rule and
then copy and paste the rule as a new rule.

• On-the-fly feature generalisation: QGIS 2.2 introduces support for on-the-fly feature generalisation. This
can improve rendering times when drawing many complex features at small scales. This feature can be
enabled or disabled in the layer settings. There is also a new global setting that enables generalisation by
default for newly added layers. Note: Feature generalisation may introduce artefacts into your rendered
output in some cases. These may include slivers between polygons and inaccurate rendering when using
offset-based symbol layers.

• Anchor points can be set for marker layers: When defining symbology with marker layers (e.g., a point
layer symbolized with SVG markers) you can now specify what part of the image should correspond to the
‘anchor point’. For example, you can indicate that the bottom-left corner of the image should coincide with
the position of the feature. You can also use the data-defined properties to have this property set at render
time based on an attribute in the data table for that layer (or an arbitrary expression).

• Thematic maps based on expressions: Categorized and graduated thematic maps can now be created
using the result of an expression. In the Properties dialog for vector layers, the attribute chooser has been
augmented with an expression builder. So now, you no longer need to write the classification attribute to
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a new column in your attribute table if you want the classification attribute to be a composite of multiple
fields, or a formula of some sort.

• Expression support in symbol diagrams for size and attributes: You can now use an expression to define
the size and attributes when using the diagramming capabilities of QGIS.

• Else rule in rule-based renderer: The rule-based renderer now supports an Else rule that will be run if
none of the other rules on that level match. Else rules can be nested just like any other rules. An example
might be:

type = ’water’ (style grey) ELSE (style red)

• Inner stroke support for polygons: Support has been added for polygon strokes to be limited to the interior
of the polygon (so as not to overflow into a neighbouring polygon).

5.8 Gebruikers-interface

• Improved properties dialogs: All properties dialogs have had their main property menus updated so that
they look slicker, with an inverse-coloured side bar. This is purely cosmetic but should make it easier to
know what your current context is in a dialog.

• Expression dialog improvements: We have made some tweaks to the expression dialog - power users can
now hide the operator buttons. There are also now splitters between the function list and function help areas,
and between the expression and function list area.

• New keybindings: We have updated the keyboard shortcuts in QGIS to make it more efficient to carry out
repetitive tasks.

– Ctrl-d: Remove selected layers in table of contents

– >: Select next vertex when using the node tool

– <: Select previous vertex when using the node tool

– Delete or Backspace: Delete the selected features (you can undo these actions), or nodes when
using the node tool

– F5: Update the canvas (instead of Ctrl-r)

.
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Beginnen

Dit hoofdstuk geeft een snel overzicht van de installatie van QGIS, voorbeeld data die gedownload kan worden
van de QGIS web pagina en een eerste simpele GIS-sessie waarbij raster en vector kaartlagen zichtbaar worden
gemaakt.

6.1 Installatie

Het installeren van QGIS is eenvoudig. Er zijn standaard installatiepakketten beschikbaar voor MS Windows
en Mac OS X. Voor GNU/Linux distributies bestaan er zogenaamde binary packages (rpm and deb) of soft-
ware repositories die toegevoegd kunnen worden aan de installatie manager waarna QGIS gedownload en geïn-
stalleerd kan worden. De laatste informatie over binary packages is beschibaar op de QGIS website onder
http://download.qgis.org.

6.1.1 Installatie vanuit broncode

Wanneer je QGIS vanuit de broncode wilt opbouwen zie de installatie instructies. Deze worden gedis-
tribueerd met de QGIS broncode in een bestand met de naam ‘INSTALL’. Deze is ook online beschikbaar zie
http://htmlpreview.github.io/?https://raw.github.com/qgis/QGIS/master/doc/INSTALL.html

6.1.2 Installatie op een extern medium

Het is mogelijk om QGIS op een USB stick of een ander extern medium te zetten met plugins, persoonlijke in-
stellingen en data. Dit kan door gebruik te maken van de --configpath optie als extra opstart argument mee
te geven die het standaardpad overschrijft (bijv. ~/.qgis2 onder linux) die gebruikt word voor de gebruikersconfig-
uratie en instellingen (QSettings gebruikt dan nl. dit pad), zie ook Systeem Menu.

6.2 Voorbeeld Data

De gebruikershandleiding bevat voorbeelden die gebaseerd zijn op de QGIS voorbeeld dataset.

Het installatiepakket voor Windows, bevat de optie om ook de QGIS voorbeeld dataset te downloaden. Wanneer
die optie wordt aangevinkt, zal de data worden gedownload en geplaatst onder Mijn Documenten in een folder
genaamd GIS Database. Je kunt uiteraard de Windows Explorer gebruiken om deze folder ergens anders neer
te zetten. Wanneer je de optie niet hebt aangevinkt om de voorbeeld database te downloaden tijdens de installie
van QGIS, kan men:

• GIS data gebruiken die je al hebt

• De voorbeeld dataset downloaden van http://download.osgeo.org/qgis/data/qgis_sample_data.zip

• De QGIS installatie verwijderen en opnieuw installeren, maar deze keer met de data download optie
aangevinkt (maar doe dit alleen wanneer je problemen had met de voorgaande keuzes)
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Voor GNU/Linux en Mac OS X is de voorbeeld dataset nog niet beschikbaar via rpm, deb of dmg packages.
Download de voorbeeld dataset door het gecomprimeerd bestand qgis_sample_data als ZIP archief van
http://download.osgeo.org/qgis/data/qgis_sample_data.zip en pak deze vervolgens uit met unzip op jouw systeem.

De Alaska dataset bevat de GIS data die is gebruikt in de voorbeelden en in de screenshots van de gebruikershan-
dleiding en bevat ook een kleine GRASS database. De gebruikte projectie voor de QGIS voorbeeld dataset is
Alaska Albers Equal Area met als lengte-eenheid de Engelse lengtemaat feet (1 ft=0.305 m). De EPSG code is
2964.

PROJCS["Albers Equal Area",
GEOGCS["NAD27",
DATUM["North_American_Datum_1927",
SPHEROID["Clarke 1866",6378206.4,294.978698213898,
AUTHORITY["EPSG","7008"]],
TOWGS84[-3,142,183,0,0,0,0],
AUTHORITY["EPSG","6267"]],
PRIMEM["Greenwich",0,
AUTHORITY["EPSG","8901"]],
UNIT["degree",0.0174532925199433,
AUTHORITY["EPSG","9108"]],
AUTHORITY["EPSG","4267"]],
PROJECTION["Albers_Conic_Equal_Area"],
PARAMETER["standard_parallel_1",55],
PARAMETER["standard_parallel_2",65],
PARAMETER["latitude_of_center",50],
PARAMETER["longitude_of_center",-154],
PARAMETER["false_easting",0],
PARAMETER["false_northing",0],
UNIT["us_survey_feet",0.3048006096012192]]

Wanneer je QGIS wilt gebruiken als de grafische gebruikersinterface om te werken met GRASS databases,
kun je ook voorbeeldgegevens vinden (Spearfish en South Dakota) op de officiele GRASS GIS website
http://grass.osgeo.org/download/sample-data/.

6.3 Voorbeeld Sessie

Nu QGIS is geinstalleerd en je beschikt over voorbeeldgegevens, kunnen we het gebruik van QGIS demonstreren
via een eenvoudige sessie. We zullen kaartgegevens in raster- en vectorformaat laden en zichtbaar maken. We
gebruiken daarvoor de landcover raster laag, qgis_sample_data/raster/landcover.img en de
vectorlaag lakes, qgis_sample_data/gml/lakes.gml.

6.3.1 Start QGIS

• Start QGIS door “QGIS” in te typen op de commando regel, of door deze te starten vanuit het Applicaties
menu.

• Start QGIS vanuit het Start menu of vanuit de snelkoppeling op je bureaublad of door te dubbelklikken
op een QGIS project.

• Dubbelklik op het icoontje van QGIS in de Applicatie folder.

6.3.2 Laad een raster- en vectorkaart uit de voorbeeld dataset

1. Klik op het icoon Rasterlaag Toevoegen.

2. Blader naar de folder qgis_sample_data/raster/, selecteer het ERDAS Img bestand
landcover.img en klik op [Open].
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3. If the file is not listed, check if the Files of type combo box at the bottom of the dialog is set on the
right type, in this case “Erdas Imagine Images (*.img, *.IMG)”.

4. Klik vervolgens op het icoon Vectorlaag Toevoegen.

5. De Bestand dient te worden geselecteerd als Databron in de dialoog Vectorlaag toevoegen. Klik op de
knop [Bladeren] om het vectorbestand te selecteren.

6. Browse to the folder qgis_sample_data/gml/, select ‘Geography Markup Language [GML] [OGR]

(.gml,.GML)’ from the Files of type combo box, then select the GML file lakes.gml and click
[Open]. In the Add vector layer dialog, click [OK].

7. Zoom een beetje in op een gebied met enkele meren.

8. Dubbelklik op de kaartlaag lakes in het lagen panel aan de linkerkant, om de dialoog Eigenschappen te
openen.

9. Selecteer het tabblad Stijl en selecteer blauw als vulkleur.

10. Selecteer het menu Labels en vink de optie Label deze laag met aan. Kies als Veld te gebruiken voor
labels, het veld “NAMES”.

11. Om de leesbaarheid van de labels te vergroten, kun je er een witte buffer omheen laten tekenen. Klik op

“Buffer” in de lijst aan de linkerzijde en vink vervolgens de optie Labels met buffer en kies 3 als waarde
voor Grootte van buffer.

12. Klik op [Apply], en controleer of het resultaat er goed uitziet, klik tenslotte op [OK].

U ziet hoe eenvoudig het is om Raster en Vector gegevens te tonen in QGIS. Laten we verder gaan om meer te
leren over de beschikbare functionaliteit, eigenschappen en mogelijke instellingen en hoe deze te gebruiken.

6.4 Het starten en afsluiten van QGIS

In Voorbeeld Sessie heb je geleerd hoe je QGIS kunt starten. Dit komt nogmaals aan bod en we zullen ook laten
zien dat QGIS opgestart kan worden met extra opties op de opdrachtregel.

• Er vanuitgaande dat het pad naar QGIS is opgenomen in PATH, kun je QGIS opstarten door qgis op
de opdrachtregel in te typen of door te dubbelklikken op de snelkoppeling naar de QGIS applicatie op het
bureaublad of in het applicatiemenu.

• Start QGIS vanuit het Start menu of vanuit de snelkoppeling op je bureaublad of door te dubbelklikken
op een QGIS project.

• Dubbelklik op het icoon van QGIS in je Applicatie folder. Wanneer
je QGIS wilt opstarten vanuit een terminal-venster, start deze dan op met:
/pad-naar-installatie-executable/Contents/MacOS/Qgis.

Om QGIS af te sluiten, klic in het menu Bestand QGIS → Afsluiten Om QGIS af te sluiten, of gebruik
de toetsencombinatie Ctrl+Q.

6.5 Commando Regel Opties

QGIS ondersteund een aantal opties die meegegeven kunnen worden wanneer deze gestart worden vanaf de
opdrachtregel. Om een lijst van argumenten te zien die je op de opdrachtregel mee kunt geven gebruik geef qgis
--help op de opdrachtregel. Het te gebruikte statement voor QGIS en het resultaat is hieronder weergegeven:

qgis --help
QGIS - 2.2.0-Valmiera ’Valmiera’ (exported)
QGIS is a user friendly Open Source Geographic Information System.
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Usage: qgis [OPTION] [FILE]
options:
[--snapshot filename] emit snapshot of loaded datasets to given file
[--width width] width of snapshot to emit
[--height height] height of snapshot to emit
[--lang language] use language for interface text
[--project projectfile] load the given QGIS project
[--extent xmin,ymin,xmax,ymax] set initial map extent
[--nologo] hide splash screen
[--noplugins] don’t restore plugins on startup
[--nocustomization] don’t apply GUI customization
[--customizationfile] use the given ini file as GUI customization
[--optionspath path] use the given QSettings path
[--configpath path] use the given path for all user configuration
[--code path] run the given python file on load
[--help] this text

FILES:
Files specified on the command line can include rasters,
vectors, and QGIS project files (.qgs):
1. Rasters - Supported formats include GeoTiff, DEM

and others supported by GDAL
2. Vectors - Supported formats include ESRI Shapefiles

and others supported by OGR and PostgreSQL layers using
the PostGIS extension

Tip: Voorbeeld gebruik argumenten opdrachtregel
Je kunt QGIS starten door een of meerdere gegevensbestanden te geven op de opdrachtregel. Bijvoorbeeld wan-
neer je je in de folder qgis_sample_data bevindt kun je QGIS starten en tegelijkertijd een raster en een
vectorbestand openen tijdens het opstarten met de volgende opdracht: qgis ./raster/landcover.img
./gml/lakes.gml

Opdrachtregel optie --snapshot

Deze optie geeft de mogelijkheid om een shapshot (een plaatje) te schieten in PNG formaat van de huidige view.
Dit is een handige optie wanneer je heel veel projecten hebt en je snel snapshots wilt aanmaken van de projecten.

Standaard genereerd deze een PNG bestand met een resolutie van 800x600 pixels. Dit kan worden aangepast door
de opties --width en --heightmee te geven op de opdrachtregel. Een bestandsnaam kan worden meegegeven
achter --snapshot.

Opdrachtregel optie --lang

Gebaseerd op de ingestelde standaard taal van je systeem zal QGIS opstarten in die taal. Wanneer je echter
toch QGIS in een andere taal wilt opstarten dan kun je dit doen door een taalcode mee te geven bijvoorbeeld:
--lang=it start QGIS in het italiaans. Een lijst van de huidige ondersteunde talen met taalcode en status is
gegeven op http://hub.qgis.org/wiki/quantum-gis/GUI_Translation_Progress.

Opdrachtregel optie --project

Het opstarten van QGIS met een bestaand projectbestand is ook mogelijk. Voeg aan de opdrachtregel de optie
--project gevolgd door het QGIS project bestand waarmee je QGIS wilt openen.

Opdrachtregel optie --extent

Met deze optie kun je precies het geografische gebied aangeven dat je direct na het opstarten in beeld wilt zien. De
volgende coördinaten van de linker benedenhoek en de rechter bovenhoek dienen, gescheiden door een komma,
als volgt ingegeven te worden:

--extent xmin,ymin,xmax,ymax

Opdrachtregel optie --nologo

Hiermee start je QGIS op zonder het eerste intro scherm van QGIS te zien.
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Opdrachtregel optie --noplugins

Wanneer het opstarten problemen geeft en je denkt dat dit veroorzaakt wordt door plugins, kun je deze optie
meegeven zodat de plugins niet direct worden bijgeladen tijdens het opstarten. De plugins zullen nadien wel
beschikbaar zijn vanuit de Plugins Manager.

Opdrachtregel optie --customizationfile

Met deze opdrachtregel optie, kun je een GUI aanpassingen bestand opgeven die wordt toegepast tijdens het
opstarten.

Opdrachtregel optie --nocustomization

Met deze opdrachtregel optie zullen bestaande GUI aanpassingen niet worden toegepast tijdens het opstarten.

Opdrachtregel optie --optionspath

You can have multiple configurations and decide which one to use when starting QGIS with this option. See
Opties to confirm where the operating system saves the settings files. Presently, there is no way to specify a file to
write settings to; therefore, you can create a copy of the original settings file and rename it.

Opdrachtregel optie --configpath

Deze optie lijkt sterk op voorgaande optie, maar daarbij wordt ook het standaard pad /.qgis overschreven voor de
voorkeursinstellingen van QGIS en dwingt QSettings om in plaats daarvan gegeven folder te gebruiken. Gebruik
van deze optie geeft gebruikers de mogelijkheid om de QGIS installatie met alle plugins en instellingen op een
USB-stick te zetten en van daaruit op te starten.

6.6 Projecten

De staat van een QGIS sessie wordt beschouwd als een project. QGIS werkt met één project tegelijkertijd. In-
stellingen kunnen betrekking hebben op het project, maar ook standaardinstellingen betreffen voor nieuwe pro-

jecten (zie Opties). QGIS kan de huidige staat opslaan in een project bestand met de menu opties Project →

Opslaan of Project → Opslaan als....

Laad een opgeslagen project in de huidige QGIS sessie met Project → Open ..., Project → Nieuw van template
of Project → Open Recent →.

Wanneer je de huidige sessie wilt opschonen en met een nieuwe wilt beginnen, kies Project → Nieuw. Beide
menu opties zullen met de vraag komen of je de laatste wijzigingen wilt opslaan, wanneer er wijzigingen zijn
geweest sinds de laatste keer dat je het project hebt opgeslagen of geopend.

De informatie die wordt opgeslagen in een projectbestand zijn:

• De toegevoegde kaartlagen

• De eigenschappen van elke laag, inclusief symbologie

• Gebruikte coordinatensysteem voor het kaartbeeld

• De grootte en inhoud van de kaart zoals je deze het laatst zag

Het projectbestand wordt opgeslagen in XML formaat, wat een formaat is dat men ook buiten QGIS eenvoudig kan
bewerken, maar dan moet je wel voorzichtig zijn met wijzigingen. De opbouw van het XML bestand is gewijzigd
met het uitkomen van nieuwe versies van QGIS. De kans is groot dat delen van oudere projectbestanden op een
gegeven moment niet meer goed functioneren. Om hiervan op de hoogte te worden gehouden kan men in het
tabblad Algemeen tab under Instellingen → Opties het volgende aanvinken:

• Geef een waarschuwing om project en gewijzigde gegevens op te slaan indien nodig

• geef een waarschuwing bij het openen van een projectfile uit een oudere versie van QGIS

Wanneer je een project opstaat in QGIS 2.2 zal er nu automatisch een backup worden gemaakt van het projectbe-
stand.
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6.7 Eindproducten

Er zijn verschillende manieren om eindproducten te maken vanuit je QGIS sessie. We hebben al een manier be-
sproken in Projecten opslaan als een project bestand. Hier is een voorbeeld van andere manieren om eindproducten
te genereren:

• Menu optie Project → Opslaan als afbeelding... opent een bestandsdialoog waarmee je de naam, het pad en
een afbeeldingstype (PNG of JPG formaat) kunt selecteren waarmee deze wordt opgslagen. Er wordt au-
tomatisch een world file toegevoegd, met de extensie PNGW of JPGW in dezelfde folder, die de afbeelding
een goede georeferentie meegeven.

• Via menu Project → DXF Export ... opent een dialoog waarin je de ‘Symbologie modus’, de ‘Symbologie
schaal’ en de vectorlagen die je wilt exporteren naar DXF.

• Menu optie:menuselection:Project –> Nieuwe Print Layouter opent een nieuw scherm waarmee je
een nieuwe kaartlayout kunt maken waarin het kaartbeeld kan worden verwerkt om deze vervolgens af te
drukken (zie Printvormgeving).

.
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QGIS GUI

Wanneer QGIS start zal de volgende gebruikersinterface getoond als in de afbeelding ( nummer 1 t/m 5 in het geel
refereren worden hierna toegelicht):

Figuur 7.1: QGIS GUI met Alaska voorbeeld data

Notitie: Dit kan enigszins afwijken afhankelijk onder welk platform QGIS draait en welke vensterbeheer je
gebruikt of hoe deze is ingesteld.

De QGIS gebruikersinterface is onderverdeeld in 5 gebieden:

1. Menubalk

2. Werkbalk

3. Legenda

4. Kaartbeeld

5. Statusbalk

Deze vijf onderdelen worden in de volgende subparagrafen in detail beschreven. Daarnaast wordt in twee sub-
paragrafen de snelkoppelingen en de context helpfunctie beschreven.
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7.1 Menubalk

De menubalk biedt toegang tot verschillende QGIS functies vanuit een standaard hierarchisch opgebouwd menu.
De hoofdmenu’s en een samenvatting van enkel menu-opties die zich daarin bevinden worden hieronder gegeven
samen met van elk daarvan het icoon van de daarbij behorende knop op de werkbalk en bijbehorende snelkop-
peling. De hier beschreven snelkoppelingen zijn standaard ingesteld; maar indien gewenst kunnen deze snelkop-
pelingen aangepast worden, gebruik daarvoor de dialoog Snelkoppelingen bewerken die geopend kan worden via
Extra → Snelkoppelingen bewerken....

Alhoewel de meeste menu opties een overeenkomstige functie hebben en vice-versa, zijn de menu’s niet exact
ingedeeld zoals de werkbalken. De werkbalk die een functie bevat, wordt eveneens genoemd. Enkele menuop-
ties verschijnen alleen wanneer de overeenkomstige plugin is geladen. Voor meer informatie over functies en
werkbalken, zie Werkbalk.

7.1.1 Project

Menu Optie Snelkoppeling Referentie Werkbalk

Nieuw Ctrl+N zie Projecten Project

Open Ctrl+O zie Projecten Project
Nieuw van template → zie Projecten Project
Open Recent → zie Projecten

Opslaan Ctrl+S zie Projecten Project

Opslaan Als... Ctrl+Shift+S zie Projecten Project

Opslaan als afbeelding see Eindproducten
DXF Export ... see Eindproducten

Nieuwe print Layouter Ctrl+P zie Printvormgeving Project

Layouter manager ... zie Printvormgeving Project
Print Layouter → zie Printvormgeving

QGIS Afsluiten Ctrl+Q
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7.1.2 Bewerken

Menu Optie Snelkop-
peling

Referentie Werkbalk

Ongedaan maken Ctrl+Z zie Geavanceerd Digitaliseren Geavanceerd
Digitaliseren

Opnieuw Ctrl+Shift+Zzie Geavanceerd Digitaliseren Geavanceerd
Digitaliseren

Kaartobjecten knippen Ctrl+X zie Het digitaliseren van een
bestaande kaartlaag

Digitaliseren

Kaartobjecten kopiëren Ctrl+C zie Het digitaliseren van een
bestaande kaartlaag

Digitaliseren

Kaartobjecten Plakken Ctrl+V zie Het digitaliseren van een
bestaande kaartlaag

Digitaliseren

Objecten plakken als → zie Werken met de Attributen
Tabel

Object toevoegen Ctrl+. zie Het digitaliseren van een
bestaande kaartlaag

Digitaliseren

Object(en) Verplaatsen zie Het digitaliseren van een
bestaande kaartlaag

Digitaliseren

Geselecteerd(e) Object(en)
Verwijderen

zie Het digitaliseren van een
bestaande kaartlaag

Digitaliseren

Objecten roteren zie Geavanceerd Digitaliseren Geavanceerd
Digitaliseren

Versimpel Object zie Geavanceerd Digitaliseren Geavanceerd
Digitaliseren

Ring Toevoegen zie Geavanceerd Digitaliseren Geavanceerd
Digitaliseren

Onderdeel Toevoegen zie Geavanceerd Digitaliseren Geavanceerd
Digitaliseren

Vul Ring zie Geavanceerd Digitaliseren Geavanceerd
Digitaliseren

Verwijder Ring zie Geavanceerd Digitaliseren Geavanceerd
Digitaliseren

Verwijder Onderdeel zie Geavanceerd Digitaliseren Geavanceerd
Digitaliseren

Object vervormen zie Geavanceerd Digitaliseren Geavanceerd
Digitaliseren

Verspring Curve zie Geavanceerd Digitaliseren Geavanceerd
Digitaliseren

Kaartobjecten splitsen zie Geavanceerd Digitaliseren Geavanceerd
Digitaliseren

Onderdelen splitsen zie Geavanceerd Digitaliseren Geavanceerd
Digitaliseren

Geselecteerde Objecten
Samenvoegen

zie Geavanceerd Digitaliseren Geavanceerd
Digitaliseren

Attributen van Geselecteerde
Objecten Samenvoegen

zie Geavanceerd Digitaliseren Geavanceerd
Digitaliseren

Knooppunt-gereedschap zie Het digitaliseren van een
bestaande kaartlaag

Digitaliseren

Puntsymbolen roteren zie Geavanceerd Digitaliseren Geavanceerd
Digitaliseren
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Na het activeren van de Bewerken modus Bewerken aan/uitzetten voor een geselecteerde vector kaartlaag, zal er een
extra menu optie Toevoegen zijn toegevoegd in het menu Bewerken afhankelijk van het type vector (punt, lijn
of polygoon).

7.1.3 Bewerken (extra)

Menu Optie Snelkoppeling Referentie Werkbalk

Object toevoegen zie Het digitaliseren van een bestaande kaartlaag Digitaliseren

Object toevoegen zie Het digitaliseren van een bestaande kaartlaag Digitaliseren

Object toevoegen zie Het digitaliseren van een bestaande kaartlaag Digitaliseren

7.1.4 Beeld

Menu Optie Snelkoppeling Referentie Werkbalk

Kaart verschuiven Kaart
Navigatie

Kaart verschuiven naar
selectie

Kaart
Navigatie

Inzoomen Ctrl++ Kaart
Navigatie

Uitzoomen Ctrl+- Kaart
Navigatie

Selecteren → zie Selecteren en deselecteren van
objecten

Attributen

Objecten Identificeren Ctrl+Shift+I Attributen
Opmeten → zie Meten Attributen

Volledig uitzoomen Ctrl+Shift+F Kaart
Navigatie

Op Kaartlaag Inzoomen Kaart
Navigatie

Inzoomen Op Selectie Ctrl+J Kaart
Navigatie

Laatste Zoomniveau Kaart
Navigatie

Zoom naar Volgende Kaart
Navigatie

Zoom naar Ware Grootte Kaart
Navigatie

Decoraties → zie Decoraties

Kaart Tips Attributen

Nieuwe favoriet Ctrl+B zie Favoriete Plaatsen Attributen

Toon Favorieten Ctrl+Shift+B zie Favoriete Plaatsen Attributen

Bijwerken Ctrl+R Kaart
Navigatie
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7.1.5 Kaartlagen

Menu Optie Snelkoppeling Referentie Werkbalk
Nieuw → zie Het aanmaken van een nieuwe Vectorlagen Kaartlagen bewerken
Kaartlagen en groepen inbedden ... zie Projecten in een project

Vectorlaag Toevoegen Ctrl+Shift+V zie Werken met Vector Data Kaartlagen bewerken

Rasterlaag Toevoegen Ctrl+Shift+R zie Raster data laden in QGIS Kaartlagen bewerken

PostGIS Laag Toevoegen Ctrl+Shift+D zie PostGIS kaartlagen Kaartlagen bewerken

Spatialite-laag Toevoegen Ctrl+Shift+L zie SpatiaLite-kaartlagen Kaartlagen bewerken

MSSQL Spatial-Laag Toevoegen Ctrl+Shift+M zie label_mssql Kaartlagen bewerken

Oracle GeoRaster Toevoegen zie Oracle Spatial GeoRaster-plugin Kaartlagen bewerken

SQL Anywhere Laag Toevoegen zie Plug-in SQL Anywhere Kaartlagen bewerken

WMS/WMTS Laag Toevoegen Ctrl+Shift+W zie WMS/WMTS-cliënt Kaartlagen bewerken

WCS-Laag toevoegen zie WCS-cliënt Kaartlagen bewerken

WFS-Laag toevoegen zie WFS- en WFS-T-cliënt Kaartlagen bewerken

Toevoegen Tekengescheidentekst kaartlaag see label_dltext Kaartlagen bewerken

Kopiëer stijl zie Menu Stijl

Plak stijl zie Menu Stijl

Open attributentabel zie Werken met de Attributen Tabel Attributen

Bewerken aan/uitzetten zie Het digitaliseren van een bestaande kaartlaag Digitaliseren

Wijzigingen opslaan zie Het digitaliseren van een bestaande kaartlaag Digitaliseren

Huidige Wijzigingen → zie Het digitaliseren van een bestaande kaartlaag Digitaliseren
Opslaan als...
Selectie opslaan als vectorbestand... zie Werken met de Attributen Tabel

Laag/lagen verwijderen Ctrl+D

Laag/lagen dupliceren
Instellen laag-CRS Ctrl+Shift+C
Project CRS van kaartlaag overnemen
Eigenschappen
Query...

Labels

Toevoegen aan Overzichtskaart Ctrl+Shift+O Kaartlagen bewerken

Alles aan Overzichtskaart Toevoegen

Verwijder Alles Van Overzichtskaart

Toon Alle Lagen Ctrl+Shift+U Kaartlagen bewerken

Verberg Alle Lagen Ctrl+Shift+H Kaartlagen bewerken
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7.1.6 Instellingen

Menu Optie Snelkoppeling Referentie Werkbalk
Panelen → zie Panelen en Werkbalken
Werkbalken → zie Panelen en Werkbalken
Volledig scherm aan/uit F 11

Projectinstellingen ... Ctrl+Shift+P zie Projecten

Aangepaste CRS ... zie Aangepaste Coördinaten Referentie Systeem
Stijl Manager... zie vector_style_manager

Snelkoppelingen bewerken ...
Aanpassingen ... zie Aanpassingen
Opties ... zie Opties

‘Snapping’-opties ...

7.1.7 Plugins

Menu Optie Snelkoppeling Referentie Werkbalk

Beheer en installeer Plugins zie The Plugins Menus
Python Console

De eerste keer wanneer QGIS wordt gestart worden niet all core plugins geladen.

7.1.8 Vector

Menu Optie Snelkoppel-
ing

Referentie Werk-
balk

Open Street Map → zie Het laden van vectorgegevens van
OpenStreetMap

Analyse Gereedschap → zie Plug-in fTools

Onderzoeksgereedschap → zie Plug-in fTools

Geoprocessing
Gereedschap →

zie Plug-in fTools

Geometrie Gereedschap → zie Plug-in fTools

Datamanagement
Gereedschap →

zie Plug-in fTools

De eerste keer wanneer QGIS wordt gestart worden niet all core plugins geladen.

7.1.9 Raster

Menu Optie Snelkoppeling Referentie Werkbalk
Rasterberekeningen zie Rasterberekeningen

De eerste keer wanneer QGIS wordt gestart worden niet all core plugins geladen.
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7.1.10 Processing

Menu Optie Snelkoppeling Referentie Werkbalk

Gereedschapskist zie De Toolbox

Grafische Modeler zie Grafische modellen bouwen

Historie en log zie Beheren van de historie

Opties en configuratie zie Configureren van het framework Processing

Resultaten viewer see Configureren externe toepassingen

Commander Ctrl+Alt+M zie The SEXTANTE Commander

De eerste keer wanneer QGIS wordt gestart worden niet all core plugins geladen.

7.1.11 Help

Menu Optie Snelkoppeling Referentie Werkbalk

Inhoudsopgave F1 Help

What’s This? Shift+F1 Help
API documentatie
Commerciële ondersteuning nodig?

QGIS Start Pagina Ctrl+H

QGIS op updates controleren

Info

QGIS Sponsors

De hierboven genoemde Menubalk items zijn in Linux standaard allemaal aanwezig onder de KDE window
manager. Onder GNOME heeft het hoofdmenu Extra een andere inhoud en de onderdelen kunnen hier gevonden
worden:

Projectinstellingen Project
Opties Bewerken
Snelkoppelingen bewerken ... Bewerken

Stijl Manager... Bewerken

Aangepaste CRS ... Bewerken
Panelen → Beeld
Werkbalken → Beeld
Volledig scherm aan/uit Beeld
Tile schaalschuif Beeld
GPS-informatie Beeld

7.2 Werkbalk

De werkbalken geven toegang tot de meeste functies die je ook terugvindt in de menu-structuur, plus kaartgereed-
schap. Elke knop op de werkbalk heeft ook een tooltip, informatie die na een tijdje automatisch verschijnt wanneer
je de muisaanwijzer er even boven houdt.

Elke werkbalk kan verplaatst worden en zowel verticaal als horizontaal geplaatst worden waar jij wilt, tussen de
menubalk bovenin en de statusbalk onderin. Daarnaast kun je werkbalken tijdelijk verwijderen via het snelmenu,
die verschijnt wanneer je de rechtermuisknop indrukt wanneer de muisaanwijzer zich boven een werkbalk bevindt
(zie ook Panelen en Werkbalken).
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Tip: Werkbalken weer terugzetten
Wanneer je per ongeluk al je werkbalken hebt verwijderd, dan kun je ze weer terugzetten via de menukeuze Extra
→ Werkbalken →. Wanneer een werkbalk verdwenen is onder Windows, wat blijkbaar wel eens gebeurt, dan kun
je dat ook oplossen door de registry key \HKEY_CURRENT_USER\Software\QGIS\qgis\UI\state te
verwijderen uit de registry. Wanneer je vervolgens QGIS opnieuw start zullen alle werkbalken weer zichtbaar zijn.

7.3 Legenda

The map legend area lists all the layers in the project. The checkbox in each legend entry can be used to show or
hide the layer.

Een laag kan na selectie hoger of lager in de legenda gezet worden door deze te slepen met ingedrukte linker-
muisknop. Hoe hoger in de legenda, hoe later deze laag getekend wordt. De bovenste kaartlaag wordt dan ook
over alle andere kaartlagen getekend.

Notitie: Dit gedrag kan overschreven worden via het paneel ‘Laagvolgorde’.

Lagen in het Legenda venster, kunnen in groepen worden ondergebracht. Er zijn twee manieren om dit te doen:

1. Right click in the legend window and choose Add New Group. Type in a name for the group and press
Enter. Now click on an existing layer and drag it onto the group.

2. Selecteer enkele lagen, start met de rechtermuisknop het snelmenu vanuit het paneel van de legenda en kies
Groep geselecteerd. De geselecteerde lagen zullen automatisch aan de nieuwe groep worden toegevoegd.

Om een laag uit een groep te halen kun je deze eruit slepen, of door een laag in een groep te selecteren en dan via
de rechtermuis het snelmenu te openen en te kiezen voor Maak hier een toplevel item van. Een groep kan groepen
bevatten.

Met het aanvinkvakje kun je ineens de zichtbaarheid van alle lagen die behoren tot die groep aan- of uitzetten.

De inhoud van het snelmenu, die je met de rechtermuisknop kunt oproepen voor een geselecteerd legenda object,
is anders voor vector of raster kaartlagen. Wanneer het een GRASS vector laag betreft ontbreekt de menu-optie

bewerken aan/uitzetten. Zie Digitaliseren en bewerken van een GRASS vectorlaag voor informatie hoe je GRASS
vector kaartlagen kunt bewerken.

Snelmenu onder rechtermuisknop voor raster lagen

• Zoom naar laagextent

• Zoom naar Beste Schaal (100%)

• Uitrekken naar huidige extent

• Toon in overzichtskaart

• Verwijder

• Duplicaat

• Instellen laag-CRS

• Project CRS van kaartlaag overnemen

• Opslaan als ...

• Eigenschappen

• Hernoem

• Kopiëer stijl

• Add New Group
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• Expand all

• Collapse all

• Update Drawing Order

Aanvullen, volgens laagpositie en selectie

• Maak hier een ‘top level’ item van

• Groep geselecteerd

Snelmenu onder Rechter muisknop voor vector lagen

• Zoom naar laagextent

• Toon in overzichtskaart

• Verwijder

• Duplicaat

• Instellen laag-CRS

• Project CRS van kaartlaag overnemen

• Open attributentabel

• Bewerken aan/uitzetten (niet beschikbaar voor GRASS lagen)

• Opslaan als ...

• Save Selection As

• Query

• Aantal kaartobjecten tonen

• Eigenschappen

• Hernoem

• Kopiëer stijl

• Add New Group

• Expand all

• Collapse all

• Update Drawing Order

Aanvullen, volgens laagpositie en selectie

• Maak hier een ‘top level’ item van

• Groep geselecteerd

Snelmenu onder rechtermuisknop voor laag groepen

• Zoom naar groep

• Verwijder

• Instellen groep-CRS

• Hernoem

• Add New Group

• Expand all

• Collapse all

• Update Drawing Order
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Het is mogelijk om meer dan een laag of groep tegelijkertijd te selecteren door de Ctrl -toets vast te houden tij-
dens het selecteren van lagen met de linkermuisknop. Je kunt dan ineens alles wat je geselecteerd hebt verplaatsen
naar een groep.

Je kunt ook meer dan één laag of groep tegelijkertijd verwijderen door deze te selecteren met ingehouden Ctrl
-toets en daarna de toetsencombinatie Ctrl+D te gebruiken. Dan zullen alle geselecteerde lagen en/of groepen
verwijderd worden van de legenda met kaartlagen.

7.3.1 Werken met de Legenda onafhankelijke volgorde van lagen

Er is een paneel waarmee je de tekenvolgorde onafhankelijk van de legenda kunt aangeven. Dit paneel kan
geactiveerd worden via het menu Extra → Panelen → Laag volgorde. Bepaal de tekenvolgorde van de lagen in
het paneel Laag Volgorde. Vervolgens kun je in de legenda de groepen anders indelen, waarbij deze lagen toch
in de goede volgorde worden getekend (zie figure_layer_order). Wanneer onderin het paneel van de legenda, het

aanvinkvak Rendervolgorde controleren uitgezet wordt, dan geldt alleen de tekenvolgorde van de legenda.

Figuur 7.2: Een Legenda onafhankelijke volgorde van lagen definiëren

7.4 Kaartbeeld

Het kaartbeeld is deel van QGIS waar het resultaat van QGIS - de kaarten worden getoond! De kaart die getoond
word is afhankelijk van de geladen vector- en rasterkaarten (zie volgende onderwerpen voor meer informatie hoe
kaartlagen geladen worden). Men kan het kaartbeeld verschuiven of erop inzoomen of uitzoomen. Men kan nog
verschillende andere dingen doen met het kaartbeeld. De legenda van kaartlagen en het kaartbeeld hebben een
sterke relatie met elkaar. Het kaartbeeld veranderd direct wanneer je lagen in de legenda wijzigt.

Tip: Het kaartbeeld in/uitzoomen met het muiswieltje
Met het muiswieltje kun je in- en uitzoomen op de kaart. Plaats de muisaanwijzer in het kaartbeeld en roll het
wieltje naar voren (van je af) om in te zoomen en achteruit (naar je toe) om uit te zoomen. De plaats van de
muisaanwijzer is de plaats waar het in/uitzoomen gebeurd. Je kunt het gedrag van de muiswieltje instellen in het
Opties menu Extra → Opties in het tabblad Kaart gereedschap.
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Tip: Verschuiven van het kaartbeeld met de pijltjestoetsen en de spatiebalk
Je kunt de pijtljestoetsen gebruiken om het kaartbeeld te verschuiven. Plaats de muisaanwijzer in het kaartbeeld
en druk op de toets met het linkerpijltje/rechterpijltje om het kaartbeeld naar west/oost te verschuiven of pijltje
omhoog/pijltje omlaag om deze naar noord/zuid te verschuiven. Maar je kunt ook de spatiebalk gebruiken om het
kaartbeeld te verschuiven! Met ingedrukte spatiebalk kun je met de muisaanwijzer het kaartbeeld verschuiven in
gewenste richting o klik op het muiswieltje.

7.5 Statusbalk

De statusbalk toont de huidige positie in kaartcoordinaten. Wanneer je de muisaanwijzer over de kaart heen
beweegt, worden de coördinaten van de muisaanwijzer direct getoond. Links van de plaats waar de coordinaten
wordt getoond op de statusbalk is een knop waarmee je kunt wisselen tussen Coordinaat en Extents. De Extents
laat de coordinaten van linkeronderhoek en rechterbovenhoek zien van wat er in het kaartbeeld getoond wordt
welke veranderd wanneer je het kaartbeeld wijzigt door deze te verschuiven of door in/uitzoomen.

Naast het getoonde coordinaat wordt de schaal getoond. Hier kun je de huidige schaal zien van het kaartbeeld.
Er is ook een keuzelijst van voorgedefinieerde schalen toegevoegd van schaal 1:500 tot 1:1000000. Behalve dat
je een schaal kunt kiezen kun je hier ook zelf een schaal ingeven waarna het kaartbeeld in die schaal getoond zal
worden.

Op de statusbalk bevindt zich ook een voortgangsbalkje waarmee de voortgang kan worden gezien wanneer het
kaart opnieuw wordt opgebouwd (het renderen van de kaart). In enkele andere gevallen wordt de voortgangsbalk
gebruikt voor het tonen van de voortgang van andere processen die meer tijd in beslag nemen, zoals het verzamelen
van statistieken over rasterlagen.

Wanneer er een nieuwe plugin of een update van een plugin beschikbaar is zal dit bekend worden gemaakt via
de statusbalk. Aan de rechterkant van de statusbalk kan men via een aanvinkvakje aangeven of je het opnieuw

opbouwen van het kaartbeeld even wilt stoppen (zie Renderen onderaan). Het icoontje stopt onmiddeling het
renderen van de kaart.

Helemaal aan de rechterkant van de statusbalk kan men de EPSG code van het huidige gebruikte coordinaten
referentie systeem zien. Daarnaast bevindt zich een icoontje waarmee je direkt toegang hebt tot het tabblad
Ruimtelijk Referentie Systeem van het menu Projectinstellingen zodat je deze kunt bekijken/aanpassen.

Tip: Rekenen met de correcte schaal in het kaartbeeld
Wanneer je QGIS voor het eerst start, worden standaard de eenheid graden gebruikt en worden de coordinaten in
graden weergegeven. Men kan de eenheid omzetten van graden naar meters in het tabblad Algemeen onder Extra

→ Projectinstellingen of je kunt de project coördinaten referentie systeem wijzigen via het icoontje CRS status

helemaal aan de rechterkant van de statusbalk. Wanneer het nieuwe coördinaten referentie systeem in de definitie
een eenheid bevat (bijvoorbeeld ’+units=m’) dan wordt de gebruikte eenheid van het kaartbeeld hier ook direct
door aangepast.

.
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HOOFDSTUK 8

Algemeen Gereedschap

8.1 Snelkoppelingen toetsenbord

QGIS heeft voor veel functies standaard snelkoppelingen. Deze worden in Menubalk beschreven. Daarnaast geeft
de menu optie Extra → Snelkoppelingen bewerken ... de mogelijkheid om de standaard snelkoppelingen aan te
passen en nieuwe toe te voegen, voor QGIS functies die nog geen snelkoppeling hebben.

Figuur 8.1: Optiemenu snelkoppelingen definiëren (Gnome)

Configuratie van snelkoppelingen is erg eenvoudig. Selecteer een actie van de lijst, selecteer [Aanpassen], [Niet
gebruiken] of [Als standaard zetten]. Wanneer je tevreden bent over je configuratie, dan kun je deze opslaan als
een XML file en laden in een andere QGIS installatie via dit menu.

8.2 Contextuele help

Wanneer je hulp nodig hebt over een specifiek onderwerp, kun je in veel dialogen/menu’s op de [Help] knop
drukken. De help knop in plugins die door derden zijn ontwikkeld, kunnen verwijzen naar speciaal daarvoor
gemaakte webpagina’s.

8.3 Renderen

QGIS zal standaard automatisch de zichtbare lagen opnieuw opbouwen, renderen, wanneer nodig. De gebeurtenis-
sen die het verversen van het kaartbeeld starten zijn:
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• Toevoegen van een kaartlaag

• Verschuiven of in/uitzoomen

• Het wijzigen van de grootte van het QGIS programma venster

• Het wijzigen van de zichtbaarheden van een laag of lagen

QGIS geeft je op een aantal manieren controle op het renderings-proces.

8.3.1 Schaalafhankelijk Tonen

Met schaalafhankelijk tonen is het mogelijk om de minimum en maximum schalen in te stellen waarbij een laag
zichtbaar zal zijn. Om schaalafhankelijk tonen in te stellen open de dialoog Eigenschappen door te dubbelklikken

op een kaartlaag in de legenda. In het tabblad Algemeen kan men het aanvinkvakje Gebruik schaalafhanke-
lijk tonen aanvinken en vervolgens de minimum en maximum schaalwaarden invullen waarbinnen de kaartlaag
zichtbaar zal zijn.

Je kunt deze waarden achterhalen door het kaartbeeld eerst in te zoomen tot je de kaart net niet/wel wilt zien en
dan de bijbehorende schaal af te lezen van de statusbalk.

8.3.2 Controle over het renderen van de kaart

Men kan op de volgende manieren meer controle krijgen over het renderen van het kaartbeeld:

Uitstellen van het Renderen

Om het renderen uit te stellen, vink het aanvinkvakje (Her)teken uit in de rechteronderhoek van de statusbalk.

Wanneer het aanvinkvakje (Her)teken niet is aangevinkt, zal QGIS het kaartbeeld niet opnieuw opbouwen in
de gebeurtenissen die beschreven zijn in Renderen. Voorbeelden wanneer je het opnieuw opbouwen van de kaart
wilt uitstellen zijn:

• Na het toevoegen van veel kaartbladen wil je deze eerst van symbologie voorzien en de tekenvolgorde
instellen

• Na het toevoegen van een of meer grote kaartlagen wil je eerst instellen bij welke schalen deze getekend zal
worden

• Na het toevoegen van één of meer grote kaartlagen, wil je eerst inzoomen op een bepaald gebied voordat
deze getekend wordt

• Een combinatie van bovenstaande redenen

Het weer aanvinken van Render zal onmiddelijk het opnieuw opbouwen van het kaartbeeld starten.

Instelling Toevoegen Laag Optie

Er is ook de mogelijkheid om het kaartbeeld niet opnieuw te tekenen na het toevoegen van nieuwe kaartlagen. Het
aanvinkvak die de zichtbaarheid weergeeft van de nieuw toegevoegde kaartlaag, is dan niet aangevinkt. Om deze
optie in te stellen kies de menuoptie Extra → Opties → en open het tabblad Rendering. Ontvink het aanvinkvak

Standaard zullen nieuw toegevoegde lagen aan de kaart direct worden afgebeeld. De zichtbaarheid van elke
laag die hierna wordt toegevoegd, zal standaard uit staan in de legenda.
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Het renderen stoppen

Om het tekenen van de kaart te stoppen druk op de ESC toets. Dit zal het tekenen van de kaart onderbreken waarbij
de kaart slechts gedeeltelijk getekend is. Het kan even duren voordat het tekenen stopt na het indrukken van de
ESC toets.

Notitie: Het is momenteel niet mogelijk om het renderen te stoppen - dit is tijdelijk uitgeschakeld in de op Qt4
gebouwde versie aangezien dit kon leiden tot problemen als het stoppen van de applicatie.

Bijwerken van het kaartbeeld tijdens het Renderen

Men kan gebruik maken van een optie om kaartgegevens al te tekenen tijdens het inlezen en opbouwen van
kaartgegevens. Standaard, laat QGIS nog geen objecten van een laag zien totdat het inlezen en opbouwen van
de kaartlaag is afgerond. Om kaartgegevens te tekenen tijden het lezen ervan, kies de menuoptie Extra → Opties
Open het tabblad. Rendering. Zet het aantal objecten alvorens de kaart te hertekenen op een geschikte waarde
om tijdens het inlezen de kaart al te zien opbouwen. Wanneer de waarde op 0 staat zal de kaartlaag pas getoond
worden wanneer deze volledig is opgebouwd. Het instellen van een te lage waarde zal resulteren in een traag
opbouwende kaart omdat de kaart bijna continue moet worden bijgewerkt. Een voorgestelde waarde om mee te
beginnen is 500.

Beinvloeden van de kwaliteit van het renderen

Er zijn twee opties waarmee men de kwaliteit van het renderen kan beinvloeden. Kies de menuoptie Extra →
Opties open het tabblad Rendering en vink of ontvink de volgende aanvinkvakjes.

• Maak de lijnen minder rafelig ten koste van de tijd dat het tekenen kost

• Problemen met fout (gevulde) polygonen oplossen

Het renderen versnellen

Er zijn twee opties waarmee men de snelheid van het renderen kan beinvloeden. Kies de menuoptie Extra →
Opties open het tabblad Rendering en vink of ontvink de volgende aanvinkvakjes.

• Een andere optie in het menu Extra → Opties → Rendering is het aanvinkvak Back buffer inschakelen.
Dit geeft een betere grafische performance maar dan kan men het tekenen niet onderbreken en ook niet
incrementeel objecten tekenen. Wanneer deze niet is aangevinkt, kun je het Aantal objecten alvorens de
kaart te hertekenen instellen, anders is deze inactief.

• Gebruik de cache voor het tekenen indien mogelijk om het hertekenen te versnellen

8.4 Meten

Men kan direct beginnen te meten binnen geprojecteerde coordinatensystemen zoals het UTM of het Nederlandse
RijksDriehoek stelsel. Wanneer de geladen kaartlaag echter een geografisch coordinatensysteem betreft, die ge-
bruik maakt van lengtegraden/breedtegraden, dan zal het resultaat van gemeten lengtes en op- pervlaktes in eerste
instantie onjuist zijn. Om dit op te lossen moet er eerst een meer toepasselijk coordinaten systeem ingesteld
worden (zie Werken met Projecties). Alle onderdelen die gebruikt worden om te meten gebruiken dezelfde snap-
ping opties van het digitaliseer-gereedschap. Dit is vooral handig wanneer je bestaande lijnen en vlakken van
vectorlagen wilt opmeten.

Om een meetgereedschap te kiezen selecteer en kies vervolgens het gereedschap dat je wilt gebruiken.
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8.4.1 Het meten van lengte, oppervlakte of hoek

Lijn Meten QGIS kan de directe afstand meten tussen twee punten of via een gedefinieerde ellipsoide oftewel de
aardkromming, van gebruikt coordinaten systeem. Om dit in te stellen, kies de menuoptie Extra → Opties. Open
het tabblad Kaart gereedschap en kies de juiste ellipsoide voor afstandsberekeningen. Men kan hier ook de kleur
van de rubberband en de voorkeuren voor te gebruiken eenheden voor lengtematen en hoeken instellen. Met de
rubberband wordt het flexibele meetlint bedoelt waarmee de afstanden kunnen worden opgemeten. Men kan nu
het meetgereedschap gebruiken door te klikken in het kaartbeeld. Het menu opmeten verschijnt waarbij zowel de
lengtes van de lijnsegmenten als de totale lengte wordt getoond. Gebruik de rechtermuisknop om te stoppen met
meten.

Figuur 8.2: Het meten van afstanden (Gnome)

Vlak Opmeten: Je kunt ook oppervlaktes meten. In het menu opmeten, komt dan de totale oppervlakte te staan.
Ook in dit geval zal het meetgereedschap naar objecten van de geselecteerde vectorlaag proberen te snappen, ten-
minste wanneer voor die laag een snapping tolerantie is ingesteld. (Zie Het instellen van de Snapping Toleranties
en Zoek Radius). Wanneer men nauwkeurig oppervlakte wilt opmeten, zet dan eerst voor een laag de snapping
tolerantie en selecteer dan vervolgens die laag. Vervolgens kan men nu precies oppervlaktes inmeten waarbij
elke muisklik naar de dichtsbijzijnde hoek of lijn van geselecteerde laag zal springen, wanneer deze zich binnen
ingestelde tolerantie bevindt.

Figuur 8.3: Het meten van oppervlaktes (Gnome)

Hoek Opmeten: Men kan ook hoeken opmeten, selecteer Hoek Opmeten. De muisaanwijzer veranderd in een
kruisje. Zet eerst twee punten de basislijn om vervolgens met het derde punt de relatieve hoek t.o.v. de basislijn
op te meten. De meting wordt getoond in een popup menu.

Figuur 8.4: Het meten van hoeken (Gnome)
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8.4.2 Selecteren en deselecteren van objecten

De QGIS werkbalk bevat functionaliteit waarmee men objecten kan selecteren in het kaartbeeld. Om een of

meerdere objecten te selecteren klik op en kies de gewenste selectiefunctie:

• Selecteer 1 Object

• Selecteer Objecten binnen Rechthoek

• Selecteer Objecten binnen Polygoon

• Selecteer objecten via Vrije Selectie

• Selecteer Objecten binnen Straal

Om de huidige selectie van geselecteerde objecten ongedaan te maken klik op Objecten uit alle layers deselecteren.

8.5 Identificeer objecten

Met Objecten Identificeren kan men zichtbare objecten op de kaart bevragen waarbij de attributen worden getoond
in een resultaatvenster. Deze functie kan men via het menu selecteren Beeld → Objecten Identificeren of gebruik

Ctrl+Shift+I, of selecteer het icoon Objecten Identificeren in de werkbalk.

Wanneer je meerdere objecten selecteert, dan zal de guilabel:Resultaatlijst Objecten Identificeren een overzicht
geven van alle geselecteerde objecten. Het eerste item in de resultaatlijst is het nummer gevolgd door de laagnaam.
In een niveau daaronder bevindt zich de naam van het attribuutveld met de attribuutwaarde, vervolgens wordt alle
informatie van het object getoond.

Dit venster kan via maatwerk (-formulier) worden aangepast om extra informatie te tonen, maar standaard zal
deze drie soorten informatie tonen.

• Acties: acties kunnen worden toegevoegd aan de resultaatlijst van de tool objecten identificeren. Wanneer
men een actie selecteert zal die actie worden gestart. Standaard wordt er slechts één actie toegevoegd, de
actie Het object bewerken formulier.

• Afgeleid: deze bevat attribuutwaarden die is berekend of afgeleid van andere informatie. Men kan hier het
coördinaat vinden waarmee is gezocht, de X- en Y-coördinaten, de oppervlakte en omtrek in kaarteenheden
wanneer het een polygoon (vlak) object betreft, de lengte in kaarteenheden wanneer het een lijn betreft en
het object ID.

• Veld attributen: Dit is de lijst van velden met attribuutwaarden.

Aan de onderkant van het venster Indentificatieresultaten bevinden zich vijf knoppen met iconen:

• Boom uitklappen

• |mActionIdentifyCollapset| Boom inklappen

• Nieuwe resultaten zullen standaard worden uitgebreid

• Kopieer attributen

• Geselecteerde HTML antwoord afdrukken

Andere functionaliteit kan worden gevonden in het contextmenu van het geïdentificeerde item. Vanuit het context
menu kun je bijvoorbeeld:

• Object-bekijken formulier

• Naar object inzoomen

• Kopieer object: kopieer het hele object, geometrie en attribuutwaarden
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Figuur 8.5: De dialoog Objecten identificeren (Gnome)

• Attribuut-waarden kopiëren: Kopieert alleen de via de rechtermuisknop geselecteerde attribuutwaarde

• Kopiëren objectattributen: kopieert alleen de attribuutwaarden

• Wis resultaat: Het scherm Identificatieresultaten wordt leeggemaakt

• Wis highlights: De objecten die gehighlight waren op de kaart zijn niet langer gehighlight

• Alles Highlighten

• Highlight de laag

• Activeer laag: Kies een laag die moet worden geactiveerd

• Laag eigenschappen: opent het menu Laag Eigenschappen

• Alles uitklappen

• Alles inklappen

8.6 Decoraties

De kaartdecoraties van QGIS zijn het Grid, het Copyright Label, de Noordpijl en de Schaalbalk. Ze worden
gebruikt om de kaart te ‘decoreren’ door kaartelementen toe te voegen.

8.6.1 Grid

Grid geeft de mogelijkheid om een coördinaten grid met labels toe te voegen aan het kaartbeeld.

1. Selecteer via het menu Beeld → Decoraties → Grid. De dialoog opent (zie figure_decorations_1).

2. Activeer het aanvinkvak Grid activeren en zet de grid definities volgens de geladen lagen in het kaart-
beeld.

3. Activeer het aanvinkvak Teken labels en stel de annotatie definities in volgens de lagen die geladen zijn
in het kaartbeeld.

4. Klik op [Apply] om het resultaat direct te zien.

5. Klik op **[OK] om de dialoog te sluiten.
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Figuur 8.6: De Grid Dialoog

8.6.2 Copyright Label

Copyright label plaatst een Copyright label met je eigen tekst op de kaart.

Figuur 8.7: De Copyright Dialoog

1. Selecteer via het menu Beeld → Decoraties → Copyright Label. De dialoog opent (zie fig-
ure_decorations_2).

2. Geef de tekst die geplaatst dient te worden op de kaart. Je kunt daarbij HTML gebruiken zoals getoond in
het voorbeeld.

3. Kies de plaatsing van het label met de keuzelijst Plaatsing .

4. Zorg ervoor dat het aanvinkvak Copyright Label tonen aangevinkt is.

5. Klik [OK].

In het voorgaande voorbeeld (standaard) plaatst QGIS het copyright symbool gevolgd door de datum rechtsonder
in het kaartbeeld.
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8.6.3 Noordpijl

Noordpijl plaatst een simpele noordpijl op de kaart. Momenteel is er slechts 1 stijl beschikbaar. Je kunt de
hoek van de noordpijl instellen of door QGIS de richting automatisch laten instellen. Wanneer er voor gekozen
worden om door QGIS zelf de richting te laten bepalen, zal deze de richting zo goed mogelijk bepalen. Voor het
plaatsen van de noordpijl zijn er vier opties, die overeenkomen met de vier hoeken van het kaartbeeld.

Figuur 8.8: De Noordpijl Dialoog

8.6.4 Schaalbalk

Schaalbalk plaatst een eenvoudige schaalbalk op de kaart. De stijl en de plaats kan worden aangepast evenals
de labels van de Schaalbalk.

Figuur 8.9: De Schaalbalk Dialoog

QGIS ondersteunt alleen het tonen van de schaalbalk in dezelfde lengteenheid als die van de kaart. Wanneer de
eenheid van de lagen in meters zijn kun je niet een schaalbalk maken in feet . Zo kun je ook geen schaalbalk in
meters tonen wanneer de gebruikte kaart als eenheid in graden wordt getoond.

Toevoegen van een schaalbalk:

1. Selecteer via het menu Beeld → Decoraties → Schaalbalk The dialoog opent (zie figure_decorations_4).

2. Kies de plaatsing met de keuzelijst Plaatsing .

3. Kies de stijl in de keuzelijst Schaalbalkstijl .

4. Kies de kleur van de balk via het kleurenpalet achter Schaalbalkkleur

of laat deze op zwart staan
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5. Zet de grootte van de schaalbalk en het label Grootte van de balk .

6. Zorg ervoor dat het aanvinkvak Schaalbalk gebruiken is aangevinkt.

7. Geef aan of de schaalbalk automatisch naar gehele getallen verspringt wanneer de kaart van grootte wijzigd

door het aanvinkvak Klik automatisch naar gehele getallen tijdens het aanpassen van de grootte aan te
vinken

8. Klik [OK].

Tip: Decoratie Instellingen
Wanneer je een QGIS project opslaat, zullen de wijzigingen die je hebt gemaakt aan Grid, Noordpijl, Schaalbalk
en Copyright mee worden opgeslagen in het projectbestand en teruggezet worden bij het openen van het project.

8.7 Annotatie Functies

De Tekst Annotatie functies in de werkbalk Attributen geven de mogelijkheid om een tekstballon ergens in het
kaartbeeld te plaatsen. Gebruik het Tekst Annotatie gereedschap en klik ergens in het kaartbeeld.

Figuur 8.10: Annotatie tekst dialoog

Wanneer men dubbelklikt op de ballontekst heeft men verschillende mogelijkheden om deze aan te passen. Er
is een tekstvak waar men de tekst mee kan aanpassen. Men kan kiezen of het de tekst verbonden is aan een
kaartlokatie of dat deze steeds op dezelfde plaats blijft staan ook al verschuift men de kaart. Men kan het tekst
item verplaatsen door de marker of de ballontekst naar een andere plek te slepen. De gebruikte icoontjes zijn
onderdeel van het gis thema, maar worden ook in de andere thema’s gebruikt.

De Verplaats Annotatie functie wordt gebruikt om de annotatie te verplaatsen in het kaartbeeld.

8.7.1 Html annotatie

De Html Annotatie functies in de werkbalk Attributen geven de mogelijkheid om de inhoud van een html bestand
in een tekstballon ergens in het kaartbeeld te plaatsen. Gebruik de Html Annotatie functie en klik ergens in het
kaartbeeld en voeg een pad toe naar het html bestand in de dialoog.
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8.7.2 SVG annotatie

De SVG Annotatie functie in de werkbalk Attributen geven de mogelijkheid om een SVG symbool in een ballon
ergens in het kaartbeeld te plaatsen. Gebruik de SVG Annotatie functie en klik ergens in het kaartbeeld en voeg
een pad toe naar het SVG bestand in de dialoog.

8.7.3 Formulier annotatie

Het is mogelijk om je eigen annotatie formulieren te maken en te gebruiken. De functie Formulier annotatie

kan gebruikt worden om de attributen van een vector laag te tonen in een speciaal daarvoor door jezelf ont-
worpen formulier in de QT designer (zie figure_custom_annotation). Dit is hetzelfde formulier dat wordt
gebruikt voor de identiteit tool, maar dan gebruikt als annotatie. De volgende video van Tim Sutton
https://www.youtube.com/watch?v=0pDBuSbQ02o laat het gebruik ervan zien.

Figuur 8.11: Maatwerk qt designer annotatie formulier

Notitie: Wanneer je de toetsencombinatie Ctrl+T gebruikt terwijl een annotatie functie actief is (verplaats
annotatie, tekst annotatie, formulier annotatie), dan wisselt het tekstitem van zichtbaar naar onzichtbaar en ander-
som.

8.8 Favoriete Plaatsen

De Engelse term ’Spatial Bookmarks’ is vrij vertaald naar ’Favoriete plaatsen’. Je kunt met Favoriete plaatsen
aangeven waar je later (vaker) terug wilt keren.

8.8.1 Aanmaken van Favoriete Plaats

Hoe je een favoriete plaats aanmaakt:

1. Zoom in op een gebied naar keuze.
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2. Selecteer de menu optie Beeld → Nieuwe Favoriet ... of gebruik de snelkoppeling Ctrl-B.

3. Geef een beschrijvende naam waaronder je de Favoriete plaats op wilt slaan (tot 255 tekens).

4. Klik op Enter om de Favoriete plaats toe te voegen of [Verwijderen] om de Favoriete plaats te verwi-
jderen.

Men kan meerdere favorieten onder dezelfde naam opslaan.

8.8.2 Werken met Favoriete Plaatsen

Om een Favoriet te gebruiken of te beheren, kies de menu optie Beeld → Toon Favorieten. De dialoog Favoriete
Plaatsen geeft de mogelijkheid om snel te springen naar die opgeslagen favoriete plaats of om een Favoriete plaats
te verwijderen. Je kunt de naam of de positie van een Favoriete plaats niet wijzigen.

8.8.3 Verplaatsen naar een Favoriete Plaats

Vanuit de dialoog Ruimtelijke Favorieten ..., kies de favoriete plaats door deze te selecteren en druk daarna op de
knop [Zoom naar]. Je kunt ook naar een Favoriete plaats springen door hierop te dubbelklikken.

8.8.4 Verwijderen van een Favoriete Plaats

Om een favoriete plaats te verwijderen vanuit de dialoog Ruimtelijke Favorieten ... selecteer de favoriet en druk op
[Verwijder]. Bevestig gemaakte keuze in het vervolgschermpje door op [Ja] te drukken of maak het verwijderen
alsnog ongedaan door te drukken op [Nee] .

8.9 Projecten in een project

Wanneer je de inhoud van een ander project wilt opnemen in een project kun je kiezen voor menuselec-
tion:Kaartlagen –> Kaartlagen en groepen inbedden.

8.9.1 Inbedden van lagen

De volgende dialoog maakt het inbedden van lagen vanuit een ander project mogelijk. Hier volgt een voorbeeld:

1. Gebruik om een ander project te selecteren van de Alaska dataset.

2. Selecteer het projectbestand grassland. Je kunt de inhoud van het project zien (zie fig-
ure_embed_dialog).

3. Druk op Ctrl en selecteer de lagen grassland en regions. Druk op [OK]. De lagen zijn nu
toegevoegd in de kaartlegenda en het kaartbeeld.

Figuur 8.12: Selecteer lagen en groepen om in te voegen
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Alhoewel je de ingebedde kaartlagen kunt bewerken, kun je eigenschappen als Stijl en Labeling van deze lagen
niet aanpassen.

8.9.2 Verwijderen van ingebedde lagen

Klik met de rechtermuis op de ingebedde lagen en selecteer Verwijder.

.
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HOOFDSTUK 9

QGIS Configureren

QGIS is zeer goed te configuren via het menu Extra. Kies tussen Panelen, Werkbalken, Project instellingen, Opties
en Aanpassingen.

9.1 Panelen en Werkbalken

Via het menu Panelen→ kun je QGIS panelen aan of uitzetten. Via het menu Werkbalken→ kun je werkbalken
toevoegen of verwijderen in de ruimte gereserveerd voor werkbalken in QGIS (zie figure_panels_toolbars).

Figuur 9.1: Het menu Panelen en Werkbalken

Tip: Het activeren van Kaartoverzicht in QGIS
In QGIS kun je een paneel activeren die een overzichtskaart toon met de volledige extent van de toegevoegde
lagen. Activeer deze via Extra → Panelen of Beeld → Panelen. Binnen de overzichtskaart wordt een
rechthoek getoond die overeenkomt met de gebiedsgrenzen van het getoonde kaartbeeld. Hiermee zie je snel welk
deel van kaart je momenteel bekijkt. Labels worden niet getoond in de overzichtskaart ook al zijn de lagen zo
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ingesteld dat er labels moeten worden getoond. Wanneer je het rode vierkant in de overzichtskaart versleept met
ingehouden linkermuisknop, zal het kaartbeeld zich overeenkomstig aanpassen.

Tip: Toon Logboekmeldingen
Het is mogelijk om gegenereerde logboekmeldingen van QGIS te bekijken. Deze kan geactiveerd worden door

het aanvinkvakje Logboekmeldingen aan te vinken in het menu Extra → Panelen of Beeld → Panelen.
Vervolgens kun je de meldingen volgen die worden gegeneerd tijdens het opstarten en gebruik van QGIS.

9.2 Projectinstellingen

In the properties window for the project under Settings → Project Properties or Project → Project Proper-
ties, you can set project-specific options. These include:

• Onder het tabblad Algemeen kan men het volgende instellen; de projecttitel, de selectie- en achtergrondkleur,
de laageenheden, de precisie (aantal decimalen van coördinaten) en of paden relatief of absoluut moeten
worden opgeslagen. Wanneer gelijktijdige CRS transformatie is ingeschakeld, kun je een ellipoïde kiezen
die gebruikt kan worden voor afstandsberekeningen. De te gebruiken eenheden en de precisie in aantal
decimalen kunnen worden ingesteld. Je kun er ook een lijst van kaartschalen voor het project instellen die
de globale ingestelde lijst van kaartschalen overschrijft.

• In het tabblad Ruimtelijke Referentie Systeem (CRS) kun je de gewenste CRS voor dit project instellen. Daar-
naast kun je instellen dat gelijktijdige CRS transformatie moet worden gebruikt wanneer er lagen aanwezig
zijn met verschillende CRS.

• In het derde tabblad Identificeerbare Lagen kun je instellen welke lagen zullen reageren wanneer Objecten
Indentificeren wordt gebruikt. (zie de paragraaf “Kaartgereedschap” van :ref‘gui_options‘ waarin het ge-
bruik hiervan wordt uitgelegd.)

• The Default Styles menu lets you control how new layers will be drawn when they do not have an existing
.qml style defined. You can also set the default transparency level for new layers and whether symbols
should have random colours assigned to them.

• Het tabblad OWS Server geeft de mogelijkheid om informatie in te vullen die meegegeven wordt door de
WMS en WFS Capabilities die door QGIS Server terug wordt gegeven plus de extent, het maximale bereik
van de kaart en het beperken van mogelijke Coördinaten Referentie Systemen.

• Het menu Macro’s kan worden gebruikt om Python functies te schrijven die als module mee worden opges-
lagen in het QGIS projectbestand. Momenteel zijn er drie macro’s beschikbaar: “openProject()”, “savePro-
ject()” en “closeProject()”.

• Het menu Relaties wordt gebruikt om 1:n join relaties mee vast te leggen. Deze relaties worden vastgelegd
in het project eigenschappen dialoog. Wanneer een eigenschap is aangemaakt voor een laag, dan zal het
object formulier een nieuwe item bevatten waarmee de gerelateerde objecten zichtbaar getoond worden. Dit
biedt een krachtige manier waarmee bijvoorbeeld de onderhoudshistorie van een leiding of een wegdeel kan
worden vastgelegd. Lees meer over de ondersteuning van 1:n relaties in Een tot veel-relaties maken.

9.3 Opties

Voor het instellen van globale instellingen van QGIS gebruik de dialoog Opties. Open deze via het menu Extra
→ Opties. Voor het wijzigen van de instellingen zijn de volgende tabbladen beschikbaar:

9.3.1 Tabblad Algemeen

Applicatie
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Figuur 9.2: Macro instellingen in QGIS

• Maak onder Stijl (Herstart QGIS nodig) en kies tussen ‘Oxygen’,’Windows’,’Motif’,’CDE’, ‘Plas-
tique’ en ‘Cleanlooks’ ( ).

• Geef het Icoon Thema . Momenteel is alleen ‘standaard’ beschikbaar.

• Geef de Icoongrootte .

• Geef het Lettertype. Kies tussen het keuzerondje Qt standaard of maak een keuze uit een systeem
lettertype.

• Wijzig de Zichtbaarheidstijd voor berichten of dialogen .

• Verberg het openingsscherm tijdens opstarten

• Tips tonen tijdens het opstarten

• Groepsvak titels vet weergeven

• Groepsvakken in QGIS stijl

• Gebruik direkt bijwerken kleurkeuze dialoog

Projectbestanden

• Open project bij het opstarten (kies tussen ‘Nieuw’. ‘Meest recente’ en ‘Specifiek’). Wanneer men

kiest voor ‘Specifiek’ blader naar het project met waarmee opgestart moet worden.

• Maak een nieuw project op basis van het standaardproject. Men heeft de mogelijkheid om het huidige
project in te stellen als standaard project met de knop [Huidige project als standaardproject opslaan]
of terug te gaan naar het standaardproject met de knop [Standaard terugzetten]. Men kan een folder
(Sjabloonmap) instellen waar de project templates komen te staan met de knop [Bladeren]. Er zal een
template project gekozen kunnen worden bij de menu optie Project → Nieuw van Template, wanneer eerst

het aanvinkvak Maak een nieuw project op basis van het standaardproject is geactiveerd en vervolgens
het project in de folder met templates is opgeslagen.

• Geef een waarschuwing om project en gewijzigde databronnen op te slaan indien nodig

• Geef een waarschuwing bij het openen van een projectfile uit een oudere versie van QGIS
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• Macro’s toestaan . Je kunt daarbij kiezen tussen ‘Nooit’, ‘Vragen’, ‘Alleen voor deze sessie’ en
‘Altijd (wordt afgeraden)’.

9.3.2 Systeem Menu

Systeem

De Systeem omgevingsvariabelen kunnen nu worden bekeken en deze kunnen ook worden geconfigureerd via het
onderdeel systeemvariabelen (zie figuur figure_environment_variables). Dit is erg handig voor besturingssyste-
men zoals die op de Mac waarbij voor een grafische applicatie de omgevingsvariabelen zoals men die kan opvragen
via de terminal niet dezelfde hoeven te zijn als die door het programma worden gebruikt. Dit kan ook handig zijn
om omgevingsvariabelen te zetten die gebruikt worden door externe tools die o.a. gebruikt worden door de pro-
cessing toolbox, bijv. SAGA, GRASS; en die ook gebruikt kan worden zodat zodat bepaalde onderdelen van de
broncode meer output genereren voor het opsporen van fouten (debugging).

• Gebruik aangepaste systeemvariabelen (herstart noodzakelijk - voeg scheidingstekens toe). Je kunt
nieuwe systeemvariabelen [Toevoegen] en met [Verwijder] deze weer verwijderen. Bestaande omgev-
ingsvariabelen worden getoond met Huidige systeemvariabelen –>, en het is mogelijk om alleen de spec-

ifieke systeemvariabelen voor QGIS te tonen met het aanvinkvak Alleen QGIS-specifieke variabelen
tonen.

Figuur 9.3: Systeem omgevingsvariabelen in QGIS

Plugin paden
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[Toevoegen] of [Verwijder] Pad(en) om voor additionele C++ pluginbibliotheken te zoeken

9.3.3 Databronnen Menu

Object-attributen en tabel

• Open de attributentabel in een ‘dock-window’ (QGIS herstart vereist)

• Kopiëer geometrie in WKT formaat van attributen tabel. Wanneer de functie
Kopiëer geselecteerde rijen naar klembord in het Attributentabel menu gebruikt wordt, dan zullen ook de coördinaten
van de punten of hoekpunten worden gekopieerd naar het klembord.

• Attributentabel gedrag . Er zijn drie mogelijkheden: ‘Alle attributen tonen’ (standaard), ‘Gese-
lecteerde objecten tonen’ en ‘Toon objecten in huidig kaartbeeld’

• Attributentabel rijcache . Deze instelling zorgt ervoor dat het gegeven aantal rijen in de cache
(=geheugenruimte) wordt opgeslagen, zodat deze gegevens sneller beschikbaar zijn en het werken met de
attributentabel ook sneller is. De gegevens in de cache worden verwijderen tijdens het sluiten van de dialoog
attributentabel.

• Weergave van NULL waarden Hier kun je een een andere waarde opgeven om te laten zien, voor velden die
een NULL waarde bevatten.

Omgang met databron

• Zoek naar geldige items in het browser dock . Je kunt kiezen tussen ‘Extentie controleren’ en ‘Be-
standsinhoud controleren’.

• Zoek naar de inhoud van gecomprimeerde (.zip) bestanden in het browser-dock . ‘Nee’, ‘Basic scan’
en ‘Volledige scan’ zijn mogelijk.

• Suggereer raster sublagen tijdens het openen. Enkele rasterformaten ondersteunen sublagen — deze worden
subdatasets in GDAL genoemd. Een voorbeeld is het netCDF bestandsformaat - wanneer er veel netCDF
variabelen zijn, dan ziet GDAL elke variabele als een subdataset. De optie wordt gebruikt om controle te
krijgen hoe om te gaan, tijdens het laden van, met een rasterfile die sublagen bevat. De volgende keuzes zijn
mogelijk:

– ‘Altijd’: Altijd vragen (wanneer er sublagen aanwezig zijn)

– ‘indien nodig’: Vraag wanneer de laag geen bandlagen maar wel sublagen heeft

– ‘Nooit’: Geen vragen, laad geen sublagen

– ‘Laad alles’: Geen vragen gewoon alle sublagen laden

• Vastgelegde shapefile codering negeren. Wanneer een shapefile informatie over gebruikte karaktercoder-
ing bevat, kan men hier aangeven of QGIS die informatie moet negeren.

• PostGIS lagen toevoegen door dubbelklikken en selectie in uitgebreide modus

• PostGIS lagen toevoegen door dubbelklikken en selectie in uitgebreide modus

9.3.4 Tabblad Rendering

Rendering gedrag

• Standaard zullen nieuwe toegevoegde lagen aan de kaart direct worden afgebeeld

• Enable back buffer

• Gebruik de cache voor het tekenen indien mogelijk om het hertekenen te versnellen
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• Objectvereenvoudiging standaard toepassen voor nieuwe lagen

• Vereenvoudigen bij de bron indien mogelijk

Rendering kwaliteit

• Maak de lijnen minder rafelig ten koste van de tijd dat het tekenen kost

• Fix problems with incorrectly filled polygons

Rasters

• met RGB-band selectie kan men het nummer voor de Rode, de Groene en de Blauwe band opgeven.

Contrast enhancement

• Enkelbands grijs . Een enkelbands grijs kan de waarden hebben ‘Geen Stretch’ ‘Stretch tot MinMax’,
‘Stretch en Clip tot MinMax’ en ook ‘Clip naar MinMax’.

• Multiband kleur (byte/band) . Mogelijke keuzes zijn ‘Geen Stretch’, ‘Stretch tot MinMax’, ‘Stretch
en Clip tot MinMax’ en ‘Clip naar MinMax’.

• Multiband kleur (>byte/band) . Mogelijke keuzes zijn ‘Geen stretch’, ‘Stretch tot MinMax’, ‘Stretch
en Clip tot MinMax’ en ‘Clip naar MinMax’.

• Bereik (minimum/maximum) . Mogelijke keuzes zijn ‘Cumulatieve telling deel van pixels’, ‘Mini-
mum/Maximum’, ‘Gemiddelde +/- standaardafwijking’

• Bereik Cumulatieve telling van pixels

• Vermenigvuldigingsfactor voor standaardafwijking

Debuggen

• Kaartvenster update

9.3.5 Kaartvenster en Legenda Menu

Standaard waarden kaart (worden door projectwaarden overschreven)

• Wijzig de Selectiekleur en de Achtergrondkleur.

Legenda lagen

• Dubbelklik actie in legenda . Kies tussen ‘Open laag eigenschappen’ of ‘Open attributentabel’ voor
de dubbelklik actie.

• De volgende Legenda onderdeel stijlen zijn mogelijk:

– Laagnamen in hoofdletters

– Laagnamen vet

– Groepnamen vet

– Toon classificatie-attribuutnamen

– Raster iconen aanmaken (kan langzaam zijn)

– Voeg nieuwe lagen toe aan geselecteerde of huidige groep
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9.3.6 Tabblad Kaart gereedschap

Identify

• Open identify results in a dock window (QGIS restart required)

• The Mode setting determines which layers will be shown by the Identify tool. By switching to ‘Top down’
or ‘Top down, stop at first’ instead of ‘Current layer’, attributes for all identifiable layers will be shown with
the Identify tool. In QGIS 2.2. you can now use a ‘Layer selection’ option so that you can choose with the
left-mouse menu which layer you want to identify (see the “Project properties” section under Projecten to
set which layers are identifiable).

• Open feature form, if a single feature is identified

• Define Search radius for identifying and displaying map tips as a percentage of the map width

Meetgereedschap

• Geef de Rubberband kleur voor het meetgereedschap

• Zet het aantal te gebruiken Decimale posities

• Basis eenheid bewaren

• Voorkeurs meeteenheden (‘meters’, ‘voet’, ‘Zeemijlen’ of ‘graden’)‘

• Voorkeur hoekeenheden (‘Graden’, ‘Radialen’ of ‘Gon’)

Schuiven en zoomen

• Zet het Muiswielgedrag op (‘Zoom’, ‘Zoom en recenter’, ‘Zoom naar muis cursor’, ‘Niets’)

• Stel de Zoom factor in voor het muiswiel

Vooraf ingestelde schalen

Hier tref je de lijst aan met vooraf ingestelde schalen. Met de [+] en [-] knoppen kun je schalen toevoegen of
verwijderen.

9.3.7 Printomgeving

Standaardwaarden opmaak

HIer kun je het Standaard lettertype geven.

Ruitennetweergave

• Kies voor het Ruitennetstijl uit (‘Doorrgetrokken’, ‘Stippels’ of ‘Kruisjes’)

• Geeft de Kleur...

Ruitennetstandaarden

• Geef de Tussenruimte

• Geef de Ruitennetverspringing voor x en y

• Geef de ‘Snap’ tolerantie

Hulplijnstandaarden

• Geef de ‘Snap’ tolerantie
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9.3.8 Tabblad Digitaliseren

Objectcreatie

• Geen attribuut-popus na het aanmaken van elk kaartobject tonen

• Laatst ingevoerde attribuutwaarden gebruiken

• Valideer geometriën tijdens het bewerken van complexe lijnen/polygonen bestaande uit veel punten kan
dat dit het tekenen vertragen. Dit komt omdat de standaard validatie in QGIS veel tijd kan kosten. Om
het tekenen te versnellen tijdens het bewerken kan men ook kiezen voor de GEOS geometrie validatie
(beschikbaar vanaf GEOS 3.3) of om de validatie uit te zetten. De validatie met GEOS is veel sneller maar
het nadeel is dat deze alleen het eerste geometrie probleem rapporteert.

Rubberband

• Wijzig de Lijndikte en Lijnkleur van de Rubberband

Snapping

• Snapping instellingen openen in een ‘dock-window’ (QGIS herstart vereist)

• Zet de Standaard ‘snap’-modus (‘Naar hoekpunt’, Naar segment’, ‘Naar hoekpunt en segment’,
‘Uit’)

• Zet de Standaard ‘snapping’-tolerantie in kaarteenheden of pixels

• Zet de zoekradius voor hoekpuntaanpassingen in ‘kaart eenheden’ of ‘pixels’

Hoekpunten

• Markers alleen gebruiken voor geselecteerde objecten heeft betrekking op het tonen ervan

• Wijzig de Markerstijl naar (‘Kruis’ (standaard), ‘Semi transparente cirkel’ of ‘Niets’)

• Zet de Markergrootte

Lijnverspring-gereedschap

De volgende 3 opties hebben betrekking op de tool Verspring Curve, zie Geavanceerd Digitaliseren. Met de
verschillende settings, is het mogelijk om de vorm van de versprongen lijn te beïnvloeden. Deze opties zijn
beschikbaar sinds GEOS 3.3.

• Verbindingsstijl

• Segmenten per Kwadrant

• Maximale puntlengte bij scherpe hoeken

9.3.9 GDAL Menu

GDAL is een functiebibliotheek voor het kunnen inlezen converteren van veel rasterformaten. In dit tabblad kun
je Creatie Opties bewerken en Pyramide Opties bewerken voor de raster formaten. Je kunt hier ook instellen
welke GDAL driver gebruikt moet worden voor welk rasterformaat, aangezien in sommige gevallen er meer dan
1 GDAL driver beschikbaar zijn voor een rasterformaat.

9.3.10 CRS Menu

Standaard CRS voor nieuwe projecten

• Gelijktijdige herprojectie uitschakelen

• Gelijktijdige CRS-transformatie gebruiken wanneer lagen verschillende CRS hebben
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• Gelijktijdige CRS-transformatie gebruiken

• Selecteer een CRS voor Altijd dit CRS gebruiken voor nieuwe projecten

CRS voor nieuwe kaartlagen

Dit deel geeft de mogelijkheid om aan te geven of er een actie volgt nadat een nieuwe laag is aangemaakt, of
wanneer een laag zonder CRS wordt geladen.

• Vraag om CRS

• Gebruik huidige project CRS

• Gebruik het standaard CRS zoals hieronder getoond

Standaard datumtransformaties

• Ask for datum transformation when no default is defined

• Wanneer je hebt gewerkt met de gelijktijdige CRS transformatie kun je het resultaat in het onderliggende
scherm zien. Je kunt informatie vinden over de ‘Bron CRS’ en de ‘Doel CRS’ maar ook over de ‘ Bron
datum transformatie’ en de ‘Doel datum transformatie’.

9.3.11 Menu Locale

• Systeem locale negeren en Te gebruiken locale

• Informatie over gedetecteerde systeem locale

9.3.12 Netwerk Menu

Algemeen

• Geef een WMS zoekadres, het standaard adres is http://geopole.org/wms/search?search=\%1\&type=rss

• Geef de Timeout for netwerkaanvraagen (ms) - standaard ingesteld op 60000

• Define Standaard verlooptijd van WMSC/WMTS tegels (uur) - standaard is 24

• Geef Maximaal aantal pogingen bij tile request fouten

• Geef de User-Agent

Cache instellingen

Wijzig de Folder en Grootte voor de cache.

• Gebruik een proxy voor internettoegang en geef de ‘Host’, ‘Poort’, ‘Gebruiker’ en ‘Wachtwoord’.

• Geef het Proxy type naar behoefte.

– Default Proxy: Proxy wordt bepaald gebasseerd op de huidige applicatie proxy set

– Socks5Proxy: Een generieke proxy die voor meerdere connectie protocollen. Ondersteund TCP, UDP,
directe verbinding op poort (binnenkomende connecties) en autenticatie.

– HttpProxy: Gebruikt de “CONNECT” opdracht, ondersteund alleen uitgaande TCP connecties; on-
dersteund autenticatie.

– HttpCachingProxy: Gebruikt normale HTTP opdrachten, deze is alleen geschikt bij het gebruik van
HTTP requests

– FtpCachingProxy: Gebruikt een FTP proxy, is alleen goed bruikbaar in de context van FTP requests.
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Figuur 9.4: Proxy-instellingen in QGIS

56 Hoofdstuk 9. QGIS Configureren



QGIS User Guide, Release 2.2

Men kan URL’s uitsluiten door deze toe te voegen aan het tekstinvoervak onder de proxy-instellingen (zie Fig-
ure_Network_Tab).

Wanneer je meer gedetailleerde informatie nodig hebt over de verschillende proxy set-
tings, verwijzen we naar de handleiding QT functie bibliotheek documentatie zie
http://doc.trolltech.com/4.5/qnetworkproxy.html#ProxyType-enum.

Tip: Het gebruik van Proxies
Het gebruiken van proxies kan soms erg lastig zijn. Gebruik de ‘trial and error’ methode om de verschillende
proxy typen te testen en controleer of deze voor jou werken.

Je kunt de opties wijzigen naar behoefte. Enkele aanpassingen hebben echter een herstart van QGIS nodig voordat
deze effectief worden.

• Settings are saved in a text file: $HOME/.config/QGIS/qgis.conf

• De instellingen worden opgeslagen in: $HOME/Library/Preferences/org.qgis.qgis.plist

• Instellingen worden opgeslagen in de windows registry onder:
HKEY\CURRENT_USER\Software\QGIS\qgis

9.4 Aanpassingen

Met de tool Aanpassingen kun je bijna elke element aan-/uitzetten in de QGIS gebruikersinterface. Dit kan erg
handig zijn wanneer veel plugins geinstalleerd zijn die je nooit gebruikt maar die wel schermruimte innemen.

Figuur 9.5: Het Aanpassingen dialoog

QGIS Aanpassingen is onderverdeeld in vijf groepen. Onder Menus kun je menu onderdelen verbergen. Onder

Panelen vind je de ‘panelen’. Panelen zijn applicaties die gestart kunnen worden als een losstaand window
maar die ook kunnen worden ingebed in het window van de QGIS applicatie zelf (zie ook Panelen en Werkbalken).

Onder Status Bar kun je onderdelen zoals de coördinaten informatie uitzetten. Onder Toolbars kun je

iconen van de QGIS werkbalken (de)activeren en onder Hulpmiddelen kun je ook knoppen en bijbehorende
dialogen verbergen.

Met Schakel naar widgets in de hoofdapplicatie kun je klikken op elementen in QGIS die je wilt verbergen
waarna deze ook direct springt naar de bijbehorende entry in het Aanpassingen dialoog (zie figure_customization).
Je kunt ook verschillende sets van instellingen voor verschillende soorten gebruikers opslaan. Om de wijzigen toe
te passen is een herstart van QGIS nodig.

.
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Werken met Projecties

QGIS geeft gebruikers de mogelijkheid om een globale en projectbrede CRS (Coördinaten Referentie Systeem)
toe te voegen aan lagen die zelf geen CRS bevatten. Het is ook mogelijk om zelf een custom coördinaten referentie
systeem te maken en het ondersteund gelijktijdige CRS transformaties van vector- en rasterkaartlagen. Dit geeft
de gebruiker de mogelijkheid om lagen die verschillende CRS bevatten over elkaar heen te projecteren.

10.1 Overzicht Ondersteuning van Projecties

QGIS ondersteund ongeveer 2700 bekende CRS. De definities van al deze Coördinaat Referentie Systemen zijn
opgeslagen in een SQLite database die onderdeel is van een QGIS installatie. Normaal gesproken hoeven deze
beschrijvingen niet te worden aangepast. Dit kan er zelfs voor zorgen dat hierdoor de ondersteuning van projec-
ties faalt. Zelf gedefinieerde (aangepaste/Custom) CRS worden opgeslagen in een gebruikers database. Zie het
onderdeel Aangepaste Coördinaten Referentie Systeem voor informatie over het beheren van custom coördinaten
referentie systemen.

De beschikbare CRS in QGIS zijn gebaseerd op definities die zijn gepubliceerd door de European Petroleum
Search Group (EPSG) en het Institut Geographique National de France (IGNF) die grotendeels zijn opgenomen in
de spatiale referentie tabellen die gebruikt worden in GDAL. De EPSG ID zijn aanwezig in de database en kunnen
gebruikt worden om een CRS te selecteren in QGIS.

Om de gelijktijdige CRS transformatie te gebruiken, dienen er voor alle kaartlagen een coördinaat referentie
systeem zijn gedefinieerd of moet er een globale of een projectbrede CRS gedefinieerd te zijn (gebruikt voor
alle kaartlagen zonder CRS). Voor PostGIS lagen gebruikt QGIS de spatiale referentie die gebruikt is tijdens het
aanmaken van de laag. Voor kaartgegevens die ondersteund worden door OGR, gaat QGIS uit van de aanwezigheid
van onderdelen die de CRS definitie bevatten. Voor Shapefiles betekent dit dat er een bestand aanwezig moet zijn
die de Well Known Text (WKT) beschrijving van een CRS bevat. Dit projectiebestand heeft dezelfde basis naam
als de shapefile en wordt gevolgd door de bestandsextensie ‘.prj’. Voorbeeld, naast een shapefile met de naam
alaska.shp dient ook een bijbehorend projectbestand met de naam alaska.prj te bestaan.

Wanneer je een nieuw CRS selecteert, zal de gebruikte lengte-eenheid mee veranderen in het tabblad Algemeen
van de Projectinstellingen dialoog onder het menu Project (Gnome, OSX) of Extra (KDE, Windows) menu.

10.2 Globale Projectie Specificatie

QGIS gebruikt voor elk nieuw project de globale standaard projectie. De standaard globale CRS na installatie van
QGIS is EPSG:4326 - WGS 84 (proj=longlat +ellps=WGS84 +datum=WGS84 +no_defs). Deze
globale CRS kan worden gewijzigd gebruik makende van de knop [Selecteren...] in het eerste deel waarmee
de Standaard Coördinaten Referentie Systeem te gebruiken voor nieuwe projecten (bijvoorbeeld het Nederlandse
RD systeem) zoals getoond in figure_projection_1. Deze keuze zal opgeslagen worden voor gebruik in volgende
QGIS sessies.
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Figuur 10.1: Tabblad CRS in het QGIS Opties Dialoog
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Wanneer je kaartlagen gebruikt die geen CRS bevatten, dan zul je moeten definiëren welke CRS QGIS moet
gebruiken voor deze lagen. Dit kan met een globale of een project CRS in het CRS tabblad onder Extra →
Opties.

De opties getoond in figure_projection_1 zijn:

• Vraag om CRS

• Gebruik huidige project CRS

• Gebruik het standaard CRS zoals hieronder getoond

Wanneer je de coördinaten referentie systeem voor een bepaalde laag zonder CRS informatie wilt definiëren, dan
kun je dat doen in het tabblad Algemeen van de dialoog Eigenschappen van de raster (zie Tabblad Algemeen) en
vectorlaag (zie vectorgeneraltab). Wanneer je laag al een CRS heeft, zal dit getoond worden als in figuur Het
Vector Eigenschappen Menu .

Tip: CRS in de kaartlegenda
Met de rechtermuis op een laag klikken in de Kaartlegenda (zie Legenda) geeft twee CRS snelkoppelingen In-
stellen laag CRS zal direct de Ruimtelijk Referentie Systeem Keuze openen (zie figure_projection_2). Project
CRS van laag overnemen zal de project CRS instellen en gelijk maken aan de CRS van geselecteerde laag

10.3 Gelijktijdige CRS transformatie gebruiken

QGIS ondersteund gelijktijdige CRS transformatie voor zowel raster- als vectorkaartgegevens, deze is echter niet

standaard geactiveerd. Vink het aanvinkvakje Gelijktijdige CRS transformatie gebruiken aan in het tabblad

CRS van de Projectinstellingen dialoog.

Er zijn drie manieren om dit te doen:

1. Selecteer Projectinstellingen van het menu Project (Gnome) of Extra (KDE, Windows, OSX).

2. Klik op de CRS status icoon in de linkeronderhoek van de statusbalk.

3. Zet Gelijktijdige CRS transformatie standaard aan, door in het tabblad CRS van de Opties dialoog en de
checkbox| Gelijktijdige CRS transformatie gebruiken aan te vinken of Gelijktijdige CRS transformatie in-
schakelen indien kaartlagen verschillende CRS hebben.

Wanneer je al een laag geladen hebt, en je wilt gelijktijdige CRS transformatie gebruiken, dan kun je het beste

het tabblad CRS van de Projectinstellingen dialog openen, een CRS selecteren en daarna de optie Gelijktijdige

CRS transformatie gebruiken aanvinken. Het CRS status icoon zal niet langer uitgegrijsd zijn en alle lagen
zullen geprojecteerd worden naar de CRS die getoond wordt naast het icoon.

Het tabblad CRS van de Projectinstellingen dialoog bevat vijf belangrijke onderdelen zoals getoond in Fig-
ure_projection_2 die hieronder worden beschreven:

1. Gelijktijdige CRS-Transformatie gebruiken - dit aanvinkvakje wordt gebruikt om de gelijktijdige CRS
transformatie te (de)activeren. Wanneer uit, zal elke laag getekent worden gebruik maken van de de coör-
dinaten zoals gelezen van de gegevensbron en de onderstaande beschreven componenten zijn daarbij uit-
geschakeld. Wanneer aan, zullen de coördinaten van elke laag worden geprojecteerd naar het coördinaten
referentie systeem zoals ingesteld voor het kaartbeeld.

2. Filter — wanneer de EPSG code bekend is, of de identifier of de naam ven een Coördinaten Referentie
Systeem, kun je gebruik maken van een zoekterm om deze te vinden. Geef de EPSG code, de identifier of
de naam als zoekterm.

3. Recent gebruikte coördinaten referentie systemen — wanneer je bepaalde CRS vaker gebruikt, dan
zullen deze getoond worden onder in de tabel van de Projectie Dialoog. Klik op een van deze knoppen
om de daarbijhorende CRS te selecteren.
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Figuur 10.2: Projectinstellingen Dialoog

4. Coördinaten Referentie Systeem — Dit is een lijst van alle CRS die ondersteund worden door QGIS,
inclusief geografische, geprojecteerde en zelf gedefiniëerde coördinaten referentie systemen. Om een CRS
in te stellen, selecteer deze uit de lijst door de bijbehorende lijst uit te klappen en de CRS te selecteren. De
actieve CRS is voorgeselecteerd.

5. Proj4 text — Dit is de CRS tekst gebruikt door de PROJ.4 projectie engine. Deze tekst is alleen-lezen en
wordt gegeven ter informatie.

Tip: Projectinstellingen Dialog
Wanneer je de Projectinstellingen dialoog opent via het menu Project, dan moet je vervolgens het tabblad CRS
selecteren om de CRS instellingen te bekijken.

Het openen van de dialoog vanuit het icoon CRS status zal direct het tabblad CRS openen.

10.4 Aangepaste Coördinaten Referentie Systeem

Indien QGIS niet het coördinaten referentie systeem levert die je nodig hebt, kun je zelf een CRS maken. Kies,
om een CRS te maken, |mctionCustomProjection| Aangepaste CRS via het menu Extra. Zelf gemaakte CRS-en
worden opgeslagen in een gebruikersdatabase van QGIS. Deze database bevat ook de Favoriete plaatsen (spatial
bookmarks) en andere eigen instellingen.

Om zelf een CRS in QGIS te maken, vereist dat je wel de PROJ.4 projectie functie bibliotheek moet begri-
jpen. Om te beginnen, verwijzen we naar Cartographic Projection Procedures for the UNIX Environment - A
User’s Manual by Gerald I. Evenden, U.S. Geological Survey Open-File Report 90-284, 1990 (beschikbaar via
ftp://ftp.remotesensing.org/proj/OF90-284.pdf ).

Deze handleiding beschrijft het gebruik van proj.4 en de daarbijhorende ‘command line utilities’. De car-
tografische parameters die gebruikt worden voor proj.4 worden beschreven in de gebruikershandleiding en
deze kunnen ook worden gebruikt in QGIS.
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Figuur 10.3: Aangepaste CRS Dialoog

De Aangepaste Coordinaten Referentie Systeem Definitie dialoog heeft slechts twee parameters nodig om een
gebruikers CRS te maken:

1. een beschrijvende naam

2. De cartographische parameters in PROJ.4 formaat

Om een nieuwe CRS te maken, klik op de knop Nieuwe CRS toevoegen en geef een beschrijvende naam en de CRS
parameters.

Let daarbij op dat Parameters moet beginnen met +proj= om een nieuw coördinaten referentie systeem te maken.

Je kunt de gegeven CRS parameters testen om te zien of deze goede resultaten geeft. Om dit te doen, geef bekende
coördinaten in WGS84 lat/long waarden in de velden Noord en Oost. Klik op [Bereken] en vergelijk de resultaten
met de bekende waarden in jou coördinaten referentie systeem.

10.5 Standaard datumtransformaties

OTF is afhanbkelijk van het feit om in staat te zijn gegevens te transformeren naar een ‘standaard CRS’, en QGIS
gebruikt WGS84. Voor enkele CRS-en zijn er een aantal transformaties beschikbaar. QGIS stelt u in staat de
gebruikte transformatie te definiëren, anders gebruikt QGIS een standaard transformatie.

In de tab CRS onder Extra → Opties kunt u:

• QGIS instellen om u te vragen wanneer het een transformatie moet definiëren met behulp van Vraag
naar datumtransformatie als geen standaard is gedefinieerd

• een lijst van gebruiksstandaarden voor transformaties te bewerken.
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QGIS laten vragen welke transformatie te gebruiken door een dialoogvenster te laten openen met PROJ.4-tekst
weergegeven die de bron- en doeltransformatie beschrijft. Verdere informatie kan worden gevonden door de
muis boven een transformatie te houden. gebruikersstandaarden kunnen worden opgeslagen door te selecteren
Selectie onthouden.

.
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QGIS Browser

De QGIS Browser is een paneel in QGIS waarmee je eenvoudig door je GIS bestanden kunt browsen en beheren. Je
hebt daarbij toegang tot vector bestanden (bijv. ESRI shapefiles of MapInfo bestanden), databases (bijv. PostGIS
Oracle, Spatialite of MSSQL Spatial) en WMS/WFS webservices. Je kunt ook GRASS data bekijken (hoe je deze
data in QGIS kunt laden zie Integratie van GRASS GIS).

Figuur 11.1: De QGIS Browser kan ook gebruikt worden als een losstaande applicatie

Gebruik de QGIS Browser om vooraf de gegevens te bekijken. Met de ‘drag en drop’ functie kun je eenvoudig
gegevens in je kaart en in de legenda slepen.

1. Activeren van het QGIS Browser paneel: Klik met de rechtermuis op een werkbalk en selecteer Browser
of selecteer deze via Extra → Panelen.

2. Sleep het paneel in het paneel van de legenda en laat los.

3. Selecteer het tabblad Browser.

4. Browse door je bestandensysteem en kies de folder shapefiles van qgis_sample_data.

5. Hou de Shift -toets ingedrukt en selecteer het bestand airports.shp en alaska.shp.

6. Sleep nu met ingehouden linkermuisknop, de bestanden in het kaartbeeld en laat los.
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7. Selecteer een laag open het snelmenu met de rechtermuisknop en kies Project CRS van laag overnemen.
Voor meer informatie zie Werken met Projecties.

8. Selecteer Volledig uitzoomen om de lagen zichtbaar te maken.

Er is een tweede browser beschikbaar onder Extra → Panelen. Dit is handig wanneer je bestanden of kaartlagen
van de ene lokatie naar een andere wilt verplaatsen.

1. Activeer een tweede QGIS Browser: Klik met de rechtermuis op een werkbalk en selecteer Browser (2)
of selecteer deze via Extra → Panelen.

2. Sleep het paneel in het paneel van de legenda.

3. Ga naar guilabel:Browser (2) en browse naar een shapefile in je bestandssysteem.

4. Selecteer een bestand met de linkermuisknop. Je kunt nu het icoon Geselecteerde Lagen Toevoegen gebruiken
om deze toe te voegen aan het huidige project.

QGIS zal bij een leeg project automatisch zoeken naar het Coördinaten Referentie Systeem (CRS) in het bestand
en inzoomen naar de volledige extent van de kaartlaag. Wanneer het project al kaartlagen bevat, en deze hebben
dezelfde extent en CRS dan zullen de nieuwe kaartlagen direct zichtbaar woden. Wanneer het bestand echter
een andere CRS en/of extent bevat kan men eerst met de rechtermuisknop de zojuist ingelezen laag selecteren en
vervolgens de Project CRS wijzigen naar die van de laag met Project CRS van laag overnemen. Kies vervolgens
in hetzelfde snelmenu Zoom naar laagextent.

De Bestandsfilter werkt op folderniveau. Browse naar de folder waar je wilt filteren op bestanden en geef een
woord waarmee u wilt zoeken waarbij u wildcards kunt gebruiken. De browser zal dan alleen bestandsnamen
tonen die overeenkomen met het filter, overige bestanden worden dan niet getoond.

De QGIS Browser kan ook gebruikt worden als een losse applicatie.

Opstarten van de QGIS browser

• Geef “qbrowser” in op de opdracht prompt.

• Start QGIS browser vanuit het Startmenu of via de snelkoppeling op het bureaublad.

• de QGIS browser is beschikbaar in uw folder Programma’s.

In figure_browser_standalone_metadata kun je de uitgebreide functionaliteit van de QGIS browser applicatie zien.
Het tabblad Param geeft de details de database connecties van bijvoorbeeld PostGIS of MSSQL Spatial. Het
tabblad Metadata bevat algemene informatie over het bestand (zie vectormetadatatab). Met het tabblad Preview
kun je de inhoud van bestanden bekijken zonder deze eerst te importeren in een QGIS project. Het is ook mogelijk
de attribuutvelden te bekijken via het tabblad Attributes.

.
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Werken met Vector Data

.

12.1 Ondersteunde gegevensindelingen

QGIS gebruikt de bibliotheek OGR om vectorgegevens te kunnen lezen van en te schrijven naar ESRI Shapefiles,
MapInfo en Microstation bestandsformaten; PostGIS, SpatiaLite, MSSQL Spatial en Oracle Spatial databases
en vele andere formaten. Ondersteuning voor GRASS vector en PostgreSQL wordt verschaft door eigen QGIS
plug-ins voor gegevensverschaffing. De vectorgegevens kunnen ook in leesmodus geladen worden in QGIS vanuit
gecomprimeerde zip en gzip-archiefbestanden. Op het moment van schrijven van dit document worden, 69 vector
formaten ondersteund door de bibliotheek OGR (zie OGR-SOFTWARE-SUITE Verwijzingen naar literatuur en
web). De volledige lijst is beschikbaar op http://www.gdal.org/ogr_formats.html.

Notitie: Niet alle genoemde indelingen zullen zomaar werken in QGIS voor verschillende redenen. Sommige
indelingen vereisen de aanwezigheid van externe commerciele functiebibliotheken. Of een indeling wordt niet
ondersteund door GDAL/OGR functiebibliotheek die is opgebouwd voor het gebruikte besturingssysteem. Alleen
die indelingen die goed zijn getest zullen verschijnen in de lijst van bestandstypen wanneer men een vectorbestand
in QGIS wil inlezen. Overige niet geteste indelingen kunnen worden geladen door *.* te selecteren.

Het werken met vectorgegevens voor GRASS is beschreven in Integratie van GRASS GIS.

Dit deel beschrijft hoe je kunt werken met enkele veelvoorkomende vectorindelingen: ESRI shapefiles, PostGIS
lagen, Spatialite lagen, OpenStreetMap vector en Comma Separated data (CSV = tekengescheiden gegevenstabel).
Veel van de beschikbare gebruikersfuncties in QGIS werken precies hetzelfde voor ondersteunde vectorindelingen.
Dit is een uitgangspunt geweest bij het ontwerp van QGIS en betreft o.a. de volgende functies, het identificeren,
het selecteren, het toevoegen van labels en het werken met attributen.

12.1.1 ESRI Shapefiles

De standaard vector bestandsindeling die gebruikt wordt in QGIS is ESRI-shapefile. De ondersteuning hiervoor
wordt mogelijk gemaakt door de OGR Simple Feature Library ( http://www.gdal.org/ogr/ ).

Een shapefile bestaat uit meerdere bestanden. De volgende drie zijn noodzakelijk:

1. .shp bestand die de geometrieen van de objecten bevat

2. .dbf bestand die de attribuutwaarden bevat in dBase formaat

3. .shx het index bestand

Shapefiles kunnen ook een bestand bevatten met de bestandsextensie .prj , het projectiebestand die informatie
over het gebruikte coordinatensysteem bevat. Alhoewel een projectie bestand erg handig is, is het niet noodza-
kelijk. Een shapefile dataset kan daarnaast nog meer bestanden bevatten. Voor verdere details, bekijk de ESRI
technisch specificaties op http://www.esri.com/library/whitepapers/pdfs/shapefile.pdf.
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Het laden van een Shapefile

Voor het laden van een shapefile, open QGIS en klik op het pictogram |mActionOgrLayer| Vectorlaag toevoegen in de
werkbalk of gebruik de snelkoppeling Ctrl+Shift+V. Dit zal een nieuw scherm openen (zie figure_vector_1).

Figuur 12.1: Dialoogvenster Vectorlaag toevoegen

Uit de beschikbare opties selecteer het keuzerondje Bestand. Klik vervolgens op de knop [Bladeren]. Dit
zal een standaard bestandskeuze menu openen (zie figure_vector_2) waarmee je kunt bladeren naar de gewenste

shapefile of een andere door QGIS ondersteunde vectorindeling. De keuzelijst Bestandstypen geeft de
mogelijkheid om te filteren op door OGR ondersteunde bestandsindelingen.

Je kunt ook, indien gewenst de karakterset codering, oftewel de encoding meegeven voor de te openen shapefile,
(CP1252 is de latijnse karakterset veelal gebruikt in westerse talen).

Figuur 12.2: Dialoogvenster openen voor een door OGR ondersteunde vectorlaag

Selecteer een shapefile uit de lijst en selecteer de knop [Open] zodat deze geladen wordt in QGIS. Figure_vector_3
toont QGIS na het laden van de shapefile alaska.shp.

Tip: Kleuren van kaartlagen
Wanneer u een kaartlaag toevoegt, zullen de objecten getoond worden in een willekeurige kleur. Wanneer u meer
dan een kaartlaag toevoegt, zal elke kaartlaag een andere kleur krijgen.
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Figuur 12.3: QGIS met de geopende shapefile van Alaska
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Eenmaal geladen, kun je kaartlaag bestuderen met de kaart navigatie functies. Om de symbologie van een kaart-
laag te wijzigen, open het scherm: guilabel:Laag Eigenschappen door te dubbelklikken op de naam van de kaart-
laag in de legenda, of door de laag te selecteren en met de rechtermuis het snelmenu op te roepen en daarin te
kiezen voor Eigenschappen. Zie ook Menu Stijl voor meer informatie over het toekennen van symbologie aan
vector kaartlagen.

Tip: Het laden van kaartlagen en projecten van exerne drives onder OS X
Onder OS X, worden de extern toegevoegde USB-sticks en externe harde schijven niet getoond onder Bestand
→ Open project zoals men zou verwachten. Er wordt gewerkt aan een oplossing die beter aansluit op de OSX-
standaard open/opslaan menu om dit te verhelpen. Je kunt echter, als tijdelijke oplossing, ‘/Volumes’ invullen
bij Bestandsnaam en op return drukken. Vervolgens kun je nu ook de externe gekoppelde geheugeneenheden,
zoals USB sticks, benaderen.

Verbeteren van de uitvoering voor shapefiles

Om de performance van het werken met shapefiles te verbeteren, kunt u een ruimtelijke index maken. Een
ruimtelijke index zal er voor zorgen dat het kaartbeeld veel sneller getekend wordt zodat u ook sneller kunt in-
en uitzoomen of het beeld kunt verschuiven. Ruimtelijke indexen gebruikt door QGIS hebben de bestandsnaam-
extensie .qix.

Gebruik volgende stappen om een index te maken:

• Laad een shapefile door het pictogram Vectorlaag toevoegen in de werkbalk te selecteren of gebruik de
snelkoppeling Ctrl+Shift+V.

• Open het menu Laag Eigenschappen door in de legenda te dubbelklikken op de naam van de shapefile of na
selectie in de legenda, met de rechtermuisknop het snelmenu te openen en hierin Eigenschappen te kiezen.

• In het tabblad Algemeen selecteer de knop [Ruimtelijke index maken].

Problemen bij het laden van een shape .prj bestand

Wanneer je een shapefile laad met een .prj bestand en QGIS is niet in staat om het Coordinaten referentiesysteem
van dat bestand te lezen, dan kun je zelf handmatig de goede CRS projectie instellen op het tabblad Algemeen van
het scherm Laag Eigenschappen voor die laag via de knop [Opgeven...]. Dit is nodig omdat de gegeven definitie
in het bestand .prj vaak niet alle benodigde projectieparameters bevat, die gebruikt worden in QGIS en wel
voorkomen in de lijst van het dialoogvenster van CRS .

Om die reden worden er bij het aanmaken van een nieuwe shapefile met QGIS, twee verschillende projectiebe-
standen aangemaakt. Een bestand .prj met een kleiner aantal projectieparameters, compatibel met ESRI soft-
ware, en een bestand .qpj , dat een uitgebreidere set van parameters bevat van de gebruikte CRS. Wanneer QGIS
een bestand .qpj aantreft, zal dat gebruikt worden in plaats van het bestand .prj .

12.1.2 Het laden van MapInfo gegevens

To load a MapInfo layer, click on the Add Vector Layer toolbar button; or type Ctrl+Shift+V, change the

file type filter Files of type : to ‘Mapinfo File [OGR] (*.mif *.tab *.MIF *.TAB)’ and select the MapInfo
layer you want to load.

12.1.3 Het laden van ArcInfo Binary Coverage

Om een ArcInfo Binary Coverage te laden, druk op het pictogram Vectorlaag toevoegen in de werkbalk of
gebruik snelkoppeling Ctrl+Shift+V om het dialoogvenster Vectorlaag toevoegen te openen. Selecteer nu
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eerst de status van optieknop Map. Selecteer vervolgens in de keuzelijst bestandtypes Type Arc/Info
Binary Coverage . Navigeer vervolgens naar de map die de Arc/Info Coverage-bestanden bevat en selecteer deze.

Op dezelfde wijze kun je ook de vectorbestanden in het UK National Transfer Format laden, die eveneens zijn
opgeslagen in een folder als bestanden in het TIGER formaat van het US Census Bureau.

12.1.4 Tekengescheiden bestanden

Tabulaire gegevens zijn een veel en breed gebruikte indeling vanwege zijn eenvoud een leesbaarheid – gegevens
kunnen zelfs in een tekstbewerkingsprogramma worden gelezen en bewerkt. Een gescheiden tekstbestand is een
tabel met attributen waarin elke kolom is gescheiden door een gedefinieerd teken en elke regel door een wordt
gescheiden door een regeleinde. De eerste regel bevat gewoonlijk de namen van de kolommen. Een veelgebruikt
type gescheiden tekstbestand is een CSV (Comma Separated Values= komma gescheiden waarden), wwaarin elke
kolom wordt gescheiden door een komma.

Zulke gegevensbestanden kunnen ook positionele informatie bevatten in twee belangrijke vormen:

• Als puntcoördinaten in afzonderlijke kolommen

• Als welbekende tekst (WKT) weergave van geometrie

QGIS stelt u in staat een gescheiden tekstbestand te laden als een laag of ordinale tabel. Controleer echter eerst of
het bestand voldoet aan de volgende vereisten:

1. Het bestand moet een gescheiden kopregel met veldnamen hebben. Dit moet de eerste regel in het tekstbe-
stand zijn.

2. De kopregel moet veld(en) bevatten met een definitie voor geometrie. Dit/Deze veld(en) mogen elke naam
hebben.

3. De X- en Y-coördinaten (als de geometrie wordt gedefinieerd door coördinaten) moeten zijn gespecificeerd
als getallen. Het coördinatensysteem is niet belangrijk.

Als voorbeeld importeren wij het valide hoogtepunten tekstbestand elevp.csv dat onderdeel is van de QGIS
voorbeeld gegevensset (zie Voorbeeld Data):

X;Y;ELEV
-300120;7689960;13
-654360;7562040;52
1640;7512840;3
[...]

Enkele opmerkingen over het tekstbestand:

1. Het voorbeeld tekstbestand gebruikt ; (puntkomma) als scheidingsteken. Elk teken kan gebruikt worden
als scheidingsteken.

2. De eerst rij is de kopregel. Deze bevat de velden X, Y en ELEV.

3. Er zijn geen aanhalingstekens (") gebruikt voor de tekstvelden.

4. De X-coördinaten staan onder het veld X.

5. De Y-coördinaten staan onder het veld Y.

Het laden van een tekengescheiden tekstbestand

Selecteer het pictogram Tekstgescheiden kaartlaag toevoegen in de werkbalk Kaartlagen bewerken om het dialoogven-
ster Creëer een Kaartlaag van een Tekengescheiden bestand te openen zoals getoond in figure_delimited_text_1.

Selecteer eerst het bestand (bijv. :file:qgis_sample_data/csv/elevp.csv‘) via de knop

**[Bladeren...]**. Wanneer het bestand is geselecteerd, zal |qg| proberen
om het bestand op te delen in records met velden, met het laatst gebruikte
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Figuur 12.4: Creëer Tekstgescheiden Kaartlaag Dialoog

scheidingsteken, in dit geval een puntkomma (;‘‘). Het is belangrijk om eerst het goede
scheidingsteken te selecteren om vanuit een tekstbestand de afzonderlijke velden te kunnen bepalen. Je kunt een
scheidingsteken opgeven door het keuzerondje Zelfgekozen scheidingsteken en een teken in te vullen in het
veld Overige scheidingstekens, of door het activeren van het keuzerondje Reguliere expressie scheidingsteken
te kiezen en de tekst op te geven in het tekstveld Expressie. Om het tab-teken te kiezen als scheidingsteken,
gebruik \t (dit is de reguliere expressie voor het tabulator karakter).

Wanneer het bestand is ingelezen, activeer het keuzerondje Punt coördinaten bij Geometrie definitie en kies de
velden X en Y via de keuzelijsten. Wanneer de coördinaten zijn gegeven in Degrees(=Graden)/Minuten/Seconden,
activeer dan het aanvinkvak DMS coördinaten.

Geef tenslotte de nieuwe laag een naam (bijv., elevp) zoals getoond in figure_delimited_text_1 . Na het se-
lecteren van [OK] wordt de laag toegevoegd aan de kaart. Het tekengescheiden tekstbestand gedraagtd zich als
elke andere kaartlaag in QGIS.

Men kan de spaties voor en achter een veld verwijderen door het aanvinkvak Verwijder spaties voor/na velden.

Men kan Sla lege velden over voor elk record gebruiken. Men kan aangeven dat de comma het decimale

scheidingsteken is door het het aanvinkvak Decimale scheidingsteken is de comma te activeren, anders is de
punt het decimale scheidingsteken.

Indien ruimtelijke informatie wordt weergegeven als WKT, activeer dan de optie Well Known Text en selecteer
het veld met de definitie voor WKT voor punt-, lijn- of polygoonobjecten. Als het bestand geen ruimtelijke
gegevens bevat, activeer dan Geen geometrieën (alleen attributentabel) en het zal worden geladen als een
ordinale tabel.

Aanvullend kunt u inschakelen:

• Ruimtelijke index gebruiken om de uitvoering van de weergave te verbeteren en objecten ruimtelijk te
selecteren.

• gebruik een subset index.

• Bestand in de gaten houden om de wijzigingen aan het bestand door andere toepassingen terwijl QGIS
wordt uitgevoerd bij te houden.
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12.1.5 Gegevens van OpenStreetMap

In recente jaren is het project OpenStreetMap enorm aan populariteit gewonnen omdat in vele landen geen gratis
geo-gegevens zoals digitale wegenkaarten beschikbaar zijn. het doel van het project OSM is om een gratis be-
werkbare kaart van de wereld te maken vanuit GPS-gegevens, lucht-/satellietfotografie of lokale kennis. QGIS
verschaft ondersteuning voor gegevens van OSM om dat doel te ondersteunen.

Het laden van vectorgegevens van OpenStreetMap

Openstreetmap import is standaard functionaliteit van QGIS.

• Om met de OSM server verbinding te maken en gegevens te downloaden, open het menu Vector → Open-
streetmap → Download data. Deze stap kan worden overgeslagen wanneer het al een .osm XML bestand
hebt verkregen via JOSM, de Overpass API of via een andere bron.

• Het menu Vector → Openstreetmap → Importeer topology van XML zal je .osm bestand omzetten naar
een SpatiaLite database en daarmee verbinding maken.

• Het menu Vector → Openstreetmap → Exporteer topologie naar Spatialite geeft de mogelijkheid om de
database connectie te openen, wat voor type gegevens je wilt (punten, lijnen of polygonen) en kies de tags
om te importeren. Dit zal een SpatiaLite geometrie laag aanmaken die je kunt toevoegen aan het project

door te klikken op het werkbalk icoon SpatiaLite laag Toevoegen of SpatiaLite laag toevoegen... uit het
menu Kaartlagen → , (zie ook SpatiaLite-kaartlagen).

12.1.6 PostGIS kaartlagen

PostGIS kaartlagen zijn opgeslagen in een PostgreSQL database. Het voordeel van PostGIS zijn de spatiale
indexering, filters en de uitgebreidere bevragingsmogelijkheden waarin PostGIS voorziet. Wanneer men gebruik
maakt van PostGIS, werken vectorfuncties zoals het selecteren en het identificeren van objecten meer accuraat dan
met OGR lagen in QGIS.

Een opgeslagen verbinding maken

De eerste keer dat u een gegevensbron voor PostGIS gebruikt, dient u een verbinding te maken naar

de database van PostgreSQLdie de gegevens bevat. Begin met het klikken op de knop op de werkbalk
Add PostGIS Layer, selecteer de optie Add PostGIS Layer... uit het menu Layer, of typ Ctrl+Shift+D. U kunt
ook het dialoogvenster Add Vector Layer openen en selecteren Database. Het dialoogvenster Add PostGIS
Table(s) zal worden weergegeven. Klik op de knop [Nieuw] om het dialoogvenster Nieuwe PostGIS-verbinding
aanmaken weer te geven om toegang te krijgen tot beheren van de verbindingen. De voor de verbinding vereiste
parameters zijn:

• Naam: Een naam voor deze verbinding. Kan gelijk zijn aan de Database.

• Service: Service parameter die gebruikt kan worden als alternatief voor Host/Poort (en eventueel ook
Database). Dit kan gedefinieerd worden in de pg_service.conf.

• Host: Naam van de database host. De naam van de host moet dezelfde zijn als waarmee je deze kunt vinden
via een telnet verbinding of hoe je deze kunt pingen. Wanneer de database op dezelfde computer staat als
QGIS, gebruik hier dan ‘localhost’.

• Poort: Poortnummer waar de database van PostgreSQL naar luistert. De standaardpoort is 5432.

• Database: Naam van de database.

• SSL mode: De instelling van het opzetten van een beveiligde SSL verbinding met de server. De perfor-
mance van het opbouwen van kaarten in QGIS is overigens veel beter door SSL uit te schakelen. Dit zijn de
opties:
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– Uitschakelen: alleen verbinden zonder SSL versleuteling

– Toestaan: Probeer een verbinding zonder SSL versleuteling, als dat mislukt probeer dan met SSL.

– Voorkeur (=standaard): Probeer een verbinding met SSL versleuteling, als dat mislukt probeer dan een
verbinding zonder SSL.

– Vereist: Alleen verbinden met SSL versleuteling.

• Gebruikersnaam: Gebruikersnaam om toegang te krijgen tot de database.

• Wachtwoord: Wachtwoord dat hoort bij Gebruikersnaam om toegang te krijgen tot de database.

Optioneel kunnen de volgende aanvinkvakjes worden geactiveerd:

• Gebruikersnaam opslaan

• Wachtwoord opslaan

• Alleen in de geometrie-kolommen kijken

• Niet het type geometrie bepalen voor onbeperkte kolommen (GEOMETRY)

• Alleen in het ‘publieke’-schema kijken

• Ook tabellen zonder geometrie tonen

• Gebruik ’estimated table statistics’

Wanneer alle veldparameters en opties zijn ingesteld, kunt u de verbinding testen met de knop [Test verbinding].

Tip: QGIS Gebruikersinstellingen en beveiliging
Depending on your computing environment, storing passwords in your QGIS settings may be a security risk. Your
customized settings for QGIS are stored based on the operating system:

• De instellingen voor linux worden opgeslagen in de thuismap ~.qgis2/.

• , De instellingen voor windows worden opgeslagen in de registry.

Laden van een PostGIS-laag

Na het aanmaken van een verbinding met een of meerdere PostgreSQL databases, kun je een kaartlaag laden
vanuit de PostgreSQL database. Uiteraard moet deze wel eerst kaartgegevens bevatten. Zie Het importeren van
gegevens in PostgreSQL voor een uitleg hoe je gegevens in een PostGis database kunt inlezen.

Voer de volgende stappen uit om een laag te laden vanuit PostGIS:

• Wanneer het venster PostGIS Tabel(len) toevoegen nog niet geopend is, selecteer in de werkbalk de knop

PostGIS-laag Toevoegen... in het menu Layer of via de de snelkoppeling Ctrl+Shift+D.

• Kies een aangemaakte verbinding vanuit de keuzelijst en druk op [Verbinden].

• Vink aan of ontvink het keuzevakje Ook tabellen zonder geometrie tonen

• Optioneel kun je het keuzevakje Zoek opties aanvinken om een selectie te maken van objecten die
geladen dienen te worden of gebruik de knop [Filter instellen] om het venster te openen waarmee je een
Filter kunt instellen middels een zoekopdracht.

• Zoek naar de laag/lagen die u wilt laden uit de lijst van beschikbare tabellen met gegevens.
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• Selecteer deze door er op te klikken. Je kunt meerdere lagen selecteren door de Shift toets in te drukken
tijdens het klikken. Zie Querybouwer voor meer informatie over het instellen van een filter hoe je een
zoekopdracht kunt maken voor een gegevenslaag.

• Klik op de knop [Toevoegen] om de laag toe te voegen aan de legenda en het kaartbeeld.

Tip: PostGIS-lagen
Normaal gesproken bevat een PostGIS laag een geometrieveld. Maar vanaf versie 0.9.0 is het ook mogelijk om in
QGIS PostGIS lagen zonder geometrieveld te laden. Daarnaast is het ook mogelijke om gedefinieerde SQL Views
te laden. Dit biedt krachtige mogelijkheden om gegevens visueel weer te geven. Zie de PostgreSQL handleiding
voor informatie over het aanmaken van SQL Views.

Enkele details over PostgreSQL-lagen

Dit deel bevat enkele details over de toegang van QGIS naar PostgreSQL lagen. Meestal geeft QGIS een lijst van
database tabellen die geladen kunnen worden en laad deze wanneer je deze selecteert. Maar wanneer je problemen
hebt om een PostgreSQL tabel te laden in QGIS, kan de onderstaande informatie helpen om de meldingen van
QGIS te begrijpen zodat je een aanwijzing hebt wat je moet veranderen aan de PostgreSQL tabel of aan de View
definitie zodat QGIS deze alsnog kan laden.

QGIS vereist dat PostgreSQL tabellen een uniek sleutelveld bevatten voor de te laden laag. In QGIS, moet deze
tabel van het type int4 zijn, een integer (geheel getal) met een grootte van 4 bytes. Als een alternatief kan het veld
ctid gebruikt worden als sleutelveld. Wanneer in een tabel 1 van deze velden ontbreekt zal in plaats daarvan het
veld oid worden gebruikt. De performance zal verbeteren door een index te definieren op het sleutelveld. (opm.
Sleutelvelden krijgen automatisch een index in PostgreSQL).

Wanneer de PostgreSQL laag een view betreft, bestaan dezelfde vereisten, maar views hebben geen sleutelvelden
of velden met regels die ervoor zorgen dat deze uniek zijn. Er moet eerst een sleutelveld (van het type integer) in
de QGIS dialoog gedefinieerd zijn voordat de view geladen kan worden. Wanneer er niet een daarvoor geschikte
kolom bestaat in de view zal de laag niet geladen worden in QGIS. Wanneer dat gebeurd kun je dat oplossen door
de view te veranderen zodat deze een kolom bevat van het type integer en die ook kan fungeren als sleutelveld (bij
voorkeur geïndexeerd).

Het keuzevak Select at id van QGIS is standaard geactiveerd. Met deze opties worden de ID’s opgehaald zonder
attributen wat in de meeste gevallen sneller is. Deze optie uitschakelen heeft zin wanneer er ‘dure’ views worden
gebruikt.

12.1.7 Het importeren van gegevens in PostgreSQL

Gegevens kunnen op een aantal verschillende manieren geimporteerd worden in PostgreSQL gebruik makende
van de SPIT plugin of met opdrachtregel programma’s shp2pgsql of ogr2ogr.

DB Manager

QGIS heeft standaard ook de DB Manager plugin. Deze kan gebruikt worden om meerdere shapefiles en andere
dataformaten te laden en ondersteund ook schemas. Zie Plug-in DB Manager voor meer informatie.

shp2pgsql

PostGIS bevat een stuk gereedschap genaamd shp2pgsql dat gebruikt kan worden om shapefiles te laden in een
PostGIS database. Om bijvoorbeeld een shapefile met de naam lakes.shp te laden in een PostgreSQL database
genaamd gis_data, gebruik de volgende opdracht:

shp2pgsql -s 2964 lakes.shp lakes_new | psql gis_data
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Dit maakt een nieuwe tabel aan genaamd lakes_new in de database gis_data. De nieuwe tabel zal een
spatiale referentie ID (SRID) bevatten van 2964. Zie Werken met Projecties voor meer informatie over Spatiale
Referentie Systemen en projecties.

Tip: Exporteren van gegevens uit PostGIS
Net zoals de importeerfunctie shp2pgsql is er ook een functie waarmee je PostGIS tabellen kunt exporteren naar
shape: pgsql2shp. Deze functies vormen een standaard onderdeel van een PostGIS distributie.

ogr2ogr

Naast shp2pgsql en DB Manager is er nog een manier om geografische gegevens in PostGIS in te lezen: ogr2ogr.
Dit is een onderdeel van GDAL.

Geef de volgende opdracht om een shapefile te importeren in PostGIS:

ogr2ogr -f "PostgreSQL" PG:"dbname=postgis host=myhost.de user=postgres
password=topsecret" alaska.shp

Dit zal de shapefile alaska.shp importeren in de PostGIS-database postgis als gebruiker postgres met het
wachtwoord topsecret op host server myhost.de.

Opm. OGR (GDAL) moet gebouwd zijn met ondersteuning voor PostgreSQL om te kunnen werken met PostGIS.
Je kunt dit controleren m.b.v. volgende opdracht (in )

ogrinfo --formats | grep -i post

Wanneer je PostgreSQL’s COPY -opdracht wilt gebruiken in plaats van de standaard INSERT INTO opdracht

kun je dat doen door de volgende omgevingsvariabele in te stellen (tenminste voor en ):

export PG_USE_COPY=YES

ogr2ogr maakt geen spatiale index aan in tegenstelling tot shp2pgsl die dat wel doet. Deze moet nadien, als
extra handeling, alsnog handmatig worden aangemaakt met de normale SQL-opdracht CREATE INDEX (zoals
beschreven in de volgende paragraaf Verbeteren van de uitvoering).

Verbeteren van de uitvoering

Het opvragen van gegevens uit een PostgreSQL database kan vertragend werken, zeker over een netwerk. Je kunt
het tekenen echter een stuk sneller maken door er voor te zorgen dat er een PostGIS spatial index is aangemaakt
voor elke laag uit de PostgreSQL database. PostGIS ondersteund het aanmaken van een zogenaamde GiST (Gen-
eralized Search Tree) index zodat de spatiale zoekopdrachten een stuk sneller uitgevoerd worden. (Informatie over
GiST indexeren is overgenomen vanuit de PostGIS documentatie beschikbaar via http://postgis.refractions.net).

De opdracht voor het aanmaken van een GiST index is:

CREATE INDEX [indexname] ON [tablename]
USING GIST ( [geometryfield] GIST_GEOMETRY_OPS );

Voor grote tabellen kan het aanmaken van een index veel tijd kosten. Wanneer de index is aangemaakt dient deze
gevolgd te worden door de opdracht VACUUM ANALYZE. Zie de PostGIS documentatie (POSTGIS-PROJECT
Verwijzingen naar literatuur en web) voor meer informatie.

Hier volgt een voorbeeld hoe je een GiST index kunt aanmaken:

gsherman@madison:~/current$ psql gis_data
Welcome to psql 8.3.0, the PostgreSQL interactive terminal.

Type: \copyright for distribution terms
\h for help with SQL commands
\? for help with psql commands
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\g or terminate with semicolon to execute query
\q to quit

gis_data=# CREATE INDEX sidx_alaska_lakes ON alaska_lakes
gis_data-# USING GIST (the_geom GIST_GEOMETRY_OPS);
CREATE INDEX
gis_data=# VACUUM ANALYZE alaska_lakes;
VACUUM
gis_data=# \q
gsherman@madison:~/current$

12.1.8 Vectorlagen die de 180° lengtegraad overschrijden

Veel GIS pakketten zullen verkeerd omgaan met het aanmaken van vector kaarten, met een ge-
ografisch referentie systeem (lengte-/breedtegraden), wanneer deze de 180 lengtegraad lijn overschrijden.
(http://postgis.refractions.net/documentation/manual-2.0/ST_Shift_Longitude.html). Wanneer ze zo’n kaart ope-
nen in QGIS, zullen we zien dat twee plaatsen die dicht bij elkaar liggen, ver uit elkaar getoond worden. In
Figure_vector_4 ligt, het kleine puntje helemaal aan de linkerkant van het kaartbeeld (de Chatham Islands), in
werkelijkheid aan de rechterkant van de Nieuw Zeeland’s hoofdeilanden.

Figuur 12.5: Kaarten maken voor lat/lon die de 180° lengtegraad overschrijden

Dit probleem kan men oplossen door de lengtegraden te transformeren gebruik makende van PostGIS, en de
ST_Shift_Longitude functie. De transform functie leest elke coördinaat van de geometrie van elk object en
wanneer de lengtegraad < 0° telt deze er 360° bij op. Het resultaat zal een 0° - 360° versie zijn van de gegevens
die afgedrukt worden op een 180° gecentreerde kaart.

Figuur 12.6: Het overschrijden van de 180° lengtegraad met het toepassen van de ST_Shift_Longitude functie

Gebruik

• Importeer gegevens in PostGIS (Het importeren van gegevens in PostgreSQL) bijvoorbeeld door gebruik te
maken van de DB Manager plugin.
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• Geef de volgende opdracht op de SQL opdrachtregel van PostGIS (dit is een voorbeeld
waar “TABEL” de echte naam is van je PostGIS tabel): gis_data=# update TABLE set
the_geom=ST_Shift_Longitude(the_geom);

• Wanneer alles goed ging, zou je nu een bevestiging moeten ontvangen van het aantal objecten die bijgewerkt
zijn. Daarna kan deze tabel geladen worden en zie je het verschil (Figure_vector_5)

12.1.9 SpatiaLite-kaartlagen

Wanneer je gegevens van een SpatiaLite database wilt laden, selecteer het icoontje SpatiaLite-laag Toevoegen op

de werkbalk of door de menu-optie SpatiaLite-laag Toevoegen... te selecteren onder het hoofdmenu Kaartla-
gen of via de sneltoets Ctrl+Shift+L. Een menu zal openen waarin je een nieuwe verbinding met een Spatialite
database kunt aanmaken of een bestaande verbinding die bekend is bij QGIS kunt kiezen in een keuzelijst. Om
een nieuwe connectie aan te maken selecteer de knop [Nieuw], vervolgens kun je via een bestandsverkenner de
SpatiaLite database vinden, wat vaak een bestand is die meestal de bestandsextensie :file‘.sqlite‘ heeft.

Wanneer je een vectorlaag wilt opslaan in SpatiaLite formaat kun je dit doen door een vectorlaag in de legenda
te selecteren en dan met de rechtermuis het snelmenu te openen en daarin Opslaan als... te selecteren. Geef een
naam voor de aan te maken database, geef ‘Spatialite’ als formaat en de CRS (Coördinaten Referentie Systeem).
Je kunt ook ‘SQLite’ als formaat selecteren en de volgende opdracht in het veld OGR data source creation op-
tion SPATIALITE=YES meegeven. OGR weet dan dat deze een SpatiaLite database moet aanmaken. Zie ook
http://www.gdal.org/ogr/drv_sqlite.html.

QGIS ondersteunt ook het bewerken van Views die gewijzigd kunnen worden in SpatiaLite.

Het maken van een nieuwe SpatiaLite kaartlaag

Wanneer je een nieuwe SpatiaLite laag wilt aanmaken, ga naar Het aanmaken van een nieuwe Spatialite Laag.

Tip: SpatiaLite data management Plugins
Voor het beheren van SpatiaLite gegevens kun je een aantal Python plugins gebruiken: QSpatiaLite, SpatiaLite
Manager of DB Manager (standaardplugin, aanbevolen). Deze kunnen gedownload en geïnstalleerd worden met
de Plugin Installer.

12.1.10 MSSQL Spatial kaartlagen

QGIS biedt ook ondersteuning voor MS SQL 2008. De eerste keer wanneer je een MSSQL Spatial database

wilt openen, begin met het selecteren van het icoontje MSSQL Spatial laag Toevoegen in de werkbalk, of selecteer

de menuoptie MSSQL Spatial laag Toevoegen... van het menu Kaartlagen of gebruik de snelkoppeling
Ctrl+Shift+M.

12.1.11 Oracle Spatial kaartlagen

De ruimtelijke objecten in Oracle Spatial helpen gebruikers bij het beheren van geografische en locatie-gegevens
in een eigen type binnen een database van Oracle. QGIS heeft nu ondersteuning voor dergelijke lagen.

Een opgeslagen verbinding maken

De eerste keer wanneer je een Oracle Spatial database wilt openen, moet er eerst een connectie met

de database gemaakt worden die de spatiale gegevens bevat. Begin met het selecteren van het icoontje
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Oracle Spatial laag Toevoegen in de werkbalk, of selecteer de menuoptie Oracle Spatial laag Toevoegen... van het
menu Kaartlagen of gebruik de snelkoppeling Ctrl+Shift+O. Druk in het menu dat verschijnt op de knop
[Nieuw] om toegang te krijgen tot de connectie manager, vervolgens opent het menu Nieuwe Oracle Spatial
verbinding aanmaken. De verplichte velden voor het opzetten van een verbinding zijn:

• Naam: Een naam voor deze verbinding. Kan gelijk zijn aan de Database.

• Database SID of SERVICE_NAME van de Oracle instantie.

• Host: Naam van de database host. De naam van de host moet dezelfde zijn als waarmee je deze kunt vinden
via een telnet verbinding of hoe je deze kunt pingen. Wanneer de database op dezelfde computer staat als
QGIS, gebruik hier dan ‘localhost’.

• Poort: Poortnummer waar de database van PostgreSQL naar luistert. De standaardpoort is 1521.

• Gebruikersnaam: Gebruikersnaam om toegang te krijgen tot de database.

• Wachtwoord: Wachtwoord dat hoort bij Gebruikersnaam om toegang te krijgen tot de database.

Optioneel kunnen de volgende aanvinkvakjes worden geactiveerd:

• Opslaan Gebruikersnaam Geef aan of de gebruikersnaam van de database-connectie moet worden
opgeslagen.

• Opslaan Gebruikersnaam Geef aan of de gebruikersnaam van de database-connectie moet worden
opgeslagen.

• Kijk alleen in de metadata tabel. Dit beperkt de tabellen tot die aanwezig in de view
all_sdo_geom_metadata. Dit kan het tonen van tabellen voor selectie aanzienlijk versnellen.

• Kijk alleen in de gebruikerstabellen. Beperk de zoekopdracht tot alleen die spatiale tabellen waar de
gebruiker eigenaar van is.

• Ook tabellen zonder geometrie tonen Geeft aan dat ook tabellen zonder geometrie standaard in de lijst
getoond worden.

• Gebruik geschatte tabelstatistieken voor de laag metadata Wanneer een laag wordt aangemaakt wordt er
ook verschillende metadata aangemaakt voor de Oracle tabel. Deze bevat informatie als bijhouding van het
aantal regels, het geometrie type en de extent van alle geometrieën in de tabel. Het bijhouden van deze meta-
data is tijdrovend wanneer de tabellen veel records bevatten. Door deze optie te activeren, wordt het verza-
melen van de metadata als volgt sneller bepaald: Het aantal regels word bepaald vanuit all_tables.num_rows.
De extent van elke tabel wordt altijd bepaald met de functie SDO_TUNE.EXTENTS_OF zelfs wanneer er
een filter wordt gebruikt. Het bepalen van de geometrie type van de tabel, worden de eerste 100 regels van
de tabel gelezen die geometrie bevatten.

• Alleen bestaande geometrie typen Toon alleen bestaande geometrie types en biedt niet aan om andere
toe te voegen.

Wanneer alle veldparameters en opties zijn ingesteld, kunt u de verbinding testen met de knop [Test verbinding].

Tip: QGIS Gebruikersinstellingen en beveiliging
Afhankelijk van je besturingssysteem kan de opslag van wachtwoorden in de instellingen voor QGIS een beveilig-
ingsrisico vormen. Wachtwoorden worden opgeslagen als leesbare tekst in de systeem configuratie en in de
projectbestanden! De opslag van gebruikersinstellingen voor QGIS hangt af van je besturingssysteem:

• The settings are stored in your home directory in .config/QGIS/QGIS2.conf.

• , De instellingen voor windows worden opgeslagen in de registry.
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Het laden van Oracle Spatial-lagen

Na het aanmaken van een verbinding met een of meerdere Oracle databases, kun je een kaartlaag laden vanuit
de Oracle database. Uiteraard moet deze wel eerst kaartgegevens bevatten.

Doe de volgende stappen, om een spatiale tabel te laden vanuit Oracle Spatial:

• Wanneer het venster Oracle Spatial Tabel(len) toevoegen nog niet open is, selecteer in de werkbalk de knop
Oracle Spatial laag Toevoegen.

• Kies een aangemaakte verbinding vanuit de keuzelijst en druk op [Verbinden].

• Vink aan of ontvink het keuzevakje Ook tabellen zonder geometrie tonen

• Optioneel kun je het keuzevakje Zoek opties aanvinken om een selectie te maken van objecten die
geladen dienen te worden of gebruik de knop [Filter instellen] om het venster te openen waarmee je een
Filter kunt instellen middels een zoekopdracht.

• Zoek naar de laag/lagen die u wilt laden uit de lijst van beschikbare tabellen met gegevens.

• Selecteer deze door er op te klikken. Je kunt meerdere lagen selecteren door de Shift toets in te drukken
tijdens het klikken. Zie Querybouwer voor meer informatie over het instellen van een filter hoe je een
zoekopdracht kunt maken voor een gegevenslaag.

• Klik op de knop [Toevoegen] om de laag toe te voegen aan de legenda en het kaartbeeld.

Tip: Oracle Spatial Kaartlagen
Normaal gesproken wordt een spatiale laag in ORACLE gedefinieerd in de tabel USER_SDO_METADATA.

.

12.2 Het dialoogvenster Vectoreigenschappen

Het menu Laag-eigenschappen voor een vectorlaag geeft informatie over de laag, instellingen van de stijlen en
de opties voor labels. Wanneer de vectorlaag geladen is vanuit een database van PostgreSQL/PostGIS, kun je
ook de opdracht voor SQL aanpassen waarmee deze laag is opgehaald door het venster Querybouwer te starten
onder het tabblad Algemeen. Om toegang te krijgen tot het menu Laag-eigenschappen kun je dubbelklikken op
een laag in de legenda of een laag selecteren en met een rechter muisklik het snelmenu openen en de menuoptie
Eigenschappen selecteren.

12.2.1 Menu Stijl

Het menu Stijl geeft toegang tot het toevoegen van symbologie van de vectorgegevens en hoe deze moet worden
gerenderd. U kunt het gereedschap Laag rendering → kiezen die voor alle vectorgegevens gebruikt kunnen
worden maar ook speciaal symboolgereedschap dat is ontworpen voor verschillende soorten vectorgegevens.

Renderen van lagen

• Laag transparantie : Men kan hiermee onderliggende lagen zichtbaar maken in het
kaartvenster. Gebruik de schuifbalk om de transparantie van de geselecteerde vectorlaag aan te passen.
Rechts naast de schuifbalkl kunt u een exact gewenst percentage voor de transparantie invullen.

• Laag blending modus en Object blending modus: Met dit gereedschap kan men speciale effecten op de kaart
toepassen die voorheen alleen bekend waren van grafische programma’s. De pixels van de overliggende en
onderliggende kaartlagen wordt vermengd volgens de instellingen zoals hieronder beschreven.
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Figuur 12.7: Het Vector Eigenschappen Menu
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– Normaal: Dit is de standaard mengmodus die het alfakanaal van de bovenliggende pixels mengt met
de pixel eronder. De kleuren worden daarbij niet gemengd.

– Lichter maken: Deze selecteert de maximum waarden van de pixels van de voor en achtergrond. Het
resultaat is vaak ruw, grof en kartelig.

– Screen: Lichte pixels van de bronlaag worden getekend over de doellaag, terwijl dat niet gebeurd met
donkere pixels. Deze modus is geschikt voor het mengen van de textuur van de ene laag met die van
een andere laag. Je kunt deze bijvoorbeeld gebruiken om schaduwen van heuvels in te brengen in een
andere laag.

– Dodge: Hoe lichter de bovenliggende pixel is des te feller en met meer kleur zullen de onderliggende
pixels getoond worden. Dit werkt het beste wanneer de bovenliggende top pixels niet te fel gekleurd
zijn anders wordt het resultaat nogal extreem.

– Toevoegen: Deze mengmodus telt de pixelwaarde van de ene laag op bij de andere. Wanneer de
waarden boven 1 uitkomen (in het geval van RGB), zal die pixel wit worden. Deze modus is geschikt
om bepaalde objecten op te laten lichten en zo te markeren.

– Donkerder maken: De resulterende pixel die overblijft is die met de laagste waarde van de voor en
achtergrond pixel. Net zoals bij de modus Lichter maken, neigt het resultaat naar ruw, grof en gekarteld

– Vermenigvuldigen: Deze vermenigvuldigt de waarden voor elke pixel van de toplaag met die van de
onderliggende laag. Het resultaat is een donkerder kaartbeeld.

– Branden: Donkere kleuren in de toplaag zorgen ervoor dat onderliggende lagen ook donkerder worden.
Dit kan worden gebruikt om de kleuren van onderliggende lagen bij te stellen.

– Overlay: Combineert de mengmodi vermenigvuldigen en screen. In het resulterend kaartvenster wor-
den de lichtere delen lichter en donkere delen donkerder.

– Zacht licht: Lijkt erg op overlay, maar in plaats van de combinatie vermenigvuldigen/screen wordt de
combinatie branden/dodge gebruikt. Het effect waarnaar gestreefd wordt is dat van het schijnen van
een zacht licht op het kaartbeeld.

– Hard licht: Hard licht lijkt op de modus overlay. Deze moet ervoor zorgen dat het lijkt of er een sterk
licht schijnt op het kaartbeeld.

– Verschil: Verschil haalt de waarde van de top pixel van de onderliggend pixel af of omgekeerd, zodat
er altijd een positieve waarde onstaat. Het mixen met zwart levert geen wijziging, omdat waarden voor
alle kleuren 0 zijn.

– Aftrekken: Deze blending modus trekt eenvoudig de pixelwaarde van de ene laag af van de andere.
Wanneer pixelwaarden negatief worden zullen die pixels zwart worden getoond.

Renderers

The renderer is responsible for drawing a feature together with the correct symbol. There are four types of
renderers: single symbol, categorized, graduated and rule-based. There is no continuous color renderer, because it
is in fact only a special case of the graduated renderer. The categorized and graduated renderers can be created by
specifying a symbol and a color ramp - they will set the colors for symbols appropriately. For point layers, there
is a point displacement renderer available. For each data type (points, lines and polygons), vector symbol layer
types are available. Depending on the chosen renderer, the Style menu provides different additional sections. On
the bottom right of the symbology dialog, there is a [Symbol] button, which gives access to the Style Manager
(see section vector_style_manager). The Style Manager allows you to edit and remove existing symbols and add
new ones.

Tip: Selecteer en wijzig meerdere symbolen
Met symbologie kun je meerdere symbolen selecteren en via de rechtermuis kun je de kleur, transparantie, de
grootte en de dikte van de buitenlijnen aanpassen.

De Enkel Symbool-renderer
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De renderer Enkel Symbool wordt gebruikt om alle objecten van een kaartlaag te presenteren met een enkel door
de gebruiker toegekend symbool. De eigenschappen die kunnen worden gewijzigd in het tabblad Stijl is deels
afhankelijk van het type kaartlaag, maar voor alle typen geldt de volgende opbouw. Links bovenin het menu, kun
je de voorvertoning zien van het huidige symbool. Aan de rechterkant van het menu is een lijst van symbolen die
reeds aangemaakt zijn voor de huidige stijl, klaar om te gebruiken door deze te selecteren uit de lijst. Het huidige
symbool kan worden aangepast gebruik makende van het menu aan de rechterkant. If you click on the first level
in the Symbol layers dialog on the left side, it’s possible to define basic parameters like Size, Transparency, Color
and Rotation. Here, the layers are joined together.

Figuur 12.8: Eigenschappen van enkele lijnsymbologie

More detailed settings can be made when clicking on the second level in the Symbol layers dialog. You can
define Symbol layers that are combined afterwards. A symbol can consist of several Symbol layers. The following
settings are possible:

• Point layers:

• Symbol layer type: You have the option to use Ellipse markers, Font markers, Simple markers, SVG markers
and Vector Field markers.

• Colors

• Size

• Outline style

• Outline width

• Angle

• Offset X,Y: You can shift the symbol in the x- or y-direction.
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• Anchor point

• Data defined properties ...

• Line layers:

• Symbol layer type: Here you can use Simple Lines and Marker Lines.

• Color

• Pen width

• Offset

• Pen style

• Join style

• Cap style

• Use custom dash pattern

• Dash pattern unit

• Data defined properties ...

• Polygon Layers:

• Symbol layer type: It’s possible to use Centroid Fill, Gradient Fill, Line Pattern Fill, Point Pattern Fill, SVG
Fill, Simple Fill and two Outlines (Marker line and Simple line).

• Colors

• Fill style

• Border style

• Border width

• Offset X,Y

• Data defined properties ...

‘Gradient Fill’ Symbol layer type allows you to select between a Two color and Color ramp setting. You

can use the Feature centroid as Referencepoint. All fills ‘Gradient Fill‘ Symbol layer type is also available
through the Symbol menu of the Categorized and Graduated Renderer and through the Rule properties menu of
the Rule-based renderer.

It is possible to only draw polygon borders inside the polygon. Using ‘Outline: Simple line’ select Draw line
only inside polygon.

Note that once you have set the size in the lower levels of the Symbol layers dialog, the size of the whole symbol
can be changed with the Size menu in the first level again. The size of the lower levels changes accordingly,
while the size ratio is maintained. After having made any needed changes, the symbol can be added to the list

of current style symbols (using [Symbol] Save in symbol library), and then it can easily be used in the

future. Furthermore, you can use the [Save Style] button to save the symbol as a QGIS layer style file
(.qml) or SLD file (.sld). SLDs can be exported from any type of renderer – single symbol, categorized, graduated
or rule-based – but when importing an SLD, either a single symbol or rule-based renderer is created. That means
that categorized or graduated styles are converted to rule-based. If you want to preserve those renderers, you have
to stick to the QML format. On the other hand, it can be very handy sometimes to have this easy way of converting

styles to rule-based. With the Style manager from the [Symbol] menu you can administer your symbols.

You can add item, edit item, remove item and share item. ‘Marker’ symbols, ‘Line’ symbols, ‘Fill’ patterns
and ‘Color ramps’ can be used to create the symbols (see defining_symbols). The symbols are then assigned to
‘All Symbols’, ‘Groups’ or ‘Smart groups’.

De Categoriën Renderer
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De Categoriën Renderer wordt gebruikt om alle objecten van een laag te tekenen met één symbool met een kleur
die afhankelijk is van een attribuutwaarde van diezelfde laag. Het tabblad Stijl geeft je de mogelijkheid om een
keuze te maken uit:

• The attribute (using the Column listbox or the Set column expression function)

• Het symbool (gebruik makende van het Symbool selectie menu)

• The colors (using the Color Ramp listbox)

Met de knop [Geavanceerd] die zich rechtsonder in het menu bevindt, kun je instellen welke velden gebruikt
kunnen worden voor de rotatie of voor de schaalgrootte van het symbool afhankelijk te maken van de veldwaarde.
Daarbij kun je eenvoudig een veld kiezen in een keuzelijstje van velden die je daar eventueel voor kunt gebruiken.
De lijst centraal in het menu toont de waarden van de huidig geselecteerde attributen, inclusief de symbolen die
zullen worden getekend.

Het voorbeeld in figure_symbology_2 toont de categoriën rendering dialoog gebruikt voor de laag rivers van
de QGIS sample dataset.

Figuur 12.9: Categoriën Symbologie opties

You can create a custom color ramp choosing New color ramp... from the Color ramp drop-down menu. A dialog
will prompt for the ramp type: Gradient, Random, ColorBrewer, or cpt-city. The first three have options for

number of steps and/or multiple stops in the color ramp. You can use the Invert option while classifying the
data with a color ramp. See figure_symbology_3 for an example of custom color ramp and figure_symbology_3a
for the cpt-city dialog.

The cpt-city option opens a new dialog with hundreds of themes included ‘out of the box’.

De Graduele Renderer

De renderer Gradueel wordt gebruikt om alle objecten in een laag te renderen, met behulp van één enkel gebruiker-
gedefinieerd symbool waarvan de kleur de aanwijzing van een geselecteerd attribuut van het object aan een klasse
weergeeft.

Net als de renderer Categorieën stelt de renderer Gradueel u in staat om rotatie en schaal voor de grootte uit
gespecificeerde kolommen te definiëren.

Ook, analoog aan de renderer Categorieën, stelt de tab Stijl u in staat om te selecteren:
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Figuur 12.10: Example of custom gradient color ramp with multiple stops

Figuur 12.11: cpt-city dialog with hundreds of color ramps
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Figuur 12.12: Graduele Symbologie opties

• The attribute (using the Column listbox or the Set column expression function)

• Het symbool (Gebruik makende van het Symbool selectie menu)

• The colors (using the Color Ramp list)

Aanvullend kunt u het aantal klassen specificeren en ook de modi voor het classificeren van objecten binnen de
klassen (met behulp van de lijst Modus). De beschikbare modi zijn:

• Equal Interval

• Quantilen

• Natural Breaks (Jenks)

• Standard Deviation

• Pretty Breaks

De lijst in het onderste deel van het tabblad Stijl somt de klassen op met hun bereik, labels en symbolen die voor
het renderen worden gebruikt.

Het voorbeeld in figure_symbology_4 toont de dialoog van de Renderer Gradueel voor de laag rivers van de
QGIS voorbeeld dataset.

Tip: Thematische kaarten met behulp van een uitdrukking
Thematische kaarten van Categorieën en Gradueel kunnen nu worden gemaakt met behulp van het resultaat van
een expressie. In het dialoogvenster Eigenschappen voor vectorlagen, zijn de keuzen voor attributen uitgebreid
met een functie Expressie voor kolom instellen. U hoeft dus nu niet meer het attribuut voor de classificatie
naar een nieuwe kolom in uw attributentabel weg te schrijven als u wilt dat het attribuut voor de classificatie een
samenstelling is van meerdere velden of een formule van enig soort.

De Regel-gebaseerde Renderer

De renderer Regel-gebaseerd wordt gebruikt om alle objecten in een laag te renderen, met behulp van op regels
gebaseerde symbolen waarvan de kleur de aanwijzing van een attribuut van een geselecteerd object aan een klasse
weergeeft. De regels zijn gebaseerd op argumenten in SQL. Het dialoogvenster stelt u in staat te groeperen op
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filter of schaal, en u kunt bepalen of u niveaus voor de symbolen wilt inschakelen of alleen de eerste regel die
overeenkomt wilt gebruiken.

Het voorbeeld in figure_symbology_5 toont de dialoog van een Regel-gebaseerde renderer voor de laag rivers
van de QGIS voorbeeld dataset.

To create a rule, activate an existing row by double-clicking on it, or click on ‘+’ and click on the new rule. In the

Rule properties dialog, you can define a label for the rule. Press the button to open the expression string
builder. In the Function List, click on Fields and Values to view all attributes of the attribute table to be searched.
To add an attribute to the field calculator Expression field, double click its name in the Fields and Values list.
Generally, you can use the various fields, values and functions to construct the calculation expression, or you can
just type it into the box (see Veld berekening). Since QGIS 2.2, you can create a new rule by copying and pasting
an existing rule with the right mouse button. Also since QGIS 2.2, you can use the ‘ELSE’ rule that will be run if
none of the other rules on that level match.

Figuur 12.13: Regelgebasseerde Symbologie opties

De Punt Verplaatsing Renderer

De renderer Puntverplaatsing werkt om alle objecten in een puntenlaag te visualiseren, zelfs als zij dezelfde
locatie hebben. De symbolen van de punten worden op een verplaatsingscirkel geplaatst rondom een symbool in
het centrum om dit te doen.

Tip: Vectorsymbologie exporteren
You have the option to export vector symbology from QGIS into Google *.kml, *.dxf and MapInfo *.tab files. Just
open the right mouse menu of the layer and click on Save selection as → to specify the name of the output file and
its format. In the dialog, use the Symbology export menu to save the symbology either as Feature symbology →
or as Symbol layer symbology →. If you have used symbol layers, it is recommended to use the second setting.

12.2.2 het Labels menu

De brontoepassing Labels verschaft slim labelen voor vectorpunt-, lijn- en polygoonlagen en het vereist slechts
enkele parameters. Deze nieuwe toepassing ondersteund ook on-the-fly getransformeerde lagen. De bronfuncties
van de toepassing zijn opnieuw ontworpen. In QGIS zijn er een aantal andere mogelijkheden die het labelen
verbeteren. De volgende menu’s zijn gemaakt voor het labelen van de vectorlagen:

• Tekst
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Figuur 12.14: De Punt Verplaatsings dialoog
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• Opmaak

• Buffer

• Achtergrond

• Schaduw

• Plaatsing

• Rendering

Laten we eens kijken hoe de nieuwe menu’s gebruikt kunnen worden voor verschillende vectorlagen. Het labelen
van vector puntlagen

Start QGIS en laad een punt-vectorlaag. Selecteer deze in de legenda en druk op het Laag Labelen Opties in de
werkbalk Labels van QGIS.

De eerste stap is om het keuzevak Deze laag labelen met te activeren en een kolom uit de attributen te selecteren
om te gebruiken voor het labelen. Klik op als u labels wilt definiëren die zijn gebaseerd op expressies - Bekijk
labeling_with_expressions.

De volgende stappen beschrijven eenvoudige labeling zonder de functies Data-bepaalde override te gebruiken die
zich in naast de keuzemenu’s bevinden.

U kunt de tekststijl definiëren in het menu Tekst (bekijk Figure_labels_1 ). gebruik de optie Hoofd- of kleine
letters om het renderen van de tekst te beïnvloeden. U heeft de mogelijkheid om de tekst te renderen in ‘Alles in
hoofdletters’, ‘Alles in kleine letters’ of ‘Eerste letter een hoofdletter’. gebruik de Meng-modus om effecten te
creëren die bekend zijn van grafische programma’s (bekijk blend_modes).

In het menu Opmaak kunt u een teken definiëren voor een regeleinde in de labels met de functie ‘Afbreking-

steken’. Gebruik de optie Opgemaakte getallen om de getallen in een attributentabel op te maken. Hier
kunnen decimale plaatsen worden ingevoegd. Als u deze optie inschakelt worden drie decimale plaatsen als stan-
daard ingesteld.

Activeer eenvoudigweg het keuzevak Teken tekstbuffer in het menu Buffer om een buffer te maken,. De kleur
voor de buffer is variabel. Hier kunt u ook Meng-modus gebruiken (bekijk blend_modes).

If the Color buffer’s fill checkbox is activated, it will interact with partially transparent text and give mixed
color transparency results. Turning off the buffer fill fixes that issue (except where the interior aspect of the buffer’s
stroke intersects with the text’s fill) and also allows you to make outlined text.

In het menu Achtergrond kun je met Grootte X en Grootte Y de vorm van de achtergrond definiëren. Gebruik
Lettergrootte om een extra ‘buffer’ in uw achtergrond in te brengen. De grootte van de buffer wordt standaard
ingesteld. De achtergrond bestaat dan uit de buffer plus de extra Grootte X en Grootte Y. U kunt met Rotatie
de rotatie van het label instellen waarbij u kunt kiezen uit ‘Met label synchroniseren’, ‘Op afstand van label’ en
‘Vast’. Met ‘Op afstand van label’ en ‘Vast’ kan de achtergrond worden geroteerd. Definieer een Op afstand
X,Y met X- en Y-waarden en de achtergrond zal verplaatst worden. Wanneer Radius X,Y wordt gebruikt zal de
achtergrond afgeronde hoeken krijgen. Het is ook mogelijk de achtergrond met de onderliggende lagen in het
kaartvenster te mengen met meng-modus (zie blend_modes).

Gebruik het menu Schaduw voor een gebruikergedefinieerde:Valschaduw. Het tekenen van de achtergrond is
zeer variabel. Kies uit ‘Laagste label component’, ‘Tekst’, ‘Buffer’ en ‘Achtergrond’. De hoek Verspringing is

afhankelijk van de richting van het label. Als u kiest voor het keuzevak Gebruik globale schaduw, dan is het
nulpunt van de hoek altijd gericht op het Noorden en is niet afhankelijk van de richting van het label. U kunt de
weergave van de schafuw beïnvloeden met Radius vervagen. Hoe hoger het nummer, hoe vager de schaduwen.
De weergave van de valschaduw kan ook worden gewijzigd door een meng-modus te kiezen (zie blend_modes).

Kies het menu Plaatsing voor het plaatsen van het label t.o.v. het object en de prioriteit van het plaatsen van
labels. Wanneer je gebruik maakt van Op afstand van punt kun je gebruik maken van Kwadranten om aan
te geven waar het label geplaatst moet worden t.o.v. het object. Aanvullend kun je de hoek waaronder het label
wordt geplaatst ook wijzigen met de instelling Rotatie. Dus is een plaatsing in een bepaald kwadrant onder een
bepaalde rotatie mogelijk.
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In het menu Rendering kunt u opties voor label en object definiëren. Onder Labelopties vind u nu de instelling
voor op schaal gebaseerde zichtbaarheid. U kunt voorkomen dat QGIS alleen geselecteerde labels rendert met

het keuzevak Toon alle labels voor deze laag (inclusief conflicterende labels). Onder Mogelijkheden kunt u
definiëren of elk gedeelte van meerdelige objecten moet worden gelabeld. Het is mogelijk om te definiëren of het

aantal objecten dat moet worden gelabeld begrensd is en om Voorkom dat labels objecten overschrijven.

Figuur 12.15: Slim labelen van punt-vectorlagen

Het labelen van vector lijnlagen

De eerste stap is het activeren van het keuzevak Deze laag labelen met in het menu Labels en kies het attribu-
utveld dat gebruikt moet worden voor de labels. Klik op als u op expressie gebaseerde labels wilt gebruiken.
- Zie labeling_with_expressions.

Hierna kunt u de tekststijl kiezen in het menu Tekst. Hier kun je dezelfde instellingen gebruiken als voor punten-
lagen.

Ook in het menu Opmaak kunt u dezelfde instellingen gebruiken als voor puntenlagen.

Het menu Buffer heeft dezelfde functies als beschreven in het gedeelte labeling_point_layers .

Het menu Achtergrond heeft dezelfde items als beschreven in het gedeelte labeling_point_layers .

Ook het menu Schaduw heeft dezelfde items als beschreven in het gedeelte labeling_point_layers .

In het menu Plaatsing vindt u speciale instellingen voor lijnlagen. Het label kan Parallel, Gebogen of

Horizontaal worden geplaatst. Met de opties Parallel en Gebogen kunt u de positie definiëren Boven

lijn, Op lijn en Onder lijn. Het is mogelijke meerdere opties tegelijkertijd te kiezen. In dat geval zal QGIS
de optimale positie voor het label zoeken. Onthoud dat u ook de richting van de lijn voor de positie van het label
kunt gebruiken. Aanvullend kunt u een Maximale hoek tussen bochtvolgende tekens definiëren bij het selecteren
van de optie Gebogen (zie Figure_labels_2 ).

Het menu Rendering heeft bijna dezelfde items als die voor puntlagen. Bij Mogelijkheden kunt u nu aangeven
Onderdruk labelen van objecten kleiner dan.
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Figuur 12.16: Slim labelen van lijn vectorlagen

Het labelen van polygoon vectorlagen

De eerste stap is om het keuzevak Deze laag labelen met te activeren en een kolom uit de attributen te selecteren
om te gebruiken voor het labelen. Klik op als u labels wilt definiëren die zijn gebaseerd op expressies - Bekijk
labeling_with_expressions.

Definieer de tekststijl in het menu Tekst. De items zijn gelijk aan die voor punt- en lijnlagen.

Het menu Opmaak geeft de mogelijkheid om meerdere regels op te maken, ook net zoals voor punt- en lijnlagen.

Zoals met punt- en lijnlagen kunt u een tekstbuffer creëren met het menu Buffer.

Gebruik het menu Achtergrond om een complexe gebruiker-gedefinieerde achtergrond voor de polygoonlaag te
maken. U kunt het menu net zo gebruiken als voor punt- en lijnlagen.

De invulbare velden in het menu Schaduw zijn dezelfde als voor punt- en lijnlagen.

In het menu Plaatsing vindt u speciale instellingen voor polygoonlagen (zie Figure_labels_3 ). Op afstand
van centroïde, Horizontaal (langzaam), Rondom centroïde, Vrij (langzaam) en Gebruik omtrek zijn
mogelijk.

Voor de instelling Op afstand van centroïde kunt u aangeven of de centroïde de zichtbare polygoon of de
gehele polygoon moet zijn. Dat betekent dat de centroïde ofwel wordt gebruikt voor de polygoon die zichtbaar

is op de kaart of dat de centroïde wordt bepaald voor de gehele polygoon, waarbij het niet van belang is of u
het gehele object op de kaart kunt zien. U kunt kwadranten gebruiken en daarbij hoeveel afstand en de rotatie
definiëren. De instelling Rondom centroïde maakt het mogelijk het label te plaatsen op een bepaalde afstand
rondom de centroïde. Ook hier kunt u zichtbare polygoon of gehele polygoon voor de centroïde definiëren.
Bij de instelling Gebruik omtrek kunt u een positie en afstand voor het label opgeven. Voor de positie zijn de

mogelijkheden Boven lijn, Op lijn, Onder lijn en Positieafhankelijk oriëntatie van lijn.
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Het menu Rendering heeft bijna dezelfde invulbare velden als die voor lijnlagen. Je kunt bij de Label opties
aangeven wanneer het labelen niet gedaan mag worden met Onderdruk het labelen van objecten kleiner dan.

Figuur 12.17: Slim labelen van polygoon vectorlagen

Labels definiëren die zijn gebaseerd op expressies

QGIS maakt het mogelijk om expressies te gebruiken voor de mogelijkheden van labels. Klik eenvoudigweg op

het pictogram in het menu Labels van het dialoogvenster Eigenschappen. In figure_labels_4 ziet u een
voorbeeld van een expressie om de regio’s van Alaska te labelen met naam en grootte van het gebied, gebaseerd
op het veld ‘NAME_2’, enige beschrijvende tekst en de functie ‘$area()’ in combinatie met ‘format_number()’
om het er netter uit te laten zien.

Op expressie gebaseerd labelen is eenvoudig om mee te werken. Alles waar u rekening mee dient te houden is dat u
alle elementen (tekenreeksen, velden en functies) moet combineren met een verbindingsteken voor tekenreeksen
‘||’ en dat velden worden geschreven met “dubbele aanhalingstekens” en tekenreeksen met ‘enkele aanhaling-
stekens’. Laten we eens naar een aantal voorbeelden kijken:

# label based on two fields ’name’ and ’place’ with a
"name" || ’, ’ || "place"

-> John Smith, Paris

# label based on two fields ’name’ and ’place’ with a descriptive text
’My name is ’ || "name" || ’and I live in ’ || "place"

-> My name is John Smith and I live in Paris

# label based on two fields ’name’ and ’place’ with a descriptive text
# and a line break (\n)
’My name is ’ || "name" || ’\nI live in ’ || "place"

-> My name is John Smith
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Figuur 12.18: Expressies gebruiken voor labelen

I live in Paris

# create a multi-line label based on a field and the $area function
# to show the place name and its area size based on unit meter.
’The area of ’ || "place" || ’has a size of ’ || $area || ’m²’

-> The area of Paris has a size of 105000000 m²

# create a CASE ELSE condition. If the population value in field
# population is <= 50000 it is a town, otherwise a city.
’This place is a ’ || CASE WHEN "population <= 50000" THEN ’town’ ELSE ’city’ END

-> This place is a town

As you can see in the expression builder, you have hundreds if functions available to create simple and very
complex expressions to label your data in QGIS.

Gebruik data gedefinieerd labelen

Met de functie Data-bepaalde override worden de instellingen voor het labelen overschreven door items uit de
attributentabel. U kunt deze functie activeren/deactiveren met de rechtermuisknop. Hou de muisaanwijzer boven
het symbool en u ziet de informatie over de Data-bepaalde override, inclusief het huidige gebruikte veld voor de
definitie. We zullen nu een voorbeeld geven hoe de functie Data-bepaalde override gebruikt kan worden voor de

functie Verplaats label (zie figure_labels_5 ).

1. Importeer lakes.shp uit de voorbeeld gegevensset van QGIS.

2. Dubbelklik op de laag om de laageigenschappen te openen. Klik op Labels en Plaatsing. Selecteer Op
afstand van centroïde.

3. Ga naar de items Data gedefinieerd. Klik op het pictogram om te bepalen welk veld gebruikt moet
worden voor Coördinaat. Kies ‘xlabel’ voor X en ‘ylabel’ voor Y. De pictogrammen worden nu geel geac-
centueerd.

4. Zoom in op een meer.

5. Ga naar de werkbalk Label en klik op het pictogram . Nu kunt u het label handmatig naar een andere
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positie verplaatsen (zie figure_labels_6 ). De nieuwe positie van het label wordt opgeslagen in de kolommen
‘xlabel’ en ‘ylabel’ van de attributentabel.

Figuur 12.19: Het labelen van polygoon vectorlagen met data-gedefinieerde overrides

12.2.3 Menu velden

in het menu Velden kunt u eigenschappen van de velden van de geselecteerde gegevensset wijzigen. De

knoppen Nieuwe kolom en Verwijder kolom kunnen worden gebruikt als de gegevensset met de knop
Bewerken aan/uitzetten in de modus Bewerken is gezet.

Wijzig hulpmiddel

In het menu Velden vindt u in de lijst van velden ook een kolom Wijzig-hulpmiddel. Deze kolom kan wor-
den gebruikt om waarden of een bereik van waarden te definiëren die zijn toegestaan om te worden toegevoegd
aan deze specifieke kolom van de attibutentabel. Wanneer u op de knop [Wijzig-hulpmiddel] drukt, opent een
dialoogvenster, waar u de verschillende hulpmiddelen kunt instellen. Deze hulpmiddelen zijn de volgende:

• Line edit: An edit field that allows you to enter simple text (or restrict to numbers for numeric attributes).

• Classificatie: Toont een keuzelijst met waarden die al gebruikt zijn voor dat veld wanneer je dat veld ook
hebt gebruikt om daarmee de symbologie te classificeren in het tabblad Stijl. Voor elke ‘unieke waarde’ is
het dan mogelijk een andere symbologie te gebruiken.

• Range: Maakt het mogelijk numerieke waarden in te stellen binnen een specifiek bereik. het hulpmiddel
voor bewerking kan een schuifbalk of een draaiknop zijn

• Unieke waarden: U kunt één van de al in de attributentabel gebruikte waarden kiezen. Als ‘Aanpasbaar’ is
geactiveerd wordt een hulpmiddel voor bewerken getoond met ondersteuning voor automatisch aanvullen,
anders wordt een combinatievak gebruikt.
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Figuur 12.20: Verplaatsen van labels

Figuur 12.21: Dialoog om een wijzig-hulpmiddel te kiezen voor een attribuutveld
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• Bestandsnaam: Hiermee kun je een bestandsnaam invullen door een bestand te selecteren via de bestand-
skiezer.

• Aanwezige waarden: Een combinatievak met vooraf gedefinieerde items. De waarde is opgeslagen in het
attribuut, de omschrijving wordt weergegeven in het combinatievak. U kunt waarden handmatig definiëren
of laden vanuit een laag of een CSV-bestand

• Enumeratie: Opent een combinatievak met waarden die gebruikt kunnen worden binnen dit type kolom.
Dit wordt momenteel alleen ondersteund voor de provider PostgreSQL.

• Immutable: The immutable attribute column is read-only. The user is not able to modify the content.

• Verborgen: Een verborgen attribuut is niet zichtbaar. De gebruiker kan de inhoud ervan niet zien.

• Aanvinkvakje: Toont een keuzevak en u kunt zelf definiëren welk attribuut moet worden toegevoegd als
dit keuzevak is geactiveerd of niet.

• Text edit: This opens a text edit field that allows multiple lines to be used.

• Calendar: Opens a calendar widget to enter a date. Column type must be text.

• Waarde-relatie: Keuzeveld waarde de waarden zijn ingevuld vanuit een gerelateerde tabel. Je kunt hiervoor
een laag, een sleutelveld en het veld met te kiezen waarden instellen.

• UUID Generator: Genereert een veld waarin automatisch een UUID (Universele Unieke IDentifier), een
unieke waarde die automatisch wordt gegenereerd wanneer het veld, door de gebruiker,niet wordt ingevuld.

• Foto: Het veld bevat de veldnaam van een afbeelding. De breedte en hoogte van het veld kunnen worden
gegeven.

• Webview: Het veld bevat een URL. De breedte en hoogte van het veld zijn variabel.

• Color: A field that allows you to enter color codes. During data entry, the color is visible through a color
bar included in the field.

• Relatie Referentie: Dit hulpmiddel laat u het objectformulier van laag waarnaar verwezen wordt inbedden
in het objectformulier van de actuele laag. Zie Een tot veel-relaties maken.

Met de Attribuut editor lay-out, kunt u nu ingebouwde formulieren definiëren voor de invoer van gegevens

(zie figure_fields_2). Kies ‘Drag and drop ontwerp’ en een attribuutkolom. Gebruik het pictogram om een
categorie te maken die zal worden getoond gedurende de sessie van digitaliseren (zie figure_fields_3). De volgende

stap zal het toewijzen van de relevante velden aan de categorie zijn met het pictogram . U kunt meerdere
categorieën maken en dezelfde velden opnieuw gebruiken. Bij het maken van een nieuwe categorie zal QGIS een
nieuwe tab voor de categorie invoegen in het ingebouwde formulier.

Andere opties in het dialoogvenster zijn ‘Automatisch genereren’ en ‘Geef een ui-bestand’. ‘Automatisch gener-
eren’ zal bewerkers aanmaken voor alle velden en deze in een tabel zetten. Met de optie ‘Geef een ui-bestand’
kunt u veel complexere dialoogvensters gebruiken die zijn gemaakt met de Qt-Designer. Het gebruik van
een UI-bestand geeft veel meer vrijheid om een dialoogvenster te maken. Voor gedetailleerde informatie zie
http://nathanw.net/2011/09/05/qgis-tips-custom-feature-forms-with-python-logic/ .

Dialoogvensters van QGIS mogen een Python-functie hebben die wordt aangeroepen als het dialoogvenster wordt
geopend. Gebruik deze functie om extra logica aan uw dialoogvensters toe te voegen. Een voorbeeld is (in module
MyForms.py):

def open(dialog,layer,feature):
geom = feature.geometry()
control = dialog.findChild(QWidged,"My line edit")

Refereer naar de Python Init Functie als volgt: MyForms.open

MyForms.py moet bereikbaar zijn via PYTHONPATH, in .qgis2/python, of binnen de projectmap.
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Figuur 12.22: Dialoogvenster om categorieën aan te maken met de Attribute editor layout

Figuur 12.23: Resultaat ingebouwd formulier in een sessie gegevensinvoer
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12.2.4 Tabblad Algemeen

Gebruik het tabblad Algemeen voor algemene instellingen voor een vectorlaag. Je kunt hiermee verschillende
zaken instellen:

Laag Info

• Wijzig de zichtbare naam van de laag in de legenda met Toon als

• Zet de bron van de vectorlaag

• Definieer de Tekencodering databron om specifieke opties voor de provider te geven en om het bestand te
kunnen lezen

Coördinaten Referentie Systeem

• Specificeer het Coördinaten Referentie Systeem. Hier kun je de projectie bekijken of wijzigen voor de
specifieke vectorlaag.

• Maak een :guilabel: Ruimtelijke Index aan (alleen voor OGR-ondersteunde indelingen)

• De knop [Update Extents] zal de kleinste rechthoek bepalen waarbinnen alle geometriëen van deze laag
passen

• Bekijk of wijzig de ruimtelijke projectie van deze specifieke vectorlaag, met de knop [Geef het CRS]

Schaalafhankelijke zichtbaarheid

• U kunt de schaal Maximum (inclusief) en Minimum (exclusief) instellen. De schaal kan ook gezet worden
met de knop [Current]

Deelverzameling objecten

• With the [Query Builder] button, you can create a subset of the features in the layer that will be visualized
(also refer to section Save selected features as new layer).

12.2.5 Menu Rendering

QGIS 2.2 introduceert ondersteuning voor on-the-fly objectgeneralisatie. ThiDit kan de tijd voor het renderen
verbeteren bij het tekenen van vele complexe objecten op kleine schalen. Deze mogelijkheid kan in de instellin-

gen voor de laag worden in- of uitgeschakeld met behulp van de optie Vereenvoudig geometrie. Er is ook een
nieuwe globale instelling die generalisatie standaard inschakelt voor nieuw toegevoegde lagen (zie gedeelte Op-
ties). Opmerking: Objectgeneralisatie kan in sommige gevallen artefacten in uw gerenderde uitvoer veroorzaken.
Dit kunnen versplinteringen zijn tussen polygonen en niet-accuraat renderen bij het gebruiken van op verplaatsing
gebaseerde symboollagen.

12.2.6 Het menu Tonen

Dit menu is specificaal gemaakt voor Kaarttips. Het bevat een nieuwe mogelijkheid: Karttip tekst weergeven
in HTML. Waar u nog steeds een Veld kunt kiezen om te worden weergegeven op de kaart wanneer u met de
muisaanwijzer over een object gaat, is het nu mogelijk om HTML-code in te voegen die een complexe weergave
maakt bij het boven het object zijn. Selecteer de menu-optie Beeld → Kaart Tips om Kaarttips te activeren.
Afbeelding Display 1 geeft een voorbeeld van HTML-code.

12.2.7 Tabblad Acties

QGIS geeft de mogelijkheid om een actie te starten waarbij gebruik wordt gemaakt van attribuutwaarden.
Je kunt meerdere acties per vectorlaag aanmaken waarmee je bijvoorbeeld een ander programma kunt aanroepen
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Figuur 12.24: Het menu Algemeen in de vectorlaag eigenschappen dialoog

Figuur 12.25: HTML-code voor tip op kaart
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Figuur 12.26: Tip voor kaart gemaakt met HTML-code

waarbij attribuutwaarden als argumenten meegeeft.

Acties zijn erg handig wanneer u regelmatig een extern programma wilt uitvoeren of een webpagina wilt bekijken
die is gebaseerd op een of meer waarden in uw vectorlaag. Zij zijn onderverdeeld in 6 typen die als volgt gebruikt
kunnen worden:

• De acties Algemeen, Mac, Windows en Unix starten een extern proces.

• De actie Python voert een expressie in Python uit.

• Acties Algemeen en Python zijn overal zichtbaar.

• De acties Mac, Windows en Unix zijn alleen zichtbaar op die specifieke besturingssystemen (u kunt bijv.
drie acties ‘Bewerken’ maken om een bewerkingsprogramma te openen, maar de gebruikers kunnen alleen
de actie ‘Bewerken’ voor hun platform zien en uitvoeren om het bewerkingsprogramma uit te voeren).

Er zijn enkele voorbeelden opgenomen in het dialoogvenster. U kunt deze laden door te klikken op [Standaard
acties toevoegen]. Een voorbeeld is een zoekactie gebaseerd op een waarde van een attribuut. Dit concept is
gebruikt in volgende bespreking.

Het definiëren van Acties

Acties op attributen worden gedefinieerd in het vectordialoogvenster vector Laag eigenschappen. Open het vec-
tordialoogvenster Laag eigenschappen en klik op het menu Acties om een actie te definiëren. Ga naar Actie-
eigenschappen. Selecteer ‘Algemeen’ als type en geef een beschrijvende naam voor de actie. De actie zelf moet
de naam van de toepassing bevatten die moet worden uitgevoerd als de actie wordt gestart. U kunt één of meer
waarden van velden met attributen als argumenten toevoegen voor de toepassing. Wanneer de actie wordt gestart,
zal elke set tekens die begint met een %, gevolgd door de naam van een veld, worden vervangen door de waarde
van dat veld. De speciale tekens %% zullen worden vervangen door de waarde van het veld dat werd geselecteerd
uit de resultaten van de identificatie of de attributentabel (zie using_actions hieronder). Dubbel aanhalingstekens
kunnen worden gebruikt om tekst te groeperen naar één enkel argument voor het programma, script of de opdracht.
Dubbele aanhalingstekens zullen worden genegeerd indien zij worden voorafgegaan door een backslash.

Wanneer u veldnamen gebruikt waarvan de naam een deel vormt van een andere veldnaam (bijv. col1 en col10)
zou u dat moeten aangeven door rechte haken om de veldnaam (en het % teken) te plaatsen (bijv. [\%col10]).
Dit voorkomt dat het veld %col10 wordt gelezen als veld %col1 met daarachter de tekst 0. De rechte haken
zullen door QGIS worden verwijderd bij het vervangen door de veldwaarde. Als u echter wilt dat het te vervangen
veld wordt omgeven door rechte haken, gebruik dan een tweede paar, bijvoorbeeld: [[\%col10]].

Met behulp van het gereedschap Objecten identificeren kunt u het dialoogvenster Identificatieresultaten openen.
Dit heeft een deel (Afgeleid) dat informatie bevat die relevant zijn voor dit type vectorlaag. Toegang tot de waarden
in dit item kan worden verkregen op een soortgelijke wijze als tot andere velden door de naam van het afgeleide
veld vooraf te laten gaan door (Afgeleid).. Een puntlaag heeft bijvoorbeeld de afgeleide velden X en Y en de
waarden van die velden kunnen in een actie worden gebruikt als %(Afgeleid).X en %(Afgeleid).Y. De
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Figuur 12.27: Het actie menu met enkele voorbeeldacties

afgeleide waarden zijn alleen beschikbaar vanuit het dialoogvenster Identificatieresultaten niet uit het dialoogven-
ster Attributentabel.

Twee :index:’voorbeeldacties’ worden hieronder weergegeven:

• konqueror http://www.google.com/search?q=%nam

• konqueror http://www.google.com/search?q=%%

In het eerste voorbeeld wordt de webbrowser Konqueror gestart en een URL ingegeven als argument. Er
wordt zoekactie via Google uitgevoerd op de waarde van het veld nam van onze vectorlaag. Let er
op dat de toepassing wel in het pad staat, anders moet u ook het volledige pad ingeven. dat deze
werkt, kunnen We zouden het eerste voorbeeld kunnen herschrijven als: /opt/kde3/bin/konqueror
http://www.google.com/search?q=\%nam om zeker te zijn. Dit zal er voor zorgen dat de toepass-
ing Konqueror zal worden uitgevoerd wanneer de actie wordt gestart.

Het tweede voorbeeld gebruikt de notatie %% , die niet afhankelijk is van een bepaald veld voor zijn waarde.
Wanneer de actie wordt gestart, zal %% worden vervangen door de waarde van het geselecteerde veld in Identifi-
catieresultaten of de Attributentabel. Acties gebruiken

Acties kunnen worden gestart vanuit het venster Identificatieresultaten of vanuit het venster Attributentabel of

vanuit Object-actie uitvoeren (onthoud dat deze dialoogvensters kunnen worden geopend door te klikken op
Objecten identificeren of Attributentabel openen of Object-actie uitvoeren). Klik met rechts op een record en kies de actie
uit het pop-upmenu, om een actie te starten,. Acties zijn in het pop-upmenu vermeld met de naam die u heeft
toegewezen bij het definiëren van de actie. Klik op de actie die u wilt starten.

Wanneer je een actie start die de %% notatie gebruikt, selecteer dan eerst het veld dat je wilt meegeven als argument,
in het venster Identificatieresultaten of de dialoog Attribuut tabel zodat de waarde van dat veld wordt meegegeven
aan de actie.

Hier volgt nog een voorbeeld dat gegevens uit een vectorlaag haalt en die met behulp van bash en de opdracht

echo naar een bestand schrijft (dit werkt dus alleen onder en misschien ook onder ). De betrokken laag heeft
velden met de soortnaam soortnaam, de breedtegraad lat en de lengtegraad long. We zouden een ruimtelijke
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selectie willen maken van locaties en de veldwaarden voor de geselecteerde records willen exporteren naar een
tekstbestand (in geel weergegeven in het kaartvenster van QGIS). Hier volgt de actie om dat te bereiken:

bash -c "echo \"%taxon_name %lat %long\" >> /tmp/species_localities.txt"

Na het achtereenvolgens selecteren van een aantal objecten (planten) en het aanroepen van de actie ziet de inhoud
van het bestand er ongeveer zo uit:

Acacia mearnsii -34.0800000000 150.0800000000
Acacia mearnsii -34.9000000000 150.1200000000
Acacia mearnsii -35.2200000000 149.9300000000
Acacia mearnsii -32.2700000000 150.4100000000

Als oefening kunnen we een actie maken voor de laag lakes waarbij we gegevens opzoeken met Google.
Eerst moeten we bepalen wat de URL is waarmee we met een zoekterm kunnen zoeken. Dat doen we door
naar Google te gaan en een simpele zoekopdracht uit te voeren en vervolgens uit de adresregel van de web-
browser de gebruikte URL over te nemen. Met deze kleine inspanning zien we dat de indeling van de URL is:
http://google.com/search?q=qgis, waarbij in dit geval qgis de zoekterm is. Gewapend met deze kennis kunnen
we doorgaan.

1. Eerst moet de laag lakes zijn geladen.

2. Open het dialoogvenster Laag eigenschappen door in de legenda te dubbelklikken op de laag of door met
rechts te klikken en Eigenschappen te selecteren uit het pop-upmenu.

3. Open het tabblad Acties.

4. Geef een naam voor de actie bijvoorbeeld Google Search.

5. Voor de actie moeten we de opdracht geven waarmee de webbrowser wordt opgestart. In dit geval gebruiken
we Firefox. Wanneer het programma niet rechtstreeks kan worden opgestart met alleen de programmanaam
dan dient het volledige pad te worden meegegeven.

6. Geef, na de naam van de webbrowser, de URL in waarmee we gaan zoeken in Google maar zonder de
zoekterm: http://google.com/search?q=

7. De tekst in het veld Actie ziet er nu als volgt uit: firefox http://google.com/search?q=

8. Selecteer de keuzelijst die de vectorlaag lakes bevat. Deze keuzelijst staat links van de knop [Voer veld
in].

9. Selecteer in de keuzelijst het veld Names en klik op de knop [Voer veld in].

10. De tekst van actie ziet er nu als volgt uit:

firefox http://google.com/search?q=\%NAMES

11. Klik op de knop [Voer actie in] om de actie te voltooien.

Hiermee is de actie aangemaakt en klaar om te gebruiken. De uiteindelijke tekst van de actie zou er zo uit moeten
zien:

firefox http://google.com/search?q=%NAMES

We kunnen deze actie nu gebruiken. Sluit het dialoogvenster Laag-eigenschappen. Zorg er voor dat de laag
lakes geselecteerd is in de legenda en start de functie Objecten identificeren. Na het selecteren van een meer zie
je dat de actie beschikbaar is in het resultaat:

Wanneer we de actie selecteren, zal deze Firefox opstarten en navigeren naar de URL
http://www.google.com/search?q=Tustumena. Het is ook mogelijk om nog meer attribuutvelden aan de
zoekterm toe te voegen Daartoe kunt u aan het einde van de tekst van de actie een ‘+’ toevoegen, een ander veld
te selecteren en te klikken op [Voer veld in]. Voor dit voorbeeld is er echter geen veld beschikbaar dat zin zou
hebben om op te zoeken.

U kunt meerdere acties voor een laag definiëren en elk daarvan zal worden weergegeven in het dialoogvenster
Identificatieresultaten.
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Figuur 12.28: Selecteer een object en kies een actie

U kunt allerlei toepassingen voor acties bedenken. Als u bijvoorbeeld een puntenlaag heeft die locaties van
afbeelding of foto’s bevat met een bestandsnaam, zou u een actie kunnen maken om een viewer te starten om de
afbeelding weer te geven. U zou ook acties kunnen gebruiken op web-gebaseerde rapporten voor een attribuutveld
of combinatie van velden te starten, die u op dezelfde specificeert als we met ons zoekvoorbeeld voor Google
hebben gedaan.

We kunnen ook meer complexe acties maken, bijvoorbeeld door gebruik te maken van acties van Python.

Normaal gebruiken we, als we een actie maken om een bestand met een externe toepassing te openen, absolute
paden of eventueel relatieve paden. In het tweede geval is het pad relatief ten opzichte van de locatie van de externe
toepassing. Maar wat wanneer we een relatief pad moeten gebruiken, relatief ten opzichte van de geselecteerde
laag (een op een bestand gebaseerde laag, zoals een shapefile of een SpatiaLite)? De volgende code geeft een
mogelijke oplossing:

command = "firefox";
imagerelpath = "images_test/test_image.jpg";
layer = qgis.utils.iface.activeLayer();
import os.path;
layerpath = layer.source() if layer.providerType() == ’ogr’

else (qgis.core.QgsDataSourceURI(layer.source()).database()
if layer.providerType() == ’spatialite’ else None);

path = os.path.dirname(str(layerpath));
image = os.path.join(path,imagerelpath);
import subprocess;
subprocess.Popen( [command, image ] );

We moeten eenvoudigweg onthouden dat de actie van het type Python is en de variabelen command en imagerel-
path moeten worden gewijzigd om aan onze behoeften te voldoen.

Maar wat als het relatieve pad relatief moet zijn ten opzichte van het (opgeslagen) projectbestand? De code van
de Python-actie zou dan zijn:

command="firefox";
imagerelpath="images/test_image.jpg";
projectpath=qgis.core.QgsProject.instance().fileName();
import os.path; path=os.path.dirname(str(projectpath)) if projectpath != ’’ else None;
image=os.path.join(path, imagerelpath);
import subprocess;
subprocess.Popen( [command, image ] );

Een ander voorbeeld van een Python-actie is die welke ons in staat stelt nieuwe lagen toe te voegen aan het
project. Bijvoorbeeld: de volgende voorbeelden zullen respectievelijk een vector- en een rasterlaag aan het project
toevoegen. De namen van de bestanden die toegevoegd zullen worden, evenals de namen die gegeven worden
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aan de lagen, zijn reeds geladen gegevens (filename en layername zijn kolomnamen van de attributentabel van de
vectorlaag waarmee de actie werd gemaakt.

qgis.utils.iface.addVectorLayer(’/yourpath/[% "filename" %].shp’,’[% "layername" %]’,
’ogr’)

Het wordt, om een rasterbestand toe te voegen (in dit voorbeeld een TIF-afbeelding):

qgis.utils.iface.addRasterLayer(’/yourpath/[% "filename" %].tif’,’[% "layername" %]
’)

12.2.8 Het tabblad Koppelingen

The Joins menu allows you to join a loaded attribute table to a loaded vector layer. After clicking , the
Add vector join dialog appears. As key columns, you have to define a join layer you want to connect with the
target vector layer. Then, you have to specify the join field that is common to both the join layer and the target
layer. As a result of the join, all information from the join layer and the target layer are displayed in the attribute
table of the target layer as joined information.

QGIS heeft momenteel ondersteuning voor het koppelen van niet-ruimtelijke tabelindelingen die worden onder-
steund door OGR (bijv., CSV, DBF en Excel), gescheiden tekst en de provider PostgreSQL (zie figure_joins_1).

Figuur 12.29: Een attributentabel koppelen aan een bestaande vectorlaag

Aanvullend stelt het dialoogvenster Vectorkoppeling toevoegen u in staat om:

• Koppellaag in virtueel geheugen ‘cachen’

• Attribuutindex aanmaken op het koppelveld
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12.2.9 Het tabblad Diagrammen

Met het tabblad Diagrammen kun je diagrammen in je vectorlaag plaatsen (zie figure_diagrams_1).

De huidige bron-implementatie voor diagrammen verschaffen ondersteuning voor taartdiagrammen, tekstdiagram-
men en histogrammen.

Het menu is opgedeeld in vier tabs: Uiterlijk, Grootte, Postie en Opties.

In de gevallen van tekstdiagram en taartdiagram wordt de de tekstwaarden van verschillende gegevenskolommen
onder elkaar getoond worden met een cirkel of een vierkant en scheidingen. In de tab Grootte is de grootte
van diagrammen gebaseerd op een vaste grootte of een lineaire schaal die overeenkomt met een attribuut voor
classificatie. Het plaatsen van diagrammen, wat wordt gedaan in de tab Positie, werkt samen met de nieuwe
manier van labels plaatsen, dus conflicten tussen de positie van het diagram en het label worden onderkend en
opgelost. Daarnaast kunnen posities van het diagram later handmatig worden gerepareerd.

Figuur 12.30: Vector eigenschappen dialoog met diagram menu

We zullen een voorbeeld geven waarbij we in de Alaska boundary-laag een tekstdiagram weergeven met temper-
atuurgegevens uit een klimaat vectorlaag. Beide vectorlagen zijn onderdeel van de voorbeeld gegevensset van
QGIS (zie Voorbeeld Data).

1. Klik eerst op het pictogram Vectorlaag Toevoegen, ga naar de map waarin zich de voorbeeld gegevensset van
QGIS bevindt en laad de twee shapefiles alaska.shp en climate.shp.

2. Dubbelklik op de laag climate in de kaartlegenda waarna het menu Laag Eigenschappen opent.

3. Klik op het menu Diagrammen, activeer Toon diagrammen en selecteer uit het combinatievak Diagram type

Tekstdiagram als Diagram type.

4. In de tab Uiterlijk kiezen we een lichtblauw als achtergrondkleur en in de tab Grootte tab stellen we een
vaste grootte in van 18 mm.
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5. In de tab Positie, kan Plaatsing worden ingesteld op ‘Rondom Punt’.

6. In het diagram willen we de waarden van de eerste drie kolommen tonen. T_F_JAN, T_F_JUL en

T_F_MEAN. Selecteer eerst T_F_JAN als Attribuut en klik op de groene knop , daarna T_F_JUL
en tenslotte T_F_MEAN.

7. Druk nu op de knop [Apply] om de diagrammen te tonen in het kaartbeeld van QGIS.

8. U kunt de grootte van het diagram aanpassen in de tab Grootte. Deactiveer het keuzevak Vast formaat en
stel de grootte van de diagrammen in op basis van een attribuut met de knop [Vind de maximum waarde]
en het menu Grootte. Als het diagram op het scherm te klein lijkt te zijn, kunt u het keuzevak Vergroot
kleine diagrammen activeren en de minimale grootte van de diagrammen definiëren.

9. Wijzig de kleuren voor de attributen door dubbel te klikken op de kleurwaarden in het veld Toegekende
attributen. Figure_diagrams_2 geeft een indruk van het resultaat.

10. Klik tenslotte op [Ok].

Figuur 12.31: Een cirkeldiagram met gegevens over temperaturen geprojecteerd op een kaart

Onthoud dat in de tab Positie, een Data-bepaalde positie van de diagrammen mogelijk is. Hier kunt u attributen
gebruiken om de positie van het diagram te definiëren. U kunt ook een schaalafhankelijke zichtbaarheid instellen
in de tab Uiterlijk.

The size and the attributes can also be an expression. Use the button to add an expression.

12.2.10 Tabblad Metadata

Het menu Metadata bestaat uit de gedeelten Omschrijving, Naamsvermelding, MetadataURL en Eigen-
schappen.

In het gedeelte Eigenschappen krijgt u algemene informatie over de laag, inclusief specificaties over het type en
locatie, aantal objecten, type objecten en mogelijkheden voor bewerking. De tabel Extent geeft u informatie over
het bereik van de kaart en onder Ruimtelijk Referentie Systeem vindt u informatie over welk coördinatensysteem
is gebruikt voor de laag. Dit is een snelle manier om informatie te vinden over een laag.

Aanvullend kunt u een titel en korte inhoud toevoegen of bewerken voor de laag in het gedeelte Omschrijving. Het
is ook mogelijk om hier een Sleutelwoordenlijst te definiëren. Deze sleutelwoordenlijst kan worden gebruikt in
een catalogus voor metadata. Als u een titel wilt gebruiken uit een XML- metadatabestand, moet u de link invullen
in het veld DataUrl. Gebruik Naamsvermelding om gegevens van attributen uit een catalogus met XML-metadata
te halen. In MetadataUrl kunt u het algemene pad definiëren naar de catalogus met de XML-metadata. Deze
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informatie zal worden opgeslagen in het projectbestand van QGIS voor volgende sessies en zal worden gebruikt
voor de server van QGIS.

Figuur 12.32: Het menu Metadata in het eigenschappen dialoog voor vectorlagen

.

12.3 Bewerken

QGIS ondersteund verschillende mogelijkheden om OGR, SpatiaLite, PostGIS, MSSQL Spatial en Oracle Spatial
vectorlagen en tabellen te bewerken.

Notitie: Het bewerken van GRASS vectorlagen gaat anders - zie Digitaliseren en bewerken van een GRASS
vectorlaag for details.

Tip: Tegelijk bewerken
Deze versie van QGIS houdt niet bij of er iemand toevallig hetzelfde object bewerkt. De laatste die zijn wijzigingen
opslaat wint.

12.3.1 Het instellen van de Snapping Toleranties en Zoek Radius

Voordat we de hoekpunten gaan bewerken doen we er goed aan eerst de snapping toleranties en de zoek radius in
te stellen zodat het bewerken van vector laag geometrieën beter zal gaan.

Snapping toleranties

De Snapping tolerantie is de afstand die QGIS gebruikt om te zoeken naar het dichtsbijzijnde hoekpunt en/of
lijnsegment waar een nieuw hoekpunt geplaatst of een bestaand hoekpunt naar verplaatst moet worden. Wanneer
de muiscursor verder dan die afstand van een bestaand hoekpunt bevindt dan zal het hoekpunt daar geplaatst
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worden waar de muiscursor zich bevindt. Binnen die afstand zal deze naar een bestaand hoekpunt ‘snappen’! De
instellingen van de snapping tolerantie heeft effect op al het gereedschap dat toleranties gebruikt.

1. A general, project-wide snapping tolerance can be defined by choosing Settings → Options. On Mac, go
to QIS → Preferences.... On Linux: Edit → Options. In the Digitizing tab, you can select between
‘to vertex’, ‘to segment’ or ‘to vertex and segment’ as default snap mode. You can also define a default
snapping tolerance and a search radius for vertex edits. The tolerance can be set either in map units or in
pixels. The advantage of choosing pixels is that the snapping tolerance doesn’t have to be changed after
zoom operations. In our small digitizing project (working with the Alaska dataset), we define the snapping
units in feet. Your results may vary, but something on the order of 300 ft at a scale of 1:10000 should be a
reasonable setting.

2. Een kaartlaag gebaseerde snapping tolerantie kan worden ingesteld door te kiezen voor Extra → (of Bestand
→) ‘Snapping’-opties... om de snapping modus en tolerantie voor elke laag in te stellen (zie figure_edit_1
).

Opm: Indien laaggebasseerde instellingen zijn gebruikt, zullen deze worden gebruikt in plaats van de standaard
instellingen. Wanneer je één laag moet bewerken waarbij de hoekpunten moeten snappen naar de hoekpunten
van een andere laag, activeer dan snapping voor die andere laag en maak de standaard snappingtoleranties een
stuk kleiner. Daarnaast zal snapping niet plaatsvinden naar lagen die niet aanstaan in de snapping opties voor
kaartlagen, ook niet na het instellen van de standaard snapping toleranties. Dus zorg ervoor dat deze lagen waar
je wel naar toe wilt snappen aangevinkt zijn.

Figuur 12.33: Bewerk de snapping opties op laagniveau

Zoekradius

De zoekradius is de afstand die QGIS gebruikt om het dichtsbijzijnde hoekpunt te vinden wanneer je op de kaart
klikt. Wanneer er zich binnen die afstand geen hoekpunt aangetroffen wordt, dan zal er een melding verschijnen
dat er geen hoekpunt gevonden is om te bewerken. Zowel snap tolerantie als zoek radius kunnen in pixels en
kaarteenheden gegeven worden en het vereist wat uitzoekwerk om de goede instellingen te vinden. Wanneer je
een te grote snap tolerantie instelt, dan heb je een grote kans dat deze naar het verkeerde hoekpunt snapt. Wanneer
de zoek radius te klein is zal deze niets vinden om te verplaatsen.

De zoekradius voor het bewerken van hoekpunten in laageenheden kan worden ingesteld in het tabblad :guil-
abel‘Digitaliseren‘ onder Extra → Opties. Dezelfde plaats waar je de standaard snapping tolerantie instelt.

12.3.2 Zoomen en Kaart verschuiven

Voordat je een laag gaat bewerken, moet je inzoomen op het betreffende gebied. Dit voorkomt dat alle hoekpunten
die je kunt bewerken getekend moeten worden voor de hele laag, dat kost meer tijd.
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Naast het gebruik van de knoppen Kaart verschuiven en de Inzoomen / Uitzoomen op de werkbalk kun je ook
het muiswieltje, de spatiebalk en de pijltjestoetsen gebruiken.

Zoomen en de kaart verplaatsen met het muiswieltje

Tijdens het digitaliseren kun je met het ingedrukte muiswieltje binnen de kaart, het kaartbeeld verplaatsen. Wan-
neer je het muiswieltje naar je toe rolt zal het kaartbeeld uitzoomen en wanneer je het muiswieltje van je af rolt
inzoomen. De plaats van de muiscursor zal het centrum van het gebied zijn waar je op in of uitzoomt. Je kunt het
gedrag voor het in- en uitzoomen met het muiswieltje aanpassen onder het tabblad Kaart gereedschap onder het
menu Extra → Opties.

De kaart verplaatsen met de pijltjestoetsen

Tijdens het digitaliseren kun je het kaartbeeld verplaatsen met behulp van de pijltjestoetsen. Plaats de muiscursor
in het kaartbeeld en druk op de rechter- of de linkerpijltjestoets om het kaartbeeld naar het oosten of het westen
te verplaatsen. Met de pijltjestoets omhoog of omlaag kun je het kaartbeeld naar het noorden of naar het zuiden
verplaatsen.

Met ingedrukte spatiebalk, kun je met de muiscursor het kaartbeeld verplaatsen in de richting waar je de muiscur-
sor naar toe beweegt. Met de toetsen PgUp en PgDown van je toetsenbord kun je in- en uitzoomen op de kaart
zonder je digitaliseer sessie te onderbreken.

12.3.3 Topologische bewerkingen

Vanuit het menu Snapping opties kun je ook instellen of er bij bewerkingen rekening moet worden gehouden met
topologische relaties tussen lagen onderling. Deze dialoog kan worden opgestart vanuit het hoofdmenu via Extra

→ Snapping opties.... Hier kun je het aanvinkvakje Topologisch bewerken aanzetten activeren en/of kun je

voor polygoonlagen de kolom Voorkom kruisingen aanvinken waarmee voorkomen wordt dat polygoonvlakken
elkaar overlappen.

Topologisch bewerken aanzetten

De optie Topologisch bewerken aanzetten is voor het bewerken en onderhouden van polygoon-objecten met
gedeelde grenzen. QGIS herkent gedeelde grenzen tussen vlakken en wanneer je een hoekpunt van een grens
verplaatst, dan zal QGIS ook direct de geometrie van (het) andere vlakobject(en), waar deze grens een onderdeel
van vormt, aanpassen. Wanneer deze optie aanstaat dan zal tijdens het inbrengen van nieuwe polygoonobjecten het
‘overbodig’ overlappende gedeelte van het nieuwe vlak worden verwijderd en de grens exact aansluitend worden
gemaakt. Zorg er bij het opvoeren van het nieuwe vlak er dan wel voor dat het beginpunt en het eindpunt van de
grens waar de overlapping begint gelijk zijn. Op deze manier kun je veel sneller een gedeelde grens opvoeren die
vaak bestaat uit meerdere punten.

Kruisingen voorkomen

De tweede topologische instelling die je kunt instellen is het aanvinkvak in de kolom Voorkom kruisingen, waarbij
het aanvinkvak alleen aanwezig is voor polygonen. Wanneer deze aanwezig is en je voert een polygoon op waarbij
de grens zichzelf snijd waardoor er meer dan 1 aaneengesloten vlak ontstaat, dan zal er direkt een melding volgen
die de gebruiker daarop attendeert, maar die het aanmaken van het object niet voorkomt! Staat het aanvinkvak
‘Voorkom kruisingen’ niet aangevinkt, dan blijft die melding achterwege. In de praktijk blijkt dat deze controle
er ook voor zorgt dat binnen een bestaande polygoon, voor een laag waar deze controle voor aanstaat, niet een
andere polygoon kan worden opgevoerd die daar geheel binnen valt. In de engelse handleiding staat bovendien
dat de optie Voorkom kruisingen indien aangezet helpt bij het digitaliseren van aansluitende grenzen, maar het is
de optie Topologisch bewerken aanzetten die daarvoor zorgt.
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Snappen op snijpunten aanzetten

Een andere optie is het aanvinkvak Snappen op snijpunten aanzetten. Dit geeft de mogelijkheid te ‘snappen’
naar snijpunten van achtergrondlagen zelfs wanneer er geen hoekpunt aanwezig is op het snijpunt.

12.3.4 Het digitaliseren van een bestaande kaartlaag

Standaard staan kaartlagen in QGIS, na het laden, op alleen lezen. Dit voorkomt dat je per ongeluk een kaart-
laag gaat wijzigen. Maar je kunt elke kaartlaag wijzigen, tenminste voor kaartlagen waarvoor het wijzigen van
kaartlagen ondersteund wordt en wanneer je, op bestandsniveau, schrijfrechten hebt voor die bestanden.

In general, tools for editing vector layers are divided into a digitizing and an advanced digitizing tool-
bar, described in section Geavanceerd Digitaliseren. You can select and unselect both under Set-
tings → Toolbars →. Using the basic digitizing tools, you can perform the following functions:

Icoon Doel Icoon Doel

Huidige wijzigingen Bewerken aan/uitzetten

Toevoegen Objecten: Punten Toevoegen Objecten: Lijnen

Toevoegen Objecten: Polygonen Verplaatsen Object

Bewerken van Knooppunten Verwijderen Geselecteerd(e) Object(en)

Knippen van Objecten Kopiëren van Objecten

Plakken van Objecten Opslaan wijzigingen laag

De functies van de werkbalk ‘Digitaliseren’

Elke sessie waarbij je een kaartlaag gaat bewerken begint met het schrijfbaar maken van de geselecteerde laag met
Bewerken aan/uitzetten. Deze bestaat als menu-optie in het snelmenu, die je opent met de rechtermuisknop na het

selecteren van een laag in de legenda.

Maar je kunt ook het icoon Bewerken aan/uitzetten kiezen van de werkbalk Digitaliseren om met bewerken te
beginnen of te stoppen. Wanneer het bewerken van een laag aanstaat, zullen er markingen verschijnen voor de
hoekpunten en meer knoppen op de werkbalk zullen actief en beschikbaar worden.

Tip: Regelmatig Opslaan

Vergeet niet om de knop Wijzigingen Laag Opslaan regelmatig te gebruiken. Deze zal ook controleren of je je
gegevens nog kunt schrijven naar de databron.

Toevoegen van Objecten

Je kunt de knoppen Object toevoegen, Object toevoegen of Object toevoegen van de werkbalk Digitaliseren ge-
bruiken om QGIS te wijzigen naar de modus Dititaliseren waarbij ook de muisaanwijzer veranderd. Welke knop
op de werkbalk aanwezig is, is afhankelijk van de actieve soort vectorlaag.

Voor elk object begin je eerst met het digitaliseren van de geometrie en vervolgens geef je de attribuutwaarden in.
Door met de linkerknop in het kaartbeeld te klikken digitaliseer je een punt voor de nieuwe geometrie.

Voor lijnen en polygonen, voeg je volgende punten toe door met de linkermuis door te klikken in het kaartbeeld.

Voor het laatste punt, klik je ergens in het kaarbeeld met de rechtermuis. Voor Mac moet je bij het ingeven van
het laatste punt de control toets ingedrukt houden.

Vervolgens opent het venster waarmee je de attribuutwaarden voor het nieuwe object kunt inbrengen. Fig-
ure_edit_2 toont het venster voor het inbrengen voor een nieuwe fictieve rivier. In het tabblad Digitaliseren in
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het menu Extra → Opties, kun je het de aanvinkvakje Geen attribuut-popups na het aanmaken van elk kaar-

tobject tonen en het aanvinkvak Laatst ingevoerde attribuutwaarden gebruiken aanzetten.

Figuur 12.34: Geef attribuutwaarden via het attributenformulier na het digitaliseren van nieuwe geometrie

Met de werkbalkknop Object(en) verplaatsen kun je bestaande objecten verplaatsen.

Tip: Soorten Attribuutwaarden
Tijdens het bewerken vindt er controle plaats van ingevoerde attribuutwaarden. Het is daarom niet mogelijk om
een tekstwaarde in te vullen voor een numeriekveld in het formuliervenster Attributen.Wanneer dat toch nodig is,
dan kun je dat naderhand alsnog doen in de dialoog Attribuuttabel.

Huidige wijzigingen

This new feature allows the digitization of multiple layers. Choose Save for Selected Layers to save all

changes you made in multiple layers. You also have the opportunity to Rollback for Selected Layers, so that

the digitization may be withdrawn for all selected layers. If you want to stop editing the selected layers,
Cancel for Selected Layer(s) is an easy way.

Dezelfde functionaliteit is beschikbaar voor het bewerken van alle lagen.

Bewerken van Knooppunten

Voor het bewerken van geometrie kun je werkbalkknop Knooppunt-gereedschap gebruiken, Je kunt hiermee meerdere
knooppunten van een geometrie selecteren en deze verplaatsen, toevoegen of verwijderen. Het Knooppuntgereed-
schap werkt ook wanneer ‘gelijktijdige CRS-transformatie’ geactiveerd is. Daarnaast blijft de selectie na een
bewerking gewoon nog actief (in tegenstelling tot de meeste andere gereedschap in QGIS waarbij dat niet het
geval is). Wanneer het Knooppunt-gereedschap geen objecten kon vinden, zal deze een waarschuwing tonen.

Het is aan te raden om eerst de Zoekradius voor hoekaanpassingen op een waarde groter dan 0 te zetten (bijvoor-
beeld 10) anders kun je geen knooppunt in QGIS selecteren en volgt er een melding. Zet de zoekradius via het
menu Extra → Opties → Digitaliseren → :guilabel‘Zoekradius voor hoekpuntaanpassingen‘ .

Tip: Knooppunt markeringen
De huidige versie van QGIS ondersteund drie soorten markeerstijlen voor het weergevan van de hoekpunten:
‘Semi transparante circel’, ‘Kruis’ en ‘Geen’. Om de markeerstijl te wijzigen open het tabblad Digitaliseren in
het menu Opties te openen via menuselection:Extra Options .... Onder het deel Hoekpunten staan de opties
Markerstijl en Markergrootte waarmee je de markeerstijl kun aanpassen.
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Standaard bewerkingen

Start met het activeren van het Kooppunten-gereedschap en selecteer een object door hierop te klikken. Rode vierkan-
tjes verschijnen rond elk knooppunt van dit object.

• Selecteren van knooppunten: Je kunt een enkele knooppunt selecteren door er precies op te klikken.
Wanneer je op de lijn klikt die twee knooppunten verbindt, dan worden beide verbonden knooppunten gese-
lecteerd. Wanneer je een vierkant trekt (met ingehouden linkermuisknop) waarbinnen zich meerdere knoop-
punten bevinden, worden deze knooppunten allemaal geselecteerd. Wanneer een knooppunt geselecteerd is
zal de kleur hiervan blauw worden. Je kunt meer knooppunten aan de bestaande selectie toevoegen door

met ingehouden Ctrl toets, voor command toets, knooppunten te selecteren. Wordt met de Ctrl toets
op een reeds geselecteerd knooppunt geklikt dan wordt deze verwijderd uit de selectie .

• Toevoegen van knooppunten: Om een knooppunt toe te voegen kun je dichtbij of op een lijnstuk klikken.
Het nieuwe knooppunt zal overigens altijd toegevoegd worden op de bestaande lijn en niet op de plaats waar
je met de muis hebt geklikt. Het nieuwe knooppunt kun je daarna verplaatsen indien nodig.

• Verwijderen van knooppunten: Je kunt knooppunten verwijderen door deze eerst te selecteren en daarna

op de Delete toets te drukken. Voor fn + Delete toets. Je kunt met het Knooppunten-gereedschap

geen volledig object verwijderen, zodra je dreigt onder het minimaal aantal benodigde punten voor het
type vectorobject komt, dat je aan het bewerken bent (1 voor punt, 2 voor lijn, 3 voor polygoon) zal het

verwijderen niet doorgaan. Om een volledig object te verwijderen gebruik Geselecteerd(e) object(en) verwijderen.

• Verplaatsen van knooppunten Selecteer eerst alle knooppunten die je wilt verplaatsen. Klik op een gese-
lecteerd knooppunt of een lijnstuk en sleep deze naar de plek waar je alle geselecteerde knooppunten naar
toe wilt verplaatsen. Wanneer snapping is geactiveerd zal de hele selectie zich verplaatsen (‘snappen’) naar
het dichtsbijzijnde knooppunt of lijn.

Elke wijziging die gedaan is met het knooppunten-gereedschap wordt opgeslagen in de dialoog Ongedaan maken.
Daarnaast wordt topologisch bewerken ondersteund voor alle handelingen wanneer dit is geactiveerd. Gelijktijdige
CRS transformatie wordt eveneens ondersteund en er verschijnt informatie in het scherm over het knooppunt
wanneer je de muisaanwijzer even boven een knooppunt houdt.

Knippen, Kopiëren en Plakken van Objecten

Geselecteerde objecten kunnen geknipt, gekopiëerd en geplakt worden tussen vectorlagen in hetzelfde QGIS

project, maar dan moet de doellaag ook eerst bewerkbaar zijn gemaakt met Bewerken aan/uitzetten.

Objecten kunnen ook geplakt worden in externe applicatie als tekst: De objecten worden daarbij gepresenteerd
in CSV formaat (comma gescheiden waarden) waarbij de geometrie waarden zijn opgeslagen in WKT-formaat
(Well-Known Text formaat, een OGC standaard) waarbij geometrie wordt weergeven in tekst.

In deze versie van QGIS kunnen objecten in tekst formaat niet in een laag van QGIS worden geplakt. Wanneer
komt de kopieer en plakfunctionaliteit van pas? Je kunt meerdere lagen tegelijk bewerkbaar zetten en dan bijvoor-
beeld in een laag met duizenden meren alleen die twee meren kopiëren die je nodig hebt en deze plakken in een
nieuwe lege laag plakken.

Als voorbeeld zullen we enkele lagen van de laag met meren kopiëren naar een nieuwe laag:

1. Laad de laag van waaruit je objecten wilt kopieëren (de bronlaag)

2. Laad of maak de laag aan waar je naartoe wilt kopiëren (de doellaag)

3. Zet het bewerken aan voor de doellaag

4. Maak de bronlaag de actieve laag door deze te selecteren in de legenda

5. Gebruik het selectiegereedschap Eén object selecteren om object(en) te selecteren in de bronlaag

6. Klik op Kaartobjecten kopiëren
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7. Maak nu de doellaag de actieve laag door er op te klikken in de legenda

8. Klik op Kaartobjecten Plakken

9. Zet bewerken voor de laag uit en sla de wijzigingen op

Wat gebeurt er wanneer inhoudelijk de attribuutvelden niet overeenkomen? QGIS zal dan alleen die velden
kopiëren die inhoudelijk overeenkomen en de rest negeren. Wanneer je zeker wilt weten dat de attributen en
de geometrie goed overgezet worden, dan moeten de tabellen inhoudelijk overeenkomen.

Tip: Behoud van eigenschappen geplakte objecten
Wanneer de bronlaag en de doellaag dezelfde kaartprojectie hebben, zal na het plakken de geometrie goed be-
houden zijn. Echter wanneer de kaartprojectie van de bron- en de doellaag verschillen dan kan het zijn dat de
geometrie niet exact behouden blijft. Dit komt omdat tijdens de reprojectie er kleine afrondingsverschillen zullen
optreden voor het berekenen van de nieuwe coördinaten.

Verwijderen Geselecteerde Objecten

Wanneer we een polygoon willen verwijderen, kunnen we dat doen door eerst de polygoon te selecteren met het

selectiegereedschap Eén object selecteren. Je kunt ook meerdere objecten selecteren. De geselecteerde objecten

kun je verwijderen met Geselecteerd Object(en) Verwijderen.

Met Kaartobjecten knippen van de werkbalk :guilabel‘Digitaliseren‘ kun je ook objecten verwijderen. Daarbij wor-
den niet alleen de objecten uit de laag gehaald maar ook tijdelijk in het geheugen bewaard in he “ruimtelijke

clipboard”. Vervolgens kan het object met Kaartobjecten Plakken weer ingebracht worden. Knippen, kopiëren en
plakken werkt op de geselecteerde objecten, wat betekent dat die er meerdere tegelijkertijd mogen zijn.

Opslaan van Bewerkte Lagen

Wanneer een laag bewerkbaar is, zullen de wijzigingen in het geheugen van QGIS zijn opgeslagen. Deze zijn dan
nog niet opgeslagen op schijf. Wanneer je tijdens het bewerken de wijzigingen tussendoor wilt opslaan gebruik dan

Wijzigingen opslaan. Wanneer je wisselt naar bewerken uitzetten met Bewerken aan-/uitzetten en er zijn wijzigingen
gedaan (of QGIS wilt afsluiten), dan zal er de vraag komen of je huidige aanpassingen wilt opslaan.

Wanneer de wijzigingen niet opgeslagen kunnen worden (bijv. geen schijfruimte meer beschikbaar), dan blijven
de wijzigingen nog bewaard in QGIS. Je kunt dan eerst het probleem oplossen (bijv. schijfruimte beschikbaar
maken) en vervolgens alsnog de wijzigingen bewaren.

Tip: Data Integriteit
Het is altijd een goed idee om een backup te maken van je gegevens voordat je begint met het wijzigen ervan.
Alhoewel de ontwikkelaars van QGIS veel aandacht hebben gegeven aan het behouden van de integriteit van de
gegevens, zijn er geen garantie afgegeven.
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12.3.5 Geavanceerd Digitaliseren

Icoon Doel Icoon Doel

Ongedaan maken Opnieuw

Objecten Roteren Versimpel Object

Ring Toevoegen Onderdeel Toevoegen

Ring Vullen Verwijder Ring

Verwijder Onderdeel Object vervormen

Verspring Curve Kaartobjecten splitsen

Delen Splitsen Geselecteerde objecten
samenvoegen

|mActionMergeFeature-
sAttributes|

Attributen van geselecteerde objecten
samenvoegen

Puntsymbolen Roteren

Tabel Geavanceerd Bewerken: De werkbalk Geavanceerd Digitaliseren voor vectorlagen

Ongedaan maken en Opnieuw

Ongedaan maken en Opnieuw geven de gebruiker de mogelijkheid om bewerkingen op vectorlagen in stappen
ongedaan te maken of nogmaals uit te voeren. Er is ook een paneel aanwezig waarmee je een historie krijgt te zien
van alle bewerkingen (zie Figure_edit_3). Dit paneel is standaard niet zichtbaar maar je kunt dit zichtbaar maken
door met de rechtermuis op de toolbar klikken en vervolgens de keuze “Ongedaan maken/Opnieuw” te selecteren
waarna dit paneel zichtbaar wordt. Dit kan ook via menuopties Beeld → Panelen → Ongedaan maken/Opnieuw.
De functie Ongedaan maken/ Opnieuw is actief ook wanneer het paneel niet zichtbaar is.

Figuur 12.35: Ongedaan maken en Opnieuw uitvoer van gedigitaliseerde stappen

Wanneer Ongedaan maken wordt gebruikt, zal de status van de objecten weer zijn als voor de laatste bewerking.
Wanneer bewerkingen buiten de normale vectorbewerkingen om worden gedaan, bijvoorbeeld vanuit een plugin,
dan kan het zijn dat deze bewerkingen niet uitgevoerd kunnen worden (dat ligt eraan hoe deze bewerkingen
geprogrammeerd zijn).

Met het panel Ongedaan maken/Opnieuw kun je door te klikken op een bewerking in de lijst direct naar de situatie
terugspringen van voor de bewerking.

12.3. Bewerken 115



QGIS User Guide, Release 2.2

Objecten Roteren

Gebruik Puntsymbolen roteren om een of meerdere geselecteerde objecten te roteren in het kaartbeeld. Eerst moeten

er enkele objecten worden geselecteerd en selecteer vervolgens de knop Puntsymbolen roteren. Vervolgens zal het
zwaartepunt (de centroïde) van het object worden getoond wat zal dienen als rotatiepunt. Wanneer er meerdere
objecten worden geselecteerd zal het rotatiepunt het gezamenlijke zwaartepunt van die objecten zijn. Met een
ingehouden linkermuisknop kunnen de geselecteerde objecten gedraaid worden om het rotatiepunt in de gewenste
richting.

Het is mogelijk om zelf een rotatiepunt aan te maken waar geselecteerde objecten om geroteerd zullen worden.

Selecteer eerst de objecten geroteerd moeten worden selecteer vervolgens de knop Puntsymbolen roteren. Hou nu de
Ctrl toets ingedrukt en verplaats de muisaanwijzer (zonder indrukken) naar de plaats waar het rotatiepunt moet
komen te liggen. Laat nu de Ctrl toets los om het rotatiepunt vast te leggen. Met een ingehouden linkermuisknop
kunnen de geselecteerde objecten gedraaid worden om het rotatiepunt in de gewenste richting.

Versimpel Object

The Simplify Feature tool allows you to reduce the number of vertices of a feature, as long as the geometry
doesn’t change. First, select a feature. It will be highlighted by a red rubber band and a slider will appear. Moving
the slider, the red rubber band will change its shape to show how the feature is being simplified. Click [OK] to
store the new, simplified geometry. If a feature cannot be simplified (e.g. multi-polygons), a message will appear.

Ring Toevoegen

Je kunt aan een polygon ‘gaten’ toevoegen door gebruik te maken van het icoon Ring Toevoegen. Dit betekent
dat je binnen een bestaande polygoon polygonen kunt toevoegen die fungeren als ‘gaten’. Dus de ruimte tussen
de buitenste polygoon en de binnenste polygonen blijft over als polygoon.

Onderdeel Toevoegen

Met onderdeel toevoegen kun je eiland polygonen toevoegen aan een bestaande polygoon. Het nieuwe eiland
polygoon moet buiten de grens van geselecteerde (multi-)polygoon liggen.

Ring Vullen

U kunt de functie Ring vullen gebruiken om een ring aan een polygoon toe te voegen en tegelijkertijd een nieuw

object aan de laag toe te voegen. U hoeft dus niet meer eerst het pictogram Ring toevoegen te gerbuiken en dan

de functie Onderdeel toevoegen.

Verwijder Ring

Met Ring Verwijderen kun je een binnenste polygoon ‘gat’ verwijderen binnen een bestaande polygoon. Deze
tool werkt alleen met polygoon lagen. Het zal ook niets veranderen wanneer deze wordt gebruikt voor een eiland
polygoon. Deze tool werkt voor polygoon en multi-polygoon objecten. Voordat je de hoekpunten van een ring
selecteert, wijzig de zoekradius voor hoekpuntaanpassingen.
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Verwijder Onderdeel

Met Verwijder Onderdeel kun je delen van een multi-geometrie object verwijderen. Je kunt met dit gereedschap
niet de laatst overblijvende polygoon verwijderen. Dit gereedschap werkt voor alle multi-geometrie objecten
voor punten, lijnen en polygonen. Voordat je de hoekpunten van een deel selecteert, wijzig de zoekradius voor
hoekpuntaanpassingen.

Object vervormen

Je kunt lijn- en polygoonobjecten vervormen gebruik makende van Objecten vervormen. Hiermee kun je een deel
van een lijn of polygoon vervangen door een nieuw lijnstuk van het eerste tot de laatste snijpunt met de oorspronke-
lijke lijn. Bij polygonen leidt dit soms tot ongewenste resultaten. Het is vooral handig om kleinere lijnstukken van
een polygoon aan te passen, en niet om grote wijzigingen uit te voeren. Het is ook niet toegestaan om meerdere
polygoonringen te doorsnijden aangezien dit een invalide polygoon oplevert.

Je kunt, bijvoorbeeld de grens van een polygoon bewerken met deze tool. Klik eerst aan de binnenkant van de
polygoon vlak bij het punt waar de nieuwe grens moet beginnen, steek daar de grens van de polygoon over en
begin dan met het tekenen van de nieuwe grens buiten de huidige grens van de polygoon. Eindig het toevoegen
van nieuwe grenspunten door het laatste punt aan de binnenkant van de huidige grens te plaatsen met de rechter-
muisknop. Op de snijpunten van de nieuwe met de oude grens zullen door deze functie automatisch nieuwe punten
worden toegevoegd. De polygoon kan ook kleiner worden gemaakt door buiten de huidige grens te beginnen en
binnen de huidige polygoongrens de nieuwe grens te tekenen en met de rechtermuisklik het tekenen te stoppen
buiten de huidige grens.

Notitie: De tool Objecten vervormen kan het startpunt van een polygoon of een gesloten lijn wijzigen. Dus het
punt dat twee keer voorkomt kan een ander punt zijn. Dit zal geen probleem zijn voor de meeste applicaties, maar
hier dient wel rekening mee worden gehouden.

Verspring Curve

The Offset Curve tool creates parallel shifts of line layers. The tool can be applied to the edited layer (the
geometries are modified) or also to background layers (in which case it creates copies of the lines / rings and adds
them to the the edited layer). It is thus ideally suited for the creation of distance line layers. The displacement is
shown at the bottom left of the taskbar. To create a shift of a line layer, you must first go into editing mode and

then select the feature. You can make the Offset Curve tool active and drag the cross to the desired distance. Your

changes may then be saved with the Save Layer Edits tool.

Kaartobjecten splitsen

Je kunt objecten opdelen gebruik maken van Kaartobjecten Splitsen. Je kunt een lijn tekenen over het kaartobject
die je wilt splitsen.

Delen splitsen

In QGIS 2.0 is het nu mogelijk om de delen van een meerdelige object te splitsen zodat het aantal delen wordt

vergroot. Teken een lijn over het deel dat u wilt splitsen met behulp van het pictogram Kaartobjectensplitsen.

Geselecteerde objecten samenvoegen

The Merge Selected Features tool allows you to merge features that have common boundaries and the same attributes.
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Samenvoegen attribuutwaarden van geselecteerde objecten

Met de functie Attributen van geselecteerde objecten samenvoegen is het samenvoegen van attributen van objecten mogelijk
van aangrenzende objecten zonder de grenzen samen te voegen. Men kan ook de attributen van meerdere gese-

lecteerde objecten samenvoegen. selecteer de knop Attributen van geselecteerde objecten samenvoegen. QGIS geeft nu de
keuze welke attribuutwaarden voor alle geselecteerde objecten zullen worden toegekend. Het resultaat is dat alle
objecten dezelfde attribuutwaarden zullen krijgen.

Puntsymbolen Roteren

De tool Puntsymbolen Roteren‘geeft de mogelijkheid om puntsymbolen in de kaart laten roteren. Daarvoor moet er voor het object een attribuutveld aanwezig zijn in de attributentabel waarmee je de rotatie kunt vastleggen en daarnaast moet aangegeven zijn dat dit veld gebruikt moet worden voor rotatie voor deze puntenlaag, via de :guilabel:‘Geavanceerd

in het tabblad Style van Laag Eigenschappen. Je moet ook ‘SVG marker’ openen en kiezen voor Data

gedefinieerde eigenschappen .... Activeer vervolgens het aanvinkvak Hoek en kies ‘rotation’ als veld. Zonder
deze instellingen zal deze tool niet geactiveerd zijn.

Figuur 12.36: Puntsymbolen Roteren

Om de rotatie van een puntobject te wijzigen, selecteer een puntobject in de kaart en roteer deze door de linkermuis
in houden. Een rode pijl met de rotatiewaarde zal getoond worden (zie Figure_edit_4). Wanneer je de linkermuis
loslaat, zal de rotatiewaarde worden bijgewerkt in de attributentabel.

Notitie: Wanneer de Ctrl toets wordt ingehouden, zal de rotatie worden uitgevoerd in stappen van 15 graden.

12.3.6 Het aanmaken van een nieuwe Vectorlagen

QGIS ondersteund het aanmaken van nieuwe Shapefile, nieuwe SpatiaLite vectorlagen en nieuwe GPX lagen.
Het aanmaken van nieuwe GRASS vectorlagen wordt ondersteund binnen de GRASS-plugin. Zie Maken van een
nieuwe GRASS vectorlaag voor meer informatie over het aanmaken van GRASS vectorlagen.

Het aanmaken van een nieuwe Shapefile laag

Om een nieuwe Shape vectorlaag te maken om te bewerken, kies Kaartlagen → Nieuw → Nieuw Shape
Laag.... De dialoog Nieuwe Vectorlaag zal worden getoond zoals in Figure_edit_5. Kies het type vectorlaag
(punt, lijn of polygoon) en de CRS (Coördinaten Referentie Systeem).

QGIS ondersteund nog niet het aanmaken van 2.5D objecten (bijvoorbeeld objecten met X,Y en Z coördinaten).

Voeg de gewenste attributen toe door te klikken op de knop [Toevoegen aan attributenlijst] en een naam en
type voor het attribuut te specificeren om het maken van een nieuwe laag voor een shapefile te voltooien, Een
eerste kolom ‘id’ wordt standaard toegevoegd maar kan worden verwijderd indien niet gewenst. Alleen attibuten
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Figuur 12.37: Dialoog aanmaken van een nieuwe Shapefile laag

Type: real , Type: integer , Type: string en Type:date worden ondersteund. Aanvullend
en overeenkomstig het type attribuut, kunt u ook de breedte en precisie van de nieuwe kolom voor het attribuut
definiëren. Als de attributen naar wens zijn, klik dan op [OK] en geef een naam op voor het shapefile. QGIS zal
automatisch de extensie .shp aan de naam die u specificeert toevoegen. Als de laag eenmaal is gemaakt zal die
worden toegevoegd aan de kaart en kunt u die op dezelfde manier bewerken als is beschreven in het gedeelte Het
digitaliseren van een bestaande kaartlaag hierboven.

Het aanmaken van een nieuwe Spatialite Laag

Voor het aanmaken van een nieuwe Spatialite laag, kies Kaartlagen → Nieuw → Nieuwe Spatialite Laag....
De dialoog Nieuw SpatiaLite Laag wordt geopend zoals getoond in Figure_edit_6.

De eerste stap is om een bestaande SpatiaLite database te selecteren of om een nieuwe SpatiaLite database aan te

maken. Dit kan gedaan worden met de browse functie aan de rechterkant van het veld database. Geef een
naam voor die nieuwe laag en het Coördinaten Referentie Systeem met [Geef het CRS]. Indien gewenst kun men

ook het aanvinkvak Maak een automatisch ophogen primair sleutelveld aan activeren.

Om de attribuutvelden voor de nieuwe SpatiaLite laag toe te voegen, geef de naam en de attribuuttype en klik op
de knop [Toevoegen aan attributenlijst]. Wanneer tevreden druk dan op [OK]. QGIS zal automatsche de nieuwe
laag toevoegen aan de kaart en je kunt deze bewerken op dezelfde manier als beschreven in Het digitaliseren van
een bestaande kaartlaag.

De DB Manager kan gebruikt worden voor overig beheer van SpatiaLite lagen, zie Plug-in DB Manager.

Het aanmaken van een nieuwe GPX laag

Om een nieuwe GPX bestand aan te maken laad eerst de GPS plugin. menuselection:Plugins –> Beheer en

Installeer Plugins... opent de dialoog Plugin Manager. Activeer het aanvinkvak GPS-gereedschap.
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Figuur 12.38: Dialoog aanmaken van een nieuwe Spatialite Laag
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Wanneer deze plugin is geladen kies Nieuw → Aanmaken nieuwe GPX Laag... in het menu Kaartlagen. In de
dialoog Nieuw GPX bestand opslaan als kun je kiezen waar de nieuwe GPX laag wordt opgeslagen.

12.3.7 Werken met de Attributen Tabel

De attributentabel toont de objecten van een geselecteerde laag. Elke regel in de tabel representeert één kaartobject
en elke kolom bevat een attribuutwaarde die een stukje informatie bevat over het object. Objecten in de tabel
kunnen worden opgezocht, geselecteerd, verplaatst en zelfs bewerkt.

Om de attributentabel voor een vector laag te openen, maak de laag actief door deze te selecteren in de legenda.
Open de attributentabel via het menu Kaartlagen → ‘|mActionOpenTable| :menuselection:‘Open Attributentabel.
Het is ook mogelijk om door met de rechtermuis op een laag in de legenda te klikken het snelmenu te openen en

hierin Open Attributentabel te kiezen. Je kunt deze ook ook openen met de knop mActionOpenTable| Open
Attributentabel in de werkbalk Attributen.

Dit zal een nieuw venster openen die de object attributen van de laag toont (figure_attributes_1). Het aantal
objecten en het aantal geselecteerde objecten wordt getoond in de titel van de attributentabel.

Figuur 12.39: Attributentabel voor de laag regions

Het selecteren van objecten in een attributentabel

Elke geselecteerde regel in de attributen tabel toont de attributen van een geselecteerd object in de laag. Wanneer
het aantal geselecteerde objecten in de kaart veranderd, zal dit direct worden bijgewerkt in de attributentabel. Ook
wanneer in de attributentabel de selectie wijzigt zal de selectie in de kaart worden bijgewerkt.

Regels kunnen worden geselecteerd door te klikken op het regelnummer aan de linkerkant. Meerdere rijen
kunnen worden geselecteerd met de ingehouden Ctrl toets. Een Opvolgende selectie kan worden gemaakt door
de Shift toets in te drukken en een regelnummer aan de linkerkant. Alle regels tussen de regel waarin zich de
cursor bevindt en de aangeklikte regel worden geselecteerd. Het veranderen van de cursor positie door in een
andere cel van de tabel te klikken, zal de selectie niet aanpassen. Het wijzigen van de selectie in het kaartbeeld,
zal niet de cursorpositie in de attributentabel wijzigen.

De tabel kan gesorteerd worden per kolom, door een kolomhoofd te selecteren. Een kleine pijl wijst de sorteer-
volgorde aan (een pijltje omhoog betekent, de waarden zijn oplopend gesorteerd van boven naar beneden, pijltje
omlaag betekent, de waarden zijn aflopend gesorteerd van boven naar beneden).

Voor een simpele zoekactie op attribuutwaarden op één kolom, selecteer de Kolomfilter → van het keuze-
menu linksonderin. Selecteer vervolgens het veld (kolom) waarin gezocht moet worden met de inhoud van het
veld zoek naar en selecteer de knop [Zoek]. Vervolgens worden alleen overeenkomende objecten getoond in de
attributentabel.
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U moet het pictogram Selecteer objecten m.b.v. reguliere expressie boven in de attributentabel gebruiken om een selectie

te maken. Selecteer objecten m.b.v. reguliere expressie stelt u in staat een subset van een tabel te definiëren met behulp

van een Functielijst zoals in Veldberekening (bekijk Veld berekening). Het resultaat van de query kan dan worden
opgeslagen als een nieuwe vectorlaag. Als u bijvoorbeeld regio’s wilt vinden die gemeenten zijn in het bestand
regions.shp van de voorbeeldgegevens van QGIS, moet u het menu Velden en waarden openen en het veld
kiezen dat u wilt bevragen. Dubbelklik op het veld ‘TYPE_2’ en ook op [All unieke waarden laden] . Kies, uit
de lijst, en dubbelklik op ‘Borough’. In het veld Expressie verschijnt de volgende query:

"TYPE_2" = ’Borough’

Hier kunt u ook gebruiken Functielijst → Recent (Selectie) om een selectie te maken die u eerder hebt gebruikt.
De expressiebouwer onthoudt de laaste 20 gebruikte expressies.

De overeenkomstige rijen worden geselecteerd en het aantal zal weergegeven worden in de titel van de attribu-
tentabel en in de statusbalk van het hoofdscherm. Voor zoekopdrachten die alleen geselecteerde objecten op de
kaart toont, gebruik de Zoekopdrachtbouwer die beschreven is in Querybouwer.

Om alleen geselecteerde regels te tonen, selecteer Toon Geselecteerde Objecten in het menu linksonder.

De overige knoppen bovenin het menu van de attributentabel biedt de volgende functionaliteit:

• Bewerken aan/uitzetten om een veldwaarde te bewerken en ook de functies te activeren die hieronder
beschreven wordt (ook met Ctrl+E)

• Wijzigingen opslaan (ook met Ctrl+S)

• Deselecteer alles (ook met Ctrl+U)

• Verplaats selectie naar boven (ook met Ctrl+T)

• Selectie omdraaien (ook met Ctrl+R)

• Kopieer geselecteerde rijen naar klembord (ook met Ctrl+C)

• Zoom kaart naar de geselecteerde rijen (ook met Ctrl+J)

• Verschuif de kaart naar de geselecteerde rijen (ook met Ctrl+P)

• Geselecteerde objecten verwijderen (ook met Ctrl+D)

• Nieuwe kolom voor PostGIS lagen en voor OGR lagen (ook met Ctrl+W)

• Verwijder kolom voor PostGIS lagen en voor OGR lagen geopende met GDAL driver versie >= 1.9 (ook
met Ctrl+L)

• Open veldberekening (ook met Ctrl+I)

Tip: Overslaan WKT geometry

Wanneer je attribuutgegevens in externe programma’s wilt gebruiken (zoals excel) gebruik de knop
Kopieer geselecteerde rijen naar klembord. De gegevens kunnen gekopieerd worden zonder geometrie informatie wanneer

in Extra → Opties → tabblad Databronnen het aanvinkvak Kopieer geometrie in WKT representatie van at-
tributentabel is gedeactiveerd.
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Opslaan van geselecteerde objecten als nieuwe laag

The selected features can be saved as any OGR-supported vector format and also transformed into another coor-
dinate reference system (CRS). Just open the right mouse menu of the layer and click on Save selection as → to
define the name of the output file, its format and CRS (see section Legenda). It is also possible to specify OGR
creation options within the dialog.

Plakken in een nieuwe kaartlaag

Objecten die op het klembord staan kunnen worden geplakt in een nieuwe laag. maak de laag eerst bewerkbaar
om dit te kunnen doen. Selecteer enkele objecten, kopieer ze naar het klembord, en plak ze dan in de nieuwe laag
met behulp van Bewerken → Objecten plakken en kies Nieuwe vectorlaag of Nieuwe geheugenlaag.

Dit is van toepassing op geselecteerde en gekopieerde objecten binnen QGIS en ook voor objecten uit andere
bronnen die zijn gedefinieerd met behulp van bekende tekst (WKT).

Werken met niet spatiale tabellen

QGIS staat ook toe om niet spatiale tabellen te openen. Dit betreffen door OGR ondersteunde tabellen,
tekengescheiden tekst en de PostgreSQL, MSSQL en Oracle databasetabellen. De tabellen kunnen worden ge-
bruikt voor mogelijke veldwaarden of alleen voor het bekijken en bewerken gebruik makende van de tabellen-
weergave. Wanneer de tabel wordt geladen kun je dit zien in de legenda. Wanneer deze tabel wordt geopend met

de Open Attributentabel kan deze bewerkt worden als elke ander laag in de attributentabel.

Als een voorbeeld kun je kolommen van een niet spatiale tabel gebruiken om tijdens het digitaliseren de in te
geven waarde voor een veld te beperken tot een set mogelijke attribuutwaarden of een waardenbereik. Voor meer
informatie zie ook Menu velden.

12.3.8 Een tot veel-relaties maken

Relaties zijn een techniek die veel gebruikt wordt in databases. Het concept is, dat objecten (rijen) van verschil-
lende lagen (tabellen) aan elkaar kunnen behoren.

Als voorbeeld heeft u een laag met alle regio’s van Alaska (polygoon) die verschillende attributen verschaft over
de naam ervan en het regiotype en een unieke id (die dient als primaire sleutel).

Secundaire sleutels

Dan krijgt u een andere laag met punten of tabel met informatie over vliegvelden die in de regio’s liggen en u wilt
ook deze bijhouden. Als u ze wilt toevoegen aan de laag van de regio’s, dient u een één tot veel-relatie te maken
met behulp van secundaire sleutels, omdat er meerdere vliegvelden in de meeste regio’s liggen.

Maak in aanvulling op de reeds bestaande attributen in de attributentabel van de vliegvelden een ander veld
fk_region dat optreedt als een secundaire sleutel (als u een database heeft, wilt u er waarschijnlijk een voorwaarde
aan verbinden).

Dit veld fk_region zal altijd een id van een regio bevatten. Het kan worden gezien als een verwijzing naar de regio
waartoe het behoort. En u kunt een aangepaste vorm voor het bewerken ontwerpen en QGIS zorgt dan voor de
instellingen. Het werkt voor verschillende providers (dus u kunt het ook gebruiken met shape- en csvbestanden)
en alles wat u hoeft te doen is QGIS de relaties tussen uw tabellen te vertellen.

Lagen

QGIS maakt geen verschil tussen een tabel en een vectorlaag. In feite is een vectorlaag een tabel met een geome-
trie. Dus kunt u uw laag tabel als een vectorlaag toevoegen. U kunt, om het te demonstreren, het shapefile ‘region’
laden (met geometrieën) en de csv-tabel ‘airport’ (zonder geometrieën) en een secundaire sleutel (fk_region) aan
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Figuur 12.40: Regio Alaska met vliegvelden

de laag region. Dit betekent dat elk vliegveld tot precies één regio behoort terwijl elke regio een onbepaald aantal
vliegvelden kan hebben (een typische een tot veel-relatie).

Definitie (Relatiebeheer)

Het eerste dat gaan we doen is om QGIS in kennis te stellen van de relaties tussen de lagen. Dit wordt gedaan in
Project → Projectinstellingen. Open het menu Relaties en klik op Relatie toevoegen.

• Naam zal worden gebruikt als de titel. Het zou een door mensen te lezen tekenreeks moeten zijn, die
beschrijft waar de relatie voor wordt gebruikt. We zullen het in dit geval eenvoudigweg “Vliegvelden”
noemen.

• Referentielaag (Child) is die met het veld voor de secundaire sleutel erin. In ons geval is dat de laag
airports

• Referentieveld wil zeggen welk veld naar de andere laag verwijst dus dat is in dit geval fk_region

• Referentielaag (Parent) is die waarnaar de primaire sleutel verwijst, dus hier is het de laag regions

• Referentieveld is de primaire sleutel van de laag waarnaar verwezen wordt, dus dit is ID

• id zal worden gebruikt voor interne doeleinden en moet uniek zijn. U zou mogelijk een aangepaste formulier
willen maken als het eenmaal ondersteund wordt. Als u het leeg laat zal er een voor u worden gegenereerd
maar u kunt er zelf een toewijzen als dat voor u eenvoudiger is.

Formulieren

Nu QGIS van de relatie weet zal het worden gebruikt om de formulieren te verbeteren die het genereert. Als we
de standaardmethode voor het formulier niet wijzigden (autogenerated) zal het eenvoudigweg een nieuw widget
in ons formulier maken. Dus laten we de laag regions selecteren in de legenda en het gereedschap Identificeren
gebruiken. Afhankelijk van uw instellingen zou het formulier direct kunnen openen of u moet het kiezen om het
openen in het dialoogvenster Identificatieresultaten onder Acties.

Zoals u kunt zien worden de vliegvelden die tot deze bepaalde regio zijn toegewezen weergegeven in een tabel.
En er zijn ook enkele knoppen beschikbaar. Laten we die even kort bekijken

• De knop is voor het aan of uitzetten van het bewerken. Onthoud dat het de modus Bewerken voor de
laag airports schakelt, hoewel we in het objectformulier van een object uit de laag regions staan. maar de
tabel geeft objecten weer uit de laag airports.
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Figuur 12.41: Relatiebeheer

Figuur 12.42: Dialoogvenster Identificatieresultaten regions met relatie naar vliegvelden
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• De knop zal een nieuw object aan de laag airports toevoegen. En het zal standaard het nieuwe vliegveld
toevoegen aan de huidige regio.

• De knop zal het geselecteerde vliegveld permanent verwijderen.

• Het symbool zal een nieuw dialoogvenster openen waar u een bestaand vliegveld kunt selecteren dta
dan zal worden toegvoegd aan de huidige regio. Dit kan handig zijn als u per ongeluk eerder het vliegveld
in de verkeerde regio maakte.

• Het symbool zal het geselecteerde vliegveld loskoppelen van de huidige regio en het daarnna als niet-
toegewezen beschouwen (de secundaire sleutel wordt op NULL gezet).

• De twee knoppen aan de rechterkant schakelen tussen de tabelweergave en de formulierweergave waarbij
de laatste u de vliegvelden laat zien in hun respectievelijke formulier.

Als u werkt aan de tabel airports, wordt een nieuw type widget beschikbaar dat u het objectfomulier van de regio
waarnaar verwezen wordt laat inbedden in het objectformulier van de vliegvelden. Het kan worden gebruikt als u
de laageigenschappen van de tabel airports opent, schakelt naar het menu Velden en het type widget van het veld
van de secundaire sleutel ‘fk_region’ wijzigt naar Relatie referentie.

Als u nu kijkt naar het dialoogvenster van het object, zult u zien dat het formulier van regio nu is ingebed in het
formulier van de vliegvelden en zelfs een combinatievak zal hebben, wat u in staat stelt het huidige vliegveld aan
een andere regio toe te wijzen.

Figuur 12.43: Dialoogvenster Identificatieresultaten airports met relatie naar regio’s

.

12.4 Querybouwer

De zoekopdrachtbouwer geeft de mogelijkheid om van een tabel een subset te maken gebruik makende van een
soort SQL WHERE opdracht waarbij het resultaat wordt getoond in het hoofdscherm. Het resultaat van de zoekop-
dracht, kan opgeslagen worden als een nieuwe vectorlaag.

12.4.1 Zoekopdracht

Open de Querybouwer door de Laag eigenschappen te openen en daarin te gaan naar het menu Algemeen. Klik,
onder guilabel:Subset objecten, op de knop [Querybouwer] om de Querybouwer te openen. Als u bijvoorbeeld
een laag regions, heeft met een veld TYPE_2‘, zou u alleen regio’s kunnen selecteren
die in veld ‘‘TYPE_2 borough bevatten in het tekst invoervak Provider specifieke filter-expressie van
de Querybouwer. Figure_attributes_2 toont een voorbeeld van de querybouwer met gegevens geladen van de
regions.shp van de QGIS voorbeeld gegevensset. De gedeelten Velden, Waarden en Operatoren helpen de
gebruiker met het opbouwen van een SQL-achtige zoekopdracht.
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Figuur 12.44: Zoekopdrachtbouwer

Velden bevat een lijst van alle attribuutvelden van de vectorlaag uit de attributentabel waarmee gezocht kan wor-
den. Om een attributenveld toe te voegen aan de SQL where tekstinvoer gedeelte, dubbelklik op de naam in de
lijst van veldnamen. Je kunt normaal gesproken verschillende velden, waarden en operators gebruiken om een
zoekopdracht op te bouwen maar je kunt deze ook rechtsstreeks in het SQL where tekstinvoer gedeelte intypen.

Waarden geeft een lijst van de waarden van een attributentabel. Om een lijst te verkrijgen van alle mogelijke
waarden van een attribuut, selecteer eerst het attribuut in de lijst Velden en druk vervolgens op de knop [Alles].
Om een lijst op te bouwen met de 25 eerste unieke waarden van een attribuutveld, selecteer eerst het atribuut in
de lijst Velden en druk vervolgens op de knop [Voorbeeld]. Om een waarde toe te voegen aan het SQL where
tekstinvoer gedeelte, dubbelklik op de waarde in de lijst van waarden.

Operatoren bevat alle operatoren die gebruikt kunnen worden. Om een operator toe te voegen aan het SQL
WHERE tekstinvoer gedeelte druk op de bijbehorende knop. Beschikbaar zijn relationele operatoren ( = , > , ...),
de tekstvergelijkingsoperator (LIKE) en logische operatoren (AND, OR, ...).

De knop [Test] toont een melding met het aantal objecten die het resultaat zullen zijn van gegeven zoekopdracht,
wat erg handig is tijdens het proces van het opbouwen van een zoekopdracht. De knop [Leegmaken] zal de inhoud
van het SQL WHERE invoertekst gedeelte leegmaken. Met de knop [OK] worden de objecten die voldoen aan de
zoekopdracht geselecteerd en het venster gesloten. De knop [Cancel] sluit het venster zonder de huidige selectie
te veranderen.

12.4.2 Save selected features as new layer

The selected features can be saved as any OGR-supported vector format and also transformed into another coor-
dinate reference system (CRS). Just open the right mouse menu of the layer and click on Save selection as → to
define the name of the output file, its format and CRS (see section Legenda). It is also possible to specify OGR
creation options within the dialog.

.
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12.5 Veld berekening

The Field Calculator button in the attribute table allows you to perform calculations on the basis of existing
attribute values or defined functions, for instance, to calculate length or area of geometry features. The results can
be written to a new attribute column, or they can be used to update values in an existing column.

You will need to bring the vector layer into editing mode, before you can click on the field calculator icon to open
the dialog (see figure_attributes_3). In the dialog, you first must select whether you want to only update selected
features, create a new attribute field where the results of the calculation will be added or update an existing field.

Figuur 12.45: Veld berekening

Wanneer je ervoor kiest een nieuw veld toe te voegen, dient een veldnaam, een veldtype (geheel getal, decimaal
getal of tekst), de totale veldlengte en de precisie te worden gegeven (zie figure_attributes_3). Wanneer je bijvoor-
beeld voor een veldlengte van 10 en een precisie van 3 kiest betekent dit dat je 6 tekens voor de punt, daarna de
punt en daarachter nog 3 tekens voor de precisie.

The Function List contains functions as well as fields and values. View the help function in the Selected Func-
tion Help. In Expression you see the calculation expressions you create with the Function List. For the most
commonly used operators, see Operators.

In the Function List, click on Fields and Values to view all attributes of the attribute table to be searched. To add
an attribute to the Field calculator Expression field, double click its name in the Fields and Values list. Generally,
you can use the various fields, values and functions to construct the calculation expression, or you can just type it
into the box. To display the values of a field, you just right click on the appropriate field. You can choose between
Load top 10 unique values and Load all unique values. On the right side, the Field Values list opens with the
unique values. To add a value to the Field calculator Expression box, double click its name in the Field Values
list.

The Operators, Math, Conversions, String, Geometry and Record groups provide several functions. In Operators,
you find mathematical operators. Look in Math for mathematical functions. The Conversions group contains
functions that convert one data type to another. The String group provides functions for data strings. In the
Geometry group, you find functions for geometry objects. With Record group functions, you can add a numeration
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to your data set. To add a function to the Field calculator Expression box, click on the > and then double click the
function.

Een kort voorbeeld illustreert het gebruik van veld berekening. We zullen de lengte van de laag railroads van
de voorbeeld dataset van QGIS berekenen in km:

1. Laad de shapefile railroads.shp in QGIS en selecteer Open Attribuut Tabel.

2. Klik op Bewerken aan/uitzetten en open de dialoog Veld berekening met Veld berekening.

3. Selecteer het aanvinkvak Nieuw veld aanmaken om berekeningen op te slaan in het nieuwe veld.

4. Voeg lengte toe als resultaatveld, selecteer Decimaal getal (real) als veldtype en geef een
veldlengte op van 10 en een precisie van 3.

5. Klik nu op de functie $length in de Geometry groep om deze toe te voegen als $length in de veld
berekenings expressie tekstinvoer gedeelte.

6. Maak de expressie compleet door “/1000” in te typen in het veld berekenings expressie tekstinvoer gedeelte
en druk op [OK].

7. You can now find a new column length in the attribute table.

The available functions are listed below.

The field calculator Function list with the Selected Function Help , Operators and Expression menu are also
available through the rule-based rendering in the Style menu of the Layer properties, and the expression-based

labeling in the Labeling core application.

Operators

This group contains operators (e.g., +, -, *).

a + b a plus b
a - b a minus b
a * b a multiplied by b
a / b a divided by b
a % b a modulo b (for example, 7 % 2 = 1, or 2 fits into 7 three times with remainder 1)
a ^ b a power b (for example, 2^2=4 or 2^3=8)
a = b a and b are equal
a > b a is larger than b
a < b a is smaller than b
a <> b a and b are not equal
a != b a and b are not equal
a <= b a is less than or equal to b
a >= b a is larger than or equal to b
a ~ b a matches the regular expression b
+ a positive sign
- a negative value of a
|| joins two values together into a string ’Hello’ || ’ world’
LIKE returns 1 if the string matches the supplied pattern
ILIKE returns 1 if the string matches case-insensitive the supplied

pattern (ILIKE can be used instead of LIKE to make the match case-insensitive)
IS returns 1 if a is the same as b
OR returns 1 when condition a or b is true
AND returns 1 when condition a and b are true
NOT returns 1 if a is not the same as b
column name "column name" value of the field column name
’string’ a string value
NULL null value
a IS NULL a has no value
a IS NOT NULL a has a value
a IN (value[,value]) a is below the values listed
a NOT IN (value[,value]) a is not below the values listed
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Conditionals

This group contains functions to handle conditional checks in expressions.

CASE evaluates multiple expressions and returns a result
CASE ELSE evaluates multiple expressions and returns a result
coalesce returns the first non-NULL value from the expression list
regexp_match returns true if any part of a string matches

the supplied regular expression

Mathematical Functions

This group contains math functions (e.g., square root, sin and cos).

sqrt(a) square root of a
abs returns the absolute value of a number
sin(a) sine of a
cos(a) cosine of a
tan(a) tangent of a
asin(a) arcsin of a
acos(a) arccos of a
atan(a) arctan of a
atan2(y,x) arctan of y/x using the signs of the two arguments

to determine the quadrant of the result
exp exponential of a value
ln value of the natural logarithm of the passed expression
log10 value of the base 10 logarithm of the passed expression
log value of the logarithm of the passed value and base
round round to number of decimal places
rand random integer within the range specified by the minimum

and maximum argument (inclusive)
randf random float within the range specified by the minimum

and maximum argument (inclusive)
max largest value in a set of values
min smallest value in a set of values
clamp restricts an input value to a specified range
scale_linear transforms a given value from an input domain to an output

range using linear interpolation
scale_exp transforms a given value from an input domain to an output

range using an exponential curve
floor rounds a number downwards
ceil rounds a number upwards
$pi pi as value for calculations

Conversions

This group contains functions to convert one data type to another (e.g., string to integer, integer to string).

toint converts a string to integer number
toreal converts a string to real number
tostring converts number to string
todatetime converts a string into Qt data time type
todate converts a string into Qt data type
totime converts a string into Qt time type
tointerval converts a string to an interval type (can be used to take days,

hours, months, etc. off a date)

Date and Time Functions

This group contains functions for handling date and time data.

$now current date and time
age difference between two dates
year extract the year part from a date, or the number of years from an interval
month extract the month part from a date, or the number of months from an interval
week extract the week number from a date, or the number of weeks from an interval
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day extract the day from a date, or the number of days from an interval
hour extract the hour from a datetime or time, or the number

of hours from an interval
minute extract the minute from a datetime or time, or the number

of minutes from an interval
second extract the second from a datetime or time, or the number

of minutes from an interval

String Functions

This group contains functions that operate on strings (e.g., that replace, convert to upper case).

lower convert string a to lower case
upper convert string a to upper case
title converts all words of a string to title case (all words lower case

with leading capital letter)
trim removes all leading and trailing white space (spaces, tabs, etc.) from a string
length length of string a
replace returns a string with the supplied string replaced
regexp_replace(a,this,that) returns a string with the supplied regular expression replaced
regexp_substr returns the portion of a string which matches a supplied regular expression
substr(*a*,from,len) returns a part of a string
concat concatenates several strings to one
strpos returns the index of a regular expression in a string
left returns a substring that contains the n leftmost characters of the string
right returns a substring that contains the n rightmost characters of the string
rpad returns a string with supplied width padded using the fill character
lpad returns a string with supplied width padded using the fill character
format formats a string using supplied arguments
format_number returns a number formatted with the locale separator for thousands

(also truncates the number to the number of supplied places)
format_date formats a date type or string into a custom string format

Color Functions

This group contains functions for manipulating colors.

color_rgb returns a string representation of a color based on its red, green,
and blue components

color_rgba returns a string representation of a color based on its red, green,
blue, and alpha (transparency) components

ramp_color returns a string representing a color from a color ramp
color_hsl returns a string representation of a color based on its hue,

saturation, and lightness attributes
color_hsla returns a string representation of a color based on its hue, saturation,

lightness and alpha (transparency) attributes
color_hsv returns a string representation of a color based on its hue,

saturation, and value attributes
color_hsva returns a string representation of a color based on its hue, saturation,

value and alpha (transparency) attributes
color_cmyk returns a string representation of a color based on its cyan, magenta,

yellow and black components
color_cmyka returns a string representation of a color based on its cyan, magenta,

yellow, black and alpha (transparency) components

Geometry Functions

This group contains functions that operate on geometry objects (e.g., length, area).

xat retrieves an x coordinate of the current feature
yat retrieves a y coordinate of the current feature
$area returns the area size of the current feature
$length returns the length size of the current feature
$perimeter returns the perimeter length of the current feature
$x returns the x coordinate of the current feature
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$y returns the y coordinate of the current feature
$geometry returns the geometry of the current feature (can be used

for processing with other functions)
geomFromWKT returns a geometry created from a well-known text (WKT) representation
geomFromGML returns a geometry from a GML representation of geometry
bbox
disjoint returns 1 if the geometries do not share any space together
intersects returns 1 if the geometries spatially intersect

(share any portion of space) and 0 if they don’t
touches returns 1 if the geometries have at least one point in common,

but their interiors do not intersect
crosses returns 1 if the supplied geometries have some, but not all,

interior points in common
contains returns true if and only if no points of b lie in the exterior of a,

and at least one point of the interior of b lies in the interior of a
overlaps returns 1 if the geometries share space, are of the same dimension,

but are not completely contained by each other
within returns 1 if geometry a is completely inside geometry b
buffer returns a geometry that represents all points whose distance

from this geometry is less than or equal to distance
centroid returns the geometric center of a geometry
convexHull returns the convex hull of a geometry (this represents the

minimum convex geometry that encloses all geometries within the set)
difference returns a geometry that represents that part of geometry a that

does not intersect with geometry b
distance returns the minimum distance (based on spatial ref) between

two geometries in projected units
intersection returns a geometry that represents the shared portion

of geometry a and geometry b
symDifference returns a geometry that represents the portions of a and b

that do not intersect
combine returns the combination of geometry a and geometry b
union returns a geometry that represents the point set union of the geometries
geomToWKT returns the well-known text (WKT) representation of the

geometry without SRID metadata

Record Functions

This group contains functions that operate on record identifiers.

$rownum returns the number of the current row
$id returns the feature id of the current row
$scale returns the current scale of the map canvas

Fields and Values

Contains a list of fields from the layer. Sample values can also be accessed via right-click.

Select the field name from the list, then right-click to access a context menu with options to load sample values
from the selected field.

.
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Werken met Raster data

.

13.1 Werken met Raster Data

Dit hoofdstuk beschrijft hoe je raster kaartlagen kunt visualiseren en de eigenschappen ervan kunt veranderen.
QGIS gebruikt de GDAL functiebibliotheek om raster data te lezen en weg te schrijven,zoals Arc/Info Binary
Grid, Arc/Info ASCII Grid, GeoTIFF, ERDAS IMAGINE en vele andere. GRASS raster ondersteuning wordt
geleverd door een standaard QGIS data provider plugin. De raster data kunnen ook als ‘alleen lezen’ in QGIS
worden geladen vanuit zip en gzip archiefbestanden.

Op het moment van schrijven worden meer dan 100 raster formaten ondersteund door de GDAL bibliotheek
(zie GDAL-SOFTWARE-SUITE Verwijzingen naar literatuur en web). Een volledige lijst is beschikbaar op
http://www.gdal.org/formats_list.html.

Notitie: NB Niet alle formaten uit de lijst werken ook gegarandeerd in QGIS, om verschillende redenen. Som-
mige formaten vereisen bijvoorbeeld externe commerciële bibliotheken; het kan ook zijn dat of de GDAL instal-
latie van het besturingssysteem het formaat dat je wil gebruiken niet ondersteunt. Alleen de uitgebreid geteste
formaten verschijnen in de lijst met bestandsformaten wanneer je een raster in QGIS wil laden. Andere, niet
geteste rasterformaten kunnen worden geladen met het [GDAL] Alle bestanden(*) filter.

Werken met GRASS raster data wordt beschreven in hoofdstuk Integratie van GRASS GIS.

13.1.1 Wat zijn raster data?

Raster data in GIS bestaan uit cellen die gerangschikt zijn in rijen en kolommen en die objecten op, boven of
onder het aardoppervlak representeren. Alle cellen in het raster hebben dezelfde grootte en de cellen zijn meestal
rechthoekig (in QGIS zijn ze altijd rechthoekig). Typische voorbeelden van raster datasets zijn Remote Sensing
data zoals luchtfoto’s, satellietbeelden en gemodelleerde gegevens zoals een hoogtemodel.

Anders dan bij vector data is een cel in een rasterbestand niet gekoppeld aan een achterliggende tabel met at-
tributen. De geografie van een raster dataset wordt vastgelegd door een pixel resolutie en de X en Y coördinaat
van één van de hoekpunten van de kaartlaag.Deze eigenschappen zorgen ervoor dat QGIS het raster correct op de
kaart kan positioneren.

Om de rasterdata correct af te beelden maakt QGIS gebruik van georeferentie informatie in het rasterbestand zelf
(bijvoorbeeld GeoTiff) of in een bijbehorende ‘world file’.
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13.1.2 Raster data laden in QGIS

Raster kaartlagen worden aan de kaart toegevoegd met de Rasterlaag Toevoegen knop of via het menu Kaartlagen

→ Rasterlaag toevoegen. Door ingedrukt houden van de Ctrl of Shift toets en aanklikken van meerdere
bestanden in het dialoogscherm Open een GDAL ondersteunde Raster Databron kunnen meerdere kaartlagen
tegelijk worden toegevoegd.

Als een raster kaartlaag in de kaart is geladen kun je rechts klikken op de laagnaam het dialoogscherm met
laageigenschappen opvragen, of een kaartlaag-specifieke actie uitvoeren (bijvoorbeeld: naar de kaartlaag zoomen,
verwijderen of hernoemen).

Rechter muisknop menu voor raster kaartlagen

• Zoom naar laagextent

• Zoom naar beste schaal (100%)

• Uitrekken naar huidige extent

• Toon in Overzichtskaart

• Verwijder

• Dupliceer

• Instellen laag- CRS

• Project CRS van laag overnemen

• Opslaan als ...

• Eigenschappen

• Hernoem

• Kopiëer Stijl

• Nieuwe Groep toevoegen

• Alles uitklappen

• Alles inklappen

• Vernieuw volgorde tekenen

.

13.2 Raster Eigenschappen Dialoog

Om de eigenschappen van een rasterlaag te bekijken en in te stellen, dubbelklik op de naam van een rasterlaag in
de legenda of selecteer de laag en gebruik de rechtermuisknop en kies Eigenschappen van het snelmenu. Dit zal
de dialoog Laag Eigenschappen voor de rasterlaag openen (zie figure_raster_1).

De dialoog bevat verschillende tabbladen:

• Algemeen

• Stijl

• Transparantie

• Pyramiden

• Histogram

• Metadata
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Figuur 13.1: Raster Eigenschappen Dialoog

13.2.1 Tabblad Algemeen

Laag Info

Het menu Algemeen geeft basisinformatie weer over het geselecteerde raster, inclusief het pad van de bron van de
laag, de weergegeven naam in de legenda (die kan worden aangepast), en het aantal kolommen, rijen en ‘Geen-
data’-waarden van het raster.

Coördinaten referentie systeem

Ook het Coordinaten Referentie Systeem (CRS) wordt hier weergegeven als een PROJ.4-tekst. Deze kan worden
aangepast via de knop [Opgeven...].

Schaalafhankelijke zichtbaarheid

Daarnaast kunnen schaalafhankelijke zichtbaarheden worden ingesteld in dit tabblad. Vink daarvoor het aan-
vinkvak schaalafhankelijke zichtbaarheid aan en stel het bereik van de schalen waarvoor de data getoond moet
worden op de kaart.

Onderin kun je een ‘thumbnail’, een kleine afbeelding van de laag zien, het gebruikte legenda symbool en het
kleurenpalet.
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13.2.2 Tabblad Stijl

Enkelbands Renderen

QGIS biedt vier verschillende Typen Rendering. De renderer die wordt gekozen is afhankelijk van het datatype.

1. Multiband kleur - als het bestand een multiband is met verschillende banden (bijv., gebruikt in een satelliet-
foto met verschillende banden)

2. Palet - als een enkel bandbestand een geïndexeerd palet heeft (bijv., gebruikt in een digitale topografische
kaart)

3. Enkelbands grijs - (één band van) de afbeelding zal worden gerenderd als grijs; QGIS zal deze renderer
kiezen als het bestand noch multibanden noch een geïndexeerd palet noch een doorlopend palet heeft (bijv.,
gebruikt in een geschaduwd reliëfkaart)

4. Enkelbands pseudokleur - deze renderer is mogelijk voor bestanden met een doorlopend palet, of
kleurenkaart (bijv., gebruikt in een hoogtekaart)

Multibands kleur

Met de multibands kleur renderer zullen drie banden van het image worden gebruikt om te renderen, waarbij
elke band staat voor de rode, groene of blauwe component die worden gebruikt om een kleurenafbeelding op te
bouwen. Je kunt kiezen tussen verschillende Contrast verbeterings methoden: ‘Geen verbetering’, ‘Stretch to
MinMax’, ‘Stretch and clip to MinMax’ en ‘Clip to min max’.

Figuur 13.2: Raster Renderer - Multibands kleur

Deze selectie beidt u een breed scala aan opties om het uiterlijk van uw rasterlaag aan te passen. Als eerste dient
u u het gegevensbereik uit uw afbeelding te halen. Dit kan worden gedaan door Extent te kiezen en te klikken op
[Laden]. QGIS kan Schatten(sneller) de Min en Max waarden van de banden of Actueel (langzamer) in
Nauwkeurigheid gebruiken.

Nu kunt u de kleuren schalen met behulp van het gedeelte Min/max waarden laden. Veel afbeeldingen hebben
zeer lage en hoge gegevens. Deze uitschieters kunnen worden geëlimineerd met behulp van de instelling Cu-
mulatieve telling deel. Het standaard gegevensbereik is ingesteld van 2% tot en met 98% van de gegevenswaarden
en kan handmatig worden aangepast. Met deze instelling kan het grijze karakter van de afbeelding verdwijnen.
met de optie voor schaling Min/max, maakt QGIS een kleurentabel met alle gegevens die zijn opgenomen in
de originele afbeelding (bijv., QGIS maakt een kleurentabel met 256 waarden, gegeven het feit dat u 8-bit banden
heeft). U kunt ook u kleurentabel berekenen met behulp van de Gemiddelde +/- standaard afwijking x .
Dan komen alleen de waarden die vallen binnen de standaard afwijking of binnen meerdere standaard afwijkingen
in aanmerking voor de kleurentabel. Dit is handig als u één of twee cellen heeft met abnormaal hoge waarden in
raster heeft die een negatieve invloed hebben op het renderen van het raster.
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Alle berekeningen kunnen ook worden gedaan voor de Huidige extent.

Tip: Het tonen van een enkelbands of meerbands Raster
Wanneer je een enkele band raster wilt tonen (bijvoorbeeld de Rode) van een multibands afbeelding, zou je denken
dat je de Groene en Blauwe band uitschakeld. Maar dit is niet de goede manier. Om de Rode band te tonen, zet
het imagetype naar grijstinten en selecteer Rood als de te gebruiken band voor Grijstinten.

Paletted

Dit is de standaard renderoptie voor enkelbands bestanden waarin al een kleurentabel is opgenomen, waarbij
elk pixelwaarde wordt toegewezen aan een bepaalde kleur. In dat geval wordt het palet automatisch gerenderd.
Als u de aan bepaalde waarden toegekende kleuren wilt wijzigen, klik dan eenvoudigweg op de kleur en het
dialoogvenster Selecteer kleur verschijnt. ook is het in QGIS 2.2.nu mogelijk een label toe te wijzen aan de
kleurwaarden. Het label verschijnt dan in de legenda van de rasterlaag.

Figuur 13.3: Raster Renderer - Paletted

Contrastverhoging

Notitie: Wanneer een GRASS raster wordt toegevoegd, zal de optie Contrastverbetering altijd op automatisch
gezet worden op stretch to min max ook al is er gekozen onder QGIS algemene instellingen gekozen voor een
andere waarde.

Enkelbands grijs

Deze renderer stelt u in staat een enkelbandslaag te renderen met een Kleurovergang: ‘Zwart naar wit’ of ‘Wit
naar zwart’. U kunt een Min en een Max-waarde definiëren door eerst Extent te kiezen en dan te klikken op
[Laden]. QGIS kan Schatten (sneller) de Min en Max-waarden van de banden of Actueel (langzamer) in
Nauwjeurigheid gebruiken.

Met het gedeelte Min/max waarden laden is schalen van de kleurentabel mogelijk. Uitschieters kunnen worden
geëlimineerd met behulp van de instelling Cumulatieve telling deel. Het standaard gegevensbereik is ingesteld
van 2% tot en met 98% van de gegevenswaarden en kan handmatig worden aangepast. Met deze instelling kan
het grijze karakter van de afbeelding verdwijnen. Verdere instellingen kunnen worden gemaakt met Min/max
en Gemiddelde +/- standaard afwijking x . Waar de eerste een kleurentabel maakt met alle gegevens
die zijn opgenomen in de originele afbeelding, maakt de tweede een kleurentabel die alleen waarden verwerkt die
vallen binnen de standaard afwijking of binnen meerdere standaard afwijkingen. Dit is handig als u één of twee
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Figuur 13.4: Raster Renderer - Enkelbands grijs

cellen heeft met abnormaal hoge waarden in raster heeft die een negatieve invloed hebben op het renderen van het
raster.

Enkelbands pseudokleur

Dit is een renderoptie voor enkelbands-bestanden, inclusief een doorlopend palet. U kunt hier ook individuele
kleurenkaarten maken voor de enkele banden. Er zijn drie manieren van kleurinterpolatie beschikbaar:

1. Discreet

2. Lineair

3. Exact

In het linker blok voegt de knop Handmatig waarden toevoegen een waarde toe aan de individuele kleurentabel.

De knop Geselecteerde regel verwijderen verwijdert een waarde uit de individuele kleurentabel en de knop
Sorteer onderdelen kleurenkaart sorteert de kleurentabel op basis van de pixelwaarde in de kolom Waarde. Door te
dubbelklikken op de kolom Waarde kunt u ook een specifieke waarde toevoegen. Door te dubbelklikken op
de kolom Kleur opent het dialoogvenster Change Color waarin u een kleur kunt kiezen die van toepassing is
op de gegeven waarde.. Daarnaast kunt u ook elke kleur een Label geven maar deze waarde zal niet getoond

worden wanneer het geredschap Objecten Identificeren wordt gebruikt. U kunt ook klikken op de knop
Laad kleurenkaart van band wat de tabel van de band probeert te laden (indien aanwezig). U kunt ook de knoppen
Laden kleurenkaart van bestand of Exporteer kleurenkaart naar bestand gebruiken om een bestaande kleurentabel te laden of om
deze te bewaren voor andere sessies.

In het rechter blok stelt Genereer nieuw kleurenpalet u in staat om nieuw gecategoriseerde kleurenkaarten te

maken. Voor de Modus ‘Gelijke interval’, hoeft u alleen het aantal klassen te selecteren en op de
knop Classificeren te drukken. U kunt de kleuren van de kleurenkaart omdraaien door te klikken op het keuzevak

Inverteer. In het geval van de Modus ‘Continue’, maakt QGIS automatisch klassen, afhankelijk van
de Min en Max. Definiëren van de waarden Min/Max kan worden gedaan met behulp van het gedeelte Min/max
waarden laden. Veel afbeeldingen hebben zeer lage en hoge gegevens. Deze uitschieters kunnen worden geëlimi-
neerd met behulp van de instelling Cumulatieve telling deel. Het standaard gegevensbereik is ingesteld van 2%
tot en met 98% van de gegevenswaarden en kan handmatig worden aangepast. Met deze instelling kan het grijze
karakter van de afbeelding verdwijnen. Met de optie voor schalen Min/max, maakt QGIS een kleurentabel
met alle gegevens die zijn opgenomen in de originele afbeelding (bijv., QGIS maakt een kleurentabel met 256
waarden, gegeven het feit dat u 8-bit banden heeft). U kunt ook uw kleurentabel berekenen met behulp van de

Gemiddelde +/- standaard afwijking x . Dan komen alleen de waarden die vallen binnen de standaard
afwijking of binnen meerdere standaard afwijkingen in aanmerking voor de kleurentabel.
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Figuur 13.5: Raster Renderer - Enkelbands pseudokleur
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Het renderen van kleuren

Voor elke Bandrendering is een Kleurrendering mogelijk.

U kunt ook speciale effecten voor renderen voor uw rasterbestand(en) bereiken met behulp van de Meng-modi
(zie Het dialoogvenster Vectoreigenschappen).

Verdere instellingen kunnen worden gemaakt in het aanpassen van de Helderheid, de Saturatie en het Contrast. U
kunt ook een optie Grijstinten gebruiken, waar u kunt kiezen uit ‘Lichtsterkte van’, ‘Helderheid van’ en ‘Gemid-
delde van’. Voor een kleurnuance in de kleurentabel kunt u de ‘Sterkte’ aanpassen.

Resampling

De optie Resample verschijnt als u in- en uitzoomt in een afbeelding. Modi voor Resample kunnen het uiterlijk
van de kaart optimaliseren. Zij berekenen een nieuw matrix voor grijswaarden door middel van een geometrische
transformatie.

Figuur 13.6: Raster Renderen - Resample

Bij het toepassen van de methode ‘Dichtstbijzijnde buur’ kan de kaart een gepixelde structuur hebben bij het
inzoomen. Dit uiterlijk kan worden verbeterd door de methoden ‘Bilineair’ of ‘Kubisch’ te gebruiken, wat scherpe
objecten vervaagt. Het effect is een gladdere afbeelding. Deze methode kan bijvoorbeeld worden toegepast digitale
topografische rasterkaarten.

13.2.3 Tabblad Transparantie

QGIS heeft de mogelijkheid om elke rasterlaag to tonen met verschillende transparantie percentages. Gebruik de

transparantie schuifschaal om aan te geven in welke mate de onderliggende lagen zichtbaar
worden onder de huidige rasterlaag. Dit komt goed van pas om verschillende rasterlagen over elkaar heen te
leggen, bijvoorbeeld een schaduwrijke reliëfkaart met een geklassificeerde rasterkaart. Dat zal er voor zorgen dat
de kaart er meer driedimensionaal uitziet.

Daarnaast kun je aangeven welke rasterwaarde als geen data behandeld moet worden in het menu Extra geen data
waarde.

En nog flexibelere manier om de transparantie te regelen kan gedaan worden via Aangepaste transparantie opties.
De transparantie voor elke pixelwaarde kan hier worden ingesteld.

Als voorbeeld willen we de transparantie van het water van het voorbeeld rasterbestand landcover.tif in-
stellen op 20%. Daarvoor zijn de volgende stappen nodig:

1. Laad het rasterbestand landcover.tif.
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2. Open de dialoog Eigenschappen door te dubbelklikken op de rasterlaag in de legenda of via het snelmenu
die via de rechtermuisknop in de legenda geopend wordt voor geselecteerde rasterlaag en te kiezen voor
Eigenschappen.

3. Selecteer het menu Transparantie

4. In het menu guilabel:Transparantie band kies ‘Geen’.

5. Klik op Voeg handmatig waarden toe. Een nieuwe regel zal worden toegevoegd aan de Transparantie pixellijst.

6. Geef de raster waarde (we gebruiken hier 0) in de kolom ‘Van’ en ‘Tot’ en pas daarvan de transparatie aan
naar 20 %.

7. Druk op de knop [Apply] en controleer het resultaat van de kaart.

Stappen 5 en 6 kunnen herhaald worden om meer waarden te wijzigen met een aangepaste transparantie.

Het is eenvoudig om een aangepaste transparantie op te zetten, maar dit is aardig wat werk. De knop
Naar bestand exporteren geeft dan ook de mogelijkheid om de Transparantie pixellijst op te slaan naar bestand. Met

de knop van bestand importeren kun de transparantie lijst weer laden en wordt deze toegepast op de huidige raster-
laag.

13.2.4 Tabblad Pyramiden

Rasterlagen met een hoge resolutie, kunnen het navigeren binnen QGIS langzaam maken. Door het aanmaken
van lagere resolutie kopiëen (pyramiden), kan de performance van QGIS aanzienlijk worden verbeterd aangezien
QGIS de kopie met de meest geschikte resolutie selecteerd voor elk zoom niveau.

Je moet schrijfrechten hebben op de folder waarin de originel rasterdata is opgeslagen om pyramiden te bouwen.

Verschilldende resampling methoden kunnen worden gebruikt om pyramiden te berekenen:

• ‘Dichtstbijzijnde buur’

• Gemiddelde

• Gauss

• Cubic

• Modus

• Geen

Indien u ‘Intern (indien mogelijk)’ kiest uit het menu Overzichtsindeling, probeert QGIS intern piramiden te
bouwen. U kunt ook kiezen voor ‘Extern’ en ‘Extern (Erdas Imagine)’.

Merk op dat het bouwen van pyramiden de originele databestanden kan veranderen en dat interne aangemaakt
pyramiden niet meer verwijderd kunnen worden. Het is dan ook altijd verstandig om van het origineel (zonder
pyramiden) eerst een kopie te maken en te bewaren.

13.2.5 Tabblad Histogram

Het menu Histogram stelt u in staat om de verdeling van de kleurenbanden in uw raster te bekijken. Het histogram
wordt automatisch gegenereerd wanneer u het menu Histogram opent. Alle bestaande banden zullen gezamenlijk

worden weergegeven. U kunt het histogram opslaan als een afbeelding met de knop . Met de optie Zicht-

baarheid in het menu Voorkeuren/Acties, kunt u histogrammen weergeven van de individuele banden. U moet
de optie Toon geselecteerde band selecteren. De Min/max opties geven u de mogelijkheden ‘Altijd min/max-
symbolen tonen’, ‘Naar min/max zoomen’ en ‘Update stijl naar min/max’. Met de optie Acties kunt u ‘Terug naar
beginwaarden’ en ‘Histogram herberekenen’ nadat u Min/max opties heeft gekozen.
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Figuur 13.7: Het menu Pyramiden

Figuur 13.8: Raster Histogram
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13.2.6 Tabblad Metadata

Het tabblad Metadata toont veel informatie over de rasterlaag, inclusief statistieken over elke band in de huidige
rasterlaag. In dit tabblad zijn de onderdelen Beschrijving, Attributen, MetadataUrl en Eigenschappen aanwezig.
In Eigenschappen worden statistieken verzameld wanneer nodig, het is dus best mogelijk dat voor een gegeven
laag de statistieken nog niet zijn verzameld of inmiddels verouderd zijn.

Figuur 13.9: Raster Metadata

.

13.3 Rasterberekeningen

The Raster Calculator in the Raster menu allows you to perform calculations on the basis of existing raster pixel
values (see figure_raster_2_). The results are written to a new raster layer with a GDAL-supported format.

De lijst Raster banden bevat all geladen rasterlagen die kunnen worden gebruikt. Dubbelklik op de rasterlaag in
de lijst om een raster toe te voegen aan het tekstvak Rasterberekeningen Expressie. Je kunt vervolgens de opera-
toren gebruiken om een berekening expressie op te bouwen of je kunt deze rechtsstreeks typen in het tekstvak.

In het deel Resultaatlaag kun je instellingen geven voor de resulterende rasterlaag. Je kunt voor de grootte van
het te berekenen gebied een rasterlaag of X,Y coördinaten en Rijen en Kolommen gebruiken om de resolutie te
bepalen voor de te schrijven laag. Wanneer de te verwerken laag een andere resolutie heeft, dan zullen de waarden
worden bepaald met het ‘Nearest neigbor’ Algoritme.

Het onderdeel Operatoren bevat alle operatoren die gebruikt kunnen worden. Dubbelklik op een operator om deze
toe te voegen aan het tekstvak Rasterberekening expressie. Zowel wiskundige (+, -, *, ... ) als trigonometrische
functies (sin, cos, tan, ... ) zijn beschikbaar!

Door het aanvinkvak :guilabel:‘Voeg resultaat toe aan project’ zal de resultaatlaag automatisch worden
toegevoegd aan de legenda en kan deze zichtbaar worden gemaakt.

13.3.1 Voorbeelden

Omzetten hoogtewaarden van meter naar voet

Voor het omzetten van een hoogteraster van meters naar voet kun je de omrekeningsfaktor 3.28 gebruiken. De
expressie is:
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Figuur 13.10: Rasterberekeningen

"elevation@1" * 3.28

Een uitknipmasker gebruiken

Wanneer van een hoogte rasterkaart, dat deel wilt uitknippen dat boven 0 meter hoogte ligt, kunt je de volgende
expressie gebruiken om in één keer een uitknipmasker te maken en het resultaat te schrijven naar een nieuwe
rasterkaart.

("elevation@1" >= 0) * "elevation@1"

Met andere woorden, voor elke pixel met een waarde groter of gelijk aan 0, wordt de waarde 1 anders 0. Daarmee
maak je een uitknipmasker.

.
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Werken met OGC Data

.

14.1 QGIS als cliënt voor OGC-gegevens

Het Open Geospatial Consortium (OGC) is een internationale organisatie met leden in meer dan 300 commer-
ciële, overheids-, non-profit- en research-organisaties wereldwijd. De leden ervan ontwikkelen en implementeren
standaarden voor geo-ruimtelijke inhoud en diensten, het verwerken van GIS-gegevens en uitwisseling.

Beschrijven van een basis gegevensmodel voor geografische objecten, een groeiend aantal specificaties zijn on-
twikkeld door OGC om te voldoen aan specifieke behoeften voor interoperabele locatie- en georuimtelijke tech-
nologie, inclusief GIS. Meer informatie kan worden gevonden op http://www.opengeospatial.org/.

Belangrijke specificaties voor OGC die worden ondersteund door QGIS zijn:

• WMS — Web Map Service (WMS/WMTS-cliënt)

• WMTS — Web Map Tile Service (WMS/WMTS-cliënt)

• WFS — Web Feature Service (WFS- en WFS-T-cliënt)

• WFS-T — Web Feature Service - Transactional (WFS- en WFS-T-cliënt)

• WCS — Web Coverage Service (WCS-cliënt)

• SFS — Simple Features for SQL (PostGIS kaartlagen)

• GML — Geography Markup Language

OGC-diensten worden steeds meer gebruikt om georuimtelijke gegevens uit te wisselen tussen verschillende im-
plementaties van GIS en gegevensopslag. QGIS kan als een cliënt bovenvermelde specificaties afhandelen, door
SFS te zijn (door ondersteuning van de gegevensprovider PostgreSQL / PostGIS, zie het gedeelte PostGIS kaart-
lagen).

14.1.1 WMS/WMTS-cliënt

Overzicht ondersteuning voor WMS

QGIS kan momenteel dienen als een WMS-cliënt die servers met WMS 1.1, 1.1.1 en 1.3 begrijpt. In het bijzonder
is het getest met publiek toegankelijke servers, zoals DEMIS.

Een WMS-server acteert op verzoeken van de cliënt (bijv. QGIS) voor een rasterkaart met een opgegeven bereik,
set van lagen, stijl voor symbologie en transparantie. De WMS-server consulteert dan zijn lokale gegevensbron-
nen, rasteriseert de kaart en stuurt het terug naar de cliënt in de indeling van een raster. Voor QGIS, zou deze
indeling gewoonlijk JPEG of PNG zijn.

WMS is in het algemeen een REST (Representational State Transfer)-service in plaats van een volledige webser-
vice. Als zodanig kunt u in feite de URL’s gebruiken die worden gegenereerd door QGIS en die gebruiken in een
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webbrowser om dezelfde afbeeldingen op te halen als die welke QGIS intern gebruikt. Dit kan handig zijn bij het
oplossen van problemen, omdat er verschillende merken WMS-server op de markt zijn en zij allemaal hun eigen
integratie van de WMS-standaard hebben.

WMS-lagen kunnen vrij eenvoudig worden toegevoegd, zolang u de URL maar weet om toegang te krijgen tot
de server van WMS, u een verbinding met services hebt naar die server en de server HTTP begrijpt als het
mechanisme voor transport van de gegevens.

Overzicht van ondersteuning voor WMTS

QGIS kan ook optreden als een WMTS-cliënt. WMTS is een OGC-standaard voor het distribueren van tegelsets
van georuimtelijke gegevens. Dit is een snellere en meer efficiënte manier voor het distribueren van gegevens
dan WMS omdat met WMTS de tegelsets vooraf worden gegenereerd en de cliënt alleen de verzending van de
tegels verzoekt, niet hun productie. Een verzoek aan WMS omvat gewoonlijk zowel het genereren als het verzen-
den van de gegevens. Een zeer bekend voorbeeld van een niet-OGC-standaard voor het bekijken van getegelde
georuimtelijke gegevens is Google Maps.

De tegelsets van WMTS worden geproduceerd op verschillende schaalniveaus om de gegevens op een breed
bereik aan schalen tot waar de gebruiker ze zou kunnen willen weergeven en worden beschikbaar gesteld aan de
GIS-cliënt om ze te bevragen.

Dit diagram illustreert het concept van tegelsets:

Figuur 14.1: Concept van tegelsets voor WMTS

De twee typen interfaces voor WMTS die QGIS ondersteunt zijn die via Key-Value-Pairs (KVP) en RESTful.
Deze twee interfaces verschillen van elkaar en u moet ze voor QGIS verschillend specificeren.

1) In order to access a WMTS KVP service, a QGIS user must open the WMS/WMTS interface and add the
following string to the URL of the WMTS tile service:

"?SERVICE=WMTS&REQUEST=GetCapabilities"

Een voorbeeld van dit type adres is

http://opencache.statkart.no/gatekeeper/gk/gk.open_wmts?\
service=WMTS&request=GetCapabilities

Voor het testen van de laag topo2 in dit WMTS werkt het aardig. Toevoegen van deze tekenreeks geeft aan dat
een WMTS-webservice moet worden gebruikt in plaats van een WMS-service.

2. De service RESTful WMTS heeft een andere vorm, een rechttoe rechtaan URL. De door OGC aanbevolen
indeling is:

{WMTSBaseURL}/1.0.0/WMTSCapabilities.xml
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Deze indeling helpt u te herkennen dat het een adres voor RESTful is. Een RESTful WMTS is in
QGIS toegankelijk door eenvoudigweg het adres toe te voegen aan de instelling van de WMS in het
veld URL van het formulier. Een voorbeeld van dit type adres voor een Oostenrijkse basiskaart is
http://maps.wien.gv.at/basemap/1.0.0/WMTSCapabilities.xml.

Notitie: U kunt nog steeds enkele oudere services vinden, genaamd WMS-C. Deze services komen vri-
jwel overeen met WMTS (d.i.,hetzelfde doel maar werken iets anders). U kunt ze op dezelfde wijze be-
heren als u met WMTS-services doet. Voeg gewoon ?tiled=true toe aan het einde van de URL. Zie
http://wiki.osgeo.org/wiki/Tile_Map_Service_Specification voor meer informatie over deze specificatie.

Wanneer u WMTS leest, mag u ook WMS-C denken.

Selecteren van servers voor WMS/WMTS

De eerste keer dat u de mogelijkheid WMS in QGIS gebruikt, zijn er geen servers gedefinieerd.

Begin door te klikken op de knop Add WMS layer op de werkbalk, of seleceer Kaartlagen → WMS/WMTS-laag
toevoegen....

Het dialoogvenster Lagen toevoegen van een WM(T)S-server voor het toevoegen van lagen van de
WM(T)S-server verschijnt. U kunt enkele servers toevoegen om mee te spelen door te klikken op
de knop [Standaard servers toevoegen]. Dit zal ter demonstratie twee WMS-servers toevoegen
die u kunt gebruiken: de WMS-servers van de DM Solutions Group en Lizardtech. Selecteer, om
een nieuwe WMS-server te definiëren< op de tab Lagen de knop [Nieuw]. Voer dan de parame-
ters in, om te verbinden met de door u gewenste WMS-server, zoals vermeld in table_OGC_1:

Naam Een naam voor deze verbinding. Deze naam zal worden gebruikt in de keuzelijst
Serververbindingen zodat u hem kunt onderscheiden van andere WMS-servers.

URL URL van de server die de gegevens verschaft. Dit moet een herkenbare hostnaam zijn –
dezelfde indeling als wanneer u een telnet-verbinding wilt openen of een host pingt.

Gebruiker-
snaam

Gebruikersnaam om toegang te krijgen tot een beveiligde WMS-server. Deze parameter is
optioneel.

Wachtwoord Wachtwoord voor een basis geauthenticeerde WMS-server. Deze parameter is optioneel.

Negeren
GetMap URI

Negeer GetMap URI vermeld in capabilities. Gebruik de opgegeven URI uit het veld
URL hierboven.

Negeren
GetFeatureInfo
URI

Negeer GetFeatureInfo URI vermeld in capabilities. gebruik de opgegeven URI uit het
veld URL hierboven.

Tabel OGC 1: parameters voor WMS-verbinding

Als u een proxyserver moet opzetten om in staat te zijn WMS-services vanaf het internet te ontvangen, kunt u uw
proxyserver toevoegen in de opties. Kies Extra → Opties en klik op de tab Netwerk. daar kunt u uw instellingen

voor de proxy toevoegen en ze inschakelen door Gebruik een proxy voor internettoegang te selecteren. Zorg

er voor dat u het juiste type proxy selecteert uit de keuzelijst Proxy type .

Als de nieuwe verbinding voor de WMS-server eenmaal is gemaakt, zal die worden behouden voor toekomstige
sessies in QGIS.

Tip: Op WMS Server URL’s
Wees er zeker van, bij het invoeren van de URL voor de WMS-server, dat u alleen de basis-URL heeft.
U zou bijvoorbeeld in uw URL geen fragmenten moeten hebben als request=GetCapabilities of
version=1.0.0.

14.1. QGIS als cliënt voor OGC-gegevens 147

http://maps.wien.gv.at/basemap/1.0.0/WMTSCapabilities.xml
http://wiki.osgeo.org/wiki/Tile_Map_Service_Specification


QGIS User Guide, Release 2.2

Laden van lagen WMS/WMTS

Als u eenmaal met succes uw parameters hebt ingevuld, kunt u de knop [Verbinden] gebruiken om de objecten
van de geselecteerde server op te halen. Dit is inclusief de codering voor de afbeelding, lagen, stijlen voor lagen en
projecties. Omdat dit een bewerking op het netwerk is is de snelheid van het antwoord afhankelijk van de kwaliteit
van uw netwerkverbinding naar de WMS-server. Gedurende het downloaden van gegevens van de WMS-server
wordt de voortgang van dat proces gevisualiseerd in de linker benedenhoek van het dialoogvenster WMS.

Uw scherm zou er nu een beetje moeten uitzien als op figure_OGR_1, die het antwoord weergeeft dat is verschaft
door de WMS-server van DM Solutions Group.

Figuur 14.2: Dialoogvenster voor het toevoegen van een WMS-server, geeft zijn beschikbare lagen weer

Codering van afbeelding

Het gedeelte Afbeeldingsformaat vermeld de indelingen die zowel door de cliënt als de server worden ondersteund.
kies er een, afhankelijk van de vereisten voor de nauwkeurigheid van uw afbeelding.

Tip: Codering van afbeelding
U zult vrijwel altijd merken dat een WMS-server u de keuze biedt tussen de JPEG- of PNG-codering voor af-
beeldingen. JPEG is een indeling voor compressie met verlies van gegevens, waar PNG de ruwe rastergegevens
zorgeloos reproduceert.

Gebruik JPEG als u verwacht dat de gegevens van WMS van oorsprong fotografisch zijn en/of u heeft geen
bezwaar tegen verlies van enige kwaliteit in de afbeelding. Dit nadeel reduceert gewoonlijk met de factor vijf de
vereisten voor gegevensoverdracht ten opzichte van PNG.

Gebruik PNG als u precieze weergaven van de originele gegevens wilt en u geen bezwaar heeft tegen de verhoogde
vereisten voor gegevensoverdracht.
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Opties

Het gebied Opties van het dialoogvenster verschaft een tekstveld waar u een Laagnaam kunt toevoegen aan de
WMS-laag. Deze naam zal in de legenda verschijnen na het laden van de laag.

Onder de laagnaam kunt u de Tile-grootte definiëren als u grootten voor de tegels (bijv., 256x256) wilt instellen
om het verzoek aan WMS op te splitsen in meerdere verzoeken.

De Objecten-limiet voor GetFeatureInfo definieert welke objecten op de server kunnen worden bevraagd.

Als u een WMS uit de lijst selecteert verschijnt een veld met de standaard projectie die wordt verschaft door de
kaartserver. Als de knop [Aanpassen...] actief is, kunt u er op klikken en de standaard projectie van de WMS
wijzigen naar een ander CRS, dat wordt verschaft door de WMS-server.

Volgorde lagen

De tab Laagvolgorde vermeld de geselecteerde beschikbare lagen uit de huidige verbinding met de WMS-server.
het zal u opgevallen zijn dat sommige lagen uit te breiden zijn; dit betekent dat de laag kan worden weergegeven
in een keuze van stijlen voor de afbeelding.

U kunt verscheidene lagen in één keer selecteren, maar slechts één stijl voor een afbeelding per laag. Wanneer
verscheidene lagen zijn geselecteerd, zullen zij op de WMS-server worden gecombineerd en in één keer naar
QGIS worden verzonden.

Tip: Volgorde WMS-lagen
WMS-lagen die zijn gerenderd door een server worden gestapeld in de volgorde die is vermeld in het gedeelte La-
gen, van boven naar beneden in de lijst. Als u de volgorde van stapelen wilt wijzigen, kunt u de tab Laagvolgorde
gebruiken.

Transparantie

In deze versie van QGIS is de instelling Globale transparantie uit de Laageigenschappen hard gecodeerd om altijd
aan te staan, indien beschikbaar.

Tip: Transparantie voor WMS-laag
De beschikbaarheid van transparantie voor afbeeldingen van WMS is afhankelijk van de gebruikte codering voor
de afbeelding: PNG en GIF ondersteunen transparantie, terwijl JPEG het niet ondersteunt.

Coördinaten ReferentieSysteem

Een coördinaten referentiesysteem (CRS) is de terminologie van OGC voor een projectie in QGIS.

Elke WMS-laag kan worden weergegeven in meerdere CRS-en, afhankelijk van de capaciteiten van de WMS-
server.

Selecteer, om een CRS te kiezen, [Aanpassen...] en een dialoogvenster, soortgelijk aan dat van Figure Projec-
tion 3 in Werken met Projecties, zal verschijnen. Het belangrijkste verschil met de versie voor WMS van het
dialoogvenster is dat alleen de door de WMS-server ondersteunde CRS-en zullen worden weergegeven.

Server zoeken

Binnen QGIS kunt u zoeken naar WMS-servers. Figure_OGC_2 geeft de tab Servers zoeken weer met het di-
aloogvenster:Lagen toevoegen van een WM(T)S-server.

Zoals u kunt zien is het mogelijk om een zoekvraag in het tekstveld in te voeren en te drukken op de knop
[Zoeken]. na een korte tijd zal het resultaat worden weergegeven in de lijst onder het tekstveld. Blader naar de
lijst met resultaten en inspecteer uw zoekresultaten in de tabel. Selecteer, om de resultaten te visualiseren, een
item uit de tabel, druk op de knop [Geselecteerde regel aan lijst met WMS-en toevoegen] en ga terug naar
de tab Lagen. QGIS heeft automatisch uw lijst met servers bijgewerkt en het geselecteerde zoekresultaat is al
ingeschakeld in de lijst van opgeslagen WMS-servers in de tab Lagen. U hoeft alleen de lijst met lagen nog maar
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Figuur 14.3: Dialoogvenster voor het zoeken naar servers van WMS na enkele sleutelwoorden

op te vragen door te klikken op de knop [Verbinden]. Deze optie is zeer handig als u kaarten wilt zoeken met
bepaalde sleutelwoorden.

In de basis is deze optie is een beginpunt naar de API van http://geopole.org.

Tegelsets

Bij het gebruiken van WMTS (Cached WMS)-services zoals

http://opencache.statkart.no/gatekeeper/gk/gk.open_wmts?\
service=WMTS&request=GetCapabilities

bent u in staat te bladeren door de tab Tilesets die wordt gevuld door de server. Aanvullende informatie zoals de
grootte van de tegels, indelingen en ondersteunde CRS-en worden in deze tabel vermeld. In combinatie met deze
mogelijkheid kunt u de schuif voor de schaal van de tegel gebruiken door te selecteren Beeld → Panelen (KDE
en Windows) of Beeld → Panelen (Gnome en MacOSX), en dan te kiezen Tile schaal. dat geeft u de beschikbare
schalen vanaf de tileserver met een leuke schuifbalk daarin.

Gebruiken van het gereedschap Objecten identificeren

Als u eenmaal een WMS-server hebt toegevoegd en als een laag van een WMS-server is te bevragen, dan kunt u

het gereedschap Objecten identificeren gebruiken om een pixel in het kaartvenster te selecteren. Een query naar de
WMS-server wordt verstuurd voor elke gemaakte selectie. De resultaten van de bevraging worden teruggegeven
in platte tekst. De opmaak van die tekst is afhankelijk van de gebruikte WMS-server. Selecteren indeling

Indien meerdere indelingen voor uitvoer worden ondersteund door de server, wordt een combinatievak met die
ondersteunde indelingen automatisch toegevoegd aan het dialoogvenster Identificatieresultaten en de geselecteerde
indeling kan voor de laag worden opgeslagen in project. Ondersteuning indeling GML
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Het gereedschap Objecten identificeren ondersteunt antwoorden van WMS-server (GetFeatureInfo) in de indeling
GML (het wordt in de QGIS GUI in deze context Object genoemd). Als de indeling “Object” wordt ondersteund
door de server en geselecteerd, resultaten van het gereedschap Objecten identificeren zijn vectorobjecten, als uit
een gewone vectorlaag. Wanneer één enkel object is geselecteerd in de boom, wordt het geaccentueerd in de kaart
en kan het naar het klembord worden gekopieerd en geplakt op een andere vectorlaag. bekijk de voorbeeld setup
van de UMN Mapserver hieronder voor ondersteuning van GetFeatureInfo in de indeling GML.

# in layer METADATA add which fields should be included and define geometry (example):

"gml_include_items" "all"
"ows_geometries" "mygeom"
"ows_mygeom_type" "polygon"

# Then there are two possibilities/formats available, see a) and b):

# a) basic (output is generated by Mapserver and does not contain XSD)
# in WEB METADATA define formats (example):
"wms_getfeatureinfo_formatlist" "application/vnd.ogc.gml,text/html"

# b) using OGR (output is generated by OGR, it is send as multipart and contains XSD)
# in MAP define OUTPUTFORMAT (example):
OUTPUTFORMAT

NAME "OGRGML"
MIMETYPE "ogr/gml"
DRIVER "OGR/GML"
FORMATOPTION "FORM=multipart"

END

# in WEB METADATA define formats (example):
"wms_getfeatureinfo_formatlist" "OGRGML,text/html"

Eigenschappen bekijken

Wanneer u eenmaal een WMS-server hebt toegevoegd, kunt u de eigenschappen ervan bekijken door met er met
rechts op te klikken in de legenda en Eigenschappen te selecteren. Tab Metadata

De tab Metadata geeft een grote hoeveelheid informatie weer over de WMS-server, over het algemeen verzameld
door het argument capabilities dat werd teruggegeven door die server. Vele definities kunnen worden verzameld
door de WMS-standaarden te lezen (zie OPEN-GEOSPATIAL-CONSORTIUM in Verwijzingen naar literatuur
en web), maar hier zijn een aantal handige definities:

• Servereigenschappen

– WMS Versie — De door de server ondersteunde versie van WMS.

– Indelingen voor afbeeldingen — De lijst van MIME-types waarmee de server kan antwoorden bij
het tekenen van de kaart. QGIS ondersteunt alle indelingen waarmee de onderliggende bibliotheken
van Qt werden gebouwd, wat over het algemeen tenminste image/png en image/jpeg zijn.

– Indelingen voor identificeren — De lijst van MIME-types waarin de server kan antwoorden wan-
neer u het gereedschap Objecten identificeren gebruikt. Momenteel ondersteunt, QGIS het type
text-plain.

• Laageigenschappen

– Geselecteerd — Of deze laag al dan niet geselecteerd was toen de server ervan werd toegevoegd aan
dit project.

– Zichtbaar — of deze laag al dan niet is geselecteerd als zichtbaar in de legenda (nog niet gebruikt in
deze versie van QGIS).

– Kan identificeren — Of deze laag al dan niet resultaten zal teruggeven als het gereedschap Objecten
identificeren er op zal worden gebruikt.

– Kan transparant zijn — of de laag al dan niet kan worden gerenderd met transparantie. Deze ver-
sie van QGIS zal altijd transparantie gebruiken als dit Yes is en de codering voor de afbeelding
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transparantie ondersteunt.

– Kan inzoomen — Of op deze laag al dan niet kan worden ingezoomd door de server. Deze versie
van QGIS neemt aan dat WMS-lagen dit hebben ingesteld op Ja. Afwijkende lagen zouden vreemd
gerenderd kunnen worden.

– Telling doorzenden — WMS-servers kunnen als een proxy optreden voor andere WMS-servers om
de rastergegevens voor een laag te verkrijgen. Dit item geeft weer hoe vaak het verzoek voor deze laag
werd doorgezonden een collega WMS-servers voor en resultaat.

– vaste breedte, vaste hoogte — Of deze laag al dan niet vaste dimensies voor de bronpixels heeft.
Deze versie van QGIS neemt an dat alle WMS-lagen dit hebben ingesteld op niets. Afwijkende lagen
zouden vreemd gerenderd kunnen worden.

– WGS 84-begrenzing — De begrenzing van de laag, in coördinaten voor WGS 84. Sommige WMS-
servers stellen dit niet juist in (bijv.,worden in plaats daarvan coördinaten voor UTM gebruikt). Als
dit het geval is dan zou de initiële weergave van deze laag kunnen worden gerenderd met een zeer
‘uitgezoomd’ uiterlijk door QGIS. De WMS-webbeheerder zou over deze fout moeten worden geïn-
formeerd, wat zij zouden kunnen kennen als de WMS XML-elementen LatLonBoundingBox,
EX_GeographicBoundingBox of de CRS:84 BoundingBox.

– Beschikbaar in CRS — De projecties waarin deze laag kan worden gerenderd door de WMS-server.
Deze worden vermeld in de eigen indeling van.WMS

– Beschikbaar in stijl — De stijlen voor de afbeelding waarin deze laag kan worden gerenderd door de
WMS-server.

Afbeelding van WMS-legenda weergeven in inhoudsopgave en printvormgeving

De QGIS WMS-gegevensprovider is in staat om een afbeelding van de legenda weer te geven in de inhoudsopgave
van de lijst met lagen en in de printvormgeving van de kaart. De legenda voor WMSzal alleen worden weergegeven
als de WMS-server de magelijkheid GetLegendGraphic heeft en de laag getCapability heeft gespecificeerd in de
URL, dus moet u aanvullend een opmaak voor de laag selecteren.

Als een legendGraphic beschikbaar is, wordt die weergegeven onder de laag. hij is klein en u moet er op klikken
om net te openen in zijn echte afmetingen (wegens de archtectonische beperking in QgsLegendInterface). Klikken
op de legenda van de lagen zal een kader openen met de legenda in zijn volledige resolutie.

In de printvormgeving zal de legenda worden geïntegreerd in zijn originele (gedownloade) afmeting. Resolu-
tie van de afbeelding van de legenda kan worden ingesteld in de itemeigenschappen onder Legenda -> WMS
LegendGraphic om overeen te komen met uw wensen voor afdrukken.

De legenda zal contextuele informatie weergeven gebaseerd op uw huidige schaal. De legenda voor WMS zal
alleen worden weergegeven als de WMS-server de mogelijkheid GetLegendGraphic heeft en de laag getCapability
heeft gespecificeerd in de URL, dus moet u aanvullend een opmaak voor de laag selecteren.

Beperkingen WMS-cliënt

Niet alle mogelijke functionaliteit voor WMS-cliënt is opgenomen in deze versie van QGIS. Enkele van de meest
vermeldenswaardige uitzonderingen volgen.

Bewerken instellingen WMS-laag

Als u eenmaal de procedure WMS/WMTS-laag toevoegen heeft voltooid, is r geen manier om de instellingen te
wijzigen. Een manier om dat op te lossen is door de laag te verwijderen en opnieuw te beginnen.

WMS-servers vereisen authenticatie

Momenteel worden publiek toegankelijke en beveiligde WMS-services ondersteund. De beveiligde WMS-servers
kan worden benaderd met publieke authenticatie. U kunt de (optionele) persoonlijke gegevens toevoegen wanneer
u een WMS-server toevoegt. Zie het gedeelte Selecteren van servers voor WMS/WMTS voor details.

Tip: Toegang tot beveiligde OGC-lagen
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Als u beveiligde lagen dient te benaderen met beveiligde methoden anders dan basis authenticatie, kunt u InteProxy
gebruiken als een transparante proxy, die verscheidene methoden voor authenticatie ondersteunt. Meer informatie
kan worden gevonden in de handleiding van InteProxy op http://inteproxy.wald.intevation.org.

Tip: QGIS WMS Mapserver
Vanaf versie 1.7.0 heeft QGIS zijn eigen implementatie van een WMS 1.3.0 Mapserver. Lees er meer over in dit
hoofdstuk QGIS als OGC Data Server.

14.1.2 WCS-cliënt

Een Web Coverage Service (WCS) verschaft toegang tot rastergegevens in vormen die handig zijn voor cliënt-
zijdig renderen, als invoer voor wetenschappelijke modellen en voor andere cli:enten. De WCS kan worden
vergeleken met WFS en WMS. Waar WMS en WFS service uitvoeren, staat WCS cliënten toe gedeelten van
de op de server opgeslagen informatie te kiezen, gebaseerd op ruimtelijke beperkingen en andere criteria voor
bevragingen.

QGIS heeft een eigen WCS-provider en ondersteunt zowel versie 1.0 als 1.1 (die significant van elkaar verschillen),
maar heeft momenteel een voorkeur voor 1.0, omdat 1.1 nog vele problemen heeft (d.i., elke server implementeert
het op een andere manier met verschillende eigenaardigheden).

De eigen WCS-provider behandlt alle netwerkverzoeken en gebruikt alle standaard netwerkinstellingen van QGIS
(proxy in het bijzonder). Het is ook mogelijk modus cache te selecteren (‘always cache’, ‘prefer cache’, ‘prefer
network’, ‘always network’), en de provider ondersteunt ook het selecteren van de tijdpositie, indien een tijdelijk
domein wordt aangeboden door de server.

14.1.3 WFS- en WFS-T-cliënt

In QGIS, gedraagt een WFS-laag zich nagenoeg hetzelfde als elke andere vectorlaag. U kunt objecten identificeren
en selecteren en de attributentabel bekijken. Vanaf QGIS 1.6 wordt ook bewerken van WFS-T ondersteund.

Over het algemeen is het toevoegen van een WFS-laag soortgelijk aan de procedure die wordt gebruikt met WMS.
Het verschil is dat er geen standaard servers zijn gedefinieerd, dus moeten we onze eigen toevoegen.

Laden van een WFS-laag

Als voorbeeld gebruiken we de server DM Solutions WFS en geven een laag weer. De URL is:
http://www2.dmsolutions.ca/cgi-bin/mswfs_gmap

1. Klik op het gereedschap WFS-laag toevoegen op de werkbalk Kaartlagen. Het dialoogvenster Toevoegen van
een WFS-laag van een server verschijnt.

2. Klik op [Nieuw].

3. Voer als naam ‘DM Solutions’ in.

4. Voer de URL in (zie boven).

5. Klik op [OK].

6. Kies ‘DM Solutions’ uit de keuzelijst Serververbindingen .

7. Klik op [Verbinden].

8. Wacht tot de lijst met lagen is gevuld.

9. Selecteer de laag Parks uit de lijst.

10. Klik op [Toepassen] om de laag aan de kaart toe te voegen.
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Figuur 14.4: Toevoegen van een WFS-karatlaag

Onthoud dat instellingen voor een proxy die u kan hebben ingesteld in uw voorkeuren ook worden herkent.

You’ll notice the download progress is visualized in the lower left of the QGIS main window. Once the layer is
loaded, you can identify and select a province or two and view the attribute table.

Alleen WFS 1.0.0 wordt ondersteund. op dit moment zijn er nog niet veel testen uitgevoerd tegen versies van
WFS die zijn geïmplementeerd in andere WFS-servers. Als u problemen tegenkomt met enige andere WFS-
server, aarzel dan niet om contact op te nemen met het ontwikkelingsteam. Bekijk het gedeelte Ondersteuning
voor meer informatie over de mailinglijsten.

Tip: Zoeken van WFS-servers
U kunt zoeken naar aanvullende WFS-servers met behulp van Google of uw favoriete zoekmachine. Er zijn een
aantal lijsten met publieke URL’s, sommige daarvan worden onderhouden, andere niet.

.

14.2 QGIS als OGC Data Server

QGIS Server is een open bron WMS 1.3, WFS 1.0.0 en WCS 1 1.1.1 implementatie die„ in aanvulling daarop,
gevorderde cartografische mogelijkheden voor thematische kaarten implementeert. De QGIS Server is een
FastCGI/CGI (Common Gateway Interface)-toepassing, geschreven in C++ die samenwerkt met een webserver
(bijv., Apache, Lighttpd). Het is financieel mogelijk gemaakt door de EU-projecten Orchestra, Sany en de stad
Uster in Switzerland.

QGIS Server gebruikt QGIS als achterliggend programma voor de logica van GIS en voor het renderen van de
kaarten. Verder wordt de bibliotheek Qt gebruikt voor afbeeldingen en platform-onafhankelijk programmeren in
C++. In tegenstelling tot andere software voor WMS software, gebruikt QGIS Server cartografische regels als
configuratie-taal, zowel voor de configuratie van de server als voor de door de gebruiker gedefinieerde cartografis-
che regels.

Moreover, the QGIS Server project provides the ‘Publish to Web’ plugin, a plugin for QGIS desktop that exports
the current layers and symbology as a web project for QGIS Server (containing cartographic visualization rules
expressed in SLD).

As QGIS desktop and QGIS Server use the same visualization libraries, the maps that are published on the web
look the same as in desktop GIS. The ‘Publish to Web’ plugin currently supports basic symbolization, with the
option to introduce more complex cartographic visualization rules manually. As the configuration is performed
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with the SLD standard and its documented extensions, there is only one standardised language to learn, which
greatly simplifies the complexity of creating maps for the Web.

In een van de volgende handleidingen zullen we een voorbeeld configuratie opnemen om een QGIS Server in te
stellen. Voor nu bevelen we aan om één van de volgende URL’s te lezen voor meer informatie:

• http://karlinapp.ethz.ch/qgis_wms/

• http://hub.qgis.org/projects/quantum-gis/wiki/QGIS_Server_Tutorial

• http://linfiniti.com/2010/08/qgis-mapserver-a-wms-server-for-the-masses/

14.2.1 Voorbeeld installatie op Debian Squeeze

Op dit punt zullen we een korte en eenvoudige How-to geven voor een voorbeeld-installatie op Debian Squeeze.
Vele andere OS-en verschaffen ook pakketten voor QGIS Server. Bekijk de URL’s hierboven als u het allemaal
vanaf de bron moet bouwen.

Apart van QGIS en QGIS Server heeft u een webserver nodig, in ons geval apache2. U kunt alle pakketten
installeren met aptitude of apt-get install tezamen met andere benodigde pakketten met afhankeli-
jkheden. Na de installatie zou u moeten testen om te bevestigen dat de webserver en QGIS Server werken zoals
verwacht. Zorg er voor dat de server van apache wordt uitgevoerd met: /etc/init.d/apache2 start.
Open een webbrowser en type de URL: http://localhost. Als apache correct draait zou u de boodschap ‘It
works!’ moeten zien.

Nu gaan we de installatie van QGIS Server testen. De qgis_mapserv.fcgi is beschikbaar op
/usr/lib/cgi-bin/qgis_mapserv.fcgi en verschaft een standaard WMS dat de staatsgrenzen van
Alaska weergeeft. Voeg de WMS toe met de URL http://localhost/cgi-bin/qgis_mapserv.fcgi
zoals beschreven in Selecteren van servers voor WMS/WMTS.

14.2.2 Maken van een WMS/WFS/WCS uit een project van QGIS

We moeten een projectbestand van QGIS met enige gegevens hebben om een nieuw QGIS Server WMS, WFS of
WCS te verschaffen. Hier gebruiken we het shapefile ‘Alaska’ uit de voorbeeld gegevensset van QGIS. Definieer
de kleuren en stijlen van de lagen in QGIS en het CRS voor het project, als die nog niet gedefinieerd zijn.

Ga dan naar het menu OWS Server van het dialoogvenster Project → Projectinstellingen en geef enige informatie
over de OWS in de velden onder Service-mogelijkheden. Dit zal verschijnen in het antwoord GetCapabilities van

de WMS, WFS of WCS. Als u Service-mogelijkheden niet selecteert zal QGIS Server de informatie gebruiken
die is opgegeven in het bestand wms_metadata.xml dat is opgeslagen in de map cgi-bin.

WMS-mogelijkheden

In het gedeelte WMS-mogelijkheden kunt u het bereik definiëren dat zal worden opgenomen in het antwoord van
de WMS GetCapabilities door de minimum en maximum waarden voor X en Y in de velden onder Opgegeven
bereik in te voeren. Klikken op Huidige bereik van kaartvenster gebruiken stelt deze waarden in op het bereik

dat momenteel wordt weergegeven in het kaartvenster van QGIS. Door CRS-beperkingen te selecteren kunt
u beperken in welke coördinaten referentiesystemen (CRS) QGIS Server zal aanbieden de kaarten te renderen.

gebruik de knop onderin om die CRS-en te selecteren uit de selectie voor Coördinaten ReferentieSysteem, of
klik op Huidige gebruikte om het in het project van QGIS gebruikte CRS te aan de lijst toe te voegen.

Als u printvormgevingen hebt gedefinieerd in uw project, zullen zij worden vermeld in het antwoord GetCapa-
bilities en zij kunnen worden gebruikt in het verzoek GetPrint om afdrukken te maken, met behulp van een van
de lay-outs voor de printvormgeving als een sjabloon. Dit is een QGIS-specifieke uitbreiding aan de specificatie
voor WMS 1.3.0. Indien u niet wilt dat een printvormgeving wordt gepubliceerd door de WMS, selecteer dan

Printvormgeving uitsluiten en klik op de knop onderin. Selecteer dan een printvormgeving vanuit het
dialoogvenster Selecteer printvormgeving om die toe te voegen aan de lijst met uigesloten printvormgevingen.
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Figuur 14.5: Standaard WMS met grenzen voor USA opgenomen in de QGIS Server (KDE)
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Figuur 14.6: Definities voor een project QGIS Server WMS/WFS/WCS (KDE)
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Indien u niet wilt dat een laag of groep lagen wordt gepubliceerd door de WMS, selecteer dan Kaartlagen

uitsluiten en klik op de knop onderin. Dit opent het dialoogvenster Selecteer lagen en groepen met restricties
dat u in staat stelt de lagen en groepen te kiezen die u niet wilt publiceren. Gebruik de toetsen Shift of Ctrl
als u meerdere items in één keer wilt selecteren.

U kunt de door u verzochte GetFeatureInfo als platte tekst, XML en GML ontvangen. XML is standaard, de
indelingen tekst of GML zijn afhankelijk van de indeling die wordt gekozen in het verzoek GetFeatureInfo.

Als u dat wilt kunt u Geometrie aan feature response toevoegen selecteren. Dit zal in het antwoord van
GetFeatureInfo de geometrieën opnemen van de objecten in tekstindeling. Als u wilt dat QGIS Server specifieke
URL’s voor verzoeken opneemt in het antwoord van WMS GetCapabilities, voer dan de overeenkomende URL in
in het veld Opgegeven URL. verder kunt u de maximale grootte van de kaarten instellen die worden teruggegeven
door het verzoek GetMap door de maximum breedte en hoogte in te voeren in de respectievelijke velden onder
Maxima voor GetMap-verzoek.

WFS-mogelijkheden

In het gebied WFS-mogelijkheden kunt u de lagen selecteren die u wilt publiceren als WFS, en specificeren of
zij de bewerkingen Bijwerken, Toevoegen en Verwijderen zullen toestaan. Als u een URL invoert in het veld
Opgegeven URL van het gedeelte WFS-mogelijkheden, zal QGIS Server deze specifieke URL opnemen in het
antwoord WFS GetCapabilities.

WCS-mogelijkheden

In het gebied WCS-mogelijkheden kunt u de lagen selecteren die u wilt publiceren als WCS. Als u een URL invoert
in het veld Opgegeven URL van het gedeelte WCS-mogelijkheden, zal QGIS Server deze specifieke URL opnemen
in het antwoord van WCS GetCapabilities.

Sla nu de sessie op in een projectbestand alaska.qgs. We maken een nieuwe map
/usr/lib/cgi-bin/project met rechten als beheerder en voegen het projectbestand alaska.qgs
en een kopie van het bestand qgis_mapserv.fcgi toe om het project te verschaffen als WMS/WFS - dat is
alles.

Nu gaan we ons project WMS, WFS en WCS testen. Voeg de WMS, WFS en WCS toe, zoals beschreven in Laden
van lagen WMS/WMTS, WFS- en WFS-T-cliënt en WCS-cliënt, aan QGIS en laad de gegevens. De URL is:

http://localhost/cgi-bin/project/qgis_mapserv.fcgi

Fijn afstemmen van uw OWS

Voor vectorlagen geeft het menu Velden van het dialoogvenster Laag → Eigenschappen u de mogelijkheid om voor
elk attribuut te definiëren of het mag worden gepubliceerd of niet. Standaard worden alle attributen gepubliceerd
door uw WMS en WFS. Als u een specifiek attribuut niet wilt publiceren, deselecteer dan het overeenkomende
keuzevak in de kolom WMS of WFS.

U kunt watermerken over door uw WMS geproduceerde kaarten leggen door tekst-annotaties of SVG-annotaties
toe te voegen aan het projectbestand. Zie het gedeelte gereedschap Annotatie in Algemeen Gereedschap voor
instructies over het maken van annotaties. Het keuzevak Vaste positie op kaart in het dialoogvenster Annotatie
tekst moet worden gedeselecteerd om annotaties als watermerken te laten weergeven op de uitvoer van WMS.
Toegang hiertoe kan worden verkregen door te dubbelklikken op een annotatie als een van de gereedschappen
voor annotaties actief is. Voor SVG-annotaties dient u ofwel het project in te stellen om absolute paden op te slaan
(in het menu Algemeen van het dialoogvenster Project → Projectinstellingen) of door het pad handmatig aan te
passen voor de SVG-afbeelding op een dusdanige manier dat het een geldig relatief pad weergeeft.

Extra parameters ondersteund door het verzoek WMS GetMap

In het verzoek WMS GetMap accepteert QGIS Server een aantal extra parameters in aanvulling op de standaard
parameters overeenkomend met de specificatie OCG WMS 1.3.0:
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• parameter MAP: Soortgelijk aan MapServer kan de parameter MAP worden gebruikt om het pad naar het
projectbestand van QGIS te specificeren. U kunt een absoluut pad specificeren of een pad relatief aan de lo-
catie van het uitvoerbare bestand van de server (qgis_mapserv.fcgi). Indien niet gespecificeerd zoekt
QGIS Server naar .qgs-bestanden in de map waar het uit te voeren bestand voor de server is opgeslagen.

Voorbeeld:

http://localhost/cgi-bin/qgis_mapserv.fcgi?\
REQUEST=GetMap&MAP=/home/qgis/mymap.qgs&...

• parameter DPI : De parameter DPI kan worden gebruikt om de resolutie voor de verzochte uitvoer te
specificeren.

Voorbeeld:

http://localhost/cgi-bin/qgis_mapserv.fcgi?REQUEST=GetMap&DPI=300&...

• parameter OPACITIES: Doorzichtigheid kan worden ingesteld op niveau van de laag of van een groep.
Toegestane waarden reiken van 0 (volledig transparant) tot en met 255 (ondoorzichtig).

Voorbeeld:

http://localhost/cgi-bin/qgis_mapserv.fcgi?\
REQUEST=GetMap&LAYERS=mylayer1,mylayer2&OPACITIES=125,200&...

.
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Werken met GPS-gegevens

.

15.1 Plug-in GPS-gereedschap

15.1.1 Wat is GPS?

GPS, het Global Positioning System, is een op satellieten gebaseerd systeem dat het voor iedereen met een GPS-
ontvanger mogelijk maakt hun exacte positie, overal ter wereld, te vinden. GPS wordt gebruikt als hulp bij
navigatie, bijvoorbeeld in vliegtuigen, op schepen en door wandelaars. De GPS-ontvanger gebruikt de signalen van
de satellieten om zijn breedtegraad en lengtegraad te berekenen en (soms) de hoogte. De meeste ontvangers hebben
ook de mogelijkheden om locaties (bekend als waypoints), reeksen locaties die een geplande route vormen en
een log van het spoor of track van de verplaatsingen van de ontvanger in de tijd, op te slaan. Waypoints, routes en
tracks zijn de drie basistypen objecten in GPS-gegevens. QGIS geeft waypoints weer in puntlagen, terwijl routes
en tracks worden weergegeven in lijnlagen.

15.1.2 GPS-gegevens laden uit een bestand

Er bestaan heel veel verschillende bestandsindelingen voor het opslaan van GPS-gegevens. De indeling die QGIS
gebruikt wordt GPX (GPS eXchange-indeling) genoemd, wat een standaard indeling voor uitwisseling is dat een
willekeurig aantal waypoints, routes en tracks in hetzelfde bestand kan bevatten.

Laad, om een GPX-bestand te laden, eerst de plug-in GPS-gereedschap. menuselection:Plugins –> Beheer

en installeer plug-ins... opent het dialoogvenster Plugins. Activeer het keuzevak GPS-gereedschap. Wanneer
de plug-in is geladen zullen twee knoppen met een klein draagbaar GPS-apparaat zichtbaar zijn in de werkbalk:

• Creëer nieuwe GPX-laag

• GPS-gereedschap

Voor het werken met GPS-gegevens verschaffen we een voorbeeld GPX-bestand, beschikbaar in de set met
voorbeeldgegevens van QGIS: qgis_sample_data/gps/national_monuments.gpx. Zie het gedeelte
Voorbeeld Data voor meer informatie over de voorbeeldgegevvens.

1. Selecteer Vector → GPS → GPS-gereedschap of klik op het pictogram GPS-gereedschap in de werkbalk en
open de tab GPX-bestand laden (zie figure_GPS_1).

2. Blader naar de map qgis_sample_data/gps/, selecteer het GPX-bestand
national_monuments.gpx en klik op [Openen].

Gebruik de knop [Bladeren...] om het GPX-bestand te selecteren, gebruik dan de keuzevakken om de typen
objecten te selecteren die u wilt laden vanuit dat GPX-bestand. Elk type object zal in een afzonderlijke laag
worden geladen als u op [OK] klikt. Het bestand national_monuments.gpx bevat alleen waypoints.
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Figuur 15.1: Het dialoogvenster GPS-gereedschap

Notitie: GPS-apparaten stellen u in staat uw gegevens op te slaan in verschillende coördinatensystemen. Zorg
er voor, bij het downloaden van een GPX-bestand (vanaf uw GPS-apparaat of vanaf een website) om het dan te
laden in QGIS, dat de gegevens in het GPX-bestand zijn opgeslagen in de indeling WGS 84 (latitude/longitude).
QGIS verwacht dit en het is de officiële specificatie voor GPX. Zie http://www.topografix.com/GPX/1/1/.

15.1.3 GPSBabel

Omdat QGIS GPX-bestanden gebruikt heeft u een manier nodig om andere bestandsindelingen voor GPS te
converteren naar GPX. Dit kan voor veel indelingen worden gedaan met het gratis programma GPSBabel, dat
beschikbaar is op http://www.gpsbabel.org. Dit programma kan ook GPS-gegevens overdragen tussen uw com-
puter en een GPS-apparaat. QGIS gebruikt GPSBabel om deze dingen te doen, het wordt dus aanbevolen dat u
dit installeert. Als u echter alleen GPS-gegevens vanuit GPX-bestanden wilt laden, heeft u het niet nodig. Van
versie 1.2.3 van GPSBabel is bekend dat die werkt met QGIS, maar u zou latere versies zonder problemen moeten
kunnen gebruiken.

15.1.4 GPS-gegevens importeren

U gebruikt het gereedschap Ander bestand importeren in het dialoogvenster van GPS-gereedschap om GPS-
gegevens te importeren vanuit een bestand dat geen GPX-bestand is. Hier selecteert u het bestand dat u wilt
importeren (en het bestandstype), welk type object u er uit wilt importeren, waar u het geconverteerde GPX-
bestand wilt opslaan en wat de naam van de nieuwe laag moet zijn. Onthoud dat niet alle indelingen voor GPS-
gegevens alle drie de typen objecten ondersteunen, dus voor veel indelingen zult u slechts kunnen kiezen uit één
of twee typen.

15.1.5 GPS-gegevens vanaf een apparaat downloaden

QGIS kan GPSBabel gebruiken om gegevens direct als nieuwe vectorlagen te downloaden vanaf een GPS-
apparaat. Voor dit gebruik zullen we de tab Download van GPS van het dialoogvenster GPS-gereedschap ge-
bruiken (zie Figure_GPS_2). Hier selecteren we het type GPS-apparaat, de poort waarmee die is verbonden (of
USB als uw GPS dat ondersteunt), het type object dat u wilt downloaden, het GPX-bestand waar de gegevens
moeten worden opgeslagen en de naam van de nieuwe laag.

Het type apparaat dat u selecteert in het menu voor het GPS-apparaat bepaalt hoe GPSBabel probeert te commu-
niceren met uw GPS-apparaat. Als geen van de beschikbare typen werkt met uw GPS-apparaat, kunt u een nieuw
type definiëren (zie section Nieuwe typen apparaten definiéren).
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Figuur 15.2: Het gereedschap om te downloaden

De poort mag een bestandsnaam of een andere naam zijn die uw besturingssysteem gebruikt als een verwijzing
naar de fysieke poort op uw computer waarmee het GPS-apparaat is verbonden. Het mag ook eenvoudigweg USB
zijn, voor voor USB geschikte GPS-apparaten.

• Op Linux is het iets als /dev/ttyS0 of /dev/ttyS1.

• Op Windows is het COM1 of COM2.

Wanneer u op [OK] klikt zullen de gegevens worden gedownload vanaf het apparaat en als laag verschijnen in
QGIS.

15.1.6 GPS-gegevens uploaden naar een apparaat

U kunt ook de gegevens direct uploaden vanuit een vectorlaag in QGIS naar een GPS-apparaat met behulp van de
tab Upload naar GPS van het dialoogvenster van GPS-gereedschap. Selecteer eenvoudigweg de laag die u wilt
uploaden (wat een GPX-laag moet zijn), uw type GPS-apparaat en de poort (of USB) waarmee die is verbonden
om dit te doen. Net als met het gereedschap Download, kunt u nieuwe typen apparaten specificeren als uw apparaat
niet in de lijst staat.

Dit gereedschap is heel handig in combinatie met de mogelijkheden voor het bewerken van vectoren van QGIS.
Het stelt u in staat een kaart te laden, waypoints en routes te maken en ze dan weer te uploaden en ze op uw
GPS-apparaat te gebruiken.

15.1.7 Nieuwe typen apparaten definiéren

Er bestaan heel veel verschillende typen GPS-apparaten. De ontwikkelaars van QGIS kunnen ze niet allemaal
testen, dus als u er een heeft die niet werkt met een van de type apparaten die zijn vermeld in de gereedschappen
Download van GPS en Upload naar GPS, kunt u uw eigen type apparaat er voor definiëren U doet dit door de
GPS-apparaatbewerker te gebruiken, die u start door te klikken op de knop [Apparaten bewerken] op de tab
Download of de tab Upload.

U klikt eenvoudigweg op de knop [Nieuw], voert een naam in, voert de opdrachten voor downloaden en uploaden
voor uw apparaat in en klikt op de knop [Bijwerken] om een nieuw apparaat te definiëren,. De naam zal worden
vermeld in de menu’s voor apparaten in de vensters Upload en Download – het mag elke tekenreeks zijn. De
opdracht voor downloaden is de opdracht die wordt gebruikt voor het downloaden van gegevens vanaf het apparaat
naar een GPX-bestand. Dit zal waarschijnlijk een opdracht voor GPSBabel zijn, maar u kunt elk ander programma
voor de opdrachtregel gebruiken dat een GPX-bestand kan maken. QGIS zal de selutelwoorden %type, %in en
%out vervangen wanneer het de opdracht uitvoert.

%type zal worden vervangen door -w als u waypoints download , -r als u routes download en -t als u tracks
download. Dit zijn opties voor de opdrachtregel die GPSBabel vertellen welk type object moet worden gedown-
load.
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%in zal worden vervangen door de naam van de poort die u kiest in het venster Download en %out zal worden
vervangen door de naam die u kiest voor het GPX-bestand waarin de gedownloade gegevens zouden moeten
worden opgeslagen. Dus, als u een type apparaat maakt met de opdracht voor downloaden gpsbabel %type
-i garmin -o gpx %in %out (dit is in feite de opdracht voor downloaden voor het voorgedefinieerde type
apparaat ‘Garmin serial’) en het dan gebruikt om waypoints te downloaden via de poort /dev/ttyS0 naar het
bestand output.gpx, zal QGIS de sleutelwoorden vervangen en de opdracht gpsbabel -w -i garmin
-o gpx /dev/ttyS0 output.gpx uitvoeren.

De opdracht voor uploaden is de opdracht die wordt gebruikt om gegevens naar het apparaat te uploaden. Dezelfde
sleutelwoorden worden gebruikt, maar‘‘%in‘‘ wordt nu vervangen door de naam van het GPX-bestand voor de
laag die wordt geüpload, en %out wordt vervangen door de naam van de poort.

U kunt meer over GPSBabel en de daarvoor beschikbare opties voor de opdrachtregel te weten komen op
http://www.gpsbabel.org.

Als u eenmaal een nieuw type apparaat heeft gemaakt, zal het worden vermeld in de lijsten met apparaten voor de
gereedschappen Download en Upload.

15.1.8 Points/tracks downloaden vanaf GPS-apparaten

As described in previous sections QGIS uses GPSBabel to download points/tracks directly in the project. QGIS
comes out of the box with a pre-defined profile to download from Garmin devices. Unfortunately there is a bug
that does not allow create other profiles, so downloading directly in QGIS using the GPS Tools is at the moment
limited to Garmin USB units.

Garmin GPSMAP 60cs

MS Windows

Installeer de Garmin USB-stuurprogramma’s vanaf http://www8.garmin.com/support/download_details.jsp?id=591

Verbind het apparaat. Open GPS-gereedschap en gebruik type=garmin serial en port=usb: Vul de
velden Laagnaam en Uitvoerbestand. Soms lijkt het problemen te hebben met het opslaan naar een bepaalde map,
het gebruiken van iets als c:\temp werkt gewoonlijk wel.

Ubuntu/Mint GNU/Linux

Het is eerst nodig om een probleem op te lossen voor de rechten van het apparaat, zoals eb-
schreven op https://wiki.openstreetmap.org/wiki/USB_Garmin_on_GNU/Linux. U kunt proberen een bestand
/etc/udev/rules.d/51-garmin.rules te maken dat deze regel bevat

ATTRS{idVendor}=="091e", ATTRS{idProduct}=="0003", MODE="666"

Daarna is het nodig u er van te overtuigen dat de kernelmodule garmin_gps niet is geladen

rmmod garmin_gps

and then you can use the GPS Tools. Unfortunately there seems to be a bug and usually QGIS freezes several
times before the operation work fine.

BTGP-38KM gegevenslogger (alleen Bluetooth)

MS Windows

Het reeds vermelde probleem staat niet toe dat gegevens vanuit QGIS worden gedownload, dus is het nodig om
GPSBabel vanaf de opdrachtregel te gebruiken of de interface ervan te gebruiken. De werkende opdracht is

gpsbabel -t -i skytraq,baud=9600,initbaud=9600 -f COM9 -o gpx -F C:/GPX/aaa.gpx
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Ubuntu/Mint GNU/Linux

gebruik dezelfde opdracht (of instellingen als u de GPSBabel GUI gebruikt) als in Windows. Op Linux kan het
voorkomen dat u een bericht krijgt als

skytraq: Too many read errors on serial port

het is slechts een kwestie van het uit- en opnieuw inschakelen van de gegevenslogger en opnieuw proberen.

BlueMax GPS-4044 gegevenslogger (zowel BT als USB)

MS Windows

Notitie: Het moet vóóraf zijn stuurprogramma’s installeren om het te kunnen gebruiken op Windows 7. Bekijk
de site van de leverancier voor de juiste download.

Downloaden met GPSBabel, zowel met USB als met BT, geeft altijd een fout terug die lijkt op

gpsbabel -t -i mtk -f COM12 -o gpx -F C:/temp/test.gpx
mtk_logger: Can’t create temporary file data.bin
Error running gpsbabel: Process exited unsucessfully with code 1

Ubuntu/Mint GNU/Linux

Met USB

Gebruik, nadat de kabel is verbonden, de opdracht dmesg om te zien welke poort zal worden gebruikt, bijvoor-
beeld /dev/ttyACM3. Gebruik dan, zoals gewoonlijk, GPSBabel vanaf de opdrachtregel of met de GUI

gpsbabel -t -i mtk -f /dev/ttyACM3 -o gpx -F /home/user/bluemax.gpx

Met Bluetooth

Gebruik Blueman Device Manager om het apparaat te paren en het beschikbaar te maken via een systeempoort,
voer dan GPSBabel uit

gpsbabel -t -i mtk -f /dev/rfcomm0 -o gpx -F /home/user/bluemax_bt.gpx

.

15.2 GPS-informatie

U moet Beeld → Panelen GPS-informatie selecteren om het live volgen van GPS in QGIS te activeren. U zult
een nieuw vastgezet venster aan de linkerkant van het kaartvenster krijgen.

Er zijn vier mogelijke schermen in het venster van GPS-informatie:

• GPS-positie coördinaten en een interface voor het handmatig invoeren van vertices en objecten

• GPS signaalsterkte van satellietverbindingen

• GPS satellietscherm dat aantal en positie van de satellieten weergeeft

• GPS scherm Opties (zie figure_gps_options)

Met een aangesloten GPS-ontvanger (moet worden ondersteund door uw besturingssysteem) verbindt een een-
voudige klik op [Verbinden] de GPS met QGIS. Een tweede klik (nu op [Verbinding verbreken]) verbreekt de
verbinding van de GPS-ontvanger met uw computer. Voor GNU/Linux is ondersteuning voor gpsd geïntegreerd
om de verbinding te ondersteunen met de meeste GPS-ontvangers. Daarom moet u eerst gpsd correct configureren
om QGIS daarmee te kunnen verbinden.
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Waarschuwing: Als u uw positie op het kaartvenster wilt opnemen, dient u eerste een nieuwe vectorlaag te
maken en die overschakelen naar de bewerkbare status om uw spoor op te kunnen nemen.

15.2.1 Positie en aanvullende attributen

Als de GPS signalen van satellieten ontvangst, zult u uw positie zien in breedtegraad, lengtegraad en hoogte,
tezamen met aanvullende attributen.

Figuur 15.3: GPS-informatie en aanvullende attributen

15.2.2 GPS signaalsterkte

Hier ziet u de signaalsterkte van de satellieten waarvan u signalen ontvangt.

Figuur 15.4: GPS -informatie signaalsterkte
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15.2.3 GPS venster Satelliet

Als u wilt weten waar alle verbonden satellieten staan aan de hemel, moet u omschakelen naar het venster
Satelliet. U kunt ook de ID-nummers zien van de satellieten waarvan u signalen ontvangt.

Figuur 15.5: GPS-informatie venster Satelliet

15.2.4 GPS-opties

In geval van problemen met verbindingen kunt u schakelen tussen:

• Automatisch detecteren

• Intern

• Serieel apparaat

• gpsd (selecteren van de host, poort en apparaat waarmee uw GPS is verbonden)

Een klik op [Verbinden] initieert opnieuw de verbinding naar de GPS-ontvanger.

U kunt Bewaar toegevoegd object automatisch activeren wanneer u in de modus Bewerken bent. Of u kunt

activeren Voeg automatisch punten toe aan het kaartvenster met een bepaalde breedte en kleur.

Met het activeren van Cursor kunt u een schuifbalk gebruiken om de positiecursor in het
kaartvenster te verkleinen en te vergroten.

Activeren van Kaart hercentreren stelt u in staat om te bepalen op welke manier het kaartvenster zal worden
bijgewerkt. Dit bevat ‘altijd’, ‘wanneer buiten’, als u uw opgenomen coördinaten begint te verplaatsen tot buiten
het kaartvenster, of ‘nooit’ om het kaartbereik te behouden.

Tenslotte kunt u Logbestand activeren en een pad en bestand definiëren waar logberichten over het volgen van
GPS worden gelogd.

Als u handmatig een object wilt instellen, moet u teruggaan naar Positie en klikken op [Object toevoegen] of
[Trackpunt toevoegen].

15.2.5 Verbinden met een Bluetooth GPS voor live volgen

Met QGIS kunt u verbinden met een Bluetooth GPS voor het verzamelen van gegevens in het veld. U heeft een
apparaat voor GPS Bluetooth en een ontvanger voor Bluetooth op uw computer nodig om deze taak uit te kunnen
voeren.
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Figuur 15.6: GPS-informatie venster Opties
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Als eerste moet u uw GPS-apparaat laten herkennen en paren aan de computer. Schakel de GPS in, ga naar het
pictogram Bluetooth in uw systeemvak en zoek naar een Nieuw apparaat.

Zorg er voor, aan de rechterkant van het masker voor selecteren van een apparaat, dat alle apparaten zijn gese-
lecteerd, zodat uw GPS-eenheid waarschijnlijk tussen de beschikbare wordt weergegeven. In de volgende stap
zou een seriële verbindingsservice beschikbaar moeten zijn, selecteer die en klik op de knop [Configureren] .

Onthoudt het nummer van de COM-poort die is toegewezen aan de GPS-verbinding, zoals dat als resultaat wordt
weergegeven door de eigenschappen van Bluetooth.

Nadat de GPS is herkend, verzorg het paren van de verbinding. De activatiecode is gewoonlijk 0000.

Now open :guilabel:‘GPS information‘panel and switch to GPS options screen. Select the COM port assigned
to the GPS connection and click the [Connect]. After a while a cursor indicating your position should appear.

Als QGIS geen gegevens van GPS kan ontvangen, zou u uw GPS-apparaat opnieuw moeten inschakelen, 5-10
seconden wachten en dan opnieuw moeten proberen te verbinden. Normaal gesproken werkt deze oplossing. Als
u opnieuw een verbindingsfout ontvangt, zorg er dan voor dat er geen andere Bluetooth-ontvanger in de buurt is,
die gepaard is met dezelfde GPS-eenheid.

15.2.6 GPSMAP 60cs gebruiken

MS Windows

Eenvoudigste manier om het te laten werken is door een middleware te gebruiken (freeware, geen open bron)
genaamd GPSGate.

Start het programma, zorg dat het scant naar GPS-apparaten (werkt voor zowel USB als die van BT) en klik dan
in QGIS eenvoudigweg op [Verbinden] in het paneel GPS-informatie met behulp van de modus Automatisch
detecteren.

Ubuntu/Mint GNU/Linux

Net als voor Windows is de eenvoudigste manier om een server in het midden te gebruiken, in dit geval GPSD,
dus

sudo apt-get install gpsd

Laad dan de kernelmodule garmin_gps

sudo modprobe garmin_gps

En verbind dan de eenheid. Controleer dan met dmesg het actuele apparaat dat wordt gebruikt door de eenheid,
bijvoorbeeld /dev/ttyUSB0. Nu kunt u gpsd starten

gpsd /dev/ttyUSB0

En verbind tenslotte met het QGIS gereedschap GPS-informatie.

15.2.7 BTGP-38KM gegevenslogger gebruiken (alleen Bluetooth)

Het gebruiken van GPSD (onder Linux) of GPSGate (onder Windows) vereist geen inspanningen.

15.2.8 BlueMax GPS-4044 gegevenslogger gebruiken (zowel BT als USB)

MS Windows

GPS-informatie werkt voor zowel de modus USB als modus BT door GPSGate te gebruiken, of zelfs zonder,
gebruik eenvoudigweg de modus Automatisch detecteren, of wijs aan het gereedschap de juiste poort toe.
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Ubuntu/Mint GNU/Linux

Voor USB

GPS-informatie werkt met zowel GPSD

gpsd /dev/ttyACM3

of zonder, door het QGIS gereedschap GPS-informatie rechtstreeks te verbinden met het apparaat (bijvoorbeeld
/dev/ttyACM3).

Voor Bluetooth

GPS-informatie werkt met zowel GPSD

gpsd /dev/rfcomm0

of zonder, door het QGIS gereedschap GPS-informatie rechtstreeks te verbinden met het apparaat (bijvoorbeeld
/dev/rfcomm0).

.
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Integratie van GRASS GIS

De plug-in GRASS verschaft toegang tot GRASS GIS-databases en functionaliteiten (zie GRASS-PROJECT in
Verwijzingen naar literatuur en web). Dit omvat het visualiseren van GRASS raster- en vectorlagen, digitaliseren
van vectorlagen, bewerken van attributen van vectors, maken van nieuwe vectorlagen en analyseren van GRASS
2D- en 3D-gegevens met meer dan 400 modules voor GRASS.

In dit gedeelte zullen we de functionaliteiten van de plug-in introduceren en enkele voorbeelden geven van het
beheren en werken met gegevens voor GRASS. De volgende belangrijkste mogelijkheden worden verschaft door
het menu van de werkbalk als u de plug-in GRASS start, zoals beschreven in het gedeelte sec_starting_grass:

• Mapset openen

• Nieuwe mapset

• Mapset sluiten

• GRASS–Vectorlaag toevoegen

• GRASS–Rasterlaag toevoegen

• Nieuwe GRASS vector maken

• GRASS–Vectorlaag bewerken

• GRASS–gereedschap openen

• Huidige GRASS-regio weergeven

• Huidige GRASS-regio bewerken

16.1 De plug-in GRASS starten

U moet de plug-in GRASS selecteren en laden met Beheer en installeer plugins om functionaliteiten van GRASS
te gebruiken en/of om GRASS vector- en rasterlagen in QGIS te visualiseren. Ga daarom naar het menu Plugins

→ beheer en installeer plugins, selecteer GRASS en klik op [OK].

U kunt nu beginnen met het laden van raster- en vectorlagen vanuit een bestaande GRASS LOCATION (zie
gedeelte sec_load_grassdata). Of u kunt een nieuwe GRASS LOCATION maken met QGIS (zie gedeelte Maken
van een nieuwe GRASS LOCATION) en enkele raster- en vectorgegevens importeren (zie gedeelte Importeren van
gegevens in een GRASS LOCATION) voor verdere analyse met de Toolbox voor GRASS (zie gedeelte De Toolbox
voor GRASS).
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16.2 GRASS raster- en vectorlagen laden

Met de plug-in GRASS kunt u vector- of rasterlagen laden met behulp van de toepasselijke knop in het menu van de
werkbalk. Als een voorbeeld zullen we de gegevensset Alaska van QGIS gebruiken (zie gedeelte Voorbeeld Data).
Het omvat een kleine voorbeeld van een GRASS LOCATION met drie vectorlagen en één raster hoogtekaart.

1. Maak een nieuwe map genaamd grassdata, download de gegevensset QGIS ‘Alaska’
qgis_sample_data.zip vanaf http://download.osgeo.org/qgis/data/ en pak het bestand uit in
grassdata.

2. Start QGIS.

3. Indien dat nog niet in een eerdere sessie van QGIS is gedaan, laad de plug-in GRASS door te klikken op

Plugins → Beheer en installeer plugins en activeer GRASS. De werkbalk voor GRASS verschijnt
in het hoofdvenster van QGIS.

4. Klik, op de werkbalk van GRASS, op het pictogram Mapset openen om de assistent MAPSET te laten
verschijnen.

5. Voor Gisdbase: blader en selecteer of voer het pad in naar de nieuw gemaakte map grassdata.

6. U zou nu in staat moeten zijn om LOCATION alaska en MAPSET demo te selecteren.

7. Klik op [OK]. Merk op dat enkele eerder nog uitgeschakelde gereedschappen op de werkbalk van GRASS
nu zijn ingeschakeld.

8. Klik op GRASS–Rasterlaag toevoegen, kies de kaartnaam gtopo30 en klik op [OK]. De hoogtelaag zal worden
gevisualiseerd.

9. Klik op GRASS–Vectorlaag toevoegen, kies de map alaska en klik op [OK]. De vectorlaag met grenzen van
Alaska zal bovenop de kaart gtopo30worden gelegd. U kunt nu de eigenschappen voor de laag aanpassen,
zoals beschreven in het hoofdstuk Het dialoogvenster Vectoreigenschappen (bijv., de transparantie wijzigen,
kleuren voor de vulling en randen).

10. Laad ook de andere twee vectorlagen, rivers en airports, en pas hun eigenschappen aan.

Zoals u ziet is het zeer eenvoudig om raster- en vectorlagen uit GRASS te laden in QGIS. Bekijk de volgende
gedeelten voor het bewerken gegevens van GRASS en maak een nieuwe LOCATION. Meer voorbeelden van
GRASS LOCATION’s zijn beschikbaar op de website van GRASS op http://grass.osgeo.org/download/sample-
data/.

Tip: GRASS–Laden van gegevens
Als u problemen hebt met het laden van gegevens of QGIS breekt abnormaal af, controleer dan om er zeker van
te zijn dat u de plug-in GRASS juist heeft geladen, zoals beschreven in het gedeelte sec_starting_grass.

16.3 GRASS LOCATION en MAPSET

Gegevens voor GRASS worden opgeslagen in een map waarnaar wordt verwezen als GISDBASE. Deze map,
vaak grassdata genaamd, moet worden gemaakt vóórdat u met de plug-in GRASS gaat werken in QGIS.
Binnen deze map zijn de GIS-gegevens van GRASS georganiseerd in projecten die zijn opgeslagen in submappen,
genaamd LOCATION’s. Elke LOCATION wordt gedefinieerd door zijn coördinatensysteem, kaartprojectie en
geografische grenzen. Elke LOCATION kan verscheidene MAPSET’s (submappen van LOCATION) hebben, die
worden gebruikt om het project op te delen in verschillende onderwerpen of subregio’s, of als werkruimte voor
individuele teamleden (zie Neteler & Mitasova 2008 in Verwijzingen naar literatuur en web). , U moet, om vector-
en rasterlagen met modules van GRASS te analyseren, ze importeren in een GRASS LOCATION. (Dit is niet
helemaal waar – met de modules voor GRASS r.external en v.external kunt u koppelingen maken die
alleen-lezen zijn naar externe gegevenssets, die door GDAL/OGR ondersteund worden, zonder ze te importeren.
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maar omdat dat niet de normale manier voor beginners is om te werken met GRASS, zal deze functionaliteit hier
niet worden beschreven.)

Figuur 16.1: Gegevens voor GRASS op de LOCATION alaska

16.3.1 Maken van een nieuwe GRASS LOCATION

Als voorbeeld is hier hoe het voorbeeld GRASS LOCATION alaska, wat is geprojecteerd in de projectie Al-
bers Equal Area met de eenheid feet werd gemaakt voor de voorbeeldset voor QGIS. Dit voorbeeld GRASS
LOCATION alaska zal worden gebruikt voor alle voorbeelden en oefeningen in de volgende aan GRASS gere-
lateerde gedeelten. Het is nuttig om de gegevensset naar uw computer te downloaden en te installeren (zie Voor-
beeld Data).

1. Start QGIS en zorg er voor dat de plug-in GRASS is geladen.

2. Visualiseer het shapefile alaska.shp (ziee gedeelte vector_load_shapefile) uit de gegevensset Alaska
van QGIS (zie Voorbeeld Data).

3. Klik, op de werkbalk van GRASS, op het pictogram Nieuwe mapset om de assistent MAPSET te laten
verschijnen.

4. Selecteer een bestaande GRASS-database (GISDBASE) map grassdata, of maak een nieuwe
LOCATION met behulp van een bestandsbeheerder op uw computer. Klik dan op [Next].

5. We kunnen deze assistent gebruiken om een nieuwe MAPSET binnen een bestaande LOCATION te maken
(zie het gedeelte Toevoegen van een nieuwe MAPSET) of om een geheel nieuwe LOCATION te maken.
Selecteer Nieuwe locatie maken (zie figure_grass_location_2).

6. Voer een naam in voor de LOCATION – wij gebruikten ‘alaska’ – en klik op [Next].

7. Definieer de projectie door te klikken op de optieknop Projectie om de lijst met projecties in te schakelen.

8. We gebruiken de projectie Albers Equal Area Alaska (feet). Omdat wij weten dat die wordt weergegeven
door de EPSG ID 2964, voeren we die in het zoekvak in. (Opmerking: Als u dit proces wilt herhalen voor

een andere LOCATION en projectie en vergeten bent het EPSG ID te onthouden, klik op het pictogram
CRS Status in de rechter benedenhoek van de statusbalk (zie gedeelte Werken met Projecties)).

9. In Filter, voer 2964 in om de projectie te selecteren.

10. Klik op [Next].

11. We moeten de grenzen voor de LOCATION in de richtingen Noord, Zuid, Oost en West invoeren, om de
standaard regio te definiëren. Hier klikken we eenvoudigweg op de knop [Gebruik huidige |qg| -bereik],
om het bereik van de geladen laag alaska.shp als bereik voor de standaard regio in GRASS toe te passen.
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12. Klik op [Next].

13. We moeten ook een MAPSET definiëren binnen onze nieuwe LOCATION (dit is nodig bij het maken van
een nieuwe LOCATION). U mag het de naam geven die u wilt - wij gebruikten ‘demo’. GRASS maakt
automatisch een speciale MAPSET, genaamd PERMANENT, ontworpen om de brongegevens voor het project
op te slaan, het standaard ruimtelijke bereik en de definities van het coördinatensysteem (zie Neteler &
Mitasova 2008 in Verwijzingen naar literatuur en web).

14. Controleer de samenvatting om te zien of die juist is en klik op [Finish].

15. De nieuwe LOCATION, ‘alaska’, en de twee MAPSETs, ‘demo’ en ‘PERMANENT’, zijn gemaakt. De
momenteel geopende werkset is ‘demo’, zoals u heeft gedefinieerd.

16. Merk op dat enkele gereedschappen op de werkbalk van GRASS, die uitgeschakeld waren, nu zijn in-
geschakeld.

Figuur 16.2: Maken van een nieuwe GRASS LOCATION of een nieuwe MAPSET in QGIS

Als dat veel stappen lijken te zijn, het is eigenlijk niet zo slecht en een hele snelle manier om een LOCATION
te maken. De LOCATION ‘alaska’ is nu gereed voor het importeren van gegevens (zie gedeelte Importeren van
gegevens in een GRASS LOCATION). U kunt ook de reeds bestaande vector- en rastergegevens gebruiken uit het
voorbeeld van GRASS LOCATION ‘alaska’, opgenomen in de gegevensset ‘Alaska’ van QGIS Voorbeeld Data,
en doorgaan naar het gedeelte Het GRASS vectorgegevensmodel.

16.3.2 Toevoegen van een nieuwe MAPSET

Een gebruiker heeft alleen schrijfrechten voor een MAPSET van GRASS die hij of zij zelf heeft gemaakt. Dit
betekent dat, naast toegang tot uw eigen MAPSET, u mappen in MAPSET’s van andere gebruikers kunt lezen (en
zij kunnen die van u lezen), maar u kunt alleen mappen aanpassen of verwijderen vanuit uw eigen MAPSET.

Alle MAPSET’s bevatten een bestand WIND dat de huidige waarden voor coördinaten voor de grenzen opslaat en
de huidige geselecteerd rasterresolutie (zie Neteler & Mitasova 2008 in Verwijzingen naar literatuur en web, en
het gedeelte Het GRASS–gereedschap regio).

1. Start QGIS en zorg er voor dat de plug-in GRASS is geladen.

2. Klik, op de werkbalk van GRASS, op het pictogram Nieuwe mapset om de assistent MAPSET te laten
verschijnen.

3. Selecteer de GRASS database (GISDBASE)-map grassdata met de LOCATION ‘alaska’, waar we nog
een MAPSET zullen toevoegen, genaamd ‘test’.

4. Klik op [Next].
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5. We kunnen deze assistent gebruiken om een nieuwe MAPSET binnen een bestaande LOCATION te maken
of om een geheel nieuwe LOCATION te maken. Klik op de optieknop Selecteer een locatie (zie fig-
ure_grass_location_2) en klik op [Next].

6. Voer de naam text in voor de nieuwe MAPSET. Onder in de assistent ziet u een lijst van bestaande
MAPSET’s en corresponderende eigenaren.

7. Klik op [Next], controleer de samenvatting om te zien of die juist is en klik op [Finish].

16.4 Importeren van gegevens in een GRASS LOCATION

Dit gedeelte geeft een voorbeeld van hoe raster- en vectorgegevens te importeren in de ‘alaska’ GRASS
LOCATION verschaft door de gegevensset ‘Alaska’ van QGIS. Daarom gebruiken we de rasterkaart voor landbe-
dekking landcover.img en het vector GML-bestand lakes.gml uit de gegevensset ‘Alaska’ van QGIS (zie
Voorbeeld Data).

1. Start QGIS en zorg er voor dat de plug-in GRASS is geladen.

2. Klik, op de werkbalk van GRASS, het pictogram Mapset openen om de assistent MAPSET te laten zien.

3. Selecteer als database van GRASS de map grassdata in de gegevensset Alaska van QGIS, als
LOCATION ‘alaska’, als MAPSET ‘demo’ en klik op [OK].

4. Klik nu op het pictogram GRASS–gereedschap openen. het dialoogvenster van de Toolbox van GRASS (zie
gedeelte De Toolbox voor GRASS) verschijnt.

5. Klik op de module r.in.gdal op de tab Modulen Boom om de rasterkaart landcover.img te im-
porteren. Deze module voor GRASS stelt u in staat GDAL-ondersteunde rasterbestanden te importeren in
een LOCATION van GRASS. Het dialoogvenster voor de module r.in.gdal verschijnt.

6. Blader naar de map raster in de gegevensset ‘Alaska’ van QGIS en selecteer het bestand
landcover.img.

7. Definieer, als naam voor het raster-uitvoerbestand, landcover_grass en klik op [Uitvoeren].
Op de tab Output ziet u de momenteel uitgevoerde opdracht voor GRASS r.in.gdal -o
input=/pad/naar/landcover.img output=landcover_grass.

8. Klik, wanneer het zegt Succesvol geëindigd, op [Uitvoer bekijken]. De rasterlaag landcover_grass
is nu geïmporteerd in GRASS en zal worden gevisualiseerd in het kaartvenster van QGIS.

9. Klik op de module v.in.ogr op de tab Modulen Boom om het vector GML-bestand lakes.gml te
importeren. Deze module voor GRASS stelt u in staat OGR-ondersteunde vectorbestanden te importeren in
een LOCATION van GRASS. Het dialoogvenster voor de module v.in.ogr verschijnt.

10. Blader naar de map gml in de gegevensset ‘Alaska’ van QGIS en selecteer het bestand lakes.gml als
OGR-bestand.

11. Definieer, als naam voor het vector-uitvoerbestand, lakes_grass en klik op [Uitvoeren]. U hoeft zich in
dit voorbeeld geen zorgen te maken over de andere opties. Op de tab Output ziet u de momenteel uitgevoerde
opdracht van GRASS v.in.ogr -o dsn=/pad/naar/lakes.gml output=lakes\_grass.

12. Klik, wanneer het zegt Succesvol geëindigd, op [Uitvoer bekijken]. De vectorlaag lakes_grass is nu
geïmporteerd in GRASS en zal worden gevisualiseerd in het kaartvenster van QGIS.

16.5 Het GRASS vectorgegevensmodel

Het is belangrijk om, voorafgaande aan het digitaliseren, het GRASS vectorgegevensmodel te bergijpen.

In het algemeen gebruikt GRASS een topologisch vectormodel.

Dit betekent dat gebieden niet worden weergegeven als gesloten polygonen, maar door één of meer grenzen. Een
grens tussen twee aaneengesloten gebieden wordt slechts één maal gedigitaliseerd, en het wordt gedeeld door
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beide gebieden. grenzen moeten zijn verbonden en zonder gaten zijn gesloten. Een gebied wordt geïdentificeerd
(en gelabeld) door het zwaartepunt van het gebied.

Naast grenzen en zwaartepunten kan een vectorkaart ook punten en lijnen bevatten. Al deze elementen voor
geometrie kunnen worden gemixt in één vector en zullen worden weergegeven in verschillende, zogenaamde
‘lagen’, binnen één vectorkaart van GRASS. Dus in GRASS, is een laag geen vector- of rasterkaart, maar een
niveau binnen een vectorlaag. Het is belangrijk om dit verschil zorgvuldig te onderscheiden. (Hoewel het mogelijk
is om elementen voor geometrie te mixen, het is ongebruikelijk en, zelfs in GRASS, alleen gebruikt in speciale
gevallen, zoals vector netwerkanalyses. Normaal gesproken zou u de voorkeur hebben voor het opslaan van
verschillende elementen voor geometrie in verschillende lagen.)

Het is mogelijk om verscheidene ‘lagen’ op te slaan in één vector-gegevensset. Bijvoorbeeld: velden, bossen en
meren kunnen worden opgeslagen in één vector. Een aansluitend bos en meer kunnen dezelfde grens delen, maar
zij hebben afzonderlijk attributentabellen. Het is ook mogelijk attributen te verbinden aan grenzen. Een voorbeeld
zou kunnen zijn het geval waar de grens tussen een meer en een bos een weg is, dus kan het een verschillende
attributentabel hebben.

De ‘laag’ van het object wordt gedefinieerd door de ‘laag’ binnen GRASS. ‘Laag’ is het getal dat definieert of er
meer dan één laag binnen de gegevensset is (bijv., als de geometrie bos of meer is). Momenteel mag het alleen
een getal zijn. In de toekomst zal GRASS ook namen als velden in de gebruikersinterface ondersteunen.

Attributen kunnen binnen de LOCATION van GRASS worden opgeslagen als dBase of SQLite3 of in externe
databasetabellen, bijvoorbeeld PostgreSQL, MySQL, Oracle, etc.

Attributen in databasetabellen worden aan elementen van geometrie gekoppeld door middel van een waarde ‘cat-
egorie’.

‘Category’ (sleutel, ID) is een integer die is verbonden met geometrie-primitieven, en het wordt gebruikt als de
koppeling naar één sleutelkolom in de databasetabel.

Tip: Het GRASS vectorgegevensmodel leren
De beste manier om het vectormodel van GRASS en de mogelijkheden daarvan is om één van de
vele handleidingen voor GRASS te downloaden waar het vectormodel dieper wordt beschreven. Zie
http://grass.osgeo.org/documentation/manuals/ voor meer informatie, boeken en handleidingen in verschillende
talen.

16.6 Maken van een nieuwe GRASS vectorlaag

Klik, om een nieuwe vectorlaag voor GRASS met de plug-in GRASS te maken, op het pictogram van de werkbalk
Nieuwe GRASS vector maken. Voer in het tekstvak een naam in en u kunt beginnen met het digitaliseren van geome-

trieën punt, lijn of polygoon, volgens de procedure die is beschreven in het gedeelte Digitaliseren en bewerken
van een GRASS vectorlaag.

In GRASS is het mogelijk alle soorten typen geometrie (punt, lijn en gebied) te beheren in één laag, omdat
GRASS een topologisch vectormodel gebruikt, dus hoeft u niet het type geometrie te selecteren bij het maken
van een nieuwe vector in GRASS. Dit verschilt van het maken van een shapefile met QGIS, omdat shapefiles het
vectormodel Eenvoudig object gebruiken (zie het gedeelte Het aanmaken van een nieuwe Vectorlagen).

Tip: Een attributentabel maken voor een nieuwe GRASS vectorlaag
Als u attributen wilt toewijzen aan uw gedigitaliseerde geometrie-objecten, zorg er dan voor dat u een attribu-
tentabel met kolommen hebt gemaakt vóórdat u begint met digitaliseren (zie figure_grass_digitizing_5).
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16.7 Digitaliseren en bewerken van een GRASS vectorlaag

Het gereedschap voor het digitaliseren van GRASS vectorlagen is toegankelijk met behulp van het pictogram
GRASS–Vectorlaag bewerken op de werkbalk. Zorg er voor dat u een GRASS vector heeft geladen en dat het

de geselecteerde laag in de legenda is vóórdat u op het gereedschap voor bewerken klikt. Afbeelding fig-
ure_grass_digitizing_2 geeft het dialoogvenster GRASS Bewerken weer dat wordt weergegeven wanneer u op
het gereedschap voor bewerken klikt. Het gereedschap en de instellingen worden in de volgende gedeelten be-
sproken.

Tip: Digitaliseren van polygonen in GRASS
Wanneer u een polygoon wilt maken in GRASS, digitaliseert u eerst de grens van de polygoon en stelt de modus
in op ‘Geen categorie’. Dan voegt u een zwaartepunt (labelpunt) in de gesloten begrenzing in en stelt de modus in
op ‘Volgende niet gebruikt’. De reden hiervoor is dat een topologisch vectormodel de informatie voor het attribuut
van een polygoon altijd koppelt aan het zwaartepunt en niet aan de grens.

Werkbalk

In figure_grass_digitizing_1, ziet u de pictogrammen voor de werkbalk Digitaliseren voor GRASS, die wor-
den verschaft door de plug-in GRASS. Tabel table_grass_digitizing_1 verklaart de beschikbare functionaliteiten.

Figuur 16.3: GRASS Werkbalk Digitaliseren

Pic-
togram

Gereed-
schap

Doel

Nieuw punt Nieuw punt digitaliseren

Nieuwe lijn Nieuwe lijn digitaliseren

Nieuwe grens Nieuwe grens digitaliseren (voltooien door nieuw gereedschap te kiezen)

Nieuw
zwaartepunt

Nieuw zwaartepunt digitaliseren (label bestaand gebied)

Punt
verplaatsen

Verplaats één punt of bestaande lijn of grens en identificeer de nieuwe positie

Punt
toevoegen

Voeg een nieuw punt toe aan bestaande lijn

Punt
verwijderen

Verwijder punt uit bestaande lijn (bevestig te verwijderen punt door nog een klik)

Element
verplaatsen

Verplaats geselecteerde grens, lijn, punt of zwaartepunt en klik op de nieuwe
positie

Lijn splitsen Een bestaande lijn in twee delen splitsen

Element
verwijderen

Verwijder bestaande grens, lijn, punt of zwaartepunt (bevestig geselecteerde
element door nog een klik)

Attributen
bewerken

Bewerk attributen van het geselecteerde element (onthoud dat één element
meerdere objecten kan weergeven, zie boven)

Sluiten Sluit de sessie af en sla de huidige status op (bouwt topologie nadien nogmaals
op)

Tabel GRASS Digitaliseren 1: GRASS Gereedschap Digitaliseren

Tab Category
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De tab Category stelt u in staat de manier te definiëren waarop de waarden van de categorie zullen worden
toegewezen aan het nieuwe geometrie-element.

Figuur 16.4: GRASS Digitaliseren tab Categorie

• Modus: De waarde voor de categorie die zal worden toegepast op nieuwe elementen van geometrie.

– Volgende niet gebruikt - Toepassen van de categorie Volgende niet gebruikt op element van geometrie.

– Handmatige invoer - definieer handmatig de waarde voor de categorie voor het element van geometrie
in het invoerveld ‘Categorie’.

– Geen categorie - Pas geen waarde voor de categorie toe op het element van geometrie. Dit wordt,
bijvoorbeeld, gebruikt voor gebiedsgrenzen, omdat de waarden voor de categorie worden verbonden
via het zwaartepunt.

• Categorie - Het getal (ID) dat is gekoppeld aan elk gedigitaliseerd element van geometrie. Het wordt
gebruikt om elk element van geometrie met zijn attributen te verbinden.

• Laag - Elk element van geometrie kan worden verbonden met verscheidene attributentabellen door middel
van verschillende geometrielagen van GRASS. Het standaard laagnummer is 1.

Tip: Een aanvullende ‘laag’ van GRASS maken met |qg|
Als u meer lagen zou willen toevoegen aan uw gegevensset, voeg dan gewoon een nieuw nummer in in het
invoervak ‘Laag’ en druk op Return. Op de tab Tabel kunt u uw nieuwe tabel maken die wordt verbonden met uw
nieuwe laag.

Tab Extra

De tab Extra stelt u in staat om het ‘snappen’ in te stellen op schermpixels. De drempelwaarde definieert op welke
afstand nieuwe punten of einden van lijnen zullen worden ‘gesnapt’ aan bestaande knopen. Dit helpt om gaten of
hangende uiteinden tussen grenzen te voorkomen. De standaard is ingesteld op 10 pixels.

**Tab Symbologie **

De tab Symbologie stelt u in staat instellingen voor symbologie en kleur te bekijken en in te stellen voor verschil-
lende typen geometrie en hun topologische status (bijv., gesloten / geopende grens).

**Tab Tabel **

De tab Tabel verschaft informatie over de databasetabel voor een opgegeven ‘laag’. Hier kunt u nieuwe kolommen
toevoegen aan een bestaande attributentabel, of een nieuwe databasetabel maken voor een nieuwe vectorlaag in
GRASS (zie gedeelte Maken van een nieuwe GRASS vectorlaag).

Tip: GRASS Rechten voor bewerken
U moet de eigenaar zijn van de MAPSET van GRASS die u wilt bewerken. Het is onmogelijk om gegevenslagen
te bewerken in een MAPSET die niet van u is, zelfs niet als u schrijfrechten heeft.
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Figuur 16.5: GRASS Digitaliseren tab Extra

Figuur 16.6: GRASS Digitaliseren tab Symbologie

Figuur 16.7: GRASS Digitaliseren tab Tabel
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16.8 Het GRASS–gereedschap regio

De definitie van een regio (instellen van een ruimtelijk werkvenster) in GRASS is belangrijk voor het werken
met rasterlagen. Vectoranalyses zijn standaard niet beperkt tot definities van gedefinieerde regio´s. Maar alle
nieuwe gemaakte rasters zullen de ruimtelijke extensie en resolutie van de huidige gedefinieerde regio in GRASS
hebben, ongeacht hun originele extensie en resolutie. De huidige regio van GRASS is opgeslagen in het bestand
$LOCATION/$MAPSET/WIND, en het definieert de grenzen voor Noord, Zuid, Oost en West, aantal kolommen
en rijen, horizontale en verticale ruimtelijke resolutie.

Het is mogelijk de visualisatie van de regio van GRASS in het kaartvenster van QGIS in of uit te schakelen met

behulp van de knop Toon huidige GRASS-regio.

Met het pictogram Huidige GRASS-regio bewerken kunt u een dialoogvenster openen om de huidige regio en de sym-
bologie van de rechthoek van de regio van GRASS in het kaartvenster van QGIS te wijzigen. Type de nieuwe
grenzen voor de regio en resolutie in en klik op [OK]. Het dialoogvenster stelt u ook in staat, interactief met uw
muis, een nieuwe regio te selecteren in het kaartvenster van QGIS. Klik daarom met de linker muisknop in het
kaartvenster van QGIS, open een rechthoek, sluit die met opnieuw de linker muisknop en klik op [OK].

De module voor GRASS g.region verschaft nog veel meer parameters om een toepasselijk bereik voor een
regio en resolutie voor uw rasteranalyses te definiëren. U kunt deze parameters gebruiken met de Toolbox voor
GRASS, beschreven in het gedeelte De Toolbox voor GRASS.

16.9 De Toolbox voor GRASS

Het vak GRASS-gereedschap openen verschaft functionaliteiten voor modules van GRASS om met gegevens binnen
een geselecteerde LOCATION en MAPSET voor GRASS te werken. U dient een LOCATION en MAPSET te openen
waarvoor u schrijfrechten heeft toegekend gekregen (gewoonlijk toegekend als u de MAPSET zelf maakte) om de
Toolbox voor GRASS te kunnen gebruiken. Dit is nodig omdat nieuwe raster- of vectorlagen die worden gemaakt
gedurende analyses moeten worden weggeschreven naar de momenteel geselecteerde LOCATION en MAPSET.

Figuur 16.8: GRASS Toolbox en Moduleboom
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16.9.1 Werken met modules van GRASS

De GRASS-shell binnen de Toolbox voor GRASS verschaft toegang tot bijna alle (meer dan 300) modules voor
GRASS in een interface voor de opdrachtregel. Ongeveer 200 van de beschikbare modules en functionaliteiten
voor GRASS zijn ook voorzien van grafische dialoogvensters binnen de Toolbox van de plug-in GRASS om een
meer gebruikersvriendelijker werkomgeving te bieden.

Een volledige lijst van modules voor GRASS die beschikbaar zijn in de grafische Toolbox in QGIS versie 2.2 is
beschikbaar op de wiki van GRASS op http://grass.osgeo.org/wiki/GRASS-QGIS_relevant_module_list.

Het is ook mogelijk de inhoud van de Toolbox van GRASS aan te passen. Deze procedure wordt beschreven in
het gedeelte Aanpassen van de Toolbox van GRASS.

Zoals weergegeven in figure_grass_toolbox_1 kunt u naar de toepasselijke module voor GRASS zoeken met
behulp van de thematisch gegroepeerde Modulen Boom of de te doorzoeken tab Modulen Lijst.

Door te klikken op een grafisch pictogram voor een module zal een nieuwe tab worden toegevoegd aan het di-
aloogvenster van de Toolbox, die drie nieuwe sub-tabs verschaft: Opties, Output en Handleiding.

Opties

De tab Opties verschaft een vereenvoudigd dialoogvenster voor de module waar u gewoonlijk een raster- of vec-
torlaag, die is gevisualiseerd in het kaartvenster van QGIS, kunt selecteren en meer module-specifieke parameters
kunt invullen om de module uit te voeren.

Figuur 16.9: GRASS Toolbox Module Opties

De verschafte parameters voor de module zijn vaak niet compleet om het dialoogvenster duidelijk te houden. Als
u meer parameters en vlaggen voor de module wilt gebruiken, dient u de GRASS-shell te starten en de module uit
te voeren op de opdrachtregel.

Een nieuwe mogelijkheid sinds QGIS 1.8 is de ondersteuning voor een knop Geavanceerde opties tonen onder het
vereenvoudigde dialoogvenster voor de module op de tab Opties. op dit moment is het alleen toegevoegd aan de
module v.in.ascii als gebruiksvoorbeeld, maar het zal waarschijnlijk deel gaan uitmaken van de meeste of
alle modules in de Toolbox voor GRASS in toekomstige versies van QGIS. Dit stelt u in staat de volledige opties
voor de module voor GRASS te gebruiken zonder dat u hoeft over te schakelen naar de GRASS-shell.
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Output

Figuur 16.10: GRASS Toolbox Module Output

De tab Output verschaft informatie over de uitvoerstatus van de module. Wanneer u klikt op de knop [Uitvoeren],
schakelt de module naar de tab Output en ziet u informatie over het analyseproces. Als alles goed werkt ziet u
uiteindelijk een bericht Succesvol geëindigd‘.

Handleiding

De tab Handleiding geeft de HTML Help-pagina van de module voor GRASS weer. U kunt die gebruiken om te
controleren op meer parameters en vlaggen voor de module of om een beter inzicht te krijgen over het doel van
de module. Aan het einde van elke pagina met de handleiding van de module zult u verder koppelingen zien naar
de Main index, de Thematische index en de Full index. Deze koppelingen verschaffen dezelfde
informatie als de module g.manual.

Tip: Resultaten onmidellijk weergeven
Als u uw resultaten van de berekeningen direct wilt weergeven in uw kaartvenster, kunt u de knop ‘Uitvoer
bekijken’ onder op de tab van de module gebruiken.

16.9.2 GRASS voorbeelden van modules

De volgende voorbeelden zullen de kracht van enkele van de modules van GRASS demonstreren.

Contourlijnen maken

Het eerste voorbeeld maakt een vector contourenkaart uit een hoogteraster (DEM). Hier wordt aangenomen dat
u de LOCATION Alaska heeft ingesteld zoals uitgelegd in het gedeelte Importeren van gegevens in een GRASS
LOCATION.

• Open eerst de locatie door te klikken op de knop Mapset openen en de locatie Alaska te kiezen.
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Figuur 16.11: GRASS Toolbox Module Handleiding

• Laad nu het hoogteraster gtopo30 door te klikken op GRASS–Rasterlaag toevoegen en het raster gtopo30
vanaf de locatie demo te selecteren.

• Open nu de Toolbox met de knop GRASS-gereedschap openen.

• In de lijst met categorieën gereedschap, dubbelklik op Raster → ‘Surface management’ → Genereer vector
contourlijnen.

• Nu zal een enkele klik op het gereedschap r.contour het dialoogvenster voor het gereedschap openen zoals
boven uitgelegd (zie Werken met modules van GRASS). Het raster gtopo30 zou moeten verschijnen als
Name of input raster.

• Type in het vak Increment between Contour levels de waarde 100. (Dit zal contourlijnen maken met
een interval van 100 meter.)

• Type in het vak Name for output vector map de naam ctour_100.

• Klik op [Uitvoeren] om het proces te beginnen. Wacht even totdat het bericht Succesvol geëindigd
verschijnt in het uitvoervenster. Klik dan op [Uitvoer bekijken] en [Sluiten].

Omdat dit een grote regio is zal het even duren voordat alles wordt weergegeven. Nadat het renderen is voltooid,
kunt u het venster Laageigenschappen openen om de lijnkleur te wijzigen zodat de contouren duidelijk over het
hoogteraster te zien zijn, zoals in Het dialoogvenster Vectoreigenschappen.

Zoom vervolgens in op een klein bergachtig gebied in het midden van Alaska. Bij het veel inzoomen zult u op-
merken dat de contouren scherpe hoeken hebben. GRASS biedt het gereedschap v.generalize om vectorkaarten
lichtjes te wijzigen met behoud van hun overall-vorm. Het gereedschap gebruikt verscheidene verschillende al-
goritmen met verschillende doeleinden. Sommig algoritmen (d.i., Douglas Peuker en Vertex Reduction) vereen-
voudigen de lijn door enkele punten te verwijderen. De resulterende vector zal sneller laden. Dit proces is nuttig
als u een vector met veel detail heeft, maar u makat een kaart op zeer kleine schaal, dus detail is niet nodig.

Tip: Het gereedschap Vereenvoudigen
Onthoud dat de plug-in fTools voor QGIS een gereedschap Geometrieën vereenvoudigen → heeft dat net zo werkt
als het GRASS v.generalize Douglas-Peuker algoritme.
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Echter, het doel van dit voorbeeld is anders. De contourlijnen die zijn gemaakt door r.contour hebben scherpe
hoeken die gladder zouden moeten. Tussen de algoritmen voor v.generalize staat Chaiken’s, wat precies dat
doet (ook Hermite-splines). Onthoud dat deze algoritmen aanvullende hoeken kunnen toevoegen aan de vector,
waardoor het nog langzamer is te laden.

• Open de Toolbox voor GRASS en dubbelklik op categorieën Vector → Develop map → Generaliseren, klik
dan op de module v.generalize om het venster Opties daarvan te openen.

• Controleer of de vectorlaag ‘ctour_100’ verschijnt in het vak Name of input vector.

• Kies Chaiken’s Algorithm uit de lijst met algoritmen. Laat alle andere opties op hun standaard staan en
scroll naar beneden naar de laatste rij om in het veld Name for output vector map ‘ctour_100_smooth’ in te
vullen en klik op [Uitvoeren].

• Het proces duurt enige tijd. Als eenmaal Succesvol geëindigd verschijnt in het uitvoervenster, klik
dan op [Uitvoer bekijken] en dan op [Sluiten].

• U zou de kleur van de vectorlaag kunnen wijzigen om die duidelijk weer te geven tegen de achtergrond
van het raster en om contrast te krijgen met de originele contourlijnen. het zal u opvallen dat de nieuwe
nieuwe contourlijnen gladdere hoeken hebben dan de originele terwijl zij nog voldoen aan de originele
overall-vorm.

Figuur 16.12: GRASS module v.generalize om een vectorkaart gladder te maken

Tip: Ander gebruik voor r.contour
De hierboven beschreven procedure kan in equivalente andere situaties worden gebruikt. Als u een rasterkaart
heeft met gegevens over neerslag, bijvoorbeeld, dan kan dezelfde methode worden gebruikt om een vectorkaart
met isohyetale (constante neerslag) lijnen te maken.
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Een 3D heuvels met schaduw-effect maken

Verscheidene methoden worden gebruikt om hoogtelagen weer te geven en een 3D-effect aan kaarten te geven.
Het gebruiken van contourlijnen, zoals hierboven weergegeven, is een populaire methode die vaak gekozen wordt
om topografische kaarten te produceren. Een andere manier om een 3D-effect weer te geven is door schaduw op
heuvels. Het effect van schaduw op heuvels wordt gemaakt vanuit een DEM (hoogte)raster door eerst de helling
en aspect van elke cel te berekenen, dan de positie van de zon in de lucht te simuleren en een waarde van reflectie
te geven aan elke cel. U krijgt dus lichte hellingen in de zon; de hellingen die uit de zon liggen (in de schaduw)
worden donkerder.

• Begin dit voorbeeld met het laden van het hoogteraster gtopo30. Start de Toolbox voor GRASS en onder
de categorie Raster, dubbelklik om Ruimtelijke analyse → Terrain analysis te openen.

• Klik dan op r.shaded.relief om de module te openen.

• Wijzig azimuth angle 270 naar 315.

• Voer gtopo30_shade in voor het nieuwe raster met schaduw voor de heuvels en klik op [Uitvoeren].

• Wanneer het proces voltooid is, voeg dan het raster met schaduw voor de heuvels toe aan de kaart. U zou
die nu moeten zien weergegeven in grijswaarden.

• Verplaats de kaart met schaduw op de heuvels naar onder de kaart gtopo30 in de inhoudsopgave, open dan
het venster Properties van gtopo30, schakel naar de tab Transparantie en stel het niveau voor transparantie
in op ongeveer 25% om zowel de schaduw op de heuvels als de kleuren van gtopo30 tezamen te zien.

U zou nu de hoogte gtopo30moeten hebben met zijn kleurenkaart en transparante instelling weergegeven boven
de kaart van de heuvels met schaduw in grijswaarden. Schakel, om de visuele effecten van de schaduw op de hevels
te zien, de kaart gtopo30_shade uit en schakel die dan weer in.

Gebruiken van de GRASS-shell

De plug-in GRASS in QGIS is ontworpen voor gebruikers voor wie GRASS nieuw is en die niet bekend zijn
met alle modules en opties. Daarom geven sommige modules in de Toolbox niet alle beschikbare opties weer,
en sommige modules verschijnen in het geheel niet. De GRASS-shell (of console) geeft de gebruiker toegang tot
deze aanvullende modules van GRASS die niet in de boom van Toolbox verschijnen en ook tot enkele aanvullende
opties voor de modules die in de Toolbox staan met de eenvoudigste standaard parameters. Dit voorbeeld demon-
streert het gebruiken van een aanvullende optie in de module r.shaded.relief die hierboven werd weergegeven.

De module r.shaded.relief mag een parameter zmult hebben, die de waarden voor hoogte relatief ver-
menigvuldigt ten opzichte van de eenheden van de XY-coördinaten zodat het effect van schaduw op de heuvels
nog meer geprononceerd is.

• Laad het hoogteraster gtopo30 zoals hierboven en start dan de Toolbox voor GRASS en klik op de
GRASS-shell. Type, in het venster van de shell, de opdracht r.shaded.relief map=gtopo30
shade=gtopo30_shade2 azimuth=315 zmult=3 en druk op [Enter].

• Schakel, nadat het proces is voltooid, over naar de tab Browser en dubbelklik op het nieuwe raster
gtopo30_shade2 om het weer te geven in QGIS.

• Zoals hierboven uitgelegd, verplaats het raster met het schaduw-reliëf tot onder het raster gtopo30 in de
inhoudsopgave en controleer de transparantie van de gekleurde laag gtopo30. U zou moeten zien dat het
3D-effect sterker naar voren komt vergeleken met de eerste kaart met schaduw-reliëf.

Rasterstatistieken in een vectorkaart

Het volgende voorbeeld laat zien hoe een module van GRASS rastergegevens kan aggregeren en kolommen voor
statistieken voor elke polygoon in een vectorkaart kan toevoegen.

• Gebruik opnieuw de gegevens voor Alaska, bekijk Importeren van gegevens in een GRASS LOCATION om
het shapefile trees te importeren vanuit de map shapefiles in GRASS.

• Nu is een tussenstap vereist: zwaartepunten moeten worden toegevoegd aan de geïmporteerde kaart trees
om het een volledige gebiedsvector voor GRASS te maken (inclusief beide grenzen en zwaartepunten).
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Figuur 16.13: De GRASS-shell, r.shaded.relief module

Figuur 16.14: Weergeven van reliëf met schaduw, gemaakt met de module van GRASS r.shaded.relief
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• Kies, vanuit de Toolbox, Vectorlaag → Develop map → Objecten beheren en open de module v.centroids.

• Voer als output vector map in ‘forest_areas’ en voer de module uit.

• Now load the forest_areas vector and display the types of forests - deciduous, evergreen, mixed - in

different colors: In the layer Properties window, Symbology tab, choose from Legend type ‘Unique
value’ and set the Classification field to ‘VEGDESC’. (Refer to the explanation of the symbology tab in
sec_symbology of the vector section.)

• Vervolgens, open de Toolbox voor GRASS opnieuw en open Vectorlaag → Vector updaten o.b.v. andere
kaarten.

• Klik op de module v.rast.stats. Voer gtopo30 en forest_areas in.

• er is slechts één aanvullende parameter nodig: Voer column prefix elev in en klik op [Uitvoeren]. Dit is
een qua berekeningen zware bewerking die geruime tijd zal vergen (waarschijnlijk meer dan twee uur).

• Tenslotte, open de attributentabel van forest_areas en verifieer dat verschillende nieuwe kolommen
zijn toegevoegd, inclusief elev_min, elev_max, elev_mean, etc., voor elk polygoon bos.

16.9.3 Werken met de LOCATION-browser van GRASS

Een andere nuttige mogelijkheid binnen de Toolbox van is de browser LOCATION voor GRASS. In fig-
ure_grass_module_7 ziet u de huidige werk:file:LOCATION met zijn MAPSET’s.

In het linkervenster van de browser kunt u door alle MAPSET’s bladeren binnen de huidige LOCATION. Het
rechter venster van de browser geeft enige meta-informatie weer voor geselecteerde raster- of vectorlagen (bijv.,
resolutie, vak voor begrenzingen, gegevensbron, verbonden attributentabel voor vectorgegevens en een historie
van opdrachten).

Figuur 16.15: GRASS LOCATION-browser

De werkbalk op de tab Browser biedt de volgende gereedschappen voor het beheren van de geselecteerde
LOCATION:

• Geselecteerde kaart toevoegen aan kaartvenster

• Geselecteerde kaart kopiëren
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• Geselecteerde kaart hernoemen

• Geselecteerde kaart verwijderen

• Huidige regio instellen op geselecteerde kaart

• Venster van browser vernieuwen

Geselecteerde kaart hernoemen en Geselecteerde kaart verwijderen werken alleen met kaarten binnen
uw momenteel geselecteerde MAPSET. Alle andere gereedschappen werken ook met raster- en vectorlagen in een
andere MAPSET.

16.9.4 Aanpassen van de Toolbox van GRASS

Nagenoeg alle modules voor GRASS kunnen worden toegevoegd aan de Toolbox voor GRASS. Een XML-
interface wordt verschaft voor het parsen van de vrij eenvoudige XML-bestanden die het uiterlijk en parameters
van de module binnen de Toolbox configureren.

Een voorbeeld XML-bestand voor het maken van de module v.buffer (v.buffer.qgm) ziet uit zoals dit:

<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE qgisgrassmodule SYSTEM "http://mrcc.com/qgisgrassmodule.dtd">

<qgisgrassmodule label="Vector buffer" module="v.buffer">
<option key="input" typeoption="type" layeroption="layer" />
<option key="buffer"/>
<option key="output" />

</qgisgrassmodule>

De parser leest deze definitie en maakt een nieuwe tab binnen de Toolbox wanneer u de module se-
lecteert. Een meer gedetailleerde beschrijving voor het toevoegen van nieuwe modules, wijzigen van een
groep van een module, etc., is te vinden op de wiki van QGIS op http://hub.qgis.org/projects/quantum-
gis/wiki/Adding_New_Tools_to_the_GRASS_Toolbox.

.
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HOOFDSTUK 17

QGIS framework Processing

.

17.1 Introductie

Dit hoofdstuk introduceert het QGIS framework voor processing, een omgeving voor geo-processing die kan wor-
den gebruikt om eigen en algoritmen van derde partijen aan te roepen vanuit QGIS, wat uw taken voor ruimtelijke
analyses meer productief en eenvoudig uit te voeren maakt.

In de volgende gedeelten zullen we bekijken hoe de grafische elementen van dit framework gebruikt kunnen
worden en het meeste uit elk van hen te halen.

Er zijn vier basiselementen in de GUI van het framework, die worden gebruikt om algoritmen voor verschillende
doeleinden uit te voeren. Kiezen van het ene gereedschap of het andere is afhankelijk van het soort analyse dat
moet worden uitgevoerd en de bijzondere karakteristieken van elke gebruiker en project. Alle (met uitzondering
van de interface Batch processing, die, zoals we zullen zien, wordt aangeroepen vanuit de Toolbox) kunnen worden
bereikt vanuit het menuitem Processing. (U zult meer dan vier items zien. De resterende worden niet gebruikt om
algoritmen uit te voeren en zullen later in dit hoofdstuk worden besproken.)

• De Toolbox. Het hoofdelement van de GUI, het wordt gebruikt om één enkel algoritme uit te voeren of een
batch-proces gebaseerd op dat algoritme.

Figuur 17.1: Processing Toolbox
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• De grafische modellen maken. Verscheidene algoritmen kunnen grafisch worden gecombineerd met be-
hulp van de modellenmaker om een werkstroom te definiëren, één enkel proces maken dat verschillende
subprocessen omvat.

Figuur 17.2: Processing modellen

• Het Beheren van historie. Alle uitgevoerde acties met behulp van een van de hiervoor genoemde elementen
worden opgeslagen in een bestand voor historie en kan later eenvoudig worden gereproduceerd met behulp
van Beheren van historie.

• De interface voor batch-processing. Deze interface stelt u in staat batch-processen uit te voeren en het
uitvoeren van één enkel algortime om meerdere gegevenssets te automatiseren.

In de volgende gedeelten zullen we tot in detail elk van deze elementen nader bekijken.

.

17.2 De Toolbox

De Toolbox is het hoofdelement van de GUI van Processing en die welke u waarschijnlijk het meeste gaat ge-
bruiken in uw dagelijkse werk. Het geeft de lijst met alle beschikbare algoritmen weer, gegroepeerd in verschil-
lende blokken en het is het toegangspunt om ze uit te voeren, ofwel als één enkel proces of als een batch-proces
wat verscheidene uitvoeringen behelst van hetzelfde algoritme op verschillende sets van invoer.

De Toolbox bevat alle beschikbare algoritmen, opgedeeld in voorgedefinieerde groepen. Al deze groepen zijn te
vinden onder één enkel item van de boom, genaamd Geoalgorithms.

Aanvullend zijn daar nog twee items te vinden, namelijk Models en Scripts. Deze omvatten door gebruikers
gemaakte algoritmen en zij stellen u in staat uw eigen werkstromen te definiëren en taken voor verwerking. We
zullen iets later een volledig gedeelte daaraan wijden.

In het bovenste gedeelte van de Toolbox vindt u een tekstvak. U kunt een woord of een frase in dat tekstvak
invoeren om het aantal algoritmen dat wordt weergegeven in de Toolbox te reduceren en het eenvoudiger te maken
degene te vinden die u nodig heeft. Onthoud dat, terwijl u typt, het aantal algoritmen in de Toolbox wordt
gereduceerd tot net diegenen die in hun namen de tekst bevatten die u heeft ingevoerd.
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Figuur 17.3: Processing historie

Figuur 17.4: Interface Batch-processing
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Figuur 17.5: Processing Toolbox

In het onderste gedeelte vindt u een vak dat u in staat stelt te schakelen tussen de vereenvoudigde lijst met algorit-
men (die welke hierboven uitgelegd is) en de geavanceerde lijst. Als u overschakelt naar de modus Advanced, zal
de Toolbox er zo uitzien:

In de weergave Advanced vertegenwoordigt elke groep een zogenaamde ‘provider voor algoritmen’, wat een
set van algoritmen is die afkomstig is van dezelfde bron, bijvoorbeeld van een toepassing van derde partijen met
mogelijkheden voor geo-verwerking. Sommige van deze groepen vertegenwoordigen algoritmen van toepassingen
van derde partijen, zoals SAGA, GRASS of R, terwijl andere algoritmen bevatten die direct gecodeerd zijn als deel
van de plug-in Processing, niet afhankelijk van enige aanvullende software.

Deze weergave wordt aanbevolen voor die gebruikers die een bepaalde kennis van de toepassingen hebben die ten
grondslag liggen aan de algoritmen, omdat zij zullen worden weergegeven met hun originele namen en groepen.

Ook zijn, alleen in de weergave Advanced, enkele aanvullende algoritmen beschikbaar, zoals, naast andere, het
gereedschap LiDAR en scripts die zijn gebaseerd op de R statistische berekeningen software. Onafhankelijke
plug-ins voor QGIS die nieuwe algoritmen toevoegen aan de Toolbox zullen alleen worden weergegeven in de
weergave Advanced.

In bijzonder bevat de vereenvoudigde weergave algoritmen van de volgende providers:

• GRASS

• SAGA

• OTB

• Eigen algoritmen voor QGIS

In het geval van het uitvoeren van QGIS onder Windows, zijn deze algoritmen volledig functioneel in een verse
installatie van QGIS, en zij kunnen worden uitgevoerd zonder enige aanvullende installatie. Ook vereist het
uitvoeren ervan geen eerdere kennis over de externe toepassingen die zij gebruiken, wat ze meer toegankelijk
maakt voor gebruikers die ze voor het eerst toepassen.

Als u een algoritme wilt gebruiken dat niet is verschaft door een van de bovenstaande providers, schakel dan over
naar de modus Advanced door de corresponderende optie aan de onderzijde van de Toolbox te selecteren.

Dubbelklik eenvoudigweg op de naam in de Toolbox om een algoritme uit te voeren.
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Figuur 17.6: Processing Toolbox (geavanceerde modus)

17.2.1 Het dialoogvenster Algoritme

Als u eenmaal hebt geklikt op de naam van het algoritme dat u wilt uitvoeren, zal een dialoogvenster, zoals dat in
de afbeelding hieronder, worden weergegeven (in dit geval correspondeert het dialoogvenster met het algoritme
SAGA ‘Convergence index’).

Dit dialoogvenster wordt gebruikt om de waarden voor de invoer in te stellen die het algoritme nodig heeft om
te worden uitgevoerd. Het geeft een tabel weer waar waarden voor de invoer en parameters voor de configuratie
moeten worden ingesteld. Het heeft natuurlijk een andere inhoud, afhankelijk van de vereisten van het algoritme
om te worden uitgevoerd, en wordt automatisch gemaakt, gebaseerd op deze vereisten. Aan de linkerkant wordt
de naam van de parameter weergegeven. Aan de rechterkant kan de waarde van de parameter worden ingesteld.

Hoewel het aantal en type parameters afhankelijk is van de karakteristieken van het algoritme, is de structuur voor
alle ongeveer hetzelfde. De parameters in de tabel kunnen van een van de volgende types zijn.

• Een rasterlaag, om te selecteren uit een lijst van al dergelijke lagen die beschikbaar zijn (momenteel geopend
zijn) in QGIS. De selectie bevat ook een knop aan de rechterkant om u bestandsnamen te laten selecteren
die lagen vertegenwoordigen die momenteel niet geladen zijn in QGIS.

• Een vectorlaag, om te selecteren uit een lijst van alle beschikbare vectorlagen in QGIS. Lagen die niet zijn
geladen in QGIS kunnen ook worden geselecteerd , net als in het geval van rasterlagen, maar alleen als het
algoritme geen tabelveld vereist uit de attributentabel van de laag. In dat geval kunnen alleen geopende
lagen worden geselecteerd, omdat zij geopend moeten zijn om de lijst met beschikbare veldnamen op te
kunen halen.

U zult een knop zien bij elke vectorlaag om te selecteren, zoals weergegeven in de afbeelding hieronder.

Als het algoritme er verscheidene van bevat, zult u in staat zijn er slechts één van te schakelen. Als de knop die
correspondeert met een vectorinvoer wordt geschakeld, zal het algoritme iteratief worden uitgevoerd op elk van
zijn objecten, in plaats van slechts één keer voor de gehele laag, net zoveel uitvoer producerend als het aantal
keren dat het algoritme wordt uitgevoerd. Dit maakt het mogelijk het proces te automatiseren als alle objecten in
een laag afzonderlijk moeten worden verwerkt.

• Een tabel, om te selecteren uit een lijst van alle beschikbare QGIS. Niet-ruimtelijke tabellen worden in QGIS
geladen als vectorlagen en worden in feite ook als zodanig behandeld door het programma. Momenteel is de
lijst van beschikbare tabellen, die u zult zien bij het uitvoeren van een algoritme dat één ervan nodig heeft,
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Figuur 17.7: Dialoogvenster Parameters

Figuur 17.8: Knop Vector-iteratie

beperkt tot tabellen die afkomstig zijn uit bestanden in dBase (.dbf) of indelingen van Comma-Separated
Values (.csv).

• Een optie, om te kiezen uit een selectielijst met mogelijke opties.

• Een numerieke waarde, die moet worden ingevoerd in een tekstvak. U zult er een knop naast vinden. Door
daarop te klikken ziet u een dialoogvenster dat u in staat stelt een rekenkundige uitdrukking in te voeren, dus
u het kunt gebruiken als een handige calculator. Enkele handige variabelen, die zijn gerelateerd aan de in
QGIS geladen gegevens, kunnen aan uw uitdrukking worden toegevoegd, dus kunt u een waarde selecteren
die is afgeleid vanéén van deze variabelen, zoals de grootte van een cel van een laag of de meest noordelijk
gelegen coördinaat van een andere.

• Een bereik, met min en max waarden die moeten worden ingevoerd in twee tekstvakken.

• Een tekst-tekenreeks, om te worden ingevoerd in een tekstvak.

• Een veld, om te kiezen uit de attributentabel van een vectorlaag of één enkele tabel, geselecteerd in een
andere parameter.

• Een coördinaten referentiesysteem. U kunt de code voor EPSG direct in het tekstvak typen, of die se-
lecteren uit het dialoogvenster voor selectie van het CRS dat verschijnt wanneer u klikt op de knop aan de
rechterkant.

• Een bereik, dat moet worden ingevoerd met vier getallen die de grenzen xmin, xmax, ymin, ymax verte-
genwoordigen. Klikken op de knop aan de rechterkant van de selectie voor de waarde laat een pop-upmenu
verschijnen dat u twee opties geeft: selecteren van de waarde uit een laag oh het huidige bereik in het
kaartvenster, of om het direct te slepen in het kaartvenster.

Als u de eerste optie selecteert, zult u een venster zoals het volgende zien.

Als u de tweede optie selecteert, zal het venster Parameters zichzelf verbergen, zodat u kunt klikken en
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Figuur 17.9: Getalselectie

Figuur 17.10: Bereikselectie

Figuur 17.11: Bereik-lijst
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slepen in het kaartvenster. Als u de geselecteerde rechthoek heeft gedefinieerd zal het dialoogvenster op-
nieuw verschijnen en de waarden bevatten in het tekstvak voor het bereik.

Figuur 17.12: Bereik slepen

• Een lijst met elementen (rasterlagen, vectorlagen of tabellen), om te selecteren uit de lijst van dergelijke
beschikbare lagen in QGIS. Klik op de kleine knop aan de linkerkant van de overeenkomende rij om een
dialoogvenster te zien, zoals het volgende, om de selectie te maken.

Figuur 17.13: Meervoudige selectie

• Een kleine tabel om te worden bewerkt door de gebruiker. Deze worden gebruikt om parameters te
definiëren zoals tabellen voor opzoeken of samengevouwde kernen, naast andere.

Klik op de knop aan de rechterkant om de tabel te zien en de waarden ervan te bewerken.

Afhankelijk van het algoritme kan het aantal rijen, al dan niet, worden aangepast met de knoppen aan de
rechterkant van het venster.

U vindt een tab [Help] in het dialoogvenster Parameters. Als een Help-pagina beschikbaar is zal die worden
weergegeven en u meer informatie geven over het algoritme en gedetailleerde beschrijvingen over wat elke pa-
rameter doet. Helaas ontbreekt bij de meeste algoritmen goede documentatie, maar als u wilt bijdragen aan het
project, zou dit een goede plek zijn om mee te beginnen.

Een opmerking over projecties

Algoritmen worden vanuit het framework Processing uitgevoerd — dit is ook waar omdat van de meeste externe
toepassingen de algoritmen hierdoor worden weergegeven. Voer geen nieuwe projectie uit op invoerlagen en ga er
van uit dat ze allemaal al in een algemeen coördinatensysteem staan en klaar om te worden geanalyseerd. Wanneer
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Figuur 17.14: Vaste tabel

u meer dan één laag gebruikt als invoerlaag voor een algoritme, vector of raster, is het aan u om er voor te zorgen
dat zij allemaal in hetzelfde coördinatensysteem zijn.

Onthoud dat, wegens de directe mogelijkheden voor opnieuw projecteren van QGIS, hoewel twee lagen elkaar
lijken te overlappen en overeenkomen, dat niet waar hoeft te zijn als hun originele coördinaten werden gebruikt
zonder ze opnieuw te projecteren in een algemeen coördinatensysteem. Dat opnieuw projecteren zou handmatig
moeten worden uitgevoerd, en dan zouden de resulterende bestanden moeten worden gebruikt als invoer voor het
algoritme. Onthoud ook dat het proces van opnieuw projecteren kan worden uitgevoerd met de algoritmen die
beschikbaar zijn in het framework Processing zelf.

Standaard zal het dialoogvenster Parameters een beschrijving weergeven van het CRS van elke laag, tezamen met
de naam ervan, wat het eenvoudig maakt lagen te selecteren die hetzelfde CRS delen om te worden gebruikt als
invoerlagen. Als u deze aanvullende informatie niet wilt zien, kunt u die functionaliteit in het dialoogvenster
Opties en configureren uitschakelen, door de optie Show CRS niet te selecteren.

Wanneer u probeert een algoritme uit te voeren met behulp van twee of meer lagen als invoer, waarvan de CRS-en
niet overeenkomen, zal een dialoogvenster met een waarschuwing worden weergegeven.

U kunt nog steeds het algoritme uitvoeren, maar weet dat dat in de meeste gevallen verkeerde resultaten zal
produceren, zoals lege lagen, omdat de invoerlagen elkaar niet overlappen.

17.2.2 Gegevensobjecten gegenereerd door algoritmen

Gegevensobjecten gegenereerd door een algoritme kunnen van één van de volgende typen zijn:

• Een rasterlaag

• Een vectorlaag

• Een tabel

• Een HTML-bestand (gebruikt voor tekst en grafische uitvoer)

Deze worden allemaal opgeslagen op schijf en de tabel met parameters zal een tekstvak bevatten die overeenkomt
met elk van deze uitvoeren, waar u het kanaal voor uitvoer kunt typen om het op te slaan. Een kanaal voor uitvoer
bevat de informatie die nodig is om de resulterende object ergens op te kunnen slaan. In het meest normale geval,
zult u het opslaan naar een bestand, maar de architectuur staat elke andere manier voor opslag ook toe. Een
vectorlaag kan, bijvoorbeeld, worden opgeslagen in een database of zelfs geüpload worden naar een server of
afstand met behulp van een WFS-T service. Hoewel oplossingen als deze nog niet zijn geïmplementeerd, is het
framework Processing er op voorbereid ze af te kunnen handelen, en we verwachten in de nabije uitgave nieuwe
soorten kanelen voor uitvoer toe te voegen.
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Klik eenvoudigweg op de knop rechts van het tekstvak om een kanaal voor uitvoer te selecteren. Dat zal een
dialoogvenster voor het opslaan van bestanden openen, waar u het gewenste bestandspad kunt selecteren. On-
dersteunde bestandsextensies worden in de selectie voor de bestandsindeling in het dialoogvenster weergegeven,
afhankelijk van het soort uitvoer en het algoritme.

De indeling van de uitvoer wordt gedefinieerd door de extensie van de bestandsnaam. De ondersteunde indelingen
zijn afhankelijk van wat door het algoritme zelf wordt ondersteund. Selecteer eenvoudigweg de corresponderende
bestandsextensie (of voeg die toe, als u in plaats daarvan het bestandspad direct intypt) om een indeling te se-
lecteren. Als de extensie van het bestandspad dat u invoerde niet overeenkomt met een van de ondersteunde
indelingen, zal een standaard extensie (gewoonlijk .dbf‘ voor tabellen, .tif voor rasterlagen en .shp voor
vectorlagen) worden toegevoegd aan het bestandspad, en de bestandsindeling die correspondeert met die extensie
zal worden gebruikt om de laag of de tabel op te slaan.

Als u geen bestandsnaam invoert, zal het resultaat worden opgeslagen als een tijdelijk bestand in het correspon-
derende standaard bestandsindeling en het zal worden verwijderd als u QGIS afsluit (wees u daarvan bewust als u
uw project opslaat en het tijdelijke lagen bevat).

U kunt een standaard map instellen voor gegevensobjecten van uitvoer. Ga naar het dialoogvenster Opties en
configuratie (u kunt het openen vanuit het menu Processing), en in de groep General vindt u een parameter
genaamd Output folder. Deze map voor uitvoer wordt gebruikt als het standaard pad voor het geval dat u slechts
een bestandsnaam typt, zonder pad (d.i., mynbestand.shp) bij het uitvoeren van een algoritme.

Bij het uitvoeren van een algoritme dat een vectorlaag in iteratieve modus gebruikt, wordt het ingevoerde be-
standspad gebruikt als het basispad voor alle gegenereerde bestanden, die worden benoemd met behulp van de
basisnaam en de toevoeging van een getal die de index van de iteratie vertegenwoordigt. De bestandsextensie (en
indeling) wordt gebruikt alle op die manier gegenereerde bestanden.

Apart van rasterlagen en tabellen, genereren algoritmen ook afbeeldingen en tekst als HTML-bestanden. Deze
resultaten worden weergegeven aan het einde van de uitvoering van het algoritme in een nieuw dialoogvenster. Dit
dialoogvenster zal de resultaten behouden die door een algoritme zijn geproduceerd gedurende de huidige sessie,
en kan op elk moment worden weergegeven via het menu Processing → Resultaten bekijken in het hoofdmenu
van QGIS.

Sommige externe toepassingen zouden bestanden (zonder bepaalde beperkingen voor de extensie) als uitvoer
kunnen hebben, maar zij behoren niet tot de hierboven vermelde categorieën. Deze bestanden voor uitvoer zullen
niet worden verwerkt door QGIS (geopend of opgenomen in het huidige project van QGIS), omdat zij meestal niet
corresponderen met bestandsindelingen of elementen die worden ondersteund door QGIS. Dit is, bijvoorbeeld, het
geval met bestanden van LAS, gebruikt voor de gegevens van LiDAR. De bestanden worden gemaakt maar u zult
niets zien in uw nieuwe werksessie van QGIS.

Voor alle andere typen van uitvoer zult u een tekstvak vinden dat u kunt gebruiken om het algoritme te vertellen om
het bestand te laden als het eenmaal is gegenereerd door het algoritme of niet. Standaard worden alle bestanden
geopend.

Optionele uitvoeren worden ondersteund. Dat is, alle uitvoeren worden gemaakt. Echter, u kunt het correspon-
derende tekstvak deselecteren als u niet geïnteresseerd bent in een bepaalde uitvoer, wat er in essentie voor zorgt
dat het zich gedraagt als een optionele uitvoer (met andere woorden: de laag wordt toch gemaakt, maar als u het
tekstvak leeg laat, zal die worden opgeslagen in een tijdelijk bestand en worden verwijderd als u QGIS afsluit).

17.2.3 Configureren van het framework Processing

Zoals al eerder verteld geeft het menu Opties en configuratie toegang tot een nieuw dialoogvenster waar u kunt
configureren hoe algoritmen werken. Parameters voor configuratie zijn gestructureerd in afzonderlijke blokken
die u kunt selecteren aan de linkerkant van het dialoogvenster.

Naast het hiervoor genoemde item Output folder bevat het blok General parameters voor het instellen van de
standaard weergave-stijl voor lagen voor uitvoer (dat is, lagen die zijn gegenereerd met behulp van algoritmen uit
een van de GUI-componenten van het framework). Maak eenvoudigweg de stijl die wilt met behulp van QGIS, sla
die op naar ene bestand en voer dan het pad naar dat bestand in in de instellingen zodat de algoritmen het kunnen
gebruiken. Wanneer een laag wordt geladen door SEXTANTE en toegevoegd aan het kaartvenster van QGIS, zal
die worden gerenderd in die stijl.
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Stijlen voor weergave kunnen individueel worden geconfigureerd voor elk algoritme en elk van diens uitvoeren.
Klik eenvoudigweg met rechts op de naam van het algoritme in de Toolbox en selecteer Weergave-stijlen voor
uitvoer bewerken. U zult een dialoogvenster zien zoals hieronder wordt weergegeven.

Figuur 17.15: Weergave-stijlen

Selecteer het stijlbestand (.qml) dat u wilt toepassen voor elke uitvoer en druk op [OK].

Andere parameters voor configuratie in de groep General zijn hieronder vermeld:

• Gebruik bestandsnaam als laagnaam. De naam van elke resulterende laag die wordt gemaakt door een
algoritme wordt gedefinieerd dor het algoritme zelf. In sommige gevallen zou een vaste naam kunnen
worden gebruikt, wat betekent dat dezelfde naam voor de uitvoer wordt gebruikt,ongeacht welke laag voor
de invoer wordt gebruikt. In andere gevallen zou de naam afhankelijk kunnen zijn van de naam van de
invoerlaag of enkele van de parameters die worden gebruikt om het algoritme uit te voeren. Als dit keuzevak
is geselecteerd zal in plaats daarvan de naam uit de naam voor het uitvoerbestand worden genomen. Onthoud
dat, wanneer de uitvoer wordt opgeslagen naar een tijdelijk bestand, de bestandsnaam van dit tijdelijke
bestand gewoonlijk een lange en betekenisloze is, bedoeld om botsingen met reeds bestaand bestandsnamen
te vermijden.

• Alleen geselecteerde objecten gebruiken. Als deze optie is geselecteerd zullen wanneer een vectorlaag wordt
gebruikt als invoer voor een algoritme, alleen de geselecteerde objecten worden gebruikt. Als de laag geen
geselecteerde objecten heeft, zullen alle objecten worden gebruikt.

• Pre-execution script file en Post-execution script file. Deze parameters verwijzen naar de scripts die zijn
geschreven met behulp van de functionaliteit Scripten in Processing, en worden uitgelegd in het gedeelte
dat het scripten en de console behandelt.

Apart van het blok General in het dialoogvenster Opties en configuratie, zult u ook een blok vinden voor de
providers van algoritmen. Elk item in dit blok bevat een item Activate dat u kunt gebruiken om algoritmen te
laten verschijnen in de Toolbox of niet. Ook hebben sommige providers van algoritmen hun eigen items voor
configuratie, die we later zullen uitleggen bij het behandelen van bepaalde providers van algoritmen.

.

17.3 Grafische modellen bouwen

Grafische modellen bouwen stelt u in staat complexe modellen te maken met behulp van een eenvoudige en
gemakkelijk te gebruiken interface. Bij het werken met een GIS staan de meeste bewerkingen voor analyses
niet op zichzelf, maar maken, in plaats daarvan, deel uit van een reeks bewerkingen. Met behulp van Grafische
modellen bouwen kan die keten van processen worden verpakt in één enkel proces, dus is het later zo gemakkelijk
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en handig uit te voeren als één enkel proces op een andere verzameling invoer. het maakt niet uit hoeveel stappen
en verschillende algoritmen er bij betrokken zijn, een model wordt uitgevoerd als één enkel algoritme, en bespaart
dus tijd en inspanning, speciaal bij grote modellen.

Grafische modellen bouwen kan worden geopend vanuit het menu Processing.

Grafische modellen bouwen heeft een werkruimte waar de structuur van het model en de werkstroom die het
vertegenwoordigt worden weergegeven. In het linker gedeelte van het venster kan een paneel met twee tabs
worden gebruikt om nieuwe elementen aan het model toe te voegen.

Figuur 17.16: Grafische modellen bouwen

Het maken van een model omvat twee stappen:

1. Definitie van noodzakelijke invoer. Deze invoer zal worden toegevoegd aan het venster Parameters, zodat
de gebruiker zij waarden kan instellen bij het uitvoeren van het model. Het model zelf is een algoritme, dus
het venster Parameters wordt automatisch gegenereerd zoals dat gebeurd met alle beschikbare algoritmen
in het framework Processing.

2. Definitie van de werkstroom. Met behulp van de invoergegevens van het model wordt de werkstroom
gedefinieerd door het toevoegen van algoritmen en selecteren hoe zij deze invoer gebruiken of hoe zij de
uitvoer, reeds gegenereerd door andere algoritmen in het model, gebruiken.

17.3.1 Definitie van invoer

De eerste stap om een model te maken is het definiëren van de invoer die het nodig heeft. De volgende elementen
worden gevonden in de tab Invoer aan de linkerkant van het venster Grafische modellen bouwen:

• Rasterlaag

• Vectorlaag

• Tekenreeks

• Tabelveld
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• Tabel

• Bereik

• Getal

• Booleaanse waarde

• Bestand

Na dubbelklikken op een van deze elementen wordt een dialoogvenster weergegeven om de karakteristieken te
definiëren. Afhankelijk van de parameter zelf, kan het dialoogvenster slechts één basiselement bevatten (de
beschrijving, wat datgene is dat de gebruiker zal zien bij het uitvoeren van het model) of meerdere. Bijvoor-
beeld bij het toevoegen van een numerieke waarde, zoals kan worden gezien in de volgende afbeelding, los van de
beschrijving van de parameter, moet u een standaard waarde en een bereik van geldige waarden instellen.

Figuur 17.17: Parameters Grafische modellen bouwen

Voor elke toegevoegde invoer wordt een nieuw element toegevoegd aan de werkruimte van Grafische modellen
bouwen.

Figuur 17.18: Parameters Grafische modellen bouwen

17.3.2 Definitie van de werkstroom

Als de invoer eenmaal is gedefinieerd, is het tijd om de algoritmen te definiëren die daarop moeten worden
toegepast. Algoritmen kunnen worden gevonden in de tab Algoritmen tab, gegroepeerd op nagenoeg dezelfde
wijze als in de Toolbox.

Het uiterlijk van de Toolbox heeft ook hier twee modi: eenvoudig en geavanceerd. Er is echter geen element om
tussen te schakelen in Grafische modellen bouwen, dus dat zult u in de Toolbox moeten doen. De modus die is
geselecteerd in de Toolbox is die welke zal worden gebruikt voor de lijst met algoritmen in Grafische modellen
bouwen.

To add an algorithm to a model, double-click on its name. An execution dialog will appear, with a content similar
to the one found in the execution panel that is shown when executing the algorithm from the toolbox. The one
shown next corresponds to the SAGA ‘Convergence index’ algorithm, the same example we saw in the section
dedicated to the toolbox.

Zoals u ziet zijn er enkele verschillen. In plaats van het vak voor het uitvoerbestand dat werd gebruikt om het
pad voor de uitvoer van lagen en tabellen in te stellen, wordt hier een eenvoudig tekstvak gebruikt. Als de laag,
gegenereerd door het algoritme, slechts een tijdelijk resultaat is dat zal worden gebruikt als de invoer voor een
ander algoritme en niet zou moeten worden bewaard als uiteindelijk resultaat, bewerk dan dat tekstvak niet. Door
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Figuur 17.19: Parameters Grafische modellen bouwen

Figuur 17.20: Parameters Grafische modellen bouwen
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er iets in te typen betekent het dat het resultaat het eindpunt is en de tekst die u invoert zal de beschrijving voor de
uitvoer zijn, wat de uitvoer zal zijn die de gebruiker zal zien bij het uitvoeren van het model.

Selecteren van de waarde van elke parameter gaat ook een beetje anders, omdat er belangrijke verschillen zijn
tussen de context van Grafische modellen bouwen en die van de Toolbox. Laten we eens kijken hoe we de
waarden voor elk type parameter invullen.

• Lagen (raster en vector) en tabellen. Deze worden geselecteerd uit een lijst, maar in dit geval zijn de
mogelijke waarden niet de huidige in QGIS geladen lagen of tabellen, maar de lijst van ingevoerde modellen
van het overeenkomende type, of andere lagen of tabellen die zijn gegenereerd door algoritmen die al zijn
toegevoegd aan het model.

• Numerieke waarden. Letterlijke waarden kunnen direct in het tekstvak worden ingevuld. Maar dit tekstvak
is ook een lijst die kan worden gebruikt om elke van de numerieke invoerwaarden voor het model in te
voeren. In dat geval zal de parameter, bij het uitvoeren van het model, de waarde aannemen die door de
gebruiker is ingevuld.

• Tekenreeks. Net als in het geval van numerieke waarden kunnen letterlijke waarden worden ingevuld, of er
kan een tekenreeks voor invoer worden geselecteerd.

• Tabelveld. De velden van de ouder-tabel of laag hoeven niet bekend te zijn op het moment van ontwerpen,
omdat zij afhankelijk zijn van de selectie van de gebruiker, elke keer als het model wordt uitgevoerd. Type
de naam van een veld direct in het tekstvak, of gebruik de lijst om een tabelveld voor invoer te selecteren
dat al is toegevoegd aan het model om de waarde voor deze parameter in te stellen. De geldigheid van het
geselecteerde veld zal bij de uitvoering worden gecontroleerd.

In alle gevallen zult u een aanvullende parameter aantreffen, genaamd Ouder-algoritmen dat niet beschikbaar is
bij het aanroepen van het algoritme in de Toolbox. Deze parameter stelt u in staat de volgorde te definiëren waarin
de algoritmen worden uitgevoerd door expliciet één algoritme als een ouder van het huidige te definiëren, wat
forceert dat het ouder-algoritme wordt uitgevoerd vóór het huidige.

Wanneer u de uitvoer van een eerder algoritme gebruikt als de invoer voor uw algoritme, stelt dat impliciet het
eerdere algoritme in als ouder van het huidige (en plaatst de overeenkomende pijl in de werkruimte van Grafische
modellen bouwen). In sommige gevallen kan een algoritme echter afhankelijk zijn van een ander, zelfs als het
er geen uitgevoerd object van gebruikt (bijvoorbeeld een algoritme dat een zin in SQL uitvoert op een database
van PostGIS en een ander dat een laag importeert in dezelfde database). Selecteer in dat geval slechts het eerdere
algoritme in de parameter Ouder-algoritmen en de twee stappen zullen in de juiste volgorde worden uitgevoerd.

Klik, als eenmaal aan alle parameters geldige waarden zijn toegewezen, op [OK] en het algoritme zal worden
toegevoegd aan de werkruimte. Het zal worden gekoppeld aan alle andere elementen in de werkruimte, algoritme
of invoer, dat objecten verschaft die worden gebruikt als invoer voor dat algoritme.

Elements can be dragged to a different position within the canvas, to change the way the module structure is
displayed and make it more clear and intuitive. Links between elements are updated automatically.

U kunt uw algoritme op elk moment uitvoeren door te drukken op de knop [Start model]. Echter, om het algoritme
te kunnen gebruiken vanuit de Toolbox, moet het worden opgeslagen en het dialoogvenster Grafische modellen
bouwen worden gesloten, om de Toolbox in staat te stellen zijn inhoud te verversen.

17.3.3 Opslaan en laden van modellen

Gebruik de knop [Opslaan] om het huidige model op te slaan en de knop [Open model] om een eerder opgeslagen
model te openen. Modellen worden opgeslagen met de extensie .model. Als het model eerder werd opgeslagen
vanuit het venster Grafische modellen bouwen, zult u niet naar ene bestandsnaam worden gevraagd. Omdat er al
een bestand is geassocieerd met dat model, zal hetzelfde bestand worden gebruikt voor volgende opslag.

Vóór het opslaan van een model moet u een naam en een groep er voor invoeren, met behulp van de tekstvakken
in het bovenste gedeelte van het venster.

Modellen die zijn opgeslagen in de map models (de standaard map als u wordt gevraagd naar een bestandsnaam
om het model op te slaan) zullen in de corresponderende tak in de Toolbox verschijnen. Wanneer de Toolbox
wordt gestart, zoekt het in de map models naar bestanden met de extensie .model en laadt de modellen die zij
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bevatten. Omdat een model in zichzelf een algoritme is, kan het aan de Toolbox worden toegevoegd, net als elk
ander algoritme.

De map Models kan worden ingesteld in het dialoogvenster Opties en configuratie van Processing onder de groep
Models.

Modellen die zijn geladen uit de map models verschijnen niet alleen inde Toolbox, maar ook in de boom met
algoritmen in de tab Algoritmen van het venster Grafische modellen bouwen. Dat betekent dat u een model kunt
invoegen als deel van een groter model, net zoals u alle andere algoritmen kunt toevoegen.

In sommige gevallen zou een model niet behoeven te worden geladen omdat niet alle algoritmen, die in de werk-
stroom ervan zijn opgenomen, beschikbaar zijn. Als u een bepaald algoritme als deel van uw model hebt gebruikt,
zou het beschikbaar moeten zijn (dat is, het zou moeten verschijnen in de Toolbox) om te kunnen worden geladen
voor dat model. Deactiveren van het verschaffen van een algoritme in het configuratievenster van Processing ren-
dert alle algoritmen in die verschaffing als niet te gebruiken door Grafische modellen bouwen, wat problemen zou
kunnen veroorzaken bij het laden van modellen. Onthoud dat goed wanneer u problemen heeft met het laden of
gebruiken van modellen.

17.3.4 Bewerken van een model

U kunt het model, dat u momenteel maakt, bewerken, de werkstroom opnieuw definiëren en de relaties tussen de
algoritmen en invoer die het model zelf definiëren.

Als u met rechts klikt op een algoritme in de werkruimte dat het model vertegenwoordigt, zult u een contextmenu
zien zoals dat wat hieronder wordt weergegeven:

Figuur 17.21: Grafische modellen bouwen, klik met rechts

Selecteren van de optie Remove zal het geselecteerde algoritme verwijderen. Een algoritme kan alleen worden
verwijderd als er geen andere algoritmen van afhankelijk zijn. Dat is, als er geen uitvoer van het algoritme wordt
gebruikt in een ander als invoer. Als u probeert een algoritme te verwijderen waarvan andere afhankelijk zijn, zal
een waarschuwingsbericht, zoals die welke hieronder wordt weergegeven, worden getoond:

Figuur 17.22: Kan algoritme niet verwijderen

Selecteren van de optie Edit of eenvoudigweg dubbelklikken op het pictogram van het algoritme zal het di-
aloogvenster Parameters van het algoritme weergeven, zodat u de invoer- en parameterwaarden kunt wijzigen.
Niet alle beschikbare elementen voor invoer in het model zullen in dat geval verschijnen als beschikbare invoer.
Lagen of waarden die worden gegenereerd in een meer gevorderde stap in de werkstroom die is gedefinieerd door
het model zal niet beschikbaar zijn als zij cirkelverwijzingen veroorzaken.

Selecteer de nieuwe waarden en klik dan op de knop [OK] zoals gewoonlijk. De verbindingen tussen de elementen
van het model zullen overeenkomstig wijzigen in de werkruimte van Grafische modellen bouwen.
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17.3.5 Activating and deactivating algorithms

Algorithms can be deactivated in the modeler, so they will not be executed once the model is run. This can be
used to test just a given part of the model, or when you do not need all the outputs it generates.

To deactivate an algorithm, right-click on its icon in the model canvas and select the Deactivate option. You will
see that the algorithm is represented now with a red label under its name indicating that it is not active.

Figuur 17.23: Deactivate

All algorithms depending (directly or indirectly) on that algorithm will also appear as inactive, since they cannot
be executed now.

To activate an algorithm, just right-click on its icon and select the Activate option.

17.3.6 Bewerken van Help-bestanden Grafische modellen bouwen en meta-
informatie

U kunt vanuit Grafische modellen bouwen uw modellen documenteren. Klik gewoon op de knop [Help model
bewerken] en een dialoogvenster, zoals dat wat hieronder wordt weergegeven, zal verschijnen.

Figuur 17.24: Bewerken van Help

Aan de rechterkant ziet u een eenvoudige HTML-pagina, die is gemaakt met behulp van de beschrijving van
de parameters voor de invoer en de uitvoer van het algoritme, tezamen met enkele aanvullende items zoals een
algemene beschrijving van het model of de auteur ervan. De eerste keer dat u de bewerker voor de Help opent,
zijn al deze beschrijvingen leeg, maar u kunt ze bewerken met behulp van de elementen aan de linkerkant van het
dialoogvenster. Selecteer een element in het bovenste gedeelte en schrijf dan de beschrijving ervan in het tekstvak
onderin.
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Help voor modellen wordt opgeslagen in een bestand in dezelfde map als het model zelf. U hoeft zich geen zorgen
te maken over het opslaan, dat wordt automatisch gedaan.

17.3.7 Over beschikbare algoritmen

Het zal u zijn opgevallen dat sommige algoritmen die uitgevoerd kunnen worden vanuit de Toolbox niet verschij-
nen in de lijst van beschikbare algoritmen wanneer u een model ontwerpt. Een algoritme moet een juiste semantiek
hebben, zoals juist zijn gekoppeld aan andere in de werkstroom, om te kunnen worden opgenomen in een model.
Als een algoritme niet een dergelijke goed-gedefiniëerde semantiek heeft (als bijvoorbeeld het aantal uit te voeren
lagen niet vooruit bekend is), dan is het niet mogelijk om het in een model te gebruiken, en dus,verschijnt het niet
in de lijst met algoritmen die u zult zien in het dialoogvenster Grafische modellen bouwen.

Aanvullend zult u in Grafische modellen bouwen enkele algoritmen zien die niet worden aangetroffen in de Tool-
box. Deze algoritmen zijn bedoeld om exclusief als deel van een model te worden gebruikt, en zij zijn niet
van belang in enige andere. Het algoritme ‘Calculator’ is een voorbeeld daarvan. Het is slechts een eenvoudige
rekenkundige calculator die u kunt gebruiken om numerieke waarden aan te passen (ingevoerd door de gebruiker
of gegenereerd door een ander algoritme). Dit gereedschap is echt handig binnen een model, maar buiten die
context, heeft het niet veel betekenis.

17.3.8 Saving models as Python code

Given a model, it is possible to automatically create Python code that performs the same task as the model itself.
This code is used to create a console script (we will explain scripts later in this manual) and you can modify
that script to incorporate actions and methods not available in the graphical modeler, such as loops or conditional
sentences.

This feature is also a very practical way of learning how to use processing algorithms from the console and how
to create new algorithms using Python code, so you can use it as a learning tool when you start creating your own
scripts.

Save your model in the models folder and go to the toolbox, where it should appear now, ready to be run. Right-
click on the model name and select Save as Python script in the context menu that will pop up. A dialog will
prompt you to introduce the file where you want to save the script.

.

17.4 De interface Batch-processing

17.4.1 Introductie

Alle algoritmen (inclusief modellen) kunnen worden uitgevoerd als een batch-proces. Dat is, zij kunnen worden
uitgevoerd niet slechts met één enkele set van invoer, maar met meerdere daarvan, het algoritme net zo vaak
uitvoerende als nodig is. Dit is handig bij het verwerken van grote hoeveelheden gegevens, omdat het niet nodig
is het algortime vele keren vanuit de Toolbox te starten.

Kik met rechts op de naam in de Toolbox en selecteer de optie Uitvoeren als batch-proces in het pop-upmenu dat
verschijnt om een algoritme als een batch-proces uit te voeren.

Figuur 17.25: Batch-proces rechts-klik
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17.4.2 De tabel met parameters

uitvoeren van een batch-proces is soortgelijk aan het eenmalig uitvoeren van een algoritme. Waarden voor pa-
rameters moeten worden gedefinieerd, maar in dit geval hoeven niet één enkele waarde voor elke parameter op
te geven, maar in plaats daarvan een set, één voor elke keer dat het algoritme moet worden uitgevoerd. Waarden
worden ingevoerd met behulp van een tabel zoals die welke hierna wordt weergegeven.

Figuur 17.26: Batch-proces

Elke regel van deze tabel vertegenwoordigt één enkele uitvoering van het algoritme, en elke cel bevat de waarde
van één van de parameters. Het is soortgelijk aan het dialoogvenster Parameters dat u ziet bij het uitvoeren van
een algoritme vanuit de Toolbox, maar met een andere schikking.

Standaard bevat de tabel slechts twee regels. U kunt regels toevoegen of verwijderen met behulp van de knoppen
in het onderste deel van het venster.

Als de grootte van de tabel eenmaal is ingesteld, moet die worden gevuld met de gewenste waarden.

17.4.3 Vullen van de tabel met parameters

Voor de meeste parameters is het instellen van de waarde triviaal. Type de waarde of selecteer die uit de lijst van
beschikbare opties, afhankelijk van het type parameter.

De belangrijkste verschillen worden gevonden in parameters die lagen of tabellen vertegenwoordigen, en voor
bestandspaden voor de uitvoer. Met betrekking tot het invoeren van lagen en tabellen, wanneer een algoritme
wordt uitgevoerd als deel van een batch-proces, worden objecten van invoergegevens direct uit bestanden gehaald,
en niet uit de set ervan die al is geopend in QGIS. Hierdoor kan elk algoritme worden uitgevoerd als een batch-
proces, zelfs als er geen gegevensobjecten zijn geopend en het algoritme niet kan worden uitgevoerd vanuit de
Toolbox.

Bestandsnamen voor objecten van invoergegevens worden gevuld door ze direct in te typen of, meer eenvoudiger,

door te klikken op de knop aan de rechterkant van de cel, wat een normaal dialoogvenster voor het kiezen
van bestanden weer zal geven. Meerdere bestanden kunnen in één keer worden geselecteerd. Als de parameters
voor de invoer één enkele gegevensobject vertegenwoordigen en verscheidene bestanden zijn geselecteerd, zal
elk daarvan worden vermeld in een afzonderlijke rij, waarbij, indien nodig, nieuwe worden toegevoegd. Als de
parameter een meervoudige invoer vertegenwoordigt, zullen alle geselecteerde bestanden worden vermeld in één
enkele cel, gescheiden door puntkomma’s (;).
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Gegevensobjecten voor uitvoer worden altijd opgeslagen in een bestand en, anders dan bij het uitvoeren van
een algoritme vanuit de Toolbox, is het opslaan in een tijdelijk bestand niet toegestaan. U kunt de naam direct
typen of het dialoogvenster voor het selecteren van bestanden gebruiken dat verschijnt bij het klikken op de
overeenkomstige knop.

Als u eenmaal het bestand hebt geselecteerd, wordt een nieuw dialoogvenster weergegeven om het mogelijk te
maken andere cellen in dezelfde kolom automatisch aan te vullen (dezelfde parameter).

Figuur 17.27: Opslaan Batch-proces

Als de standaard waarde (‘Niet automatisch aanvullen’) is geselecteerd, zal het eenvoudigweg de geselecteerde
bestandsnaam in de geselecteerde cel van de tabel met parameters zetten. Als een van de andere opties is gese-
lecteerd, zullen alle cellen onder de geselecteerde automatisch worden gevuld, gebaseerd op gedefinieerde criteria.
Op deze manier is het veel eenvoudiger om de tabel te vullen en kan het batch-proces met minder inspaningen
worden gedefinieerd.

Automatisch aanvullen kan eenvoudig worden gedaan door simpelweg correlatieve getallen toe te voegen aan het
geselecteerde bestandspad, of door de waarde van een andere veld toe te voegen aan dezelfde rij. Dit is in het
bijzonder handig voor het benoemen van gegevensobjecten voor uitvoer overeenkomstig de ingevoerde.

Figuur 17.28: Batch-proces bestandspad

17.4.4 Uitvoerne van het batch-proces

Klik eenvoudigweg op [OK] om het batch-proces uit te voeren als u alle noodzakelijke waarden hebt ingevuld.
De voortgang van de globale taak voor de batch zal worden weergegeven in de voortgangsbalk aan de onderzijde
van het dialoogvenster.

.

17.5 Processing algoritmen gebruiken vanaf de console

De console stelt gevorderde gebruikers in staat hun productiviteit te vergroten en complexe bewerkingen uit te
voeren die niet kunnen worden uitgevoerd met een van de andere elementen van de GUI van het framework
Processing. Modellen die verscheidene algoritmen omvatten kunnen worden gedefinieerd met behulp van de
interface voor de opdrachtregel, en aanvullende bewerkingen, zoals lussen en voorwaardelijke zinnen, kunnen
worden toegevoegd om meer flexibele en meer krachtige werkstromen te maken.

er is geen console voor Proccesing in QGIS, maar alle opdrachten voor Processing zijn in plaats daarvan beschik-
baar vanuit de in QGIS ingebouwde console voor Python. Dat betekent dat u die opdrachten in uw werk op
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de console kunt inpassen en algoritmen van Processing kunt verbinden aan alle andere mogelijkheden (inclusief
methoden uit de API van QGIS) die van daaruit beschikbaar zijn.

De code die u kunt uitvoeren vanuit de console van Python, zelfs als het geen specifieke methode voor Processing
aanroept, kan worden geconverteerd naar een nieuw algoritme dat u later kunt aanroepen vanuit de Toolbox,
Grafische modellen bouwen of enige andere component, net zoals u doet met een andere algoritme. In feite zijn
enkele algoritmen, die u in de Toolbox aantreft, eenvoudige scripts.

In dit gedeelte zullen we zien hoe we algoritmen van Processing gebruiken vanuit de console voor Python in
QGIS, en ook hoe we algoritmen schrijven met behulp van Python.

17.5.1 Algoritmen aanroepen van de console van Python

Het eerste dat u moet doen is de functies voor Processing importeren met de volgende regel:

>>> import processing

Wel„ er is in de basis slechts één (interessant) ding dat u daarmee kunt doen vanaf de console: een algoritme
uitvoeren. Dat wordt gedaan met behulp van de methode runalg(), welke de naam van dat uit te voeren
algoritme als zijn eerste parameter opneemt, en dan een variabel aantal aanvullende parameters, afhankelijk van
de vereisten van het algoritme. Dus het eerste wat u moet weten is de naam van het uit te voeren algoritme. Dat
is niet de naam die u ziet in de Toolbox, maar eerder een unieke naam voor de opdrachtregel. U kunt de methode
algslist() gebruiken om de juiste naam voor uw algoritme te zoeken,. Type de volgende regel in uw console:

>>> processing.alglist()

U zult iets zien zoals dit.

Accumulated Cost (Anisotropic)---------------->saga:accumulatedcost(anisotropic)
Accumulated Cost (Isotropic)------------------>saga:accumulatedcost(isotropic)
Add Coordinates to points--------------------->saga:addcoordinatestopoints
Add Grid Values to Points--------------------->saga:addgridvaluestopoints
Add Grid Values to Shapes--------------------->saga:addgridvaluestoshapes
Add Polygon Attributes to Points-------------->saga:addpolygonattributestopoints
Aggregate------------------------------------->saga:aggregate
Aggregate Point Observations------------------>saga:aggregatepointobservations
Aggregation Index----------------------------->saga:aggregationindex
Analytical Hierarchy Process------------------>saga:analyticalhierarchyprocess
Analytical Hillshading------------------------>saga:analyticalhillshading
Average With Mask 1--------------------------->saga:averagewithmask1
Average With Mask 2--------------------------->saga:averagewithmask2
Average With Thereshold 1--------------------->saga:averagewiththereshold1
Average With Thereshold 2--------------------->saga:averagewiththereshold2
Average With Thereshold 3--------------------->saga:averagewiththereshold3
B-Spline Approximation------------------------>saga:b-splineapproximation
...

Dat is een lijst met alle beschikbare algoritmen, alfabetisch gerangschikt, tezamen met hun corresponderende
namen voor de opdrachtregel.

U kunt een tekenreeks gebruiken als een parameter voor deze methode. In plaats van de volledige lijst met algo-
ritmen terug te geven, zal het alleen die weergeven waar in de naam die tekenreeks voorkomt. Als u bijvoorbeeld
op zoek bent naar een algoritme om de helling van een DEM te berekenen, type alglist("slope") om het
volgende resultaat te verkrijgen:

DTM Filter (slope-based)---------------------->saga:dtmfilter(slope-based)
Downslope Distance Gradient------------------->saga:downslopedistancegradient
Relative Heights and Slope Positions---------->saga:relativeheightsandslopepositions
Slope Length---------------------------------->saga:slopelength
Slope, Aspect, Curvature---------------------->saga:slopeaspectcurvature
Upslope Area---------------------------------->saga:upslopearea
Vegetation Index[slope based]----------------->saga:vegetationindex[slopebased]
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Dit resultaat zou kunnen wijzigen, afhankelijk van de algoritmen die u beschikbaar heeft.

Het is nu eenvoudiger om het algoritme te vinden waar u naar zoekt en de naam voor de opdrachtregel ervan, in
dit geval saga:slopeaspectcurvature.

Wanneer u eenmaal de naam voor de opdrachtregel weet van het algoritme, is het volgende om te doen de
juiste syntaxis te bepalen om het uit te voeren. Dat betekent: weten welke parameters nodig zijn en de vol-
gorde waarin zij moeten worden doorgegeven bij het aanroepen van de methode runalg(). Er bestaat een
methode om een algoritme in detail te beschrijven, die kan worden gebruikt om een lijst van de parame-
ters te verkrijgen die een algoritme vereist en de soorten uitvoer die het zal genereren. U kunt de methode
alghelp(naam_van_het_algoritme) gebruiken om deze informatie te krijgen. Gebruik de naam voor
de opdrachtregel van het algoritme, niet de volledige beschrijvende naam.

De methode aanroepen met als parameter saga:slopeaspectcurvature, geeft u de volgende beschrijving:

>>> processing.alghelp("saga:slopeaspectcurvature")
ALGORITHM: Slope, Aspect, Curvature

ELEVATION <ParameterRaster>
METHOD <ParameterSelection>
SLOPE <OutputRaster>
ASPECT <OutputRaster>
CURV <OutputRaster>
HCURV <OutputRaster>
VCURV <OutputRaster>

Nu heeft u alles wat u nodig heeft om een algoritme uit te voeren. Zoals we al eerder hebben verteld is er slechts
één opdracht om algoritmen uit te voeren: runalg(). De syntaxis ervan is als volgt:

>>> processing.runalg(name_of_the_algorithm, param1, param2, ..., paramN,
Output1, Output2, ..., OutputN)

De lijst met parameters en de toe te voegen uitvoer is afhankelijk van het algoritme dat u wilt uitvoeren, en is exact
de lijst die de methode alghelp() u geeft, in dezelfde volgorde als weergegeven.

Afhankelijk van het type parameter dienen waarden verschillend te worden ingevoerd. De volgende lijst geeft een
snel overzicht van hoe waarden in te voeren voor elk type parameter:

• Raster Layer, Vector Layer of Table. Gebruik eenvoudigweg een tekenreeks met de naam die het te ge-
bruiken gegevensobject identificeert (de naam die het heeft in de inhoudsopgave van QGIS) of een bestand-
snaam (als de betreffende laag niet is geopend, hij zal worden geopend, maar niet worden toegevoegd aan
het kaartvenster). Als u een instantie van een object van QGIS heeft dat de laag vertegenwoordigt, kunt
u die ook doorgeven als parameter. Als de invoer optioneel is en u wilt geen gegevensobject gebruiken,
gebruik dan None.

• Selection. Als een algoritme een parameter voor selectie heeft moet de waarde van die parameter wor-
den ingevuld met behulp van een waarde integer. U kunt de opdracht algoptions() gebruiken om de
beschikbare opties te weten te komen, zoals weergegeven in het volgende voorbeeld:

>>> processing.algoptions("saga:slopeaspectcurvature")
METHOD(Method)

0 - [0] Maximum Slope (Travis et al. 1975)
1 - [1] Maximum Triangle Slope (Tarboton 1997)
2 - [2] Least Squares Fitted Plane (Horn 1981, Costa-Cabral & Burgess 1996)
3 - [3] Fit 2.Degree Polynom (Bauer, Rohdenburg, Bork 1985)
4 - [4] Fit 2.Degree Polynom (Heerdegen & Beran 1982)
5 - [5] Fit 2.Degree Polynom (Zevenbergen & Thorne 1987)
6 - [6] Fit 3.Degree Polynom (Haralick 1983)

In dit geval heeft het algoritme één dergelijke parameter, met zeven opties. Onthoud dat de volgorde begint
met nul.

• Multiple input. De waarde is een tekenreeks met beschrijvingen voor de invoer die zijn gescheiden door
puntkomma’s (;). Net als in het geval van enkele lagen of tabellen, kan elke beschrijving voor de invoer de
naam van het gegevensobject of het bestandspad zijn.
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• Table Field from XXX. Gebruik een tekenreeks met de naam van het te gebruiken veld. Deze parameter is
hoofdlettergevoelig.

• Fixed Table. Type de lijst voor alle waarden voor de tabel, gescheiden door komma’s (,) en omsluit ze met
aanhalingstekens ("). Waarden beginnen op de bovenste rij en gaan van rechts naar links. U kunt ook een
2D-array van waarden gebruiken die de tabel vertegenwoordigt.

• CRS. Voer het EPSG-codenummer van het gewenste CRS in.

• Extent. U dient een tekenreeks te gebruiken met de waarden xmin, xmax, ymin en ymax, gescheiden
door komma’s (,).

Booleaanse, bestand, tekenreeks en numerieke parameters behoeven geen aanvullende uitleg.

Input parameters such as strings, booleans, or numerical values have default values. To use them, specify None
for the corresponding parameter entry.

Voor gegevensobjecten voor de uitvoer, type het te gebruiken bestandspad om ze op te slaan, net zoals wordt
gedaan in de Toolbox. Gebruik None als u het resultaat naar een tijdelijk bestand wilt opslaan. De extensie van
het bestand bepaalt de indeling van het bestand. Als u een extensie invoert die niet wordt ondersteund door het al-
goritme, zal de standaard indeling voor het bestand voor dat type uitvoer worden gebruikt en de corresponderende
extensie worden toegevoegd aan het opgegeven bestandspad.

Anders dan wanneer een algoritme wordt uitgevoerd vanuit de Toolbox, wordt uitvoer niet toegevoegd aan het
kaartvenster als u datzelfde algoritme uitvoert vanaf de console voor Python. Als u een uitvoer wilt toevoegen aan
het kaartvenster dient u dat zelf te doen na het uitvoeren van het algoritme. U kunt opdrachten voor de API van
QGIS gebruiken om dat te doen, maar, zelfs eenvoudiger, ook een van de handige methoden gebruiken die zijn
verschaft voor dergelijke taken.

De methode runalg geeft een woordenboek terug met de namen van de uitvoer (die welke worden weergegeven
in de beschrijving van het algoritme) als sleutels en de bestandspaden van die uitvoer als waarden. U kunt deze
lagen laden door de corresponderende bestandspaden door te geven aan de methode load().

17.5.2 Aanvullende functies voor het afhandelen van gegevens

Naast de functies die worden gebruikt om algoritmen aan te roepen, zal het importeren van het pakket
processing ook enkele aanvullende functies importeren die het gemakkelijke maken om met gegevens te
werken, in het bijzonder vectorgegevens. het zijn slechts functies voor het gemak die enige functionaliteit va-
nuit de API van QGIS binden, gewoonlijk met een minder complexe syntaxis. Deze functies zouden moeten
worden gebruikt bij het ontwikkelen van nieuwe algoritmen, omdat zij het eenvoudiger maken om te werken met
invoergegevens.

Hieronder staat een lijst ven enkele van die opdrachten. Meer informatie kan worden gevonden in de klassen onder
het pakket processing/tools, en ook in de voorbeeldscripts die worden verschaft met QGIS.

• getobject(obj): Returns a QGIS object (a layer or table) from the passed object, which can be a
filename or the name of the object in the QGIS Table of Contents.

• values(layer, fields): Geeft de waarden voor de opgegeven velden in de attributentabel van een
vectorlaag terug. Velden kunnen worden opgegeven als veldnamen of als op nul gebaseerde indices van
velden. Geeft een woordenboek van lijsten terug, met de opgegeven identificaties van de velden als sleutels.
Het is van toepassing op de bestaande selectie.

• getfeatures(layer): Returns an iterator over the features of a vector layer, considering the existing
selection.

• uniquelabels(layer, field): Returns a list of unique values for a given attribute. Attributes can
be passed as a field name or a zero-based field index. It considers the existing selection.

17.5.3 Scripts maken en die uitvoeren vanuit de Toolbox

U kunt uw eigen algoritmen maken door de corresponderende code voor Python te schrijven en een paar extra
regels toe te voegen met aanvullende informatie die nodig is om de semantiek van het algoritme te definiëren.
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U vindt een menu Create new script onder de groep Tools in het blok met algoritmen Scripts van de Toolbox.
Dubbelklik erop om het dialoogvenster voor bewerken van scripts te openen. Daar zou u uw code moeten typen.
Sla het script daarvandaan op in de map scripts (de standaard map wanneer u het dialoogvenster Opslaan als...
opent) met de extensie .py en het zal automatisch het corresponderende algoritme maken.

De naam van het algoritme (die welke u zult zien in de Toolbox) wordt gemaakt uit de bestandsnaam, waarbij de
extensie is verwijderd en de lage streepjes zijn vervangen door spaties.

Laten we eens kijken naar de volgende code, die de Topographic Wetness Index (TWI) berekent, direct uit een
DEM.

##dem=raster
##twi=output
ret_slope = processing.runalg("saga:slopeaspectcurvature", dem, 0, None,

None, None, None, None)
ret_area = processing.runalg("saga:catchmentarea(mass-fluxmethod)", dem,

0, False, False, False, False, None, None, None, None, None)
processing.runalg("saga:topographicwetnessindex(twi), ret_slope[’SLOPE’],

ret_area[’AREA’], None, 1, 0, twi)

Zoals u kunt zien behelst de berekening drie algoritmen, alle drie afkomstig uit SAGA. De laatste berekent de
TWI, maar het heeft een laag slope nodig en een laag flow accumulation. We hebben deze lagen niet, maar omdat
we de DEM hebben, kunnen we ze berekenen door het aanroepen van de corresponderende algoritmen van SAGA.

Het gedeelte van de code waar dit verwerken plaatsvindt is niet moeilijk te begrijpen als u de eerdere gedeelten in
dit hoofdstuk heeft gelezen. De eerste regels behoeven echter enige nadere uitleg. Zij verschaffen de informatie
die nodig is om uw code te veranderen in een algoritme dat kan worden uitgevoerd vanuit één van de componenten
van de GUI, zoals de Toolbox of Grafische modellen bouwen.

Deze regels beginnen met een dubbel symbool voor een opmerking in Python (##) en hebben de volgende struc-
tuur:

[parameter_name]=[parameter_type] [optional_values]

Hier is een lijst met alle typen parameter die worde ondersteund in scripts voor Processing, hun syntaxis en enkele
voorbeelden.

• raster. Een rasterlaag.

• vector. Een vectorlaag.

• table. Een tabel.

• number. Een numerieke waarde. Een standaard waarde moet worden opgegeven. Bijvoorbeeld:
depth=number 2.4.

• string. Een tekst-tekenreeks. Net als in het geval van numerieke waarden moet een standaard waarde
worden toegevoegd. Bijvoorbeeld: name=string Victor.

• boolean. Een Booleaanse waarde. Voeg True of False erna toe om het in te stellen op de standaard
waarde. Bijvoorbeeld: verbose=boolean True.

• multiple raster. Een set van rasterlagen voor invoer.

• multiple vector. Een set van vectorlagen voor invoer.

• field. Een veld in de attributentabel van een vectorlaag. De naam van de laag moet worden toegevoegd
na de tag field. Als bijvoorbeeld een vector als invoer heeft gedeclareerd met mynlaag=vector, zou
u mynveld=field mynlaag kunnen gebruiken om een veld uit die laag als parameter toe te voegen.

• folder. Een map.

• file. Een bestandsnaam.

De naam van de parameter is de naam die aan de gebruiker zal worden getoond bij het uitvoeren van het algoritme,
en ook de naam van de variabele die moet worden gebruikt in de code van het script. De waarde die door de
gebruiker voor die parameter wordt ingevuld zal worden toegewezen aan een variabele met die naam.

212 Hoofdstuk 17. QGIS framework Processing



QGIS User Guide, Release 2.2

Bij het tonen van de naam van de parameter aan de gebruiker, zal de naam worden bewerkt om zijn uiterlijk te ver-
beteren, waarbij lage streepjes worden vervangen door spaties. Dus, als bijvoorbeeld wilt dat de gebruiker een pa-
rameter genaamd Een numerieke waarde ziet, kunt u als naam voor de variabele ‘‘Een_numerieke_waarde‘
gebruiken‘.

Lagen en tabelwaarden zijn tekenreeksen die het bestandspad van het corresponderende object bevatten. U kunt
de functie processing.getObjectFromUri() gebruiken om er een object voor QGIS van te maken,.
Meerdere invoer is ook een waarde van een tekenreeks, die de bestandspaden naar alle geselecteerde objecten
bevat, gescheiden door puntkomma’s (;).

Soorten uitvoer worden op een soortgelijke manier gedefinieerd, met behulp van de volgende tags:

• output raster

• output vector

• output table

• output html

• output file

• output number

• output string

De waarde die wordt toegewezen aan de variabelen voor uitvoer is altijd een tekenreeks met een bestandspad.
Het zal corresponderen met een tijdelijk bestandspad als de gebruiker geen bestandsnaam voor de uitvoer heeft
ingevoerd.

Wanneer u een uitvoer declareert, zal het algoritme proberen het aan QGIS toe te voegen als het is voltooid. Dat
is waarom, hoewel de methode runalg() niet de lagen laadt die het produceert, de uiteindelijke laag TWI zal
worden geladen (in het geval van ons vorige voorbeeld), omdat het is opgeslagen in het bestand dat is ingevoerd
door de gebruiker, wat de waarde is van de de corresponderende uitvoer.

Gebruik niet de methode load() in uw script-algoritmen, wanneer u slechts werkt met de regel voor de console.
Als een laag wordt gemaakt als uitvoer van een algoritme, zou het als zodanig moeten worden gedeclareerd.
Anders zult u niet in staat zijn het algoritme op de juiste manier te gebruiken in Grafische modellen bouwen,
omdat de syntaxis ervan (zoals gedefinieerd door de hierboven uitgelegde tags) niet overeenkomen met wat het
algoritme in werkelijkheid maakt.

Verborgen uitvoer (numbers en strings) hebben geen waarde. In plaats daarvan dient u aan hen een waarde toe te
kennen. Stel de waarde van een variabele in met de naam die u gebruikte om de uitvoer te declareren om dat te
doen,. Als u bijvoorbeeld deze declaratie gebruikte,

##average=output number

de volgende regel zal de waarde voor de uitvoer instellen op 5:

average = 5

In aanvulling op de tags voor parameters en soorten uitvoer, kunt u ook de groep definiëren waaronder het algo-
ritme zal worden weergegeven, met behulp van de tag group.

Als uw algoritme er lang over doet om te worden verwerkt, is het een goed idee om de gebruiker daarover
te informeren. U heeft een globale genaamd progress beschikbaar, met twee mogelijke methoden:
setText(text) en setPercentage(percent) om de tekst over de voortgang en de voortgangsbalk aan
te passen.

Verscheidene voorbeelden zijn meegeleverd. Bekijk ze om echte voorbeelden te zien van het maken van algorit-
men met behulp van de klassen van het framework Processing. U kunt met rechts op elk script voor een algoritme
klikken en Edit script selecteren om de code ervan te bewerken of om die slechts te zien.
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17.5.4 Documenteren van uw scripts

Net als in het geval van modellen kunt u aanvullende documentatie voor uw scripts maken, om uit te leggen wat
zij doen en hoe ze zijn te gebruiken. In het dialoogvenster Script editor vindt u een knop [Help script bewerken].
Klik er op en het brengt u naar het dialoogvenster Help editor. Bekijk het gedeelte over Grafische modellen
bouwen om mee rover dit dialoogvenster te weten te komen en hoe het te gebruiken.

Help-bestanden worden in dezelfde map opgeslagen als het script zelf, waarbij de extensie .help aan de bestand-
snaam wordt toegevoegd. Onthoud dat u uw Help voor uw script kunt bewerken vóórdat u het script voor de eerste
keer opslaat. Als u later het dialoogvenster Script editor sluit zonder het script op te slaan (d.i., u verwerpt het), zal
de inhoud voor de Help verloren gaan. Als uw script al was opgeslagen en is geassocieerd aan een bestandsnaam,
wordt de inhoud voor de Help automatisch opgeslagen.

17.5.5 Haken voor pre- en post-uitvoering van scripts

Scripts kunnen ook worden gebruikt om haken in te stellen voor pre- en post-uitvoering die worden uitgevoerd
vóórdat of nadat een algoritme is uitgevoerd. Dit kan worden gebruikt om taken te automatiseren die zouden
moeten worden uitgevoerd wanneer een algortime wordt uitgevoerd.

De syntaxis is identiek aan de hierboven uitgelegde syntaxis, maar een aanvullende globale variabele genaamd
alg is beschikbaar, die het algoritme vertegenwoordigt dat zojuist is (of op het punt staat te worden) uitgevoerd.

In de groep General van het dialoogvenster Opties en configuratie van Processing vindt u twee items genaamd
Pre-execution script en Post-execution script waar de bestandsnaam van de uit te voeren scripts in elk geval kunnen
worden ingevoerd.

.

17.6 Beheren van de historie

17.6.1 De historie van processing

Elke keer als u een algoritme uitvoert, wordt informatie over het proces opgeslagen het beheer van de historie.
Naast de gebruikte parameters worden de datum en tijd van het uitvoeren ook opgeslagen.

Op deze manier is het eenvoudig om het werk dat ontwikkeld is te volgen en te beheren met behulp van het
framework processing en is het eenvoudig te reproduceren.

Het beheer van de historie is een verzameling items uit het register die zijn gegroepeerd overeenkomstig hun
datum van uitvoering, wat het eenvoudiger maakt informatie te vinden over een algoritme dat werd uitgevoerd op
een bepaald moment.

Procesinformatie wordt opgeslagen als een uitdrukking voor de opdrachtregel, zelfs als het algoritme werd ges-
tart vanuit de Toolbox. Dit maakt het handig voor degenen die leren hoe zij de interface voor de opdrachtregel
moeten gebruiken, omdat zij een algoritme kunnen aanroepen met behulp van de Toolbox en dan het beheren
van de historie kunnen raadplegen om te zien hoe datzelfde algoritme zou kunnen worden aangeroepen vanaf de
opdrachtregel.

Apart van het bladeren door de items in het register, kunt u het proces ook opnieuw uitvoeren door simpelweg te
dubbelklikken op het overeenkomstige item.

Naast het opnemen van het uitvoeren van algoritmen, communiceert het framework processing met de gebruiker
door middel van de andere groepen van het register, namelijk Errors, Warnings en Info. In het geval dat iets niet
juist werkt, een blik op de Errors zou u kunen helpen om te zien wat er gebeurt. Als u in contact komt met een
ontwikkelaar om een probleem of fout te rapporteren, zal de informatie in die groep zeer handig zijn voor hem of
haar om uit te zoeken wat er fout gegaan is.

Algoritmen van derde partijen worden gewoonlijk uitgevoerd door hun interfaces voor de opdrachtregel aan te
roepen, die met de gebruiker communiceren via de console. Hoewel die console niet wordt weergegeven, wordt
een volledig dump ervan opgeslagen in de groep Info, elke keer als u een van deze algoritmen uitvoert. Als u,
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Figuur 17.29: Historie

bijvoorbeeld, problemen ondervindt bij het uitvoeren van een SAGA-algoritme, zoek dan naar een item genaamd
‘SAGA execution console output’ om alle berichten te controleren die door SAGA zijn gegenereerd en probeer
uit te zoeken waar het probleem ligt.

Sommige algoritmen, zelfs als zij een resultaat kunnen produceren met de opgegeven invoerdata, zouden op-
merkingen of aanvullende informatie kunnen toevoegen aan het blok Warnings als zij potentiële problemen met
de gegevens detecteren, om u te waarschuwen. Zorg er voor dat u deze berichten controleert als u onverwachte
resultaten ondervindt.

.

17.7 Configureren externe toepassingen

Het framework Processing kan worden uitgebreid met behulp van aanvullende toepassingen. Momenteel worden
SAGA, GRASS, OTB (Orfeo Toolbox) en R ondersteund, naast enkele andere programma’s voor de opdrachtregel
die functionaliteiten verschaffen voor analyses van ruimtelijke gegevens. Algoritmen die afhankelijk zijn van een
externe toepassing worden beheerd in hun eigen provider van algoritmen.

Dit gedeelte zal u laten zien hoe het framework Processing te configureren zodat het deze aanvullende toepassingen
opneemt, en zal het enkele bijzondere mogelijkheden uitleggen van de algoritmen die op hen gebaseerd zijn. Als
u het systeem eenmaal juist hebt geconfigureerd, zult u in staat zijn externe algoritmen uit te voeren vanuit elke
component, zoals de Toolbox of Grafische modellen bouwen, net zoals u doet met elk ander geo-algoritme.

Standaard zijn alle algoritmen, die afhankelijk zijn van een externe toepassing en niet worden meegeleverd met
QGIS, niet ingeschakeld. U kunt ze inschakelen in het dialoogvenster Configuratie. Zorg er voor dat de correspon-
derende toepassing al is geïnstalleerd op uw systeem. Inschakelen van een provider voor een algoritme zonder de
toepassing te installeren die het nodig heeft zal er voor zorgen dat de algoritmen verschijnen in de Toolbox, maar
er zal een fout optreden als u probeert ze uit te voeren.

Dit is omdat de beschrijvingen van de algoritmen (nodig om het dialoogvenster Parameters te maken en de ben-
odigde informatie over het algoritme te verschaffen) niet in elke toepassing zijn opgenomen, maar in plaats daarvan
in QGIS. Dat is, zij maken deel uit van QGIS, dus heeft u ze in uw installatie, zelfs als u geen andere software heeft
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geïnstalleerd. Voor het uitvoeren van het algoritme dienen echter de binaries van de toepassing te zijn geïnstalleerd
op uw systeem.

17.7.1 Een opmerking voor gebruikers van Windows

If you are not an advanced user and you are running QGIS on Windows, you might not be interested in reading
the rest of this chapter. Make sure you install QGIS in your system using the OSGeo4W application. That will
automatically install SAGA, GRASS and OTB in your system and configure them so they can be run from QGIS.
All the algorithms in the simplified view of the toolbox will be ready to be run without needing any further
configuration.

Als u mer wilt weten over hoe deze providers werken, of als u enkele algoritmen wilt gebruiken die niet zijn
opgenomen in de vereenvoudigde Toolbox (zoals R-scripts), lees dan verder.

17.7.2 Een opmerking met betrekking tot bestandsindelingen

Bij het gebruiken van externe software, betekent het openen van een bestand in QGIS niet dat het kan wor-
den geopend en ook verwerkt kan worden in die andere software. In de meeste gevallen kan andere software
lezen wat u hebt geopend in QGIS, maar in sommige gevallen hoeft dat niet zo te zijn. Bij het gebruiken van
databases of ongebruikelijke bestandsindelingen, voor raster- of vectorlagen, zouden problemen kunnen optreden.
Als dat gebeurd probeer dan goed bekende bestandsindelingen te gebruiken waarvan u weet dat zij door beide
programma’s worden begrepen, en controleer de uitvoer in de console (in de dialoogvensters Historie en log) om
meer te weten te komen over wat er fout gaat.

Bijvoorbeeld het gebruiken van GRASS rasterlagen is één geval waarbij u problemen kunt ondervinden en niet in
staat zijn uw werk te voltooien als u een extern algoritme aanroept met een dergelijke laag als invoer. Deze lagen
zullen, om deze reden, niet verschijnen als beschikbaar voor algoritmen.

U zou echter in het geheel geen problemen moeten ondervinden met vectorlagen, omdat QGIS automatisch con-
verteert vanuit de originele bestandsindeling naar een die geaccepteerd wordt door de externe toepassing vóórdat
de laag daaraan wordt doorgegeven. Dit zorgt voor extra verwerkingstijd, die significant zou kunnen zijn als de
laag een enorme grootte heeft, wees dus niet verbaasd als het meer tijd vergt om een laag uit een DB-verbinding
te verwerken dan het doet om een soortgelijk grootte die is opgeslagen in een shapefile te verwerken.

Providers die geen externe toepassingen gebruiken kunnen elke laag verwerken die u kunt openen in QGIS, omdat
zij het voor analyse openen via QGIS.

Met betrekking tot uitvoerindelingen kunnen alle indelingen die worden ondersteund door QGIS als uitvoer wor-
den gebruikt, zowel voor raster- als voor vectorlagen. Sommige providers ondersteunen bepaalde indelingen niet,
maar zij kunnen allemaal worden geëxporteerd naar veelvoorkomende indelingen voor rasterlagen die later au-
tomatisch kunnen worden getransformeerd door QGIS . Net als in het geval van invoerlagen, als deze conversie
nodig is, zou dat de verwerkingstijd kunnen verhogen.

Als de extensie van de gespecificeerde bestandsnaam bij het aanroepen van een algoritme niet overeenkomt met
de extensie van een van de door QGIS ondersteunde indelingen, dan zal een achtervoegsel worden toegevoegd om
een standaard indeling in te stellen. In het geval van rasterlagen wordt de extensie .tif gebruikt, waar .shp
wordt gebruikt voor vectorlagen.

17.7.3 Een opmerking over selecties van vectorlagen

Externe toepassingen kunnen ook bewust worden gemaakt van de selecties die bestaan in vectorlagen binnen
QGIS. Dat vereist echter het opnieuw schrijven van alle vectorlagen voor de invoer, net als wanneer zij origineel
in een indeling waren die niet wordt ondersteund door de externe toepassing. Alleen wanneer er geen selectie
bestaat, of de optie Use only selected features is niet ingeschakeld in de algemene configuratie van Processing,
kan een laag direct worden doorgegeven aan een externe toepassing.

In andere gevallen is slechts het exporteren van de geselecteerde objecten nodig, wat er voor zorgt dat de bendoigde
tijd voor uitvoering langer wordt.
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SAGA

Algoritmen voor SAGA kunnen worden uitgevoerd vanuit QGIS als u SAGA hebt geïnstalleerd op uw systeem
en u het framework Processing juist heeft geconfigureerd, zodat het de uit te voeren bestanden van SAGA kan
vinden. In het bijzonder is het uit te voeren bestand voor de opdrachtregel in SAGA nodig om algoritmen van
SAGA uit te voeren.

Als u werkt op Windows bevatten zowel het zelfstandige installatieprogramma als het installatieprogramma OS-
Geo4W SAGA tezamen met QGIS, en het pad wordt automatisch geconfigureerd, dus is er hoeft er verder niets te
worden gedaan.

Als u SAGA zelf hebt geïnstalleerd (onthoud: u heeft versie 2.1 nodig), moet het pad naar het uit te voeren bestand
van SAGA worden geconfigureerd. Open het dialoogvenster Opties en configuratie om dat te doen. In het blok
SAGA vindt u een instelling genaamd SAGA Folder. Voer het pad in naar de map waar SAGA is geïnstalleerd.
Sluit het dialoogvenster Opties en configuratie en nu bent u gereed om algoritmen van SAGA uit te voeren vanuit
QGIS.

Als u werkt op Linux zijn de binaries van, SAGA niet opgenomen in SEXTANTE, dus moet u de software zelf
downloaden en installeren. bekijk de website van SAGA voor meer informatie. SAGA 2.1 is vereist.

In dit geval is het niet nodig om het pad naar het uit te voeren bestand van SAGA te configureren, en u zult deze
mappen niet zien. In plaats daarvan dient u er voor te zorgen dat SAGA juist is geïnstalleerd en dat de map
ervan is toegevoegd aan de omgevingsvariabele PATH. Open eenvoudigweg een console en type saga_cmd om
te controleren of het systeem kan vinden waar de binaries van SAGA zijn opgeslagen.

17.7.4 Over beperkingen van het SAGA rastersysteem

De meeste algoritmen van SAGA die meerdere invoerrasterlagen vereisen eisen dat zij hetzelfde rastersysteem
hebben. Dat is, zij moeten hetzelfde geografische gebied bedekken en dezelfde celgrootte hebben, zodat hun
overeenkomende rasters overeenkomen. Bij het aanroepen van algoritmen van SAGA vanuit QGIS kunt u elke
laag gebruiken, ongeacht celgrootte en bereik ervan. Wanneer meerdere rasterlagen worden gebruikt als invoer
voor een algoritme van SAGA, resamplt QGIS ze naar een algemeen rastersysteem en geeft ze dan door aan SAGA
(tenzij het algoritme van SAGA kan werken met lagen uit verschillende rastersystemen).

De definitie van dat algemene rastersysteem wordt beheerd door de gebruiker en u zult verschillende parameters
vinden in de groep SAGA van het venster Opties en configuratie om dat te doen. Er zijn twee manieren voor het
instellen van de doel-rastersystemen:

• Handmatig instellen. U definieert het bereik door het instellen van de volgende parameters:

– Resampling min X

– Resampling max X

– Resampling min Y

– Resampling max Y

– Resampling cellsize

Onthoud dat QGIS invoerlagen zal resamplen tot dat bereik, zelfs als ze er niet mee overlappen.

• Automatisch instellen vanuit invoerlagen. Selecteer eenvoudigweg de optie Use min covering grid system
for resampling om deze optie te selecteren. Alle andere instellingen zullen worden genegeerd en het mini-
mum bereik dat alle invoerlagen bedekt, zal worden gebruikt. De celgrootte van de doellaag is het maximum
van alle celgrootten van de invoerlagen.

Voor algoritmen die niet meerdere rasterlagen gebruiken, of voor die welke geen uniek rastersysteem voor invoer
nodig hebben, wordt geen resamplen uitgevoerd vóór het aanroepen van SAGA end worden deze parameters niet
gebruikt.
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17.7.5 Beperkingen voor lagen met meerdere banden

Anders dan QGIS heeft SAGA geen ondersteuning voor lagen met meerdere banden. Als u een laag met meerdere
banden wilt gebruiken (zoals een RGB of multispectrale afbeelding), dient u die eerst te splitsen in afbeeldin-
gen met één band. U kunt het algoritme ‘SAGA/Grid - Tools/Split RGB image’ (wat drie afbeeldingen uit een
RGB-afbeelding maakt) of het algoritme ‘SAGA/Grid - Tools/Extract band’ (om één enkele band te extraheren)
gebruiken om dat te doen.

17.7.6 Beperkingen in celgrootte

SAGA gaat er van uit dat rasterlagen dezelfde celgrootte hebben in de X- en de Y-as. Als u werkt met een laag
met verschillende waarden voor horizontale en verticale celgrootte, zou u onverwachte resultaten kunnen krijgen.
In dat geval zal een waarschuwing worden toegevoegd aan het log van Processing, die aangeeft dat een invoerlaag
niet geschikt zou kunnen zijn om te worden verwerkt door SAGA.

17.7.7 Loggen

Als QGIS SAGA aanroept doet het dat door middel van de interface voor de opdrachtregel, en dus door het
doorgeven van een set opdrachten om alle vereiste bewerkingen uit te voeren. SAGA geeft zijn voortgang weer
door informatie te schrijven naar de console, wat het percentage van reeds verrichte verwerking bevat, naast
aanvullende inhoud. Deze uitvoer wordt gefilterd en gebruikt om de voortgangsbalk bij te werken terwijl het
algoritme wordt uitgevoerd.

Zowel de opdrachten die zijn verstuurd door QGIS als de aanvullende informatie die is afgedrukt door SAGA
kunnen worden gelogd naast andere logberichten voor de verwerking, en u zou ze handig kunnen vinden om tot in
detail te kunnen zien wat er gebeurd als QGIS een algoritme van SAGA uitvoert. U zult twee instellingen vinden,
namelijk Log console output en Log execution commands, om dat mechanisme voor het loggen te activeren.

De meeste andere providers die een externe toepassing gebruiken en die aanroepen via de opdrachtregel hebben
soortgelijke opties, u zult ze dus ook op andere plaatsen in de lijst met instellingen voor Processing vinden.

R. Creating R scripts

Integratie van R in QGIS is anders dan die van SAGA op die manier dat er geen voorgedefinieerde set van algo-
ritmen is die u kunt uitvoeren (uitgezonderd een aantal voorbeelden). In plaats daarvan zou u uw scripts moeten
schrijven en opdrachten in R moeten aanroepen, net zoals u zou doen vanuit R, en op een hele soortgelijke manier
als die welke we zagen in het gedeelte over scripts voor Processing. Dit gedeelte toont u de te gebruiken syntaxis
om deze opdrachten in R te gebruiken vanuit QGIS en hoe objecten van QGIS (lagen, tabellen) er in te gebruiken.

Het eerste dat u moet doen, zoals we zagen in het geval van SAGA, is om QGIS te vertellen waar uw binaries van
R zijn opgeslagen. U kunt dit doen door middel van het item R folder in het dialoogvenster Opties en configuratie.
Als u die parameter eenmaal hebt ingesteld, kunt u beginnen met het maken en uitvoeren van uw eigen scripts in
R.

Nogmaals dit is anders in Linux en u dient er voor te zorgen dat de map R is opgenomen in de omgevingsvariabele
PATH. Als u R kunt starten door slechts R in een console te typen, dan bent u klaar om te beginnen.

U dient een scriptbestand te maken dat het framework Processing vertelt hoe die bewerking moet worden uitgevo-
erd en de corresponderende opdrachten in R om dat te doen om een nieuw algoritme toe te voegen dat een functie
in R aanroept (of een meer complex script in R dat u heeft ontwikkeld en dat u beschikbaar zou willen hebben
vanuit QGIS),

Scriptbestanden van R hebben de extensie .rsx, en het maken ervan is redelijk eenvoudig als u basiskennis bezit
van de syntaxis en scripten van R. Zij zouden moeten worden opgeslagen in de map voor scripts van R. U kunt
deze map instellen in de groep met instellingen R (beschikbaar vanuit het dialoogvenster Opties en configuratie),
net zoals u doet met de map voor normale scripts voor Processing.

Laten eens kijken naar een heel eenvoudig scriptbestand, dat de methode in R spsample aanroept om een
willekeurig raster te maken binnen de begrenzing van de polygonen in een bepaalde polygoonlaag. Deze methode
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behoort tot het pakket maptools. Omdat bijna alle algoritmen die u zou willen inbedden in QGIS ruimtelijke
gegevens zullen gebruiken of genereren, is kennis van ruimtelijke pakketten zoals maptools en, speciaal, sp,
verplicht.

##polyg=vector
##numpoints=number 10
##output=output vector
##sp=group
pts=spsample(polyg,numpoints,type="random")
output=SpatialPointsDataFrame(pts, as.data.frame(pts))

The first lines, which start with a double Python comment sign (##), tell QGIS the inputs of the algorithm de-
scribed in the file and the outputs that it will generate. They work with exactly the same syntax as the SEXTANTE
scripts that we have already seen, so they will not be described here again. Check the processing_scripts section
for more information.

Wanneer u een parameter voor de invoer declareert, gebruikt QGIS die informatie voor twee dingen: het maken van
de interface om de gebruiker te vragen naar de waarde voor die parameter en het maken van een overeenkomstige
variabele in R die later kan worden gebruikt als invoer voor opdrachten in R.

In het bovenstaande voorbeeld declareren we een invoer van het type vector genaamd polyg. Bij het uitvoeren
van het algoritme zal QGIS in R de laag openen die is geselecteerd door de gebruiker en die opslaan in een
variabele die ook is genaamd polyg. Dus de naam van een parameter is ook de naam van de variabele die we
in R kunnen gebruiken voor de toegang tot de waarde van die parameter (dus zou u moeten vermijden om door R
gereserveerde worden als namen voor parameters te gebruiken).

Ruimtelijke elementen zoals vector- en rasterlagen worden gelezen met behulp van de opdrachten readOGR()
en brick() (u hoeft zich geen zorgen te maken over het toevoegen an deze opdrachten aan uw bestand voor
de beschrijving – QGIS zal dit voor u doen), en zij worden opgeslagen als objecten Spatial*DataFrame.
Tabelvelden worden opgeslagen als tekenreeksen die de naam van het geselecteerde veld bevatten.

Tabellen worden geopend met behulp van de opdracht read.csv(). Als een door de gebruiker ingevoerde tabel
niet in de indeling CSV is, zal die worden geconverteerd, voorafgaande aan het importeren in R.

Aanvullend kunnen rasterbestanden worden gelezen met behulp van de opdracht readGDAL() in plaats van met
brick() door de ##usereadgdal te gebruiken.

Als u een gevorderde gebruiker bent en niet wilt dat QGIS het object maakt dat de laag vertegenwoordigt, kunt u de
tag ##passfilename gebruiken om aan te geven dat u in plaats daarvan een tekenreeks met de bestandsnaam
prefereert. In dat geval is het aan u om het bestand te openen vóórdat een bewerking wordt uitgevoerd op de
gegevens die het bevat.

Met bovenstaande informatie kunnen we nu de eerste regel van ons eerste voorbeeldscript begrijpen (de eerste
regel die niet begint met een opmerking in Python).

pts=spsample(polyg,numpoints,type="random")

De variabele polygon bevat al een object SpatialPolygonsDataFrame, dus kan het worden gebruikt om
de methode spsample aan te roepen, net als numpoints, die het aantal punten aangeeft die moeten worden
toegevoegd aan het gemaakte voorbeeldraster.

Omdat we al een uitvoer hebben gedeclareerd van het type vector genaamd out, moeten we een
variabele genaamd out maken en er een object Spatial*DataFrame in opslaan (in dit geval een
SpatialPointsDataFrame). U kunt elke naam gebruiken voor uw tussentijdse variabelen. Zorg er alleen
voor dat de variabele die uw uiteindelijke resultaat opslaat dezelfde naam heeft als die welke u gebruikt om het te
declareren, en dat het een geschikte waarde bevat.

In dit geval zal het resultaat dat wordt verkregen uit de methode spsample expliciet moeten worden geconver-
teerd naar een object SpatialPointsDataFrame, omdat het zelf een object van de klasse ppp is, wat geen
geschikte klasse is om te worden teruggegeven aan QGIS.

Als uw algoritme rasterlagen genereert, is de manier waarop zij worden opgeslagen afhankelijk van het feit of u
al dan niet de optie #dontuserasterpackage heeft gebruikt. Wanneer u die heeft gebruikt worden lagen
opgeslagen met behulp van de methode writeGDAL(). Indien niet, zal de methode writeRaster() uit het
pakket raster worden gebruikt.
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Als u de optie #passfilename gebruikte, wordt de uitvoer gegenereerd met behulp van het pakket raster
(met writeRaster()), zelfs als het niet is gebruikt voor de invoer.

Als uw algoritme geen laag genereert, maar in plaats daarvan een tekstresultaat in de console, dient u aan te
geven dat u wilt dat de console wordt weergegeven als de uitvoering eenmaal is voltooid. Start eenvoudigweg de
opdrachtregels die de resultaten produceren die u wilt afdrukken met het teken > (‘groter dan’) om dat te doen. De
uitvoer van alle andere regels zal niet worden weergegeven. Hier is bijvoorbeeld het bestand voor de beschrijving
van een algoritme dat een test voor normalen uitvoert op een bepaald veld (kolom) van de attributen van een
vectorlaag:

##layer=vector
##field=field layer
##nortest=group
library(nortest)
>lillie.test(layer[[field]])

De uitvoer van de laatste regel wordt afgedrukt, maar de uitvoer van de eerste word dat niet (en ook de uitvoer van
de andere opdrachtregels, die automatisch door |gg| werden toegevoegd, worden dat niet).

Als uw algoritme iets grafisch maakt (met behulp van de methode plot()), voeg dan de volgende regel toe:

##showplots

Dit zal er voor zorgen dat QGIS alle grafische uitvoer voor R zal omleiden naar een tijdelijk bestand, wat zal
worden geopend als de uitvoering van R is voltooid.

Beide grafische en console-resultaten zullen worden weergegeven in het beheer van de resultaten van Processing.

Bekijk, voor meer informatie, de scriptbestanden die zijn opgenomen in SEXTANTE. De meeste daravan zijn
redelijk eenvoudig en zullen u enorm helpen te begrijpen hoe u uw eigen scripts kunt maken.

Notitie: De bibliotheken rgdal en maptools worden standaard geladen, dus u hoeft de corresponderende
opdrachten library() niet toe te voegen (u dient zich er alleen van te overtuigen dat die twee pakketten zijn
geïnstalleerd in uw distributie van R). Echter, andere aanvullende bibliotheken die u nodig zou kunnen hebben dien
expliciet te worden geladen. Voeg eenvoudigweg de noodzakelijke opdrachten toe aan het begin van uw script. U
dient zich er ook van te overtuigen dat de corresponderende pakketten zijn geïnstalleerd in de distributie van R die
wordt gebruikt door QGIS. Het framework Processing zal zich niet bemoeien met het installeren van pakketten.
Als u een script uitvoert dat een pakket vereist dat niet is geïnstalleerd, zal de uitvoering mislukken, en SEX-
TANTE zal proberen te detecteren welk pakketten ontbreken. U dient die ontbrekende bibliotheken handmatig te
installeren vóórdat u het algoritme kunt uitvoeren.

GRASS

Configureren van GRASS is niet veel anders dan het configureren van SAGA. Eerst moet het pad naar de map
GRASS worden gedefinieerd, maar alleen als u werkt op Windows. Aanvullend zal een shell interpreter (gewoon-
lijk msys.exe, die aanwezig is in de meeste distributies van GRASS voor Windows) moeten worden gedefinieerd
en ook het pad daarvoor worden ingesteld.

Standaard probeert het framework Processing zijn verbinding naar GRASS te configureren om de distributie van
GRASS te gebruiken die wordt meegeleverd met QGIS. Dit zou op de meeste systemen zonder problemen moeten
werken, maar als u problemen ondervindt, zou u de verbinding naar GRASS handmatig moeten configureren. ook
als u een andere installatie van GRASS wilt gebruiken kunt u die instelling wijzigen en verwijzen naar de map
waar die andere versie is geïnstalleerd. GRASS 6.4 is nodig om de algoritmen juist te laten werken.

Als u werkt op Linux hoeft u er slechts voor te zorgen dat GRASS correct is geïnstalleerd, en dat het zonder
problemen kan worden uitgevoerd vanaf een console.

Algoritmen van GRASS gebruiken een regio voor berekeningen. Deze regio kan handmatig worden gedefinieerd
met behulp van waarden die soortgelijk zijn aan die welke werden gebruikt in de configuratie van SAGA, of
automatisch, met het minimum bereik dat alle gebruikte invoerlagen bedekt bij het elke keer uitvoeren van het
algoritme. Als de laatste benadering het gedrag is dat u prefereert, selecteer dan de optie Use min covering region
in de configuratie van de parameters in GRASS.

220 Hoofdstuk 17. QGIS framework Processing



QGIS User Guide, Release 2.2

De laatste parameter die moet worden geconfigureerd is gerelateerd aan de kaartset. Een kaartset is nodig om
GRASS uit te voeren en het framework Processing maakt een tijdelijke voor elke uitvoering. U moet specificeren
of de gegevens waarmee u werkt geografische (lat/lon) coördinaten gebruikt of geprojecteerde.

GDAL

Er is geen aanvullende configuratie nodig om algoritmen van GDAL uit te voeren. Omdat zij al zijn opgenomen
in QGIS kunnen de algoritmen hun configuratie daaruit afleiden.

Orfeo Toolbox

Algoritmen van Orfeo Toolbox (OTB) kunnen worden uitgevoerd vanuit QGIS als u OTB heeft geïnstalleerd op
uw systeem en u QGIS juist heeft geconfigureerd, zodat het alle benodigde bestanden (gereedschappen voor de
opdrachtregel en bibliotheken) kan vinden.

Net als in het geval van SAGA zijn de bibliotheken van OTB opgenomen in het zelfstandige installatieprogramma
voor Windows, maar zij zijn niet opgenomen als u werkt op Linux, dus u dient de software zelf te downloaden en
te installeren. Bekijk de website van OTB voor meer informatie.

Als OTB eenmaal is geïnstalleerd, start QGIS, open het dialoogvenster Opties en configuratie en configureer de
provider voor de algoritmen van OTB. In het blok Orfeo Toolbox (image analysis) vindt u alle instellingen die zijn
gerelateerd aan OTB. Zorg er eerst voor dat algoritmen zijn ingeschakeld.

Configureer dan het pad naar de map waar de gereedschappen voor de opdrachtregel en de bibliotheken van OTB
zijn geïnstalleerd:

• Gewoonlijk verwijst OTB applications folder naar /usr/lib/otb/applications en OTB com-
mand line tools folder is /usr/bin.

• Als u het installatieprogramma van OSGeo4W gebruikt, installeer dan het pakket otb-bin
en voer C:\OSGeo4W\apps\orfeotoolbox\applications in als OTB applications folder en
C:\OSGeo4W\bin als OTB command line tools folder. Deze waarden zouden standaard moeten worden
geconfigureerd, maar als u een andere installatie van OTB heeft, configureer ze dan met de overeenkomstige
waarden op uw systeem.

TauDEM

U moet de gereedschappen voor de opdrachtregel van TauDEM installeren om deze provider te kunnen gebruiken.

17.7.8 Windows

Bekijk de thuispagina van TauDEM voor instructies over de installatie en voorgecompileerde binaries voor 32-
bit en 64-bit systemen. BELANGRIJK: U heeft TauDEM 5.0.6 uitvoerbare bestanden nodig. Versie 5.2 wordt
momenteel niet ondersteund.

17.7.9 Linux

Er zijn geen pakketten voor de meeste distributies van Linux, dus zou u TauDEM zelf moeten compileren. In-
stalleer het eerst met uw favoriete pakketbeheerder, omdat TauDEM MPICH2 gebruikt. Als alternatief werkt
TauDEM prima met Open MPI, dus kunt u dat gebruken in plaats van MPICH2.

Download de TauDEM 5.0.6 broncode en pak de bestanden uit in een map.

Open het bestand linearpart.h en na regel

#include "mpi.h"

voeg een nieuwe regel toe met
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#include <stdint.h>

dan krijgt u

#include "mpi.h"
#include <stdint.h>

Sla de wijzigingen op en sluit het bestand. Open nu het bestand tiffIO.h, zoek de regel #include
"stdint.h" en vervang de aanhalingstekens ("") door <>, zodat u krijgt

#include <stdint.h>

Sla de wijzigingen op en sluit het bestand. Maak een map om het te bouwen en cd daar naartoe

mkdir build
cd build

Configureer uw bouw met de opdracht

CXX=mpicxx cmake -DCMAKE_INSTALL_PREFIX=/usr/local ..

en compileer dan

make

Tenslotte, om TauDEM te installeren in /usr/local/bin, voer uit

sudo make install

.

17.8 The SEXTANTE Commander

SEXTANTE includes a practical tool that allows you to run algorithms without having to use the toolbox, but just
by typing the name of the algorithm you want to run.

This tool is known as the SEXTANTE Commander, and it is just a simple text box with autocompletion where you
type the command you want to run.

Figuur 17.30: The SEXTANTE Commander

The Commander is started from the Analysis menu or, more practically, by pressing Shift + Ctrl + M (you
can change that default keyboard shortcut in the QGIS configuration, if you prefer a different one). Apart from
executing SEXTANTE algorithms, the Commander gives you access to most of the functionality in QGIS, which
means that it gives you a practical and efficient way of running QGIS tasks and allows you to control QGIS with
reduced usage of buttons and menus.
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Daarnaast is Commando’s te configureren, dus kunt u uw aangepaste opdrachten toevoegen en ze slechts een paar
toetsaanslagen verwijderd hebben, wat het een krachtig gereedschap maakt dat u helpt productiever te worden in
uw dagelijkse werk met QGIS.

17.8.1 Beschikbare opdrachten

De beschikbare opdrachten in Commando’s vallen in de volgende categorieën:

• SEXTANTE algorithms. These are shown as SEXTANTE algorithm: <name of the
algorithm>.

• Menu-items. Deze worden weergegeven als Menu item: <tekst voor menuitem>. Alle
beschikbare menu-items voor de interface van QGIS zijn beschikbaar, zelfs als zij zijn opgenomen in een
submenu.

• Functies voor Python. U kunt korte functies voor Python maken die dan zullen worden opgenomen in de lijst
met beschikbare opdrachten. Zij worden weergegeven als Function: <naam van de functie>.

Begin, om een van de bovenstaande uit te voeren, eenvoudigweg te typen en selecteer dan het corresponderende
element uit de lijst met beschikbare opdrachten die verschijnt na het filteren van de gehele lijst met opdrachten
met de tekst die u heeft ingevoerd.

In het geval van het aanroepen van een functie in Python kunt u het item selecteren in de lijst, welke
wordt voorafgegaan door Function: (bijvoorbeeld Function: removeall), of eenvoudigweg
de naam van de functie te typen (‘‘removeall in het voorgaande voorbeeld). Het is niet nodig
haakjes te plaatsen achter de naam van de functie.

17.8.2 Aangepaste functies maken

Aangepaste functies worden toegevoegd door hun corresponderende code voor Python toe te voegen aan het
bestand commands.py dat kan worden gevonden in de ‘‘ map .qgis/sextante/commanderectory‘‘ in uw gebruik-
ersmap. Het is slechts een eenvoudig bestand van Python waar u de functies kunt toevoegen die u nodig hebt.

Het bestand is gemaakt met enkele voorbeeldfuncties als U Commando’s voor de eerste keer opent. Als u Com-
mando’s nog nooit heeft gestart, kunt u het bestand zelf maken. Gebruik uw favoriete tekstbewerker om het
bestand met opdrachten te bewerken. U kunt ook de ingebouwde bewerker gebruiken door de opdracht edit aan
te roepen in Commando’s. Het zal de bewerker openen met het bestand voor de opdrachten en u kunt het direct
bewerken en uw wijzigingen opslaan.

U kunt bijvoorbeeld de volgende functie toevoegen, die alle lagen verwijderd:

from qgis.gui import *

def removeall():
mapreg = QgsMapLayerRegistry.instance()
mapreg.removeAllMapLayers()

Wanneer u de functie eenmaal heeft toegevoegd zal die beschikbaar zijn in Commando’s, en u kunt hem uitvoeren
door te typen removeall. Er is niets anders nodig dan het schrijven van de functie zelf.

Functies kunnen parameters opnemen. Voeg *args toe aan uw definitie van de functie om argumenten te kunnen
opnemen. Bij het aanroepen van de functie vanuit Commando’s, moeten parameters worden doorgegeven door ze
te scheiden door spaties.

Hier is een voorbeeld van een functie die een laag laadt en een parameter opneemt met de bestandsnaam van de te
laden laag.

import sextante

def load(*args):
sextante.load(args[0])
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Als u de laag wilt laden vanuit /home/myuser/points.shp, type load /home/myuser/points.shp
in het tekstvak van Commando’s.

.
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Printvormgeving

De Printvormgeving verschaft een groeiend aantal mogelijkheden voor lay-out en afdrukken. Het stelt u in staat
elementen toe te voegen zoals het kaartvenster van QGIS, tekstlabels, afbeeldingen, legenda’s, schaalbalken, ba-
sisvormen, pijlen, attributentabellen en HTML-objecten. U kunt elk element wijzigen van grootte, groeperen,
uitlijnen en de positie bepalen en de eigenschappen aanpassen om uw lay-out te maken. De lay-out kan wor-
den afgedrukt of geëxporteerd naar indelingen voor afbeeldingen, PostScript, PDF of naar SVG (exporteren naar
SVG werkt nog niet correct met enkele recente versies van Qt4; u zou dat individueel moeten proberen en con-
troleren op uw systeem). U kunt de lay-out opslaan als een sjabloon en het opnieuw laden in een andere sessie.
Tenslotte kunnen verscheidene kaarten worden gegenereerd die zijn gebaseerd op een sjabloon met behulp van de
atlas-generator. Bekijk een lijst van gereedschappen in table_composer_1:
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Pic-
togram

Doel Pic-
togram

Doel

Project opslaan Nieuwe Printvormgeving

Dupliceer lay-out Printvormgeving-manager

Laden uit sjabloon Opslaan als sjabloon

Afdrukken of exporteren als PostScript Exporteren naar afbeelding

Exporteren printvormgeving naar SVG Exporteren als PDF

Laatste wijziging ongedaan maken Laatste wijziging opnieuw

Zoomen naar volledig bereik Zoomen naar 100%

Inzoomen Uitzoomen

Scherm verversen

Schuiven Zoomen naar specifiek gebied

Selecteren/Verplaatsen item in
printvormgeving

Verplaatsen inhoud binnen een item

Toevoegen nieuwe kaart vanuit QGIS
kaartvenster

Afbeelding toevoegen aan
printvormgeving

Label toevoegen aan printvormgeving Nieuwe legenda toevoegen aan
printvormgeving

Schaalbalk toevoegen aan
printvormgeving

Basisvorm toevoegen aan
printvormgeving

Pijl toevoegen aan printvormgeving Attributentabel toevoegen aan
printvormgeving

Een HTML-object toevoegen

Groeperen van items van
printvormgeving

Groeperen opheffen van items van
printvormgeving

Vastzetten geselecteerde items Alle items losmaken

Geselecteerde items verhogen Geselecteerde items verlagen

Verplaats geselecteerde items als
bovenste

Verplaats geselecteerde items als
onderste

Links uitlijnen geselecteerde items Rechts uitlijnen geselecteerde items

Gecentreerd uitlijnen geselecteerde
items

Verticaal gecentreerd uitlijnen
geselecteerde items

Boven uitlijnen geselecteerde items Onder uitlijnen geselecteerde items

Voorvertoning Atlas Eerste object

Vorige object Volgende object

Laatste object Afdrukken Atlas

Exporteer Atlas als afbeeldingen Instellingen voor Atlas

Tabel Composer 1: gereedschappen Printvormgeving

Alle gereedschappen voor Printvormgeving zijn beschikbaar in menu’s en als pictogrammen in een werkbalk. De
werkbalk kan in- en uitgeschakeld worden met behulp van de rechter muisknop boven de werkbalk.
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18.1 Eerste stappen

18.1.1 Open een nieuw sjabloon voor Printvormgeving

Vóórdat u begint te werken met de Printvormgeving dient u enkele raster- en vectorlagen te laden in het kaartven-
ster van QGIS en hun eigenschappen aan te passen om te voldoen aan uw eigen wensen. Nadat alles volgens

uw wensen is gerenderd en gesymboliseerd, klik op het pictogram Nieuwe Printvormgeving in de werkbalk of kies
Project → Nieuwe Printvormgeving. U zult naar een nieuwe titel worden gevraagd voor de nieuwe Printvormgev-
ing.

18.1.2 Using Print Composer

Opening the Print Composer provides you with a blank canvas to which you can add the current QGIS map
canvas, text labels, images, legends, scale bars, basic shapes, arrows, attribute tables and HTML frames. Fig-
ure_composer_1 shows the initial view of the Print Composer before any elements are added.

Figuur 18.1: Printvormgeving

The Print Composer provides four tabs:

• The Composition tab allows you to set paper size, orientation, the page background, number of pages and

print quality for the output file in dpi. Furthermore, you can also activate the Print as raster checkbox.
This means all elements will be rastered before printing or saving as PostScript or PDF. In this tab, you can
also customize settings for grid and smart guides.

• The Item Properties tab displays the properties for the selected item element. Click the Select/Move item

icon to select an element (e.g., legend, scale bar or label) on the canvas. Then click the Item Properties tab
and customize the settings for the selected element.
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• The Command history tab (hidden by default) displays a history of all changes applied to the Print Composer
layout. With a mouse click, it is possible to undo and redo layout steps back and forth to a certain status.

• De tab Atlas-generatie stelt u in staat een atlas te genereren voor de huidige printvormgeving en geeft
toegang tot de parameters daarvan.

In het onderste gedeelte van het venster van Printvormgeving vindt u een statusbalk met daarin de positie van de
muis, huidige paginanummer en een combinatievak voor het instellen van het niveau van zoomen.

U kunt meerdere items toevoegen aan de Printvormgeving. Het is ook mogelijk om meer dan één kaartweergave
of legenda of schaalbalk in het kaartvenster van Printvormgeving te hebben, op één of verscheidene pagina’s.
Elk item heeft zijn eigen eigenschappen en, in het geval van de kaart, zijn eigen bereik. Als u een item uit het
kaartvenster van Printvormgeving wilt verwijderen kunt u dat doen met de toetsen Delete of Backspace.

Gereedschappen voor navigatie

De Printvormgeving verschaft enkele gereedschappen voor het navigeren in de lay-out van het kaartvenster:

• Inzoomen

• Uitzoomen

• Volledig uitzoomen

• Zoomen naar 100%

• Scherm verversen (als u merkt dat het scherm zich niet in een consistente status bevind)

• Kaart verschuiven

• Modus gemarkeerd zoomen (zoomen naar een specifiek gebied in Printvormgeving)

U kunt het niveau van zoomen ook wijzigen met behulp van het muiswiel of het combinatievak in de statusbalk.
Als u moet schakelen naar de Modus schuiven, terwijl u werkt in het gebied van Printvormgeving, kunt u de
Spatiebalk of het muiswiel ingedrukt houden. Met Ctrl+spatiebalk kunt u tijdelijk overschakelen naar
de Modus gemarkeerd zoomen en met Ctrl+Shift+spatiebalk naar de Modus uitzoomen.

18.1.3 Print Composer Options

Via Instellingen → Opties Kaartopmaak kunt u enkele opties instellen die als standaard zullen worden gebruikt
gedurende uw werkzaamheden.

• Standaardwaarden opmaak laat u het te gebruiken standaard lettertype specificeren.

• Met Ruitennetweergave kunt u de stijl voor het raster en de kleur daarvan instellen.

• Ruitennetstandaarden definieert afstand, verschuiving en tolerantie van het raster. Er zijn drie typen raster:
Stippels, Doorgetrokken lijnen en Kruisjes.

• Hulplijnstandaarden definieert de tolerantie voor de hulplijnen.

18.1.4 tab Lay-out — Algemene instellingen voor lay-out

In de tab Lay-out kunt u de globale instellingen voor uw compositie definiëren.

• U kunt kiezen uit één van de Voorinstellingen voor uw blad papier, of uw aangepaste Breedte en Hoogte
invoeren.

• Printvormgeving kan nu worden opgedeeld in meerdere pagina’s. De eerste pagina ka, bijvoorbeeld, een
kaartvenster weergeven en een tweede pagina kan de attributentabel, die is geassocieerd met een laag,
weergeven, terwijl een derde een HTML-object weergeeft dat is gekoppeld aan de website van uw organ-
isatie. Stel Aantal pagina’s in op de gewenste waarde. U kunt de Oriëntatie van de pagina kiezen en de
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Export-resolutie. Wanneer Als raster afdrukken is geselecteerd betekent dat dat alle items zullen worden
gerasterd vóór het afdrukken of opslaan als PostScript of PDF.

• Grid laat u de instellingen voor het raster, zoals Tussenruimte, Grid verspringing en Tolerantie, naar uw
behoeften aanpassen.

• In Snappen naar uitlijning kunt u de Tolerantie wijzigen, wat de maximale afstand is waarop een item zal
worden gevangen door hulplijnen.

Aan grid ‘snappen’ en/of aan hulplijnen kan worden ingeschakeld vanuit het menu View. In dat menu kunt u ook
het raster en de hulplijnen verbergen of weergeven.

18.1.5 Composer items general options

Composer items have a set of common properties you will find on the bottom of the Item Properties tab: Position
and size, Frame, Background, Item ID and Rendering (See figure_composer_2).

Figuur 18.2: Dialoogvensters algemene Item-eigenschappen

• Het dialoogvenster Positie en grootte laat u de grootte en de positie definiëren van het frame dat het item
bevat. U kunt ook kiezen welk Referentiepunt zal worden ingesteld op de eerder gedefinieerde X- en Y-
coördinaten.

• De Rotatie stelt de rotatie van het item in (in graden).

• Het Frame toont of verbergt het frame rondom het label. Klik op de knoppen [Kleur] en [Dikte] om
deze eigenschappen aan te passen.

• De Achtergrond schakelt een achtergrondkleur in- of uit. Klik op de knop [Kleur...] om een dialoogven-
ster weer te geven waar u een kleur of een aangepaste instelling kunt kiezen. Transparantie kan ook worden
aangepast via het veld Alpha channel.

• Gebruik Item ID om een relatie te maken naar andere items van Printvormgeving. Dit wordt gebruikt met
de server van QGIS en een potentiële webcliënt. U kunt een ID instellen voor een item (bijv.,een kaart en
een label), en dan kan de webcliënt gegevens verzenden om een eigenschap in te stellen (bijv., tekst voor
een label) voor dat specifieke item. De opdracht GetProjectSettings zal vermelden welke items en welke
ID’s beschikbaar zijn in een lay-out.

• Modus Rendering kan worden geselecteerd in het optieveld. Zie Rendering_Mode.
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18.2 Modus Rendering

QGIS staat nu geavanceerde rendering toe voor items van Printvormgeving net zoals voor vector- en rasterlagen.

Figuur 18.3: Modus Rendering

• Transparantie : U kunt met dit gereedschap het onderliggende item in Printvormgeving
zichtbaar maken. Gebruik de schuifbalk om de zichtbaarheid van uw item aan uw behoeften aan te passen.
U kunt ook een precieze definitie van het percentage zichtbaarheid instellen in het menu naast de schuifbalk.

• Meng-modus: U kunt speciale effecten voor renderen bereiken met deze gereedschappen die u mogelijk
eerder pas kende vanuit grafische programma’s. De pixels van uw bovenliggende en onderliggende items
worden gemengd via de hieronder beschreven instellingen.

– Normaal: Dit is de standaard meng-modus, die het alfakanaal van de bovenste pixel gebruikt om te
mengen met de pixel eronder; de kleuren worden niet gemengd.

– Lichter maken: Dit selecteert de maximum waarden van elke component van de pixels van de voor-
en achtergrond. Onthoud dat het resultaat vaak ruw, grof en kartelig is.

– Screen: Lichte pixels van de bronlaag worden getekend over de doellaag, bij donkere pixels gebeurt
dat niet. Deze modus is bijzonder geschikt voor het mengen van de textuur van de ene laag met die
van een andere laag. (bijv. u kunt deze gebruiken om schaduwen van heuvels in te brengen in een
andere laag.

– Dodge: Hoe lichter de bovenliggende pixel is des te feller en met meer kleur zullen de onderliggende
pixels getoond worden. Dus:, heldere pixels bovenop zorgen er voor dat de verzadiging en helderheid
van de onderliggende pixels wordt verhoogt. Dit werkt het beste wanneer de bovenste pixels niet te
fel zijn, anders wordt het resultaat te extreem.

– Toevoegen: Deze meng-modus telt de waarden van pixels van de ene laag op bij die van de andere.
Wanneer de waarden boven de 1 uitkomen (zoals het geval is bij RGB), wordt wit weergegeven. Deze
modus is geschikt om objecten te accentueren.

– Donkerder maken: Dit maakt een resulterende pixel die de laagste componenten van de pixel voor
voor- en achtergrond behoud. Net zoals bij de modus Lichter maken is het resultaat vaak ruw, grof en
gekarteld

– Vermenigvuldigen: Dit vermenigvuldigt de waarden voor elke pixel van de bovenste laag met die van
de corresponderende pixel van de onderste laag. Het resultaat is een donkerder kaartbeeld.

– Branden: Donkere kleuren in de bovenste laag zorgen ervoor dat onderliggende lagen donkerder wor-
den. Branden kan worden gebruikt om de kleuren van onderliggende lagen bij te stellen.

– Overlay: Combineert de meng-modi Vermenigvuldigen en Screen. In het resulterende kaartbeeld
worden de lichtere delen lichter en donkere delen donkerder.

– Zacht licht: Lijkt erg op Overlay, maar in plaats van de combinatie Vermenigvuldigen/Screen wordt
de combinatie Branden/Dodge gebruikt. Deze modus wordt geacht het schijnen van een zacht licht op
een afbeelding na te bootsen.

– Hard licht: Hard licht lijkt veel op de modus Overlay. Het wordt geacht het projecteren van een zeer
intens licht op een afbeelding na te bootsen.

– Verschil: Verschil haalt de waarde van de bovenste pixel van de onderste pixel af of omgekeerd, zodat
er altijd een positieve waarde ontstaat. Het mengen met zwart levert geen wijziging op, omdat het
verschil met alle kleuren nul is.
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– Aftrekken: Deze meng-modus trekt eenvoudigweg de pixelwaarden van de ene laag af van die van de
andere. Bij negatieve waarden wordt zwart weergegeven.

18.3 Items Printvormgeving

18.3.1 Adding a current QGIS map canvas to the Print Composer

Klik op de werkbalkknop Nieuwe kaart toevoegen op de werkbalk Printvormgeving om het kaartvenster van QGIS
toe te voegen. Sleep nu, met de linker muisknop, een rechthoek op het kaartvenster van Printvormgeving om de
kaart toe te voegen. U kunt kiezen uit drie verschillende modi op de tab Item-eigenschappen van de kaart om de
huidige kaart weer te geven:

• Rechthoek is de standaard instelling. Het geeft alleen een leeg vak weer met het bericht ‘Kaart zal hier
worden afgedrukt’.

• Werkgeheugen rendert de kaart in de huidige resolutie van het scherm. Als u op het venster van Printvor-
mgeving in- of uitzoomt, wordt de kaart niet opnieuw gerenderd maar de afbeelding zal op schaal worden
gebracht.

• Renderen betekent dat als u op het venster van Printvormgeving in- of uitzoomt, de kaart opnieuw zal
worden gerenderd, maar, om redenen van maatvoering, slechts tot een maximale resolutie.

Werkgeheugen is de standaard modus voor voorvertoning voor nieuw toegevoegde kaarten in Printvormgeving.

U kunt d egrootte van het kaartitem wijzigen door te klikken op de knop Selecteren/Verplaatsen item, het item te
selecteren, en te slepen aan een van de blauwe handvatten in de hoeken van de kaart. Met de geselecteerde kaart
kunt u nu meer eigenschappen aanpassen op de tab Item-eigenschappen van de kaart.

To move layers within the map element, select the map element, click the Move item content icon and move the
layers within the map element frame with the left mouse button. After you have found the right place for an
element, you can lock the element position within the Print Composer canvas. Select the map element and click

on the right mouse button to Lock the element position and again to unlock the element. You can also lock the

map element by activating the Lock layers for map item checkbox in the Map dialog of the Item Properties
tab.

Algemene eigenschappen

The Main properties dialog of the map Item Properies tab provides the following functionalities (see fig-
ure_composer_4):

• Het gebied Voorvertoning stelt u in staat de modi voor de voorvertoning ‘Rechthoek’, ‘Werkgeheugen’ en
‘Renderen’ in te stellen, zoals boven beschreven. Als u de weergave van het kaartvenster van QGIS wijzigt
door eigenschappen van vector of raster te veranderen, kunt u de weergave in de Printvormgeving bijw-
erken door te het kaartitem te selecteren in de Printvormgeving en te klikken op de knop [Voorvertoning
bijwerken].

• Het veld Schaal stelt een handmatige schaal in.

• Het veld Rotatie stelt u in staat het kaartitem met de klok mee te roteren in graden. Onthoud dat een
coördinatenframe alleen kan worden toegevoegd met de standaardwaarde 0.

• Kaartvenster objecten tekenen laat u annotaties weergeven die kunnen zijn geplaatst op het kaartvenster
in het hoofdvenster van QGIS.

• You can choose to lock the layers shown on a map item. Check Lock layers for map item. After this is
checked, any layer that would be displayed or hidden in the main QGIS window won’t appear or be hidden
in the map item of the Composer. But style and labels of a locked layer are still refreshed according to the
main QGIS interface.
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Figuur 18.4: Tab Kaart Item-eigenschappen

Bereik

The Extents dialog of the map item tab provides the following functionalities (see figure_composer_5):

Figuur 18.5: Dialoogvenster Kaart Bereik

• The Map extent area allows you to specify the map extent using Y and X min/max values or by clicking
the [Set to map canvas extent] button.

If you change the view on the QGIS map canvas by changing vector or raster properties, you can update the Print
Composer view by selecting the map element in the Print Composer and clicking the [Update preview] button in
the map Item Properties tab (see figure_composer_2).

Raster

The Grid dialog of the map Item Properties tab provides the following functionalities (see Figure_composer_6):
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Figuur 18.6: Map Grid Dialog

• The Show grid checkbox allows you to overlay a grid onto the map element. As grid type, you can
specify to use a solid line or cross. Symbology of the grid can be chosen. See section Rendering_Mode.
Furthermore, you can define an interval in the X and Y directions, an X and Y offset, and the width used for
the cross or line grid type.

• You can choose to paint the frame with a zebra style. If not selected, the general frame option is used (see
section Frame_dialog). Advanced rendering mode is also available for grids (see section Rendering_mode).

• Het keuzevak Teken coördinaten stelt u in staat coördinaten toe te voegen aan het frame van de kaart.
De annotatie kan binnen of buiten het frame van de kaart worden getekend. De richting van de annotatie
kan worden gedefinieerd als horizontaal, verticaal, horizontaal en verticaal, of in de richting van de begren-
zing, voor elke begrenzing individueel. Eenheden mogen zijn in meters of in graden. Tenslotte kunt u de
rasterkleur definiëren, het lettertype van de annotatie, de afstand van de annotatie tot het frame van de kaart
en de precisie van de getekende coördinaten.

Overview

The Overview dialog of the map Item Properties tab provides the following functionalities (see Fig-
ure_composer_7):

Figuur 18.7: Map Overview Dialog

If the Composer has more than one map, you can choose to use a first map to show the extents of a second map.
The Overview dialog of the map Item Properties tab allows you to customize the appearance of that feature.

• The Overview frame combo list references the map item whose extents will be drawn on the present map
item.
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• The Overview Style allows you to change the frame color. See section vector_style_manager .

• The Overview Blend mode allows you to set different transparency blend modes, to enhance visibility of the
frame. See Rendering_Mode.

• If checked, Invert overview creates a mask around the extents: the referenced map extents are shown
clearly, whereas everything else is blended with the frame color.

18.3.2 Adding a Label item to the Print Composer

Klik, om een label toe te voegen, op het pictogram Label toevoegen, plaats het item met de linker muisknop op
het kaartvenster van Printvormgeving en positioneer het en pas het uiterlijk aan op de tab Item-eigenschappen van
Label.

The Item Properties tab of a label item provides the following functionalities:

Figuur 18.8: Tab Label Item-eigenschappen

Algemene eigenschappen

The Main properties dialog of the label Item Properties tab provides the following functionalities (see Fig-
ure_composer_9):

Figuur 18.9: Label Main properties Dialog
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• Het dialoogvenster Algemene eigenschappen is waar de tekst (HTML of niet) of de benodigde expressie om
het label te vullen wordt toegevoegd aan het kaartvenster van Printvormgeving.

• Labels kunnen worden geïnterpreteerd als HTML-code: selecteer Renderen als HTML. U kunt nu een
URL invoeren, een aan te klikken afbeelding die verwijst naar een webpagina of iets meer complex.

• You can also insert an expression. Click on [Insert an expression] to open a new dialog. Build an ex-
pression by clicking the functions available in the left side of the panel. On the right side of the Insert an
expression dialog, the help file associated with the function selected is displayed. Two special categories
can be useful, particularly associated with the atlas functionality: geometry functions and records functions.
At the bottom, a preview of the expression is shown.

• Define font and font color by clicking on the [Font] and [Font color...] buttons.

Uitlijning en Tonen

The Alignment and Display dialogs of the label Item Properties tab provide the following functionalities (see
Figure_composer_10):

Figuur 18.10: Label Alignment and Display Dialogs

• U kunt de horizontale en verticale uitlijning definiëren in het gebied Uitlijning.

• In the Display tag, you can define a margin in mm and/or a rotation angle in degrees for the text.

18.3.3 Adding an Image item to the Print Composer

Klik, om een afbeelding toe te voegen, op het pictogram Afbeelding toevoegen, plaats het item met de linker
muisknop op het kaartvenster van Printvormgeving en positioneer het en pas het uiterlijk aan op de tab Item-
eigenschappen.

The image Item Properties tab provides the following functionalities (see figure_composer_11):

Main properties, Search directories and Rotation

The Main properties and Search directories dialogs of the image Item Properties tab provide the following func-
tionalities (see Figure_composer_12):

• The Main properties dialog shows the current image that is displayed in the image item. Click on the [...]
button to select a file on your computer.

• This dialog shows all pictures stored in the selected directories.

• The Search directories area allows you to add and remove directories with images in SVG format to the
picture database.

• Images can be rotated with the Rotation field.
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Figuur 18.11: Tab Afbeelding Item-eigenschappen

Figuur 18.12: Image Main properties, Search directories and Rotation Dialogs
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• Activating the Sync with map checkbox synchronizes the rotation of a picture in the QGIS map canvas
(i.e., a rotated north arrow) with the appropriate Print Composer image.

18.3.4 Adding a Legend item to the Print Composer

Klik, om een legenda voor de kaart toe te voegen, op het pictogram Nieuwe legenda toevoegen, plaats het item met
de linker muisknop op het kaartvenster van Printvormgeving en positioneer het en pas het uiterlijk aan op de tab
Item-eigenschappen van de Legenda..

The Item properties of a legend item tab provides the following functionalities (see figure_composer_14):

Figuur 18.13: Tab Legenda Item-eigenschappen

Algemene eigenschappen

The Main properties dialog of the legend Item Properties tab provides the following functionalities (see fig-
ure_composer_14):

Figuur 18.14: Dialoogvenster Legenda algemene eigenschappen

• Here, you can adapt the legend title.

• You can also choose which Map item the current legend will refer to in the select list.

• Since QGIS 1.8, you can wrap the text of the legend title on a given character.

Items voor legenda

The Legend items dialog of the legend Item Properties tab provides the following functionalities (see fig-
ure_composer_15):
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Figuur 18.15: Dialoogvenster Legenda Items voor legenda

• The legend items window lists all legend items and allows you to change item order, group layers, remove
and restore items in the list, and edit layer names. After changing the symbology in the QGIS main window,
you can click on [Update] to adapt the changes in the legend element of the Print Composer. The item order
can be changed using the [Up] and [Down] buttons or with ‘drag-and-drop’ functionality.

• The feature count for each vector layer can be shown by enabling the [Sigma] button.

• The legend will be updated automatically if Auto-update is checked.

Fonts, Columns, Symbol and Spacing

The Fonts, Columns, Symbol and Spacing dialogs of the legend Item Properties tab provide the following func-
tionalities (see figure_composer_16):

• U kunt het lettertype wijzigen van de titel van de legenda, groeperen, subgroeperen en de items (laag) in de
items van de legenda. Klik op een knop voor een categorie om een dialoogvenster Selecteer lettertype te
openen.

• All these items will get the same Color.

• Legend items can be arranged in several columns. Select the correct value in the Count field.

• Gelijke kolombreedtes stelt in hoe kolommen van legenda’s zouden moeten worden aangepast.

• De optie Kaartlagen splitsen stelt u in staat een legenda voor een gecategoriseerde of een graduele laag
op te delen in kolommen.

• U kunt in dit dialoogvenster de breedte en hoogte van het symbool van de legenda wijzigen.

• Spacing aroung title, group, subgroup, symbol, icon label, box space or column space can be customized
through this dialog.

18.3.5 Adding a Scale Bar item to the Print Composer

Klik, om een schaalbalk toe te voegen, op het pictogram Nieuwe schaalbalk toevoegen, plaats het item met de linker
muisknop op het kaartvenster van Printvormgeving en positioneer het en pas het uiterlijk aan op de tab Item-
eigenschappen van de Schaalbalk.

The Item properties of a scale bar item tab provides the following functionalities (see figure_composer_17):
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Figuur 18.16: Dialoogvensters Legenda Lettertypen, Kolommen, Symbool en Tussenruimte

Figuur 18.17: Tab Schaalbalk Item-eigenschappen

18.3. Items Printvormgeving 239



QGIS User Guide, Release 2.2

Algemene eigenschappen

The Main properties dialog of the scale bar Item Properties tab provides the following functionalities (see fig-
ure_composer_18):

Figuur 18.18: Dialoogvenster Schaalbalk algemene eigenschappen

• Kies eerst de kaart waar de schaalbalk aan moet worden toegevoegd.

• Kies dan de stijl van de schaalbalk. Zes stijlen zijn beschikbaar:

– Stijlen Enkele rechthoek en Dubbele rechthoek, die een of twee lijnen met wisselende kleurvakken
bevatten.

– Midden, Boven of Onder schaalstreepjes.

– Numeriek, waar de ratio van de schaal wordt afgedrukt (bijv., 1:50000).

Eenheden en Segmenten

The Units and Segments dialogs of the scale bar Item Properties tab provide the following functionalities (see
figure_composer_19):

Figuur 18.19: Dialoogvensters Schaalbalk Eenheden en segmenten

In deze twee dialoogvensters kunt u instellen hoe de schaalbalk zal worden weergegeven.

• Select the map units used. There are three possible choices: Map Units is the automated unit selection;
Meters or Feet force unit conversions.

• Het veld Label definieert de gebruikte tekst om de eenheden van de schaalbalk te beschrijven.

• Kaarteenheden per schaalbalkeenheid stelt u in staat de ratio aan te passen tussen een kaarteenheid en de
weergave daravan in de schaalbalk.

• U kunt definiëren hoeveel Segmenten zullen worden getekend aan de linker- en rechterkant van de schaalbalk
en hoe lang elk segment zal zijn (veld Grootte). Hoogte kan ook worden gedefinieerd.
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Display, Fonts and colors

The Display and Fonts and colors dialogs of the scale bar Item Properties tab provide the following functionalities
(see figure_composer_20):

Figuur 18.20: Scale Bar Display, Fonts and colors Dialogs

• You can define how the scale bar will be displayed in its frame. Adjust the Box margin between text
and frame borders, Labels margin between text and scale bar drawing and the Line width of the scale bar
drawing.

• The Alignment in the Display dialog only applies to Numeric styled scale bars and puts text on the left,
middle or right side of the frame.

18.3.6 Adding a Basic shape or Arrow item to the Print Composer

It is possible to add basic shapes (ellipse, rectangle, triangle) and arrows to the Print Composer canvas: Click the
Add basic shape icon or the Add Arrow icon, place the element with the left mouse button on the Print Composer

canvas and position and customize the appearance in the Item Properties tab.

The Shape item properties tab allows you to draw an ellipse, rectangle, or triangle in the Print Composer canvas.
You can define its outline and fill color, the outline width and a clockwise rotation. For the rectangle shape, you
can change the value of the corner radius.

The Arrow item properties tab allows you to draw an arrow in the Print Composer canvas. You can define color,
outline and arrow width, and it is possible to use a default marker, no marker, or an SVG marker. For the SVG
marker, you can additionally add an SVG start and end marker from a directory on your computer.

Algemene eigenschappen

• For basic shapes, this dialog allows you to choose an Ellipse, Rectangle or Triangle shape and its rotation.

• Unlike the other items, line style, line color and background color of a basic shape are adjusted with the
Frame and Background dialog. No frame is drawn.

• For arrows, you can define here the line style: Color, Line width and Arrow head width.

• Arrows markers can be adjusted. If you want to set an SVG Start marker and/or End marker, browse to
your SVG file by clicking on the [...] button after selecting the SVG radio button.

Notitie: Unlike other items, the background color for a basic shape is the shape background and not the frame
background.
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Figuur 18.21: Tab Basisvorm Item-eigenschappen

Figuur 18.22: Tab Pijl Item-eigenschappen
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18.3.7 Add attribute table values to the Print Composer

Het is mogelijk om delen van een vector-attributentabel toe te voegen aan het kaartvenster van Printvormgeving:

Klik op het pictogram Attribuuttabel toevoegen, plaats het item met de linker muisknop op het kaartvenster van
Printvormgeving en positioneer het en pas het uiterlijk aan op de tab Item-eigenschappen.

The Item properties of an attribute table item tab provides the following functionalities (see figure_composer_23):

Figuur 18.23: Tab Schaalbalk Item-eigenschappen

Main properties, Show grid and Fonts

The Main properties, Show grid and Fonts dialogs of the attribute table Item Properties tab provide the following
functionalities (see figure_composer_24):

Figuur 18.24: Attribute table Main properties, Show grid and Fonts Dialog
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Figuur 18.25: Dialoogvenster Attributentabel Selecteer attributen

• The Table dialog allows you to select the vector layer and columns of the attribute table. Attribute columns
can be sorted, and you can specify whether to show values in ascending or descending order (see fig-
ure_composer_25).

• You can choose to display the attributes of only features visible on a map. Check Show only visible
features and select the corresponding Composer map to filter.

• You can define the Maximum number of rows to be displayed and the margin around text.

• Additionally, you can define the grid characteristics of the table (Stroke width and Color of the grid) and the
header and content font.

18.3.8 Add an HTML frame to the Print Composer

It is possible to add a clickable frame linked to a URL: Click the Add HTML frame icon, place the element with the
left mouse button on the Print Composer canvas and position and customize the appearance in the Item Properties
tab.

Algemene eigenschappen

The Main properties dialog of the HTML frame Item Properties tab provides the following functionalities (see
figure_composer_26):

• Point the URL field to the URL or the HTML file you want to insert in the Composer.

• You can adjust the rendering of the page with the Resize mode.

• Use existing frames constrains the page inside its first frame or in the frame created with the next settings.

• Extent to next page will create as many frames (and corresponding pages) as necessary to render the height
of the web page. Each frame can be moved around on the layout. If you resize a frame, the webpage will
be divided up between the other frames. The last frame will be trimmed to fit the web page.

• Repeat on every page will repeat the upper left of the web page on every page in frames of the same size.

• Repeat until finished will also create as many frames as the Extend to next page option, except all frames
will have the same size.
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Figuur 18.26: HTML frame Item properties Tab

18.4 Items beheren

18.4.1 Grootte en positie

Elk item binnen de Printvormgeving kan worden verplaatst/aangepast in grootte om een perfecte lay-out te maken.

Voor beide bewerkingen is de eerste stap om het gereedschap Selecteer/Verplaats item te activeren en te klikken op
het item; u kunt het dan verplaatsen met behulp van de muis terwijl u de linker muisknop ingedrukt houd. Als u de
verplaatsingen wilt beperken tot de horizontale of de verticale as, houdt eenvoudigweg de toets Shift ingedrukt
bij het verplaatsen van de muis. Als u een betere precisie nodig heeft,kunt u een geselecteerd item verplaatsen met
behulp van de pijltoetsen op het toetsenbord; als de verplaatsing te traag gaat, kunt u die versnellen door
Shift ingedrukt te houden.

A selected item will show squares on its boundaries; moving one of them with the mouse, will resize the item in
the corresponding direction. While resizing, holding Shift will maintain the aspect ratio. Holding Ctrl will
resize from the item center.

The correct position for an item can be obtained using snapping to grid or smart guides. If you need to disable the
snap on the fly just hold Ctrl while moving the mouse.

U kunt meerdere items kiezen met de knop Selecteer/Verplaats item. Houdt eenvoudigweg de knop Shift ingedrukt
en klik op alle items die u nodig heeft. U kunt dan deze groep wijzigen van grootte/verplaatsen alsof het één enkel
item is.

Once you have found the correct position for an item, you can lock it by clicking with the right mouse button.
Press the same button another time to unlock it. You can also lock/unlock items using the icons on the toolbar.

Klik eenvoudigweg op een item met de toets Shift ingedrukt om een item te deselecteren,

Binnen het menu Bewerken vindt u acties om alle items te selecteren, alle selecties op te heffen of om de huidige
selectie om te draaien.

18.4.2 Uitlijning

Raising or lowering functionalities for elements are inside the Raise selected items pull-down menu. Choose an
element on the Print Composer canvas and select the matching functionality to raise or lower the selected element
compared to the other elements (see table_composer_1).

Er zijn verscheidene functionaliteiten voor uitlijning beschikbaar binnen het menu Geselecteerde items uitlijnen (zie
table_composer_1). U selecteert eerst enkele items en klikt dan op het overeenkomende pictogram voor uitlijning
om een functionaliteit voor uitlijning te gebruiken. Alle geselecteerde items zullen dan worden uitgelijnd binnen
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Figuur 18.27: Hulplijnen voor uitlijnen in Printvormgeving
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hun algemene kader. Bij het verplaatsen in het kaartvenster van Printvormgeving verschijnen hulplijnen voor
uitlijning als randen, middelpunten of hoeken worden uitgelijnd.

18.4.3 Items kopiëren/knippen en plakken

De Printvormgeving bevat acties om de algemene functionaliteiten Kopiëren/Knippen/Plakken voor de items in
de lay-out te gebruiken. Zoals gewoonlijk dient u eerst de items te selecteren met behulp van één van de opties
die hierboven zijn weergegeven; op dit punt kunnen de acties worden gevonden in het menu Bewerken. Bij het
gebruiken van de actie Plakken zullen de items worden geplakt overeenkomstig de huidige positie van de muis.

18.5 Gereedschappen voor Ongedaan maken en Opnieuw uitvo-
eren

Gedurende het proces van de lay-out is het mogelijk wijzigingen terug te draaien en weer opnieuw uit te voeren.
Dit kan worden gedaan met behulp van de gereedschappen:

• Laatste wijziging terugdraaien

• Laatste wijziging opnieuw

This can also be done by mouse click within the Command history tab (see figure_composer_28).

Figuur 18.28: Geschiedenis van opdrachten in de Printvormgeving

18.6 Atlas-generatie

De Printvormgeving bevat functies om te genereren die u in staat stellen boeken op een geautomatiseerde manier te
maken. Het concept is om een bedekkingslaag te gebruiken, die geometrieën en velden bevat. Voor elke geometrie
in de bedekkingslaag, zal een nieuwe uitvoer worden gegenereerd waarbij de inhoud van enkele kaartvensters zal
worden verplaatst om de huidige geometrie te accentueren. Velden die zijn geassocieerd met deze geometrie
kunnen worden gebruikt binnen tekstlabels.

Every page will be generated with each feature. To enable the generation of an atlas and access generation
parameters, refer to the Atlas generation tab. This tab contains the following widgets (see Figure_composer_29):

• Genereer een atlas, die het genereren van een atlas in- of uitschakelt.

• Een combinatievak Bedekkingslaag dat u in staat stelt de (vector)laag te kiezen die de geometrieën
bevat om de iteratie op uit te voeren.

• Een optioneel Verborgen bedekkingslaag dat, indien geselecteerd, de bedekkingslaag zal verbergen
(maar niet de andere) gedurende de generatie.

• Een optioneel tekstgebied Filter met dat u in staat stelt een expressie te bouwen voor het filteren van de
objecten op de bedekkingslaag. Als de expressie niet leeg is, worden alleen objecten die evalueren naar
True worden geselecteerd. De knop rechts laat u de expressie-bouwer weergeven.
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Figuur 18.29: Tab Atlas-generatie
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• Een tekstvak Expressie uitvoer bestandsnaam dat wordt gebruikt om een bestandsnaam te genereren voor
elke geometrie, indien nodig. Het is gebaseerd op expressies. Dit veld is alleen van betekenis voor het
renderen van meerdere bestanden.

• Een Exporteren naar enkel bestand indien mogelijk dat u in staat stelt het genereren van één enkel
bestand te forceren als dat mogelijk is met de gekozen indeling voor de uitvoer (PDF bijvoorbeeld). Als dit
veld is geselecteerd is de waarde van het veld Expressie uitvoer bestandsnaam zonder betekenis.

• Een optioneel Sorteren op dat, indien geselecteerd, u in staat stelt de objecten van de bedekkingslaag
te sorteren. Het geassocieerde combinatievak stelt u in staat te kiezen welk veld als sorteersleutel moet
worden gebruikt. De volgorde van sorteren (oplopend of aflopend) wordt ingesteld door een knop met twee
statussen die een pijl naar boven of naar beneden weergeeft.

U kunt meerdere kaartitems gebruiken bij het genereren van een atlas; elke kaart zal worden gerenderd

overeenkomstig de bedekkingsobjecten. U dient Beheerd door atlas onder de Item -eigenschappen van een
kaartitem te selecteren om het genereren van een atlas voor een specifiek kaartitem in te schakelen. Eenmaal
geselecteerd kunt u instellen:

• Een invoervak Marge rond object dat u in staat stelt de hoeveelheid ruimte te selecteren die moet worden
toegevoegd aan elke geometrie binnen de toegewezen kaart. De waarde is alleen van betekenis bij het
gebruiken van de modus automatisch op schaal brengen.

• Een Vaste schaal dat u in staat stelt te schakelen tussen de modi automatisch op schaal brengen en vaste
schaal. In de modus vaste schaal zal de kaart alleen worden vertaald voor elke geometrie om te worden
gecentreerd. In de modus Automatisch op schaal brengen worden de bereikeen van de kaart dusdanig
berekend dat elke geometrie in zijn geheel zal verschijnen.

18.6.1 Labels

In order to adapt labels to the feature the atlas plugin iterates over, use a label with this special notation [%expres-
sion using field_name%]. For example, for a city layer with fields CITY_NAME and ZIPCODE, you could insert
this:

“[% ‘The area of ‘ || upper(CITY_NAME) || ‘,’ || ZIPCODE || ‘ is ‘ format_number($area/1000000,2) || ‘ km2’
%]“

That would result in the generated atlas as

“The area of PARIS,75001 is 1.94 km2”.

18.6.2 Voorvertoning

Als de instellingen voor de atlas zijn geconfigureerd en kaartitems zijn geselecteerd, kunt u een voorvertoning
maken van alle pagina’s door te klikken op Atlas → Voorvertoning Atlas en de pijlen in hetzelfde menu gebruiken
om door alle objecten te navigeren.

18.6.3 Genereren

Het genereren van een atlas kan op verschillende manieren worden gedaan. Bijvoorbeeld met Atlas → Afdrukken
Atlas kunt u hem direct afdrukken. U kunt ook een PDF maken met behulp van Atlas → Exporteer Atlas als PDF:
De gebruiker zal worden gevraagd naar een map om alle gegenereerde PDF-bestanden op te slaan (behalve als

Exporteren naar enkel bestand indien mogelijk is geselecteerd). Als u slechts één pagina van de atlas wilt
afdrukken, start dan eenvoudigweg de functie Voorvertoning, selecteer de pagina die u nodig heeft en klik op
Printvormgeving → Afdrukken (of maak een PDF).
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18.7 Uitvoer aanmaken

Figure_composer_30 shows the Print Composer with an example print layout, including each type of map element
described in the sections above.

Figuur 18.30: Printvormgeving met toegevoegde kaartweergave, legenda, afbeelding, schaalbalk, coördinaten,
tekst en HTML-object

De Printvormgeving stelt u in staat verscheidene indelingen voor de uitvoer te maken en het is mogelijk om de
resolutie (afdrukkwaliteit) en papiergrootte te definiëren:

• Het pictogram Afdrukken stelt u in staat de lay-out af te drukken naar een verbonden printer of naar een
bestand van PostScript, afhankelijk van de geïnstalleerd stuurprogramma’s voor de printer.

• Het pictogram Opslaan als afbeelding exporteert het kaartvenster van Printvormgeving naar verschillende in-
delingen voor afbeeldingen, zoals PNG, BPM, TIF, JPG,...

• Exporteren als PDF slaat het gedefinieerde kaartvenster van Printvormgeving direct op als PDF.

• Het pictogram Exporteren naar SVG slaat het kaartvenster van Printvormgeving op als een SVG (Scalable
Vector Graphic).

If you need to export your layout as a georeferenced image (i.e., to load back inside QGIS), you need to enable

this feature under the Composition tab. Check World file on and choose the map item to use. With this option,
the ‘Export as image’ action will create also a world file.

Notitie: Currently, the SVG output is very basic. This is not a QGIS problem, but a problem with the underlying
Qt library. This will hopefully be sorted out in future versions. Exporting big rasters can sometimes fail, even if
there seems to be enough memory. This is also a problem with the underlying Qt management of rasters.
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18.8 Beheren van de Printvormgeving

With the Save as template and Load from template icons, you can save the current state of a Print Composer session
as a .qpt template and load the template again in another session.

De knop Printvormgeving -manager in de werkbalk van QGIS en in Printvormgeving → Printvormgeving-manager
stelt u in staat een nieuw sjabloon voor printvormgeving toe te voegen, een nieuwe lay-out te maken gebaseerd op
een eerder opgeslagen sjabloon of reeds bestaande sjablonen te beheren.

Figuur 18.31: De Printvormgeving-manager

Standaard zoekt de Printvormgeving-manager naar sjablonen van gebruikers in ~/.qgis2/composer_template.

De knoppen Nieuwe Printvormgeving en Dupliceer Printvormgeving in de werkbalk van QGIS en in Printvormgeving
→ Nieuwe Printvormgeving en Printvormgeving → Dupliceer Printvormgeving stellen u in staat een nieuw di-
aloogvenster te openen voor Printvormgeving, of om een bestaande lay-out te dupliceren uit een eerder gemaakte.

Tenslotte kunt u uw lay-out voor de afdruk opslaan met de knop Project opslaan. Dit is dezelfde mogelijkheid als
in het hoofdvenster van QGIS. Alle wijzigingen zullen worden opgeslagen in een projectbestand van QGIS.

.
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HOOFDSTUK 19

Plugins

.

19.1 QGIS Plug-ins

QGIS is ontworpen met een architectuur voor plug-ins. Dit maakt het toevoegen van nieuwe functionaliteit en
functies aan de toepassing eenvoudiger. veel van de mogelijkheden in QGIS zijn actueel geïmplementeerd als
plug-ins

19.1.1 The Plugins Menus

The menus in the Plugins dialog allow the user to install, uninstall and upgrade plugins in different ways.

Alles

Hier worden alle beschikbare plug-ins vermeld, inclusief die voor de bron en externe plug-ins. Gebruik [Alles
opwaarderen] om te zoeken naar nieuwe versies van de plug-ins. verder kunt u [Installeer plug-in] gebruiken
als een plug-in is vermeld maar niet is geïnstalleerd en [Deïnstalleer plug-in] als ook [Herinstalleer plug-in], als
een plug-in is geïnstalleerd. Als een plug-in is geïnstalleerd, kan die worden in/uitgeschakeld met behulp van jet
keuzevak.

Geïnstalleerd

In dit menu vindt u alleen de geïnstalleerde plug-ins. De externe plug-ins kunnen worden gedeïnstalleerd en
opnieuw worden geïnstalleerd met de knoppen [Deïnstalleer plug-in] en [Herinstalleer plug-in]. U kunt hier
ook [Alles opwaarderen].

Niet geïnstalleerd

Dit menu vermeld alle beschikbare plug-ins die niet zijn geïnstalleerd. U kunt de knop [Installeer plug-in]
gebruiken om een plug-in in QGIS te implementeren.

Opwaarderen

Als u het keuzevak Ook de experimentele plug-ins tonen in het menu Settings hebt geselecteerd, kunt u dit
menu gebruiken om te zoeken naar meer recente versies van de plug-ins. Dit kan worden gedaan met de knoppen
[Plug-in opwaarderen] of [Alles opwaarderen].

Extra

In dit menu kunt u de volgende opties gebruiken:
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Figuur 19.1: Het menu Alles

Figuur 19.2: Het menu Geïnstalleerd
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Figuur 19.3: Het menu Niet geïnstalleerd

Figuur 19.4: Het menu Opwaarderen
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• Controleer op updates bij opstarten. Wanneer een nieuwe plug-in of een bijgewerkte plug-in beschik-
baar is, zal QGIS u ‘elke keer als QGIS opstart’, ‘een keer per dag’, ‘elke 3 dagen’, ‘elke week’, ‘elke 2
weken’ of ‘elke maand’ informeren.

• Ook de experimentele plug-ins tonen. QGIS zal u plug-ins tonen in hun eerste fase van ontwikkeling,
die over het algemeen niet geschikt zijn voor productie-doeleinden.

• Toon ook niet meer onderhouden plug-ins. Deze plug-ins zin vervallen en over het algemeen niet
geschikt voor productie-doeleinden.

Klik op [Toevoegen...] in het gedeelte Plug-in opslagplaatsen om externe opslagplaatsen van auteurs toe te
voegen. Als u één of meer van de toegevoegde opslagplaatsen niet meer wilt, kunnen zij worden uitgeschakeld
via de knop [Bewerken...], of volledig worden verwijderd met de knop [Verwijderen].

Figuur 19.5: Het menu Extra

De functie Zoeken is in bijna elk menu beschikbaar (met uitzondering van Extra). Hier kunt u zoeken naar
specifieke plug-ins.

Tip: bron- en externe plug-ins
Plug-ins voor QGIS worden ofwel geïmplementeerd als Bron-plug-ins of als Externe plug-ins. Bron-plug-
ins worden onderhouden door het QGIS Development Team en maken automatisch deel uit van elke distributie
van QGIS. Zij zijn geschreven in één van twee talen: C++ of Python. Externe plug-ins worden momenteel
allemaal geschreven in Python. Zij worden opgeslagen in externe opslagplaatsen en worden onderhouden door de
individuele auteurs.

Gedetailleerde documentatie over het gebruik, minimale versie van QGIS, thuispagina, auteurs en andere belan-
grijke informatie wordt voor de ‘Officiële’ opslagplaats voor QGIS verschaft op http://plugins.qgis.org/plugins/.
Voor andere externe opslagplaatsen zou documentatie beschikbaar kunnen zijn bij de externe plug-ins zelf. Over
het algemeen is het niet opgenomen in deze handleiding.
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19.2 QGIS Bron-plug-ins gebruiken

Pic-
togram

Plug-in Beschrijving Verwijzing
handleiding

Coördinaat
klikken

Prik coördinaten in afwijkend CRS Plug-in Coördinaat
klikken

DB Manager Beheren van uw databases binnen QGIS Plug-in DB Manager

DXF2Shape
Converter

Converteert vanuit indeling DXF naar
SHP-bestand

Plug-in Dxf2Shp
Converter

eVis Event Visualization Tool Plug-in eVis

fTools Een pakket gereedschap voor vectoren Plug-in fTools

GPS-
gereedschap

Gereedschappen voor het laden en importeren van
GPS-gegevens

Plug-in
GPS-gereedschap

GRASS GRASS-functionaliteit Integratie van GRASS
GIS

GDAL-
gereedschappen

GDAL-rasterfunctionaliteit GDAL Tools Plugin

Georeferencer
GDAL

Geo-verwjzingen voor rasters met GDAL Plug-in Georeferencer

Heatmap Maken van heatmap-rasters vanuit ingevoerde
vectorpunten

Plug-in Heatmap

Plug-in
Interpolatie

Interpolatie op basis van punten op een vectorlaag Interpolatie-plugin

Offline bewerken Offline bewerken en synchroniseren met database Offline Editing Plugin

Oracle Spatial
Georaster

Toegang tot Oracle Spatial GeoRasters Oracle Spatial
GeoRaster-plugin

Plug-ins beheren Beheren van bron- en externe plug-ins The Plugins Menus

Raster
Terreinanalyse

Geomorfologische mogelijkheden voor DEM’s
berekenen

Raster Terreinanalyses
Plugin

Plug-in Road
Graph

Kortste pad-analyse Plug-in Road Graph

Plug-in SQL
Anywhere

Toegang tot database van SQL anywhere Plug-in SQL Anywhere

Ruimtelijke
query

Ruimtelijke query’s op vectorlagen Spatial Query Plugin

SPIT Gereedschap voor importeren van shapefiles naar
PostgreSQL/PostGIS

Plug-in SPIT

Ge-
biedsstatistieken

Berekenen van rasterstatistieken voor
vectorpolygonen

Plug-in
Gebiedsstatistieken

.

19.2. QGIS Bron-plug-ins gebruiken 257



QGIS User Guide, Release 2.2

19.3 Plug-in Coördinaat klikken

De plug-in Coödinaat klikken is eenvoudig te gebruiken en verschaft de mogelijkheid om coördinaten weer
tegeven in het kaartvenster voor twee geselecteerde coördinaten referentie systemen (CRS).

Figuur 19.6: Plug-in Coördinaat klikken

1. Start QGIS, selecteer Projectinstellingen uit het menu Project (KDE, Windows) of Bestand (Gnome,

OSX) en klik op de tab CRS. Als alternatief kunt ook klikken op het pictogram CRS-status in de rechter
benedenhoek van de statusbalk.

2. Klik op het keuzevak Gelijktijdige CRS-transformatie gebruiken en selecteer een geprojecteerd coördi-
natensysteem van uw keuze (zie ook Werken met Projecties).

3. Load the coordinate capture plugin in the Plugin Manager (see load_core_plugin) and ensure that the dialog

is visible by going to View → Panels and ensuring that Coordinate Capture is enabled. The coordinate
capture dialog appears as shown in Figure figure_coordinate_capture_1. Alternatively, you can also go to

Vector → Coordinate Capture and see if Coordinate Capture is enabled.

4. Klik op het pictogram Klik om het CRS te selecteren voor het tonen van de coördinaten en selecteer een ander CRS dan
dat welke u hierboven selecteerde.

5. Klik op [Starten] om te beginnen met het klikken op coördinaten. U kunt nu overal in het kaartvenster
klikken en de plug-in zal de coördinaten weergeven voor uw beide geselecteerde CRS-en.

6. Klik op het pictogram Muis volgen om het traceren van coördinaten met de muis in te schakelen.

7. U kunt de geselecteerde coördinaten ook kopiëren naar het klembord.

.

19.4 Plug-in DB Manager

De plug-in DB Manager maakt officieel deel uit van de bron van QGIS en is bedoeld als vervanging van de
plug-in SPIT en, aanvullend, om alle andere indelingen van databases die worden ondersteund door QGIS in één

gebruikersinterface te integreren. De plug-in DB Manager verschaft verschillende mogelijkheden. U kunt lagen
uit de QGIS Browser in de DB Manager slepen en het zal uw laag in uw ruimtelijke database importeren. U kunt
tabellen tussen ruimtelijke databases slepen en neerzetten en zij zullen worden geïmporteerd. U kunt DB Manager
ook gebruiken om query’s in SQL uit te voeren tegen uw ruimtelijke database en dan de ruimtelijke uitvoer voor
query’s weergeven door de resultaten als een query-laag toe te voegen aan QGIS.

Het menu Database stelt u in staat te verbinden met een bestaande database, het venster SQL te starten en de plug-
in DB Manager te verlaten. Als u eenmaal verbonden bent met een bestaande database verschijnen aanvullend de
menu’s Schema en Tabel.

Het menu Schema bevat gereedschappen om (lege) schema’s te maken en te verwijderen en, indien topologie
beschikbaar is (bijv., PostGIS 2), een TopoViewer te starten.
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Figuur 19.7: Dialoogvenster DB Manager

Het menu Tabel stelt u in staat tabellen te maken en te verwijderen en tabellen en views te bewerken. Het is
ook mogelijk om tabellen leeg te maken en tabellen te verplaatsen van het ene schema naar het andere. Als
verdere functionaliteit kunt u een VACUUM uitvoeren en dan een ANALYZE uitvoeren voor elke geselecteerde
tabel. Platte VACUUM verzamelt eenvoudigweg niet gebruikte ruimte en maakt die beschikbaar voor hergebruik.
ANALYZE werkt statistieken bij om de meest efficiënte manier te bepalen om een query uit te voeren. Tenslotte
kunt u lagen/bestanden importeren als zij zijn geladen in QGIS of bestaan in het bestandssysteem. En u kunt
databasetabellen exporteren naar shape met de mogelijkheid Export naar bestand.

Het venster Tree vermeld alle bestaande databases die worden ondersteund door QGIS. Met een dubbelklik kunt
u met de database verbinden. Met de rechter muisknop kunt u bestaande schema’s en tabellen hernoemen en
verwijderen. Tabellen kunnen ook aan het kaartvenster van QGIS worden toegevoegd met het contextmenu.

Indien verbonden met een database biedt het **hoofd**venster van de DB Manager drie tabs. De tab Info tab ver-
schaft informatie over de tabel en de geometrie daarvan, als ook over bestaande velden, voorwaarden en indexen.
Het stelt u ook in staat Vacuum Analyze uit te voeren en om een ruimtelijke index te maken voor een geselecteerde
tabel, indien dat nog niet is gebeurd. De tab Tabel geeft alle attributen weer en de tab Voorvertoning rendert de
geometrieën als voorbeeld.

.

19.5 Plug-in Dxf2Shp Converter

De plug-in Dxf2shape converter kan worden gebruikt om vectorgegevens te converteren vanuit de indeling DXF
naar shapefile. Het vereist dat de volgende parameters worden gespecificeerd vóór het uitvoeren:

• DXF invoerbestand: Voer het pad in naar het DXF-bestand dat moet worden geconverteerd.

• Uitvoerbestand: Voer de gewenste naam in voor het maken shapefile-bestand.

• Bestandstype uitvoer: Specificeer het type geometrie voor het shapefile-uitvoerbestand. De momenteel
ondersteunde typen zijn polylijn, polygoon en punt.
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Figuur 19.8: Plug-in Dxf2Shp Converter

• Exporteer tekstlabels: Wanneer dit keuzevak is ingeschakeld zal een aanvullende shapefile puntenlaag
worden gemaakt en de geassocieerde DBF-tabel zal informatie bevatten over de velden “TEXT” die werden
gevonden in het DXF-bestand en de tekst-tekenreeksen zelf.

19.5.1 Gebruik van de plug-in

1. Start QGIS, laad de plug-in Dxf2Shape in beheer en installeer plug-ins (see The Plugins Menus) en klik op

het pictogram Dxf2Shape Converter, dat verschijnt in het menu met werkbalken in QGIS. Het dialoogvenster
van de plug-in Dxf2Shape verschijnt, zoals weergegeven Figure_dxf2shape_1.

2. Voer het invoerbestand van DXF in, een naam voor het uitvoerbestand in shapefile en het type shapefile.

3. Schakel het keuzevak Exporteer tekstlabels in als een extra puntenlaag met labels wilt maken.

4. Klik op [OK].

.

19.6 Plug-in eVis

(Dit gedeelte is afgeleid van Horning, N., K. Koy, P. Ersts. 2009. eVis (v1.1.0) User’s Guide.
American Museum of Natural History, Center for Biodiversity and Conservation. Beschikbaar vanaf
http://biodiversityinformatics.amnh.org/, en uitgegeven onder de GNU FDL.)

De Biodiversity Informatics Facility aan het American Museum of Natural History’s (AMNH) Center for Biodiver-
sity and Conservation (CBC) heeft de Event Visualization Tool (eVis) ontwikkeld, een ander softwaregereedschap
om toe te voegen aan het pakket van gereedschappen voor het monitoren en nemen van beslissingen voor behoud
van beschermde gebieden en plannen van landschappen. Deze plug-in stelt gebruikers eenvoudig in staat om
geo-gecodeerde (d.i., verwijzingen met breedtegraad en lengtegraad of met X- en Y-coördinaten) foto’s, en andere
ondersteunde documenten, te koppelen aan vectorgegevens in QGIS.

eVis is nu automatisch geïnstalleerd en ingeschakeld in nieuwe versies van QGIS en net als alle plug-ins, kan hij
worden in- en uitgeschakeld met behulp van Beheer en installeer plug-ins (zie The Plugins Menus).

De plug-in eVis bestaat uit drie modules: het gereedschap ‘Databaseverbinding’, gereedschap ‘Event ID’ en de
‘Event Browser’. Deze werken samen om het mogelijk te maken geo-gecodeerde foto’s en andere documenten
die zijn gekoppeld aan objecten die zijn opgeslagen in vectorbestanden, databases of werkbladen te bekijken.

19.6.1 Event Browser

De module Event Browser verschaft de functionaliteit om geo-gecodeerde foto’s weer te geven die zijn gekoppeld
aan vector-objecten die worden weergegeven in het kaartvenster van QGIS. Puntgegevens, bijvoorbeeld, kunnen
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uit een vectorbestand komen dat kan worden ingevoerd met behulp van QGIS of het kan komen uit het resultaat
van een query op een database. Het vectorobject moet informatie over attributen hebben die ermee is geassocieerd
om de locatie en de naam van het bestand dat de foto bevat te beschrijven en, optioneel, de kompasrichting waarin
de camera was gericht toen de opname werd gemaakt. Uw vectorlaag moet worden geladen in QGIS vóórdat de
Event Browser wordt uitgevoerd.

Start de module Event Browser

Klik op Database → eVis → eVis Event Browser om de module Event Browser te starten. Dit zal het venster Event
Browser openen.

Het venster Event Browser heeft drie tabs die worden weergegeven aan de bovenzijde van het venster. De tab Tonen
wordt gebruikt om de foto te bekijken en de daaraan geassocieerde gegevens van de attributen. De tab Opties
verschaft een aantal instellingen die kunnen worden aangepast om het gedrag van de plug-in eVis te beheren.
tenslotte wordt de tab Configureren externe applicaties gebruikt om een tabel met bestandsextensies en de daarn
geassocieerde programma’s te onderhouden om eVis in staat te stellen andere documenten dan afbeeldingen weer
te geven.

Begrijpen van het venster Tonen

Klik op de tab Tonen in het venster Event Browser om het venster Tonen te zien. Het venster Tonen wordt gebruikt
om geo-gecodeerde foto’s en hun geassocieerde gegevens voor attributen te bekijken.

Figuur 19.9: Het eVis venster Tonen

1. venster Tonen: Een venster waar de foto zal verschijnen.
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2. knop Inzoomen: Zoom in om meer detail te zien. Als niet de gehele afbeelding kan worden weergegeven
in het venster Tonen zullen schuifbalken aan de linker- en onderzijde van het venster verschijnen om u in
staat te stellen u over de afbeelding te verplaatsen.

3. knop Uitzoomen: Zoom uit om meer gebied te zien.

4. knop Zoomen naar maximale inhoud: Geeft de volledige inhoud van de foto weer.

5. venster Attribuutinformatie: Alle informatie over attributen voor het geassocieerde punt dat op de foto
wordt weergegeven, wordt hier getoond. Als het gerefereerde bestandstype in het record geen afbeelding
is, maar van een bestandstype dat is gedefinieerd onder de tab “Externe programma’s configureren”, dan
zal bij het dubbelklikken van de waarde, van het veld dat het pad naar het bestand bevat, het bijbehorende
programma worden geopend om de inhoud van het bestand te bekijken of beluisteren. Als de extensie van
het bestand wordt herkend zal de informatie over de attributen in groen worden weergegeven.

6. Navigatieknoppen: Gebruik de knoppen Vorige en Volgende om het vorige of volgende object te laden
wanneer meer dan één object is geselecteerd.

Begrijpen van het venster Opties

Figuur 19.10: Het eVis venster Opties

1. Bestandspad: Een keuzelijst om het veld met attributen te specificeren dat het pad naar de map of de URL
voor de foto’s of andere documenten die worden weergegeven bevat. Als de locatie een relatief pad is, dan
moet het keuzevak worden geselecteerd. Het basispad voor een relatief pad kan worden ingevoerd in het
tekstvak Basispad hieronder. Informatie over de verschillende opties voor het specificeren van de bestand-
slocatie zijn opgenomen in het gedeelte Specificeren van de locatie en de naam van een foto hieronder.

2. Kompasrichting: Een keuzelijst om het veld met attributen te specificeren dat de kompasrichting bevat
die is geassocieerd met de weergegeven foto. Als informatie over de kompasrichting beschikbaar is, is het
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noodzakelijk om het keuzevak te selecteren onder de titel van de keuzelijst.

3. Kompasafwijking: Verschuivingen aan het kompas kunnen worden gebruikt om de afbuiging (om met
behulp van magnetische richtingen verzamelde richtingen aan te passen naar richtingen van het echte Noor-
den) te compenseren. Klik op de keuzeknop Handmatig om de verschuiving in het tekstvak in te voeren
or klik op de keuzeknop Afkomstig van attribuut om het veld met de attributen dat de verschuivingen be-
vat te selecteren. Voor beide opties zouden oostelijke afbuigingen moeten worden ingevoerd met positieve
waarden en westelijke afbuigingen zouden negatieve waarden moten gebruiken.

4. Bestandspad: Het basispad waaraan het relatieve pad, gedefinieerd in Figure_eVis_2 (A) zal worden
toegevoegd.

5. Vervangpad: Als dit keuzevak is geselecteerd zal alleen de bestandsnaam uit A worden toegevoegd aan het
basispad.

6. Regel toepassen op alle documenten: Indien geselecteerd worden dezelfde regels voor paden die zijn
gedefinieerd voor foto’s worden gebruikt voor documenten die geen afbeelding zijn, zoals filmpjes, tekst-
documenten en geluidsbestanden. Indien niet geselecteerd zullen de regels voor paden alleen van toepassing
zijn op foto’s en zullen andere documenten de parameter Basispad negeren.

7. Onthouden: Als het keuzevak is geselecteerd zullen de waarden voor de geassocieerde parameters worden
opgeslagen voor de volgende sessie wanneer het venster wordt gesloten of wanneer de knop [Save] eronder
wordt ingedrukt.

8. Terug naar beginwaarden: Herstelt de waarden op deze regel naar de standaard instelling.

9. Standaarden herstellen: Dit zal alle velden terugzetten naar hun standaard waarden. Het heeft hetzelfde
effect als het klikken op alle knoppen [Terug naar beginwaarden].

10. Opslaan: Dit zal de instellingen opslaan zonder het paneel Opties te sluiten.

Begrijpen van het venster Externe programma’s configureren

Figuur 19.11: Het eVis venster Externe applicaties

1. Tabel bestandsverwijzingen: Een tabel met bestandstypen die kunnen worden geopend met eVis. Voor elk
bestandstype is een bestandsextensie en pad naar een programma/toepassing nodig om dat type bestand te
openen. Dit maakt het mogelijk om zeer veel verschillende soorten bestanden, zoals filmpjes, geluidsbe-
standen en tekstdocumenten, te kunnen openen in plaats van alleen afbeeldingen.

2. Nieuw bestandstype toevoegen: Voeg een nieuw bestandstype toe met een unieke extensie en het pad naar
het programma dat dit bestand kan openen.

3. Verwijder huidige regel: Verwijder het bestandstype dat geselecteerd is in de tabel en gedefinieerd wordt
door een bestandsextensie en een pad naar het bijbehorende programma.
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19.6.2 Specificeren van de locatie en de naam van een foto

De locatie en naam van de foto kan worden opgeslagen met behulp van een absoluut of relatief pad, of een URL
als de foto beschikbaar is op een webserver. Voorbeelden voor de verschillende benaderingen zijn vermeld in de
tabel evis_examples.

X Y FILE BEARING
780596 1784017 C:\Workshop\eVis_Data\groundphotos\DSC_0168.JPG 275
780596 1784017 /groundphotos/DSC_0169.JPG 80
780819 1784015 http://biodiversityinformatics.amnh.org/\

evis_testdata/DSC_0170.JPG 10
780596 1784017 pdf:http://www.testsite.com/attachments.php?\

attachment_id-12 76

19.6.3 Specificeren van de locatie en naam van andere ondersteunde docu-
menten

Ondersteunde documenten zoals tekstdocumenten, video’s en geluidsclips kunnen ook worden weergegeven of
afgespeeld door eVis. Het is, om dit te kunnen doen, noodzakelijk om een item toe te voegen aan de tabel met
bestandsverwijzingen, die kan worden benaderd in het venster Externe programma’s configureren in de Event
Browser, dat overeenkomt met de bestandsextensie voor een programma dat kan worden gebruikt om het bestand
te openen. Het is ook noodzakelijk om het pad of de URL naar het bestand in de attributentabel voor de vector-
laag te hebben. Een aanvullende regel die kan worden gebruikt voor URL’s die geen bestandsextensie bevatten
voor het document dat u wilt openen, is om de bestandsextensie te specificeren vóór de URL. De indeling is —
bestandsextensie:URL. De URL wordt voorafgegaan door de bestandsextensie en een dubbele punt; dit is
in het bijzonder handig voor toegang tot documenten vanaf wiki’s en andere websites die een database gebruiken
om de webpagina’s te beheren (zie tabel evis_examples).

19.6.4 Gebruiken van de Event Browser

Wanneer het venster Event Browser opent zal een foto verschijnen in het venster Tonen als het document waarnaar
verwezen wordt in de attributentabel van het vectorbestand een afbeelding is en als de informatie over de locatie
van het bestand in het venster Opties juist is ingesteld. Als een foto werd verwacht en die verschijnt niet, zal het
nodig zijn de parameters in het venster Opties aan te passen.

Als een ondersteund document (of een afbeelding die geen bestandsextensie heeft die wordt herkend door eVis)
waarnaar wordt verwezen in de attributentabel, zal het veld dat het bestandspad bevat worden geaccentueerd in
groen in het venster met informatie over de attributen als die bestandsextensie is gedefinieerd in de tabel met
bestandsverwijzingen die is opgenomen in het venster Externe programma’s configureren. Dubbelklik op de in
groen geaccentueerde regel in het venster met informatie over de attributen om het document te openen. Als naar
een ondersteund document wordt verwezen in het venster met informatie over de attributen en het bestandspad is
niet geaccentueerd in groen, dan is het noodzakelijk om een item op te nemen voor de extensie van de bestand-
snaam van het bestand in het venster Externe programma’s configureren. Als het bestandspad is geaccentueerd in
groen maar opent niet met dubbelklikken, zal het noodzakelijk zijn om de parameters in het venster Opties aan te
passen zodat het bestand kan worden gelokaliseerd door eVis.

Als er geen kompasrichting is opgegeven in het venster Opties zal een rood sterretje worden weergegeven boven
het vectorobject dat is geassocieerd met de weergegeven foto. Als er een kompasrichting is opgegeven zal er
een pijl verschijnen die wijst in de richting die wordt aangeduid door de waarde in het veld kompasrichting in
het venster Event Browser. De pijl zal zijn gecentreerd op het punt dat is geassocieerd met de foto of andere
document.

Klik op de knop [Close] van het venster Tonen om het venster Event Browser te sluiten.

19.6.5 gereedschap Event ID

De module ‘Event ID’ verschaft de functionaliteit om een foto weer te geven door te klikken op een object dat
wordt weergegeven in het kaartvenster van QGIS. Het vectorobject moet informatie over attributen hebben die
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ermee is geassocieerd om de locatie en de naam van het bestand dat de foto bevat te beschrijven en, optioneel,
de kompasrichting waarin de camera was gericht toen de opname werd gemaakt. Deze laag moet zijn geladen in
QGIS vóórdat het gereedschap ‘Event ID’ wordt uitgevoerd.

Start de module Event ID

Ofwel klik op het pictogram Event ID óf klik op Database → eVis → Event ID-gereedschap om de module
‘Event ID’ te starten. Dit zal er voor zorgen dat de cursor wijzigt naar een pijl met een ‘i’ erboven om aan te geven
dat het gereedschap ID actief is.

Verplaats de cursor van de Event ID over het object en klik met de muis om de foto’s te bekijken die zijn gekop-
peld aan vectorobjecten in de actieve vectorlaag die wordt weergegeven in het kaartvenster van QGIS. Na het
klikken op het object wordt het venster Event Browser geopend en de foto’s op of nabij de aangeklikte locatie zijn
beschikbaar om te worden weergegeven in de browser. Indien meer dan één foto beschikbaar is, kunt u door de
verschillende objecten gaan met behulp van de knoppen [Vorige] en [Volgende]. De andere besturingselementen
worden beschreven in het gedeelte ref:evis_browser van deze handleiding.

19.6.6 Databaseverbinding

De module ‘Databaseverbinding’ verschaft gereedschappen om te verbinden met en query een database of andere
ODBC-bron, zoals een werkblad.

eVis kan direct verbinden met de volgende typen databases: PostgreSQL, MySQL en SQLite; het kan ook lezen
vanuit ODBC-verbindingen (bijv., MS Access). Bij het lezen vanuit een ODBC-database (zoals een werkblad
van Excel), is het nodig om uw stuurprogramma voor ODBC te configureren voor het besturingssysteem dat u
gebruikt.

Start de module Databseverbinding

Ofwel klik op het toepasselijke pictogram eVis Databaseverbinding óf klik op Database → eVis → Databaseverbind-
ing om de module ‘Databaseverbinding’ te starten. Dit zal het venster Databaseverbinding starten. Het venster
heeft drie tabs: Voorgedefinieerde query’s, Databaseverbinding en SQL-query. Het venster Output Console onder
in het venster geeft de status weer van de acties die worden geïnitieerd door de verschillende gedeelten van deze
module.

Verbinden met een database

Klik op de tab Databaseverbinding om de interface voor de databaseverbinding te openen. Gebruik vervolgens

het combinatievak Type database om het type database te selecteren waarmee u wilt verbinden. Als een
wachtwoord of gebruikersnaam is vereist, kan die informatie worden ingevoerd in de tekstvakken Gebruikersnaam
en Wachtwoord.

Voer de naam van de host voor de database in in het tekstvak Database Host. Deze optie is niet beschikbaar als
u “MSAccess” als type database heeft gekozen. Als de database zich op uw desktop bevindt, zou u “localhost”
moeten invoeren.

Voer de naam van de database in in het tekstvak :guilabel:‘Naam database ‘. Indien u ‘ODBC’ selecteerde als het
type database, dient u de naam van de gegevensbron in te voeren.

Als alle parameters zijn ingevuld, klik dan op de knop [Verbinden]. Als de verbinding tot stand wordt gebracht
zal een bericht worden geschreven in het venster Output Console dat aangeeft dat de verbinding tot stand is
gebracht. Als geen verbinding tot stand wordt gebracht dient u te controleren of boven de juiste parameters
werden ingevoerd.

1. Type database: Een keuzelijst om het type database te specificeren dat zal worden gebruikt.

2. Database-host: De naam van de host van de database .
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Figuur 19.12: Het eVis venster Databaseverbinding

3. Poort: Het poortnummer als een type database van MySQL of PostgreSQL is geselecteerd.

4. Naam database: De naam van de database.

5. Verbinden: Een knop om te verbinden met de database met behulp van de parameters die boven werden
gedefinieerd.

6. Console-venster: Het console-venster waar berichten over de voortgang worden weergegeven.

7. Gebruikersnaam: Gebruikersnaam om te gebruiken als de database met een wachtwoord is beveiligd.

8. Wachtwoord: Wachtwoord om te gebruiken als de database met een wachtwoord is beveiligd.

9. Voorgedefinieerde query’s: Tab om het venster “Voorgedefinieerde query’s” te openen.

10. Databaseverbinding: Tab om het venster “Databaseverbinding” te openen.

11. SQL Query: Tab om het venster “SQL Query” te openen.

12. Help: Geeft de online help weer.

13. OK: Sluit het hoofdvenster “Databaseverbinding”.

SQL-query’s uitvoeren

SQL-query’s worden gebruikt om informatie te extraheren uit een database of bron van ODBC. In eVis is de
uitvoer van deze query’s een vectorlaag die wordt toegevoegd aan het kaartvenster van QGIS. Klik op de tab SQL-
query om de interface voor SQL-query’s weer te geven. Opdrachten voor SQL kunnen worden ingevoerd in dit tek-
stvenster. Een hulpvolle handleiding over opdrachten voor SQL is beschikbaar op http://www.w3schools.com/sql.
Om bijvoorbeeld alle gegevens uit een werkblad van een Excel-bestand te extraheren: select * from
[blad1$] waar sheet1 de naam is van het werkblad.
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Klik op de knop [Query uitvoeren] om de opdracht uit te voeren. Als de query met succes wordt uitgevoerd
zal een venster Database bestandsselectie worden weergegeven. Als de query niet goed werd uitgevoerd zal een
foutbericht verschijnen in het venster Console-venster.

Voer, in het venster Database bestandsselectie, de naam in van de laag die zal worden gemaakt vanuit de resultaten
van de query in het tekstvak Naam voor de nieuwe laag.

Figuur 19.13: De eVis tab SQL query

1. SQL-Query tekstvenster: Een scherm om query’s voor SQL in te typen.

2. Voer query uit: Knop om de query uit te voeren die is ingevoerd het het :guilabel:‘ venster SQL-Query‘.

3. Console-venster: Het console-venster waar berichten over de voortgang worden weergegeven.

4. Help: Geeft de online help weer.

5. OK: Sluit het hoofdvenster Databaseverbinding.

Gebruik de combinatievakken X-coördinaat en Y-coördinaat om de velden uit de database te se-
lecteren die de coördinaten voor de X (of lengtegraad) en Y (of breeedtegraad) bevatten. Klikken op de knop [OK]
zorgt er voor dat de vectorlaag wordt gemaakt vanuit de SQL-query om te worden weergegeven in het kaartvenster
van QGIS.

U kunt de opdracht van QGIS ‘Opslaan als...’ gebruiken, waar u kunt komen door met rechts te klikken op de
naam van de laag in de legenda van de kaart van QGIS en dan te selecteren ‘Opslaan als...’, om dit vectorbestand
op te slaan voor toekomstig gebruik.

Tip: Een vectorlaag maken uit een werkblad van Microsoft Excel
Bij het maken van een vectorlaag uit een werkblad van Microsoft Excel zou u kunnen zien dat niet gewenste
nullen (“0”) zijn ingevoerd in de rijen van de attributentabel onder geldige gegevens. Dit kan worden veroorzaakt
door het verwijderen van de waarden van die cellen met behulp van de toets Backspace. U moet het bestand
van Excel openen (u zult QGIS moeten sluiten als u verbonden bent met het bestand, om het bestand te kunnen
bewerken) en dan Bewerken → Verwijderen gebruiken om de blanco rijen uit het bestand te verwijderen om dit
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probleem te corrigeren. U kunt eenvoudigweg verschillende rijen uit het werkblad van Excel verwijderen door
middel van Bewerken → Verwijderen vóór het opslaan van het bestand, om dit probleem te vermijden.

Voorgedefinieerde query’s uitvoeren

Met Voorgedefinieerde query’s kunt u eerder geschreven query’s, die zijn opgeslagen in een bestand met de indel-
ing XML, selecteren. Dit is in het bijzonder handig als u niet goed bekend bent met opdrachten in SQL. Klik op
de tab Voorgedefinieerde query’s om de interface voor Voorgedefinieerde query’s weer te geven.

Klik op het pictogram Bestand openen om een set voorgedefinieerde query’s te openen. Dit opent het venster
Bestand openen, dat wordt gebruikt om het bestand dat de SQL-query’s bevat te lokaliseren. Als de query’s zijn
geladen, zullen hun titels, zoals gedefinieerd in het XML-bestand, in het keuzemenu verschijnen dat net onder het
pictogram Bestand openen staat. De volledige beschrijving van de query wordt weergegeven in het tekstvenster
onder het keuzemenu.

Selecteer de query die u wilt uitvoeren uit het keuzemenu en klik dan op de tab SQL-query om te zien dat de query
is geladen in het query-venster. Als het de eerste keer is dat u een voorgedefinieerde query uitvoert of schakelt
tussen databases, dient u zich er van te overtuigen dat u met de database bent verbonden.

Klik op de knop [Query uitvoeren] op de tab SQL-query om de opdracht uit te voeren. Als de query met succes
wordt uitgevoerd zal een venster Database bestandsselectie worden weergegeven. Als de query niet goed werd
uitgevoerd zal een foutbericht verschijnen in het venster Console-venster.

Figuur 19.14: De tab eVis Voorgedefinieerde query’s

1. Bestand openen: Start de bestandsbrowser “Bestand openen” om te zoeken naar het XML-bestand dat de
voorgedefinieerde query’s bevat.

2. Voorgedefinieerde query’s: Een keuzelijst met alle query’s die zijn gedefinieerd in het XML-bestand voor
voorgedefinieerde query’s.
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3. beschrijving query: Een korte beschrijving van de query. Deze beschrijving komt vanuit XML-bestand
voor de voorgedefinieerde query’s.

4. Console-venster: Het console-venster waar berichten over de voortgang worden weergegeven.

5. Help: Geeft de online help weer.

6. OK: Sluit het hoofdvenster “Databaseverbinding”.

XML-indeling voor voorgedefinieerde query’s van eVis

De XML-tags die worden gelezen door eVis

Tag Beschrijving
query Definieert het begin en einde van een argument query.
shortde-
scription

Een korte beschrijving van de query die verschijnt in het keuzemenu van eVis.

beschrijv-
ing

Een meer gedetailleerde beschrijving van de query die wordt weergegeven in het tekstvenster
Voorgedefinieerde query.

database-
type

Het type database, gedefinieerd in het keuzemenu Type database op de tab Databaseverbinding.

database-
port

De poort zoals die is gedefinieerd in het tekstvak Poort op de tab Databaseverbinding.

database-
name

De naam van de database zoals die is gedefinieerd in het tekstvak Naam database op de tab
Databaseverbinding.

databaseuser-
name

De gebruikersnaam voor de database zoals die is gedefinieerd in het tekstvak Gebruikersnaam
op de tab Databaseverbinding.

databasep-
assword

Het wachtwoord voor de database zoals dat is gedefinieerd in het tekstvak Wachtwoord op de tab
Databaseverbinding.

sqlstate-
ment

De opdracht SQL.

autocon-
nect

Een vlag (“true”” of “false”) om te specificeren of de bovenstaande tags moeten worden
gebruikt om automatisch te verbinden met de database zonder de routine op de tab
Databaseverbinding voor het verbinden met de database uit te voeren.

Een volledig voorbeeld XML-bestand met drie query’s wordt hieronder weergegeven:

<?xml version="1.0"?>
<doc>
<query>
<shortdescription>Import all photograph points</shortdescription>
<description>This command will import all of the data in the SQLite database to QGIS

</description>
<databasetype>SQLITE</databasetype>
<databasehost />
<databaseport />
<databasename>C:\textbackslash Workshop/textbackslash

eVis\_Data\textbackslash PhotoPoints.db</databasename>
<databaseusername />
<databasepassword />
<sqlstatement>SELECT Attributes.*, Points.x, Points.y FROM Attributes LEFT JOIN

Points ON Points.rec_id=Attributes.point_ID</sqlstatement>
<autoconnect>false</autoconnect>

</query>
<query>
<shortdescription>Import photograph points "looking across Valley"</shortdescription>
<description>This command will import only points that have photographs "looking across

a valley" to QGIS</description>
<databasetype>SQLITE</databasetype>
<databasehost />
<databaseport />
<databasename>C:\Workshop\eVis_Data\PhotoPoints.db</databasename>
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<databaseusername />
<databasepassword />
<sqlstatement>SELECT Attributes.*, Points.x, Points.y FROM Attributes LEFT JOIN

Points ON Points.rec_id=Attributes.point_ID where COMMENTS=’Looking across
valley’</sqlstatement>

<autoconnect>false</autoconnect>
</query>
<query>
<shortdescription>Import photograph points that mention "limestone"</shortdescription>
<description>This command will import only points that have photographs that mention

"limestone" to QGIS</description>
<databasetype>SQLITE</databasetype>
<databasehost />
<databaseport />
<databasename>C:\Workshop\eVis_Data\PhotoPoints.db</databasename>
<databaseusername />
<databasepassword />
<sqlstatement>SELECT Attributes.*, Points.x, Points.y FROM Attributes LEFT JOIN

Points ON Points.rec_id=Attributes.point_ID where COMMENTS like ’%limestone%’
</sqlstatement>

<autoconnect>false</autoconnect>
</query>

</doc>

.

19.7 Plug-in fTools

Het doel van de Python plug-in fTools is om een één stap bron te verschaffen voor veel algemene vector-gebaseerde
taken in GIS, zonder noodzaak voor aanvullende software, bibliotheken, of complexe workarounds. Het verschaft
een groeiende suite van ruimtelijke functies voor gegevensbeheer en analyse die zowel snel als functioneel zijn.

fTools is nu automatisch geïnstalleerd en ingeschakeld in nieuwe versies van QGIS en net als alle plug-ins, kan
hij worden in- en uitgeschakeld met behulp van Beheer en installeer plug-ins (zie The Plugins Menus). Indien in-
geschakeld voegt de plug-in fTools een menu Vector toe aan QGIS, dat functies verschaft die reiken van Analyse
en Onderzoeksgereedschap tot Geometrie en Geoprocessing-gereedschap, als ook verschillende handige gereed-
schappen voor Gegevensbeheer.
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19.7.1 Analyse-gereedschappen

Pic-
togram

Gereed-
schap

Doel

Afstandsma-
trix

Meet afstanden tussen twee puntlagen en voer de resultaten uit als a) Vierkante
afstandsmatrix, b) Lineaire afstandsmatrix, of c) Overzicht van afstanden. Kan
afstanden beperken tot de dichtstbijzijnde k objecten.

Lijnlengtes
sommeren

Bereken de total som van lijnlengten voor elke polygoon van een polygoon
vectorlaag.

Punten in
polygoon

Tel het aantal punten die voorkomen in elke polygoon van een invoer polygoon
vectorlaag.

Lijst unieke
waarden

Vermeld alle unieke waarden in een veld in de invoer vectorlaag.

Basis-
statistieken

Bereken basisstatistieken (gemiddelde, std dev, N, som, CV) in een invoerveodl.

‘Dichtstbijzi-
jnde
buur’-analyse

Berekent statistieken voor de dichtstbijzijnde buur om het niveau van clustering in
een punt vectorlaag te bepalen.

Gemiddelde
coör-
dina(a)t(en)

Bereken ofwel het normale of het gewogen gemiddelde centrum van een gehele
vectorlaag, of meerdere objecten, gebaseerd op een uniek ID-veld.

Lijn-
intersectie

Lokaliseer kruisingen tussen lijnen en voer resultaten uit als een punt-shapefile.
Handig voor het lokaliseren van kruisingen van wegen of stromen, negeert
kruisingen van lijnen met lengte > 0.

Tabel Ftools 1: fTools Analyse-gereedschappen

19.7.2 Onderzoeksgereedschap

Pic-
togram

Gereedschap Doel

Willekeurige
selectie

Selecteer willekeurig n aantal objecten, of n percentage obkecten.

Willekeurige
selectie binnen
subsets

Selecteer willekeurige objecten binnen subsets, gebaseerd op een uniek
ID-veld.

Willekeurige
punten

Genereer pseudo-willekeurige punten op een opgegeven invoerlaag.

Regelmatige
punten

Genereer een regelmatig raster van punten op een gespecificeerd gebied en
exporteer ze als een punt-shapefile.

Vectorraster Genereer een lijn- of polygoonraster gebaseerd op een gebruiker-gedefinieerde
rasterafstand.

Selecteren op
plaats

Selecteer objecten, gebaseerd op hun plaats relatief aan een andere laag, om
een nieuwe selectie te vormen, of voeg ze toe of verwijder ze uit de huidige
selectie.

Polygoon van
laaginhoud

Maak één enkele rechthoekige polygoonlaag uit het bereik van een invoer
raster- of vectorlaag.

Tabel Ftools 2: fTools Onderzoeksgereedschap
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19.7.3 Geoprocessing-gereedschap

Pic-
togram

Gereedschap Doel

Convex
omhulsel(s)

Maak minimum convex omhulsel(s) voor een invoerlaag, of gebaseerd op een
ID-veld.

Buffer(s) Maak buffer(s) rondom objecten, gebaseerd op afstand of afstandsveld.

Intersectie Overlap lagen dusdanig dat de uitvoer gebieden bevat waar beide lagen elkaar
kruisen.

Union Overlap lagen dusdanig dat de uitvoer zowel kruisende als niet-kruisende
gebieden bevat.

Symmetrisch
verschil

Overlap lagen dusdanig dat de uitvoer die gebieden van de invoer en de
verschillaag bevat die elkaar niet kruisen.

Knip Overlap lagen dusdanig dat de uitvoer gebieden bevat die kruisen met de
kniplaag.

Difference Overlap lagen dusdanig dat de uitvoer niet-kruisende gebieden met de kniplaag
bevat.

Dissolve Voeg objecten samen, gebaseerd op een invoerveld. Alle objecten met dezelfde
waarde voor de invoer worden gecombineerd om één enkel object te vormen.

Opruimen
versplinterde
polygonen

Voegt geselecteerde objecten samen met de naburige polygoon met het grootste
gebied of langste overeenkomende begrenzing.

Tabel Ftools 3: fTools Geoprocessing-gereedschap
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19.7.4 Geometrie-gereedschap

Pic-
togram

Gereedschap Doel

Controleer geldigheid
van geometrie

Controleer polygonen op kruisingen, gesloten gaten en volgorde van vaste
punten.

Geometriekolommen
exporteren/toevoegen

Voeg informatie over geometrie toe aan vectorlaag, voor punt- (XCOORD,
YCOORD), lijn- (LENGTH), of polygoon- (AREA, PERIMETER) laag.

Polygoon-
zwaartepunten

Bereken de echte zwaartepunten voor elke polygoon in een invoer
polygoonlaag.

Delauney triangulatie Bereken en exporteer (als polygonen) de Delaunay-triangulatie van een
invoer punt-vectorlaag.

Voronoi-polygonen Bereken de Voronoi-polygonen van een invoer punt-vectorlaag.

Geometriën
vereenvoudigen

Generaliseer lijnen of polygonen met een aangepast algoritme
Douglas-Peucker.

Geometriën
verdichten

Verdicht lijnen of polygonen door lijnen toe te voegen.

Meervoudige
objecten naar
enkelvoudige

Converteer objecten met meerdere delen naar meerdere ééndelige objecten.
Maakt vereenvoudigde polygonen en lijnen.

Enkelvoudige
objecten naar
meervoudige

Voeg meerdere objecten samen tot één eendelig object, gebaseerd op een
uniek ID-veld.

Polygonen naar lijnen Converteer polygonen naar lijnen, meerdelige polygonen naar meerdere
eendelige lijnen.

Lijnen naar
polygonen

Converteer lijnen naar polygonen, meerdere lijnen naar meerdere eendelige
polygonen.

Knooppunten
extraheren

Extraheer knooppunten uit lijn- en polygoonlagen en voer ze uit als punten.

Tabel Ftools 4: fTools Geometrie-gereedschap

Notitie: Het geometrie-gereedschap Geometrie vereenvoudigen kan worden gebruikt om duplicaat knooppunten
in lijn- en polygoongeometriën verwijderen. Stel eenvoudigweg de parameter Tolerantie voor vereenvoudiging in
op 0 en dat zal het doen.
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19.7.5 Gegevensbeheer-gereedschap

Pic-
togram

Gereedschap Doel

Definieer huidige
projectie

Specificeer het CRS voor shapefiles waarvan het CRS niet is gedefinieerd.

Koppel attributen
op basis van
plaats

Koppel aanvullende attributen aan de vectorlaag, gebaseerd op ruimtelijke
relatie. Attributen van één vectorlaag worden toegepast op de attributentabel
van een andere laag en geëxporteerd als een shapefile.

Vectorlaag
splitsen

Splits invoerlaag op in meerdere afzonderlijke lagen, gebaseerd op een
invoerveld.

Shapefiles
samenvoegen tot
één

Voeg verschillende shapefiles binnen een map samen tot een nieuw shapefile,
gebaseerd op het type laag (punt, lijn, gebied).

Ruimtelijke
index maken

Maak een ruimtelijke index voor OGR-ondersteunde indelingen.

Tabel Ftools 5: fTools Gegevensbeheer-gereedschap

.

19.8 GDAL Tools Plugin

19.8.1 Wat is GDAL Tools?

De plug-in GDAL Tools biedt een GUI voor de verzameling programma’s in de bibliotheek Geospatial Data
Abstraction Library, http://gdal.osgeo.org. Dit zijn beheersprogramma’s voor rasters om te bevragen, herpro-
jecteren en samenvoegen van een brede variëteit aan rasterindelingen. ook opgenomen zijn programma’s om
een omtreklaag (vector) te maken, of een schaduwreliëf uit een DEM-raster en om een VRT (Virtual Raster Tile
in XML-indeling) te maken uit een verzameling van één of meer rasterbestanden. Deze gereedschappen zijn
beschikbaar als de plug-in is geïnstalleerd en geactiveerd.

De bibliotheek GDAL

De bibliotheek GDAL bestaat uit een reeks programma’s voor de opdrachtregel, elk met een grote lijst aan opties.
Gebruikers die gewend zijn aan het uitvoeren van opdrachten via een terminal zouden de opdrachtregel kunnen
prefereren, met toegang tot de volledige set van opties. De plug-in GDALTools biedt een eenvoudige interface tot
de programma’s, die alleen de meest populaire opties laat zien.
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Figuur 19.15: De menulijst GDALTools

19.8.2 Lijst met programma’s van GDAL

Projecties

Warp
(Herpro-
jecteren)

Dit gereedschap is een gereedschap voor het maken van mozaïeken van afbeeldingen,
herprojecteren en verbuigen. Het programma kan herprojecteren naar elke ondersteunde
projectie, en kan ook GCP’s toevoegen die zijn opgeslagen in de afbeelding als de
afbeelding “ruw” is met beheersinformatie. Meer informatie kunt u lezen op de website van
GDAL http://www.gdal.org/gdalwarp.html.

Projectie
toekennen

Dit gereedschap stelt u in staat een projectie toe te wijzen aan rasters die al zijn voorzien
van geo-verwijzingen maar informatie over de projectie missen. Met hulp ervan is het ook
mogelijk bestaande definities van projecties te wijzigen. Zowel modi voor één bestand als
voor batch worden ondersteund. Bezoek voor meer informatie, de pagina voor de
mogelijkheid op de site van GDAL, http://www.gdal.org/gdalwarp.html.

Projectie
verkrijgen

Deze mogelijkheid helpt u om informatie over een projectie te extraheren uit een
invoerbestand. Als u informatie over de projectie wilt extraheren uit een hele map kunt de
modus batch gebruiken. Het maakt zowel .prj- als .wld-bestanden.
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Conversie

Rasterizeren Dit programma brandt vectorgeometrieën (punten, lijnen en polygonen) in de
rasterband(en) van een rasterafbeelding. Vectoren worden gelezen uit door OGR
ondersteunde vectorindelingen. Onthoud dat de vectorgegevens in hetzelfde
coördinatensysteem moeten staan als de rastergegevens; direct herprojecteren wordt
niet verschaft. Bekijk voor meer informatie http://www.gdal.org/gdal_rasterize.html.

Polygonizeren Dit programma mogelijkheid maakt vectorpolygonen voor alle verbonden regio’s van
pixels in het raster die een gemeenschappelijke waarde voor de pixel delen. Elk
polygoon wordt gemaakt met een attribuut dat de waarde van de pixel van die polygoon
aangeeft. Het gereedschap zal de vectorgegevensbron voor de uitvoer maken als die
nog niet bestaat, standaard in de ESRI shapefile-indeling. Zie ook
http://www.gdal.org/gdal_polygonize.html.

Translatie
(Formaat
converteren)

Dit programma kan worden gebruikt om rastergegevens te converteren tussen
verschillende indelingen, potentieel het uitvoeren van enkele bewerkingen zoals
verplaatsen, resamplen en opnieuw schalen van pixels gedurende het proces. Meer
informatie kunt u lezen op http://www.gdal.org/gdal_translate.html.

RGB naar
PCT

Dit programma zal een optimale tabel met pseudokleuren berekenen voor een
opgegeven afbeelding in RGB met behulp van een algoritme voor gemiddelde
doorsnede op een verlaagde resolutie van een RGB-histogram. Dan converteert het de
afbeelding naar een afbeelding met pseudokleuren met behulp van de kleurentabel.
Deze conversie gebruikt Floyd-Steinberg-dithering (error diffusion) om de visuele
kwaliteit van de uitgevoerde afbeelding te maximaliseren. Het programma wordt opk
beschreven op http://www.gdal.org/rgb2pct.html.

PCT naar
RGB

Dit gereedschap zal een pseudokleur-band in het invoerbestand converteren naar een
uitvoer RGB-bestand in de gewenste indeling. Bekijk voor meer informatie
http://www.gdal.org/pct2rgb.html.

Extractie

Con-
tour

Dit programma genereert een vector omtrekbestand vanuit het invoer raster hoogtemodel (DEM).
Op http://www.gdal.org/gdal_contour.html, vindt u meer informatie.

Clip-
per

Dit gereedschap stelt u in staat rasters te verkleinen (subset extraheren) met behulp van het
geselecteerde bereik of gebaseerd op maskers van laagbereiken. Meer informatie kan worden
gevonden op http://www.gdal.org/gdal_translate.html.
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Analyse

Zeef Dit gereedschap verwijdert raster-polygonen die kleiner zijn dan een opgegeven
drempelwaarde (in pixels) en vervangt ze door de pixelwaarde van het grootste
buur-polygoon. Het resultaat kan terug worden geschreven naar de bestaande rasterband,
of worden gekopieerd naar een nieuw bestand. Bekijk voor meer informatie
http://www.gdal.org/gdal_sieve.html.

Bijna zwart
(Near black)

Dit gereedschap zal een afbeelding scannen en proberen om alle pixels, die bijna zwart zijn
(of bijna wit) rondom de rand, instellen op exact zwart (of wit). Dit wordt vaak gebruikt
om met verlies gecomprimeerde luchtfoto’s “te repareren” zodat kleurpixels kunnen
worden behandeld als transparant bij mozaïeken. Zie ook
http://www.gdal.org/nearblack.html.

Vul
“nodata”

Dit gereedschap vult geselecteerde regio’s in het raster (veelal gebieden zonder waarde)
door interpolatie vanuit geldige pixels rond de randen van de gebieden. Op
http://www.gdal.org/gdal_fillnodata.html, vindt u meer informatie.

Proximity
(Rasterafstand)

Dit gereedschap genereert een nabijheidskaart voor een raster die de afstand aangeeft van
het centrum van elke pixel tot het centrum van de dichtstbijzijnde pixel die is
geïdentificeerd als een doelpixel. Doelpixels zijn die in het bronraster waarvoor de raster
pixelwaarde in de verzameling van waarden van doelpixels ligt. bekijk voor meer
informatie http://www.gdal.org/gdal_proximity.html.

Raster
(Interpolatie)

Dit gereedschap maakt een normaal raster uit de verspreide gegevens die worden gelezen
uit het bronbestand van OGR. Invoergegevens zullen worden geïnterpoleerd om knopen op
het raster te vullen met waarden, en u kunt u verschillende methoden voor interpolatie
kiezen. Het programma wordt ook beschreven op de website van GDAL,
http://www.gdal.org/gdal_grid.html.

DEM (Ter-
reinmodellen)

Gereedschappen om DEM’s te analyseren en te visualiseren. Het ken een reliëf met
schaduw genereren, een helling, een aspect, een kleur-reliëf, een Terrein Ruigte Index, een
Topografische Positie Index en een map voor de ruigte, vanuit elk door GDAL ondersteund
hoogteraster. Bekijk voor meer informatie http://www.gdal.org/gdaldem.html.
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Allerlei

Virtueel raster
aanmaken (catalogus)

Dit programma bouwt een VRT (Virtual Dataset) dat een mozaïek is van de lijst van
ingevoerde gegevenssets in GDAL. Zie ook http://www.gdal.org/gdalbuildvrt.html.

Samenvoegen Dit gereedschap zal automatisch een mozaïek maken van een verzameling
afbeeldingen. Alle afbeeldingen moeten in hetzelfde coördinatensysteem zijn en
een overeenkomend aantal banden hebben, maar zij mogen elkaar overlappen en
verschillende resoluties hebben. In overlappende gebieden zal de laatste afbeelding
bovenop eerdere worden gekopieerd. De mogelijkheid wordt ook beschreven op
http://www.gdal.org/gdal_merge.html.

Informatie Dit gereedschap vermeld verschillende informatie over een door GDAL
ondersteunde raster-gegevensset. Op http://www.gdal.org/gdalinfo.html, vindt u
meer informatie.

Overzichtskaarten
aanmaken
(pyramiden)

Het gereedschap gdaladdo kan worden gebruikt om overzichtsafbeelding te bouwen
of opnieuw te bouwen voor de meeste ondersteunde bestandsindelingen met een of
meer algoritmen voor het verlagen van de resolutie. Bekijk voor meer informatie
http://www.gdal.org/gdaladdo.html.

Tegelindex Dit gereedschap bouwt een shapefile met één record voor elk ingevoerd
rasterbestand, een attribuut dat de bestandsnaam bevat en een polygoon-geometrie
voor de omtrek van het raster. Zie ook http://www.gdal.org/gdaltindex.html.

GDAL Tools-instellingen

Gebruik dit dialoogvenster om uw variabelen voor GDAL op te slaan.

.

19.9 Plug-in Georeferencer

De plug-in Georeferencer is een programma voor het genereren van wereldbestanden voor rasterafbeeldingen. Het
stelt u in staat om rasterafbeeldingen te laten verwijzen naar geografische of geprojecteerde coördinatensystemen
door het maken van een nieuwe GeoTiff of door een wereldbestand toe te voegen aan de bestaande afbeelding. De
basis benadering voor geoverwijzingen in een rasterafbeelding is door punten op het raster te lokaliseren waarvoor
u accurate coördinaten kunt bepalen.

Mogelijkheden
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Pictogra,m Doel Pictogra,m Doel

Raster openen Geoverwijzingen starten

Generate GDAL Script GCP-punten laden

GCP-punten opslaan als Instellingen voor transformatie

Punt toevoegen Punt verwijderen

GCP-punt verplaatsen Verschuiven

Inzoomen Uitzoomen

Zoomen naar laag Zoomen naar laatste

Zoomen naar volgende Koppelen van Georeferencer aan QGIS

Koppelen van QGIS aan Georeferencer Volledige histogram stretch

Lokale histogram stretch

Tabel Georeferencer 1: Gereedschap voor Georeferencer

19.9.1 Normale procedure

Omdat X- en Y-coördinaten (DMS (dd mm ss.ss), DD (dd.dd) of geprojecteerde coördinaten (mmmm.mm)), die
overeenkomen met het geselecteerde punt in de afbeelding, bekend zijn, kunnen twee alternatieve procedures
worden gebruikt:

• Het raster zelf verschaft soms kruisingen van coördinaten die zijn “geschreven” op de afbeelding. In dat
geval kunt u de coördinaten handmatig invoeren.

• Reeds lagen die zijn voorzien van geoverwijzingen gebruiken. Dit kunnen ófwel vector- of rastergegevens
zijn die dezelfde objecten/mogelijkheden bevatten die u op de afbeelding hebt die u wilt voorzien van
geoverwijzingen en met de door u gewenste projectie voor uw afbeelding. In dat geval kunt u de coördinaten
invoeren door te klikken op de geladen gegevensset voor de verwijzingen die is geladen in het kaartvenster
van QGIS.

De normale procedure voor geoverwijzingen in een afbeelding omvat het selecteren van meerdere punten op het
raster, hun coördinaten specificeren en het kiezen van een relevant type transformatie. Gebaseerd op de param-
eters voor de invoer en de gegevens, zal de plug-in de parameters voor het wereldbestand berekenen. Hoe meer
coördinaten u opgeeft, hoe beter het resultaat zal zijn.

De eerste stap is om QGIS te starten, laad de plug-in Georeferencer (zie The Plugins Menus) en klik op Raster
→ Georeferencer , dat verschijnt in de menubalk van QGIS. Het dialoogvenster van de plug-in Georeferencer
verschijnt, zoals weergegeven in figure_georeferencer_1.

Voor dit voorbeeld gebruiken we een topografieblad van South Dakota van SDGS. Het kan later samen met
de gegevens uit het bestand spearfish60 in de locatie van GRASS worden gevisualiseerd. U kunt het to-
pografieblad hier downloaden: http://grass.osgeo.org/sampledata/spearfish_toposheet.tar.gz.

Grond ControlePunten (GCP’s) invoeren

1. We moeten een rasterafbeelding laden met behulp van de knop om te beginnen met geoverwijzingen
voor een rasterafbeelding zonder geoverwijzingen. Het raster zal worden weergegeven in het hoofdbewerk-
ingsgebied van het dialoogvenster. Als de rasterafbeelding eenmaal is geladen kunnen we beginnen met de
punten voor de verwijzingen.

2. Gebruiken van de knop Punt toevoegen voegt punten toe aan het hoofd bewerkingsgebied en voert hun
coördinaten in (zie Figure figure_georeferencer_2). Voor deze procedure heeft u drie opties:

• Klik op een punt in de rasterafbeelding en voer de X- en Y-coördinaten handmatig in.
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Figuur 19.16: dialoogvenster Georeferencer Plug-in

• Klik op een punt in de rasterafbeelding en kies de knop Van kaartvenster om de X- en Y-coördinaten toe
te voegen met de hulp van een reed in het kaartvenster van QGIS geladen kaart met geoverwijzingen.

• Met de knop kunt u de GCP’s in beide vensters verplaatsen als zij o de verkeerde plaats staan.

3. Doorgaan met invoeren van punten. U zou ten minste voer punten moeten hebben en hoe meer coördinaten
u kunt opgeven, hoe beter het resultaat zal zijn. Er staan aanvullende gereedschappen in het dialoogvenster
van de plug-in om het bewerkingsgebied te zoomen en te verschuiven om een relevante verzameling GCP-
punten te lokaliseren.

Figuur 19.17: Punten toevoegen aan de rasterafbeelding

De punten die zijn toegevoegd aan de kaart zullen worden opgeslagen in een afzonderlijk tekstbestand
([filename].points) gewoonlijk tezamen met de rasterafbeelding. Dit stelt ons in staat om later de plug-in
Georeferencer opnieuw te openen en nieuwe punten toe te voegen of bestaande te verwijderen om het resultaat
te optimaliseren. Het bestand points bevat waarden in de vorm: kaartX, kaartY, pixelX, pixelY. U

kunt de knoppen GCP-punten laden en GCP-punten opslaan als om de bestanden te beheren.
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Definiëren van de instellingen voor de transformatie

Nadat u uw GCP’s heeft toegevoegd aan de rasterafbeelding dient u de instellingen voor de transformatie te
difiniëren voor het proces van de geoverwijzingen.

Figuur 19.18: Definiëren van de instellingen voor de transformatie van geoverwijzingen

Beschikbare algoritmen voor tranfsormaties

Afhankelijk van hoeveel grond controlepunten u heeft vastgelegd, wilt u misschien verschillende algoritmes voor
transformatie gebruiken. de keuze van het algoritme voor de transformatie is ook afhankelijk van de kwaliteit
van de ingevoerde gegevens en de hoeveelheid geometrische vervorming die u toe wilt staan in het uiteindelijke
resultaat.

Momenteel zijn de volgende Transformatie types beschikbaar:

• Het algoritme Lineair wordt gebruikt om en wereldbestand te maken en is afwijkend van de andere algo-
ritmes, omdat het actueel niet de rasterafbeelding transformeert. Dit algoritme zal zeer waarschijnlijk niet
voldoende zijn als u werkt met gescand materiaal.

• De transformatie Helmert voert eenvoudige transformaties voor op schaal brengen en rotatie uit.

• De algoritmes Polynoom 1-3 behoren tot de meest breed gebruikte algoritmes die werden gemaakt voor de
vergelijking van bron- en bestemmings-grond controlepunten. Het meest breed gebruikte polynome algo-
ritme is polynome transformatie tot de tweede orde, die enige boogvorming toestaat. Eerste-orde polynome
transformatie (affine) behoudt collineariteit en maakt alleen op schaal brengen, vertalen en rotatie toe.

• Het algoritme Thin Plate Spline (TPS) is een meer modernere methode voor geoverwijzingen, dat in staat
is lokale deformaties in de gegevens aan te brengen. Dit algoritme is handig voor geoverwijzingen in
originelen van zeer lage kwaliteit.

• De transformatie Projectieve is een lineaire rotatie en vertaling van coördinaten.
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Definiëren van de methode Resample

Het type resample dat u kiest zal waarschijnlijk afhankelijk zijn van uw invoergegevens en het uiteindelijke doel
van de oefening. Als u de statistieken van de afbeelding niet wilt wijzigen, zult u willen kiezen voor ‘Dichtstbijz-
ijnde buur’, waar een ‘Cubische resample’ waarschijnlijk een meer gladder resultaat zal geven.

Het is mogelijk om te kiezen uit vijf verschillende methoden voor resample:

1. Dichtstbijzijnde buur

2. Lineair

3. Kubisch

4. Kubische spline

5. Lanczos

Definieer de instellingen voor transformatie

Er zijn verscheidene opties die moeten worden gedefinieerd voor het uitvoerraster voor geoverwijzingen.

• Het keuzevak Wereldbestand aanmaken is alleen beschikbaar als u besluit het lineaire transformatie-type
te gebruiken, omdat dit betekent dat de rasterafbeelding niet echt zal worden getransformeerd. In dat geval
wordt het veld Uitvoer rasterbestand niet geactiveerd, omdat alleen een nieuw wereldbestand zal worden
gemaakt.

• Voor alle andere typen transformatie dient u een Uitvoer rasterbestand te definiëren. Standaard zal een
nieuw bestand ([filename]_modified) worden gemaakt in dezelfde map als waar de originele rasterafbeeld-
ing in staat.

• Als een volgende stap dient u een Doel SRS (Ruimtelijk Referentie Systeem) voor de rasterafbeelding met
geoverwijzingen te definiëren (zie Werken met Projecties).

• Als u wilt kunt u een PDF-kaart maken en ook PDF-rapportage maken. Het rapport bevat informatie
over de gebruikte parameters voor de transformaties, een afbeelding van de restanten en een lijst met alle
GCP’s en hun RMS-fouten.

• verder kunt u het keuzevak Doelresolutie instellen activeren en de pixelresolutie voor de uitgevoerde
rasterafbeelding definiëren. Standaard is de horizontale en verticale resolutie 1.

• Het keuzevak Gebruik 0 voor transparantie indien nodig kan worden geselecteerd als pixels met de
waarde 0 transparant moeten worden gevisualiseerd. In ons voorbeeld topografieblad zouden alle witte
gebieden transparant zijn.

• Tenslotte laadt Na afloop in QGIS laden de uitvoer rasterafbeelding automatisch in het kaartvenster van
QGIS als de transformatie is voltooid.

Rastereigenschappen weergeven en aanpassen

Klikken op het dialoogvenster Rastereigenschappen in het menu Transformatie-instellingen opent de rastereigen-
schappen van de laag waarin u de geoverwijzingen wilt plaatsen.

Configureren van de georeferencer

• U kunt definiëren of u GCP-coördinaten wilt weergeven en/of ID’s.

• Als laatste kunnen eenheden voor de restanten, pixels en kaarteenheden, worden gekozen.

• Voor het PDF-rapport kunnen een linker- en rechtermarge worden gedefinieerd en u kunt ook de grootte van
het papier instellen voor de PDF-kaart.
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• Tenslotte kunt u selecteren Georeferencer-venster ‘docked’ weergeven.

Uitvoeren van de transformatie

Nadat alle GCP’s zijn verzameld en alle instellingen voor transformatie zijn gedefinieerd, druk dan eenvoudigweg

op de knop Georeferencer starten om de nieuwe rasterafbeelding met geoverwijzingen te maken.

.

19.10 Interpolatie-plugin

De Interpolatie-plugin kan worden gebruikt voor het genereren van een driehoeksinterpolatie of kubische interpo-
latie van een vectorlaag. De plugin is eenvoudig te gebruiken en heeft een intuïtieve grafische gebruikersinterface
voor het vervaardigen van geïnterpoleerde rasterkaartlagen (Zie Figure_interpolation_1). Voordat deze plugin kan
worden gebruikt, moeten de volgende parameters worden gedefinieerd:

• Invoer Vectorlagen: Kies de invoerlaag (of lagen) uit een lijst van geladen lagen. Als meer dan één laag
wordt opgegeven, dan worden gegevens van alle lagen gebruikt voor de interpolatie. N.B.: Men kan zowel
lijnen als polygonen gebruiken als voorwaarden voor de driehoeksmeting door een keuze te make tussen

“Punten”, “Lijnen structuren” of “Lijnen opbreken” in de keuzelijst Type .

• Interpolatie attribuut : Selecteer het attribuut dat moet worden gebruik voor de interpolatie of activeer het

keuzevak Gebruik Z-coördinaten als de Z-coördinaten moeten worden gebruikt voor de interpolatie.

• Interpolatie methode : Selecteer de interpolatiemethode. De opties zijn: ‘Triangulated Irregular Net-
work/Driehoeksinterpolatie (TIN)’ of ‘Inverse Distance Weighted/Kubische interpolatie (IDW)’.

• Aantal kolommen/rijen : Specificeer het aantal kolommen en het aantal rijen voor het uitvoerbestand.

• Uitvoerbestand: Geef de naam voor het uitvoerbestand op.

• :guidable:‘Voeg resultaat toe aan het project‘ om de uitkomst toe te voegen aan het huidige project.

Figuur 19.19: Interpolatie-plugin

19.10.1 De plugin gebruiken

1. Start QGIS en laad een punt vectorlaag (bijv., elevp.csv).
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2. Laad de Interpolatie plugin in de Plugin Manager (zie load_core_plugin) en klik op het icoon Interpolation,
dat te vinden is in het QGIS toolbar menu. Het Interpolatie-plugin venster verschijnt dan zoals getoond in
Figure_interpolation_1.

3. Kies de invoerlaag (bijv., elevp ) en kolom (bijv., ELEV) voor de interpolatie.

4. Kies een interpolatiemethode (bijv. ‘Triangulated Irregular Network (TIN)’), stel de celgrootte in op 5000
en geef de naam op van het uitvoer rasterbestand (bijv., elevation_tin).

5. Klik op [OK].

.

19.11 Offline Editing Plugin

Voor het verzamelen van gegevens is het een veel voorkomende situatie om offline in het veld te werken met een
laptop of een mobiele telefoon. Bij het terugkeren op het netwerk dienen de wijzigingen te worden gesynchro-
niseerd met het hoofd-gegevensbron (bijv.,een database van PostGIS). Als verschillende personen tegelijkertijd op
dezelfde gegevensset werken, is het moeilijk om bewerkingen met de hand samen te voegen, zelfs als mensen niet
dezelfde objecten wijzigen.

De plug-in Offline bewerken automatiseert de synchronisatie door de inhoud van een gegevensbron (gewoonlijk
PostGIS of WFS-T) te kopiëren naar een database van SpatiaLite en de offline bewerkingen op te slaan als
toegewezen tabellen. Na opnieuw te zijn verbonden met het netwerk is het mogelijk de offline bewerkingen
toe te passen op de hoofd-gegevensset.

19.11.1 Gebruik van de plug-in

• Open enkele vectorlagen (bijv., uit een gegevensbron van PostGIS of WFS-T).

• Sla het op als een project.

• Ga naar Database → Offline bewerken → Converteer naar offline project en selecteer de lagen die
moten worden opgeslagen. De inhoud van de lagen wordt opgeslagen in tabellen van SpatiaLite.

• Offline bewerken van de lagen.

• Upload, na opnieuw te zijn verbonden, de wijzigingen via Database → Offline bewerken → Synchro-
niseren.

.

19.12 Oracle Spatial GeoRaster-plugin

In Oracle databases, raster data can be stored in SDO_GEORASTER objects available with the Oracle Spatial

extension. In QGIS, the Oracle Spatial GeoRaster plugin is supported by GDAL and depends on Oracle’s database
product being installed and working on your machine. While Oracle is proprietary software, they provide their
software free for development and testing purposes. Here is one simple example of how to load raster images to
GeoRaster:

$ gdal_translate -of georaster input_file.tif geor:scott/tiger@orcl

Deze plugin laad een raster in de standaard GDAL_IMPORT tabel, als een kolom met de naam RASTER.
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Figuur 19.20: Maak een offline project uit lagen van PostGIS of WFS

19.12.1 Verbindingen beheren

Om te beginnen moet de Oracle GeoRaster plugin worden geactiveerd met behulp van de Plugin Manager (zie Sec-
tie The Plugins Menus). Wanneer men een GeoRaster in QGIS wilt geladen, moet eerst een verbinding tot stand ge-

bracht worden met de Oracle database die de gegevens bevat. Klik daarvoor op de knop Oracle GeoRaster toevoegen,
waardoor het Selecteer het Oracle Spatial GeoRaster invoerscherm zal worden geopend. Klik dan op [Nieuw] om
het invoerscherm Nieuwe Oracle-verbinding aanmaken te openen en waarin men de benodigde parameters kan
invullen (Zie Figure_oracle_raster_1):

• Name: Geef een naam voor de verbinding met de database.

• Database instance: Geef de naam van de database waarmee verbinding moet worden gemaakt.

• Gebruikersnaam: Geef de gebruikersnaam op die gebruikt zal worden om toegang te krijgen tot de
database.

• Wachtwoord: Geeft het wachtwoord die samen met gegeven gebruikersnaam toegang geeft tot de database.

Gebruik in het Oracle Spatial GeoRaster paneel (zie Figure_oracle_raster_2), de drop-down lijst om een verbind-
ing te selecteren, en maak gebruik van de [Verbinden]-knop om de verbinding tot stand te brengen. [Bijwerken]
van de gegevens van de verbinding is ook mogelijk door de vorige dialoog te starten. De [Delete]-knop kan
worden gebruikt om de verbinding te verwijderen uit de drop-down lijst.

19.12.2 Een GeoRaster selecteren

Wanneer de verbinding is opgezet, zal een scherm met subdatasets een overzicht geven van alle tabellen die
GeoRasters bevatten in het formaat van een GDAL subdataset naam .

Klik op één van de getoonde subdatasets en klik daarna op [Selecteren] om een tabel aan te wijzen. Vervolgens
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Figuur 19.21: Create Oracle connection dialog

verschijnt een nieuwe lijst met subdatasets met de namen van GeoRaster kolommen in de tabel. Dit is doorgaans
een vrij korte lijst omdat de meeste gebruikers slechts één of twee GeoRaster kolommen in dezelfde tabel hebben.

Klik op één van de getoonde subdatasets en klik vervolgens op [Selecteren] om één van de tabel/kolom-
combinaties te kiezen. De dialoog zal nu alle rijen tonen die GeoRaster objecten bevatten. De subdataset-lijst
toont nu de Raster Data Tabel en de Raster Id’s.

De keuze kan op elk moment worden gewijzigd om direct naar een bekend GeoRaster te gaan of om terug te gaan
naar het begin om een andere tabelnaam te selecteren.

Figuur 19.22: Selecteren van een Oracle GeoRaster dialoog

In het invoervak Selecteren kan ook een WHERE zoekvraag worden ingevoerd aan het eind van de
identificatie-regel, bijvoorbeeld geor:scott/tiger@orcl,gdal_import,raster,geoid=. Zie
http://www.gdal.org/frmt_georaster.html voor meer informatie.

19.12.3 Het GeoRaster tonen

Ten slotte zal de rasterafbeeling worden geladen in QGIS door het GeoRaster uit de lijst van de Raster Data
Tabellen en Raster Id’s te selecteren.
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Het venster Selecteer het Oracle Spatial GeoRaster kan nu worden gesloten. Wanneer het later opnieuw geopend
wordt zal het dezelfde verbinding gebruiken en het zal dezelfde voorgaande lijst van subdatasets tonen. Dit maakt
het eenvoudig om nog een raster uit diezelfde database te laden.

Notitie: GeoRasters die piramiden bevatten zullen veel sneller worden getoond maar de piramiden moeten vooraf
buiten QGIS worden gegenereerd met behulp van Oracle PL/SQL of gdaladdo.

Hier volgt een voorbeeld hoe gdaladdo kan worden gebruikt:

gdaladdo georaster:scott/tiger@orcl,georaster\_table,georaster,georid=6 -r
nearest 2 4 6 8 16 32

Dit is een voorbeeld met gebruikmaking van PL/SQL:

$ sqlplus scott/tiger
SQL> DECLARE
gr sdo_georaster;

BEGIN
SELECT image INTO gr FROM cities WHERE id = 1 FOR UPDATE;
sdo_geor.generatePyramid(gr, ’rLevel=5, resampling=NN’);
UPDATE cities SET image = gr WHERE id = 1;
COMMIT;

END;

.

19.13 Raster Terreinanalyses Plugin

Met de Raster Terreinanalyses Plugin kunnen berekeningen worden gedaan op basis van een digitaal ter-
reinmodel (DEM). Het werkt heel eenvoudig met behulp van de grafische interface waarmee nieuwe rasterlagen
kunnen worden gemaakt (Zie Figure_raster_terrain_1).

Beschrijving van de analyses:

• Slope: Berekent de hellingshoek van het terrein in graden (gebaseerd op een schatting van de eerste orde
afgeleide).

• Aspect: Berekent de richting van de afloop van het terrein in graden (met de klok mee vanaf het Noorden).

• Hillshade: Berekent de schaduw waarmee een beter 3-dimensionaal beeld van het terrein kan worden
gegeven.

• Ruggedness Index: Een berekening van terreinverschillen zoals beschreven door Riley et al. (1999). Voor
elke gridcel worden de hoogteverschillen met de 8 aangrenzenden cellen opgeteld.

• Relief: Genereert een hoogtekaart met kleur en schaduw op basis van een DEM. Daarbij wordt op basis van
de data bepaald hoe de hoogten worden geclassificeerd.

Figuur 19.23: Raster Terrain Modelling Plugin (helling berekening)
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19.13.1 Gebruik van de plugin

1. Start QGIS en laad het rasterbestand gtopo30 van de GRASS voorbeeld dataset.

2. Laadt de Raster Terreinanalyses Plugin met de Plugin-manager (zie hoofdstuk The Plugins Menus).

3. Selecteer de gewenste analyse via het menu (bijv. Raster → Terrain Analysis → Slope). Het dialoogvenster
Slope verschijnt zoals te zien is in Figure_raster_terrain_1.

4. Voer een map en bestandsnaam in.

5. Klik [OK].

.

19.14 Plug-in Heatmap

De plug-in Heatmap gebruikt de Kernel Density Estimation om een dichtheid (heatmap) raster te genereren vanuit
een punten-vectorkaartlaag. De dichtheid wordt berekend op basis van het aantal punten op een locatie, grotere
aantallen punten zullen resulteren in grotere waarden. Heatmap helpt bij het identificeren van “Hotspots”, plekken
met een grote dichtheid van puntobjecten.

19.14.1 De plug-in Heatmap activeren

First this core plugin needs to be activated using the Plugin Manager (see load_core_plugin). After activation, the

heatmap icon can be found in the Raster Toolbar, and under the Raster → Heatmap menu.

Selecteer via het menu Beeld → Werkbalken → Raster om de werkbalk Raster te activeren wanneer deze nog niet
actief is.

19.14.2 Gebruik van de plug-in Heatmap

Klikken op de knop Heatmap opent het dialoogvenster voor de plug-in Heatmap (zie figure_heatmap_2).

Het dialoogvenster heeft de volgende opties:

• Input punten-vectorlaag: geeft een selectielijst van alle vector punt kaartlagen in het huidige project
waarmee een puntenlijst geselecteerd kan worden om te analyseren.

• Output Raster: Via de knop kun je naar een map avigeren en een naam geven aan het rasterbestand
dat gegenereerd zal worden. Het is niet nodig een bestandsextensie op te geven.

• Uitvoerformaat: Selectie van het soort rasterbestand. Alhoewel uit alle door GDAL ondersteunde indelin-
gen gekozen kan worden is de indeling GeoTIFF in de meeste gevallen de beste indeling.

• Straal: Geef hiermee de straal (of kernel bandbreedte) in meters of kaarteenheden. De straal geeft de afstand
rondom een punt weer waar dat punt nog invloed heeft. Grotere waarden resulteren in grotere afvlakking,
kleinere waarden geven meer details en variatie in puntdichtheid.

Wanneer het keuzevak Geavanceerd is aangevinkt zullen aanvullende opties beschikbaar komen:

• Rijen en Kolommen kunnen worden gebruikt om de pixelgrootte van het te genereren raster in te stellen.
Deze waarden hebben een relatie met waarden Celgrootte X en Celgrootte Y. Meer rijen en kolommen
betekent een kleinere pixelgrootte en de bestandsgrootte van het raster dat gegenereerd wordt zal groeien en
het genereren zal meer tijd kosten. Wanneer het aantal rijen wordt verdubbeld zal automatisch ook het aantal
kolommen worden verdubbeld. De celgrootte (hoogte/breedte) zal worden gehalveerd. Het geografische
gebied van de rasterkaart blijft hetzelfde!

• Celgrootte X en Celgrootte Y: Beinvloeden rechtstreeks de pixelgrootte in het uitvoerbestand. Bij wijzig-
ing zal ook het aantal rijen en kolommen in het uitvoerbestand wijzigen.

288 Hoofdstuk 19. Plugins



QGIS User Guide, Release 2.2

• Kernel-vorm: De vorm van een kernel bepaald mede de mate waarin de invloed van een punt afneemt op
grotere afstand van het punt. Verschillende kernel vormen vervallen met verschillende mata, een triweight
kernel resulteert in scherp afgetekende hotspots en Epanechnikov resulteert in meer vlakkere hotspots. Een
aantal standaard kernel functies zijn beschikbaar in QGIS die beschreven zijn op Wikipedia.

• Afnamewaarde: kan gebruikt worden bij Triangular kernels om meer controle te krijgen in welke mate de
hitte afneemt vanuit het centrum.

– Wanneer 0 (= minimum) wordt gegeven zal de hitte geconcentreerd zijn in het centrum en volledig
gedoofd zijn aan de rand van gegeven straal.

– Een waarde van 0,5 geeft aan dat pixels aan de rand van de straal de helft van de hitte uitstralen van
de pixels in het centrum van de cirkel.

– Een waarde van 1 betekent dat de hitte gelijkmatig is verdeeld over de gehele cirkel. (dit is gelijk aan
de ‘Uniforme’ kernel )

– Een waarde groter dan 1 geeft aan dat de hitte aan de randen groter is dan in het centrum.

De punten vectorlaag kan velden voor attributen bevatten die invloed kunnen hebben op het aanmaken van de
heatmap:

• Gebruik straal uit veld: Zet de straal voor elk object vanuit een attribuutveld van de invoerlaag.

• Gebruik gewicht uit veld: Geeft de mogelijkheid om voor objecten een attribuutveld als gewicht veld te
geven. Dit kan worden gebruikt om bepaalde objecten meer invloed te geven op de resulterende heatmap.

Wanneer een uitvoerbestandsnaam is gegeven, kan de [OK] knop worden gebruikt om de heatmap aan te maken.

19.14.3 Handleiding: Maken van een Heatmap

Voor het volgende voorbeeld gebruiken we de punten vectorlaag airports van de voorbeeld gegevensset van
QGIS (zie Voorbeeld Data). Een andere goede handleiding voor QGIS voor het maken van heatmaps kan gevonden
worden op http://qgis.spatialthoughts.com.

Figure_Heatmap_1 toont de vliegvelden van Alaska.

Figuur 19.24: Vliegvelden van Alaska

19.14. Plug-in Heatmap 289

http://en.wikipedia.org/wiki/Kernel_(statistics)#Kernel_functions_in_common_use
http://qgis.spatialthoughts.com/2012/07/tutorial-making-heatmaps-using-qgis-and.html


QGIS User Guide, Release 2.2

1. Selecteer de knop Heatmap om het dialoogvenster Heatmap te openen (zie Figure_Heatmap_2).

2. Voor het veld Input punten-vectorlaag selecteer airport uit de lijst van geladen vectorlagen met
punten in het huidige project.

3. Voor het veld Output Raster geef de naam en folder van het uitvoer raster bestand gebruik makende van

de knop bladeren . Geef het uitvoerbestand de naam heatmap_airports (een bestandsextensie is
niet nodig).

4. Laat voor het veld Uitvoerformaat het formaat staan op GeoTIFF.

5. Wijzig het veld Straal naar 1000000 meter.

6. Klik op [OK] om de nieuwe heatmap voor vliegvelden te genereren en te laden (zie Figure_Heatmap_3).

Figuur 19.25: Het dialoogvenster Heatmap

QGIS zal de heatmap genereren en het resultaat toevoegen aan het kaartoverzicht. Standaard wordt de heatmap
weergegeven in grijstinten, waarbij lichtere vlakken een hogere concentratie van vliegvelden weergeeft. De
heatmap kan nu in QGIS een stijl worden gegeven om de weergave te verbeteren.

1. Open het dialoogvenster Eigenschappen voor de laag heatmap_airports (selecteer de laag
heatmap_airports, druk op de rechtermuisknop en selecteer in het menu Eigenschappen).

2. Selecteer het tabblad Stijl.

3. Wijzig, onder het deel Enkelbands eigenschappen, het veld Kleurenpalet van ‘Grijstinten’ naar ‘Pseu-
docolor’.

4. Selecteer een passend Kleurenpalet bijvoorbeeld YIOrRed.

5. Selecteer de knop [Laad] om de minimum en maximum waarden van het raster te bepalen, klik vervolgens
op de knop [Classificeren].

6. Druk op [OK] om de laag bij te werken.

Het resultaat wordt getoond in Figure_Heatmap_4.

.
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Figuur 19.26: De heatmap ziet er na het laden uit als een grijs vlak

Figuur 19.27: Opgemaakte Heatmap van vliegvelden van Alaska
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19.15 Plug-in Road Graph

De plug-in Road graph is een C++ plug-in voor QGIS die de kortste route tussen twee punten berekent over een
lijnlaag en vervolgens deze route over het netwerk heen tekent.

Figuur 19.28: Plug-in Road Graph

Belangrijkste functies

• Berekent de lengte van het pad en de reistijd.

• De route kan worden geoptimaliseerd op basis van lengte of reistijd.

• Exporteert het pad naar een vectorlaag.

• Markeert de richtingen van de wegen (dit is traag en wordt voornamelijk gebruikt om fouten op te sporen
en om te testen)

Als laag voor het transportnet kan elk door QGIS ondersteunde type lijnlaag worden gebruikt. Twee lijnen met
een gemeenschappelijk punt worden verondersteld onderling verbonden te zijn. Hou er tijdens het bewerken van
het transportnet rekening mee dat het CRS van de laag gelijk is aan het CRS van het project. Dit omdat bij een
verschillend CRS er bij het uitvoeren van de herberekening van coördinaten fouten kunnen ontstaan zodat het
netwerk niet meer goed verbonden is, zelfs wanneer ‘snappen’ wordt gebruikt.

In de attributentabel van de laag kunnen de volgende velden worden gebruikt:

• Snelheidsveld in de transportlaag (numeriek veld).

• Richtingsveld (elk type dat omgezet kan worden naar tekst waarmee je de richting aan kunt geven). Je kunt
waarden instellen die overeenkomen met een voorwaardse en achterwaartse (omgekeerde) richting voor
eenrichtingswegen, of een waarde voor beide richtingen om wegen aan te geven waar tweerichtingsverkeer
mogelijk is.

Wanneer in sommige velden geen waarde is ingevuld of niet bestaan, zullen standaardwaarden worden gebruikt.
Men kan de standaardwaarden en enkele instellingen voor de plug-in wijzigen via het dialoogvenster Instellingen
voor Road graph.
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19.15.1 De plug-in gebruiken

Na het opstarten van de plug-in verschijnt een nieuw paneel aan de linkerkant van het venster van QGIS. Vul
daarna de gegevens in door middel van het dialoogvenster Instellingen voor ‘Road graph’ in het menu Vector →
Road Graph (zie figure_road_graph_2).

Figuur 19.29: Instellingen plug-in Road graph

Na het invullen van de :guilabel: ‘Tijdseenheid’, :guilabel: ‘Afstandseenheid’ en :guilabel: ‘Topologie tolerantie’
kan men de te gebruiken vectorlaag kiezen in het tabblad :guilabel: ‘Transport laag’. Daar kan men ook het
Richtingsveld en het Snelheidsveld kiezen. In het tabblad Standaardinstellingen kan de standaard Richting worden
gegeven voor de berekening.

Tenslotte kan via het paneel Kortste pad het start- en stoppunt worden ingevoerd in de laag met de paden. Klik
vervolgens op [Bereken].

.

19.16 Spatial Query Plugin

De plug-in Ruimtelijke Query stelt u in staat een ruimtelijke query uit te voeren (d.i., objecten te selecteren) in
een doellaag met verwijzing naar een andere laag. De functionaliteit is gebaseerd op de bibliotheek GEOS en is
afhankelijk van de geselecteerde laag met bronobjecten.

Mogelijke operatoren zijn:

• bevat

• is gelijk aan

• overlapt

• kruist

• kruisend

• raakt niet

• raakt
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• binnen

19.16.1 Gebruik van de plug-in

Als een voorbeeld willen regio’s in de gegevensset van Alaska zoeken die vliegvelden bevatten. De volgende
stappen zijn nodig:

1. Start QGIS en laad de vectorlagen regions.shp en airports.shp.

2. Laad de plug-in Ruimtelijke Query in Beheer en installeer plug-ins... (zie The Plugins Menus) en klik op

het pictogram Ruimtelijke Query, dat verschijnt in het menu van de werkbalk van QGIS. Het dialoogvenster
van de plug-in verschijnt.

3. Selecteer de laag regions als de bronlaag en airports als de laag met de referentie-objecten.

4. Selecteer ‘bevat’ als de operator en klik op [Toepassen].

Nu krijgt u een lijst met object-ID’s uit de query en heeft u verschillende opties, zoals weergegeven in fig-
ure_spatial_query_1.

• Klik op Maak een laag aan met een lijst van items.

• Selecteer een ID uit de lijst en klik op Maak laag van geselecteerde.

• Selecteer ‘Verwijder uit huidige selectie’ in het veld En gebruik het resultaat om .

• Aanvullend kunt u Zoom naar item of Logboekmeldingen weergeven.

Figuur 19.30: Ruimtelijke Query-analyse - regio’s bevatten vliegvelden

.
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19.17 Plug-in SPIT

QGIS wordt geleverd met de plug-in genaamd SPIT (Shapefile naar PostGIS Import Tool). SPIT kan gebruikt
worden om meerdere shapefiles in een keer te laden in PostGIS en ondersteund ook schema’s. Open Beheer en

installeer plug-ins... in het menu Plugins, selecteer in het menu Geïnstalleerd het keuzevak naast SPIT en
klik op [OK] om SPIT te gebruiken.

Gebruik Database → Spit → Importeer shapefiles in PostgreSQL uit de menubalk om het dialoogvenster SPIT -
Importeer shapefiles naar PostGIS te openen om een shapefile te importeren. Selecteer de database van PostGIS
waarmee u wilt verbinden en klik op [Verbinden]. Als u dat wilt kunt u enkele opties voor het importeren
definiëren of wijzigen. Nu kunt u één of enkele bestanden aan de rij toevoegen door te klikken op de knop
[Toevoegen]. Klik op de knop [OK] om de bestanden te verwerken. De voortgang van het importeren, als ook
eventuele fouten/waarschuwingen, zullen worden weergegeven als elk shapefile wordt verwerkt. .

Figuur 19.31: Gebruiken van de plug-in SPIT om shapefiles te importeren in PostGIS

19.18 Plug-in SQL Anywhere

SQL Anywhere is een door de eigenaren beschermde relationele database beheerssysteem (RDBMS) van Sybase.
SQL Anywhere verschaft ruimtelijke ondersteuning, inclusief OGC, shapefiles en ingebouwde functies voor het
exporteren naar indelingen KML, GML en SVG.

SQL Anywhere stelt u in staat om te verbinden met ingeschakelde ruimtelijke databases van SQL Anywhere. Het
dialoogvenster Add SQL Anywhere layer is soortgelijk in functionaliteit aan de dialoogvensters voor PostGIS en
SpatiaLite.

.
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Figuur 19.32: Dialoogvenster SQL Anywhere (KDE)

19.19 Plug-in Topologie Checker

Topologie beschrijft de relaties tussen punten, lijnen en polygonen die de objecten vertegenwoordigen van een
geografische regio. Met de plug-in Topologie Checker kunt u uw vectorbestanden nakijken en de topologie con-
troleren door middle van verschillende regels voor de topologie. Deze regels controleren met ruimtelijke relaties
of uw objecten ‘Equal’, ‘Contain’, ‘Cover’, ‘CoveredBy’, ‘Cross’ zijn, ‘Disjoint’, ‘Intersect’, ‘Overlap’, ‘Touch’
zijn of ‘Within’ elkaar liggen. Het is afhankelijk van uw individuele vragen welke regels voor topologie uw wilt
toepassen op uw vectorgegevens (bijv:, normaal gesproken zult u geen uitschieters in lijnlagen accepteren, maar
als zij doodlopende straten weergeven wilt u ze niet verwijderen uit uw vectorlaag).

QGIS heeft een ingebouwde mogelijkheid voor het bewerken van topologie, die geweldig is voor het maken van
nieuwe objecten zonder fouten. Maar bestaande gegevensfouten en door de gebruiker geïntroduceerde fouten zijn
moeilijk te vinden. Deze plug-in helpt u dergelijke fouten te vinden met behulp van een lijst met regels.

Het is zeer eenvoudig om regels voor topologie te maken met behulp van de plug-in Topologie Checker.

Voor puntlagen zijn de volgende regels beschikbaar:

• Moet zijn bedekt door: Hier kunt u een vectorlaag kiezen uit uw project. Punten die niet zijn bedekt door
de opgegeven vectorlaag verschijnen in het veld ‘Fout’.

• Moet zijn bedekt door eindpunten van: Hier kunt u een lijnlaag kiezen uit uw project.

• Moet liggen binnen: Hier kunt u een polygoonlaag kiezen uit uw project. De punten moeten binnen een
polygoon liggen. Anders schrijft QGIS een ‘Fout’ voor het punt.

• Moet geen duplicaten hebben: Wanneer een punt twee of meer malen wordt weergegeven, zal het verschi-
jnen in het veld ‘Fout’.

• Moet geen ongeldige geometrieën hebben: Controleert of de geometrieën geldig zijn.

• Moet geen geometrieën met meerdere delen hebben: Alle punten die bestaan uit meerdere delen worden
weggeschreven naar het veld ‘Fout’.

Voor lijnlagen zijn de volgende regels beschikbaar:

• Eindpunten moeten zijn bedekt door: Hier kunt u een puntlaag selecteren uit uw project.

• Moet geen uitlopers hebben: Dit zal de uitschieters in de lijnlaag weergeven.
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Figuur 19.33: De plug-in Topologie Checker
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• Moet geen duplicaten hebben: Wanneer een lijnobject twee of meer keer wordt weergegeven, zal het
verschijnen in het veld ‘Fout’.

• Moet geen ongeldige geometrieën hebben: Controleert of de geometrieën geldig zijn.

• Moet geen geometrieën met meerdere delen hebben: Soms is een geometrie in feite een verzameling
van enkele (ééndelige) geometrieën. Een dergelijke geometrie wordt een geometrie met meerdere delen
genoemd. Als het slechts één type eenvoudige geometrie bevat, noemen we het multi-punt, multi-lijn of
multi-polygoon. Alle lijnen met meerdere delen worden weggeschreven naar het veld ‘Fout’.

• Moet geen pseudo’s hebben: Een eindpunt van een lijngeometrie zou moeten zijn verbonden met de eind-
punten van twee andere geometrieën. Als het eindpunt slechts is verbonden met één eindpunt van een andere
geometrie wordt het eindpunt een pseudo-knoop genoemd.

Voor polygoonlagen zijn de volgende regels beschikbaar:

• Moet bevatten: Polygoonlaag moet ten minste één puntgeometrie uit de tweede laag bevatten.

• Moet geen duplicaten hebben: Polygonen uit dezelfde laag moeten geen identieke geometrieën hebben.
Wanneer een polygoonobject twee of meer keer wordt weergegeven, zal het verschijnen in het veld ‘Fout’..

• Moet geen gaten hebben: Aaneensluitende polygonen zouden geen gaten tussen hen moeten vormen.
Administratieve grenzen zouden als voorbeeld kunnen worden genoemd (Polygonen van staten van de VS
hebben geen gaten ertussen...).

• Moet geen ongeldige geometrieën hebben: Controleert of de geometrieën geldig zijn. Enkele regels die
definiëren of een geometrie geldig is zijn:

– Polygoon-ringen moeten zijn gesloten.

– Ringen die gaten definiëren zouden binnen ringen moeten liggen die de buitenste grenzen definiëren.

– Ringen mogen zichzelf niet kruisen (zij mogen elkaar niet raken noch kruisen).

– Ringen mogen andere ringen niet raken, uitgezonderd op een punt.

• Moet geen geometrieën met meerdere delen hebben: Soms is een geometrie in feite een verzameling
van enkele (ééndelige) geometrieën. Een dergelijke geometrie wordt een geometrie met meerdere delen
genoemd. Als het slechts één type eenvoudige geometrie bevat, noemen we het multi-punt, multi-lijn of
multi-polygoon. Een land dat bijvoorbeeld bestaat uit meerdere eilanden kan worden weergegeven als een
multi-polygoon.

• Moet niet overlappen: Aaneensluitende polygonen zouden geen gemeenschappelijk gebied moeten delen.

• Moet niet overlappen met: Aaneensluitende polygonen uit de ene laag zouden geen gemeenschappelijk
gebied moeten delen met polygonen uit een andere laag.

.

19.20 Plug-in Gebiedsstatistieken

Met de plug-in Gebiedsstatistieken kunt u de resultaten van een thematische classificatie analyseren. Het stelt
u in staat om verschillende waarden van de pixels van een rasterlaag te berekenen met behulp van een polygone
vectorlaag (zie figure_zonal_statistics). U kunt de som, de gemiddelde waarde en het totale aantal pixels binnen
een polygoon berekenen. De plug-in genereert uitvoerkolommen in de vectorlaag met een gebruikergedefinieerd
voorvoegsel.

.
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Figuur 19.34: Dialoogvenster Gebiedsstatistieken (KDE)
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HOOFDSTUK 20

Ondersteuning

20.1 Mailinglijsten

QGIS is constant in ontwikkeling en soms werkt het niet altijd zoals je zou verwachten. De beste manier om
ondersteuning te krijgen is door je aan te melden voor de qgis-users mailinglijst. Je vragen zullen dan door een
breed publiek worden gelezen en ook anderen kunnen profiteren van gegeven antwoorden.

20.1.1 qgis-users [Engelstalig]

Deze mailinglijst wordt gebruikt voor algemene vragen en discussies over QGIS en vragen over in-
stallatie en gebruik. Je kunt je aanmelden voor de qgis-users mailinglijst via de volgende link:
http://lists.osgeo.org/mailman/listinfo/qgis-user

20.1.2 osgeo.nl

Voor het Duits sprekend publiek is er het Duitse FOSSGIS e.V. met de fossgis-talk-liste mailinglijst. Deze mail-
inglijst wordt gebruikt voor discussie over open source GIS in het algemeen inclusief QGIS. Je kunt lid worden
van de fossgis-talk-liste mailinglijst via volgende URL: https://lists.fossgis.de/mailman/listinfo/fossgis-talk-liste

20.1.3 qgis-developer [Engelstalig]

Ben je ontwikkelaar en loop je tegen technische vragen aan? Meld je dan aan op de qgis-developer mailinglijst:
http://lists.osgeo.org/mailman/listinfo/qgis-developer

20.1.4 qgis-commit [Geautomatiseerd]

Telkens wanneer er door een ontwikkelaar een wijziging wordt gecommit in de broncode repository van QGIS
wordt er een bericht geplaatst op deze lijst. Wil je bij blijven met elke wijziging in de broncode? Meld je dan aan
voor deze lijst: http://lists.osgeo.org/mailman/listinfo/qgis-commit

20.1.5 qgis-trac [Geautomatiseerd]

Deze lijst geeft technische meldingen gerelateerd aan QGIS weer. Dit zijn onder andere foutenrapporten, taken
en wijzigingsverzoeken alsmede de oplossingen. Deze lijst is niet bedoeld voor gebruikers of ontwikkelaars om
berichten te plaatsen. Wil je op de hoogte blijven van de (technische) ontwikkelactiviteiten dan kun je je aanmelden
voor deze lijst: http://lists.osgeo.org/mailman/listinfo/qgis-trac
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20.1.6 qgis-community-team [Engelstalig]

Op deze lijst komen onderwerpen als documentatie, ondersteuning, gebruikershandleiding en aan QGIS
gerelateerde websites aan bod. Ook wordt hier informatie uitgewisseld over blogs, mailinglijsten en
vertalingen. Wil je meehelpen aan een van de handleidingen? Meld je dan aan voor deze lijst:
http://lists.osgeo.org/mailman/listinfo/qgis-community-team

20.1.7 qgis-release-team [Engelstalig]

Op deze lijst worden meldingen geplaatst over het release-proces, de voortgang, het gereedmaken van
de installatiepakketten voor de verschillende besturingssystemen (o.a. Windows, Mac en Linux) en
de wereldwijde aankondiging van een nieuwe versie. Je kunt je aanmelden voor deze lijst op:
http://lists.osgeo.org/mailman/listinfo/qgis-release-team

20.1.8 qgis-tr [Engelstalig]

Deze mailinglijst is voor vertalingen en vertalers. Als je mee wilt werken aan de vertalingen van de QGIS appli-
catie of de handleidingen, meld je dan aan op: http://lists.osgeo.org/mailman/listinfo/qgis-tr

20.1.9 qgis-edu [Engelstalig]

Deze mailinglijst is specifiek voor discussies in relatie tot QGIS in het onderwijs. Als je wilt (mee)werken aan
lesmateriaal of eigen lesmateriaal wilt delen, meld je dan aan op: http://lists.osgeo.org/mailman/listinfo/qgis-edu

20.1.10 qgis-psc [Engelstalig]

Deze lijst wordt gebruikt voor discussie door de “Steering Commitee” die met name gaat over het al-
gemene management, de aansturing en het richting geven van QGIS. Je kunt lid worden van deze lijst via:
http://lists.osgeo.org/mailman/listinfo/qgis-psc

Iedereen is welkom op de mailinglijsten van QGIS. Het is belangrijk dat QGIS gebruikers en ontwikkelaars elkaar
helpen. Mocht je vragen tegenkomen op een van de lijsten die je kunt beantwoorden, neem dan een paar minuten
de tijd en help anderen! op de mailinglijsten van qgis-commit en qgis-trac worden automatisch gegenereerde
berichten geplaatst en zijn niet bedoeld om zelf berichten op te plaatsen.

20.2 IRC

De mensen van QGIS kunnen ook worden benaderd op IRC. Je kunt deelnemen aan de live discussie in het
#qgis kanaal op irc.freenode.net. De voertaal op dit kanaal is engels. Blijf alstublieft geduldig wachten op een
antwoord, er vinden vele gesprekken plaats en het kan even duren voordat de vraag wordt opgemerkt en beant-
woord. Wanneer je een dicussie gemist hebt op IRC, kun je deze nalezen op http://qgis.org/irclogs. Wil je op een
nederlandstalig IRC kanaal praten over QGIS? Dat kan op irc.freenode.net in het kanaal #osgeonl.

Commerciële ondersteuning voor QGIS is eveneens beschikbaar. Bekijk de website
http://qgis.org/en/commercial-support.html voor meer informatie.

20.3 Meldingen Volgsysteem

Hoewel de qgis-users mailinglijst de juiste plek is voor vragen als ‘Hoe doe ik XYZ met QGIS?’ is het handig om
gevonden fouten in QGIS te kunnen rapporteren. Je kunt deze foutmeldingen indienen op de QGIS Bug tracker
(het foutmeldingen volgsysteem) op http://hub.qgis.org/projects/quantum-gis/issues. Doe een melding altijd in het
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engels en gebruik een geldig e-mail adres zodat wij eventueel contact met je op kunnen nemen voor aanvullende
informatie.

Houdt er rekening mee dat fouten die jij belangrijk vindt niet altijd de hoogste prioriteit zullen krijgen. Sommige
fouten vereisen een complexe, tijdrovende oplossing en ontwikkelaars zijn niet altijd beschikbaar.

Verzoeken om nieuwe functionaliteit kunnen ook worden aangedragen in het meldingen volgsysteem. Plaats een
melding altijd in het engels en kies als type Feature.

Heb je een fout gevonden en zelf opgelost, dan kun je een patch indienen. Deze kun je indienen op het meldin-
gen volgsysteem van redmine op http://hub.qgis.org/projects/quantum-gis/issues. Vink dan ook het aanvinkvakje
Patch supplied aan voordat je de foutmelding daadwerkelijk submit. Een ontwikkelaar zal een review uitvo-
eren op geboden oplossing en deze (bij acceptatie) verwerken in de QGIS applicatie. Hou er rekening mee dat je
patch niet onmiddelijk wordt verwerkt, ontwikkelaars worden vaak opgehouden door andere verplichtingen.

20.4 Blog

De QGIS-community heeft een engelstalige weblog op http://www.qgis.org/planet waarop interessante artikelen
te lezen zijn van gebruikers en ontwikkelaars.die ook gevoed wordt door ander blogs van de community. Heb
je zelf een QGIS blog dan kun je deze hier aan toevoegen. Zo is er ook een nederlandstalig blog beschikbaar
op http://www.qgis.nl met interessante artikelen voor gebruikers en ontwikkelaars. Mocht je zelf iets interessants
willen plaatsen, neem dan contact op via de website!

20.5 Plugins

Op http://plugins.qgis.org vind je de officiële QGIS plugins. De website toont een overzicht van stabiele and
experimentele QGIS plugins die beschikbaar zijn via de ‘Officiële QGIS Plugin Repository’.

20.6 Wiki

Er is een engelstalige wiki beschikbaar op http://hub.qgis.org/projects/quantum-gis/wiki. Hier kun je waarde-
volle informatie vinden maar ook plaatsen over ontwikkeling, uitrol, links naar downloads, vertaal tips enzovoort.
Bekijk ‘m, je kunt er pareltjes aan informatie vinden!

.
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Appendix

21.1 GNU General Public License

Version 2, June 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc. 59 Temple Place - Suite 330, Boston, MA 02111-1307,
USA

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not
allowed.

Preamble

The licenses for most software are designed to take away your freedom to share and change it. By contrast,
the GNU General Public License is intended to guarantee your freedom to share and change free software–to
make sure the software is free for all its users. This General Public License applies to most of the Free Software
Foundation’s software and to any other program whose authors commit to using it. (Some other Free Software
Foundation software is covered by the GNU Library General Public License instead.) You can apply it to your
programs, too.

When we speak of free software, we are referring to freedom, not price. Our General Public Licenses are designed
to make sure that you have the freedom to distribute copies of free software (and charge for this service if you
wish), that you receive source code or can get it if you want it, that you can change the software or use pieces of
it in new free programs; and that you know you can do these things.

To protect your rights, we need to make restrictions that forbid anyone to deny you these rights or to ask you to
surrender the rights. These restrictions translate to certain responsibilities for you if you distribute copies of the
software, or if you modify it.

For example, if you distribute copies of such a program, whether gratis or for a fee, you must give the recipients
all the rights that you have. You must make sure that they, too, receive or can get the source code. And you must
show them these terms so they know their rights.

We protect your rights with two steps: (1) copyright the software, and (2) offer you this license which gives you
legal permission to copy, distribute and/or modify the software.

Also, for each author’s protection and ours, we want to make certain that everyone understands that there is no
warranty for this free software. If the software is modified by someone else and passed on, we want its recipients
to know that what they have is not the original, so that any problems introduced by others will not reflect on the
original authors’ reputations.

Finally, any free program is threatened constantly by software patents. We wish to avoid the danger that redis-
tributors of a free program will individually obtain patent licenses, in effect making the program proprietary. To
prevent this, we have made it clear that any patent must be licensed for everyone’s free use or not licensed at all.

The precise terms and conditions for copying, distribution and modification follow. TERMS AND CONDITIONS
FOR COPYING, DISTRIBUTION AND MODIFICATION

0. This License applies to any program or other work which contains a notice placed by the copyright holder
saying it may be distributed under the terms of this General Public License. The “Program”, below, refers to
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any such program or work, and a “work based on the Program” means either the Program or any derivative
work under copyright law: that is to say, a work containing the Program or a portion of it, either verbatim
or with modifications and/or translated into another language. (Hereinafter, translation is included without
limitation in the term “modification”.) Each licensee is addressed as “you”.

Activities other than copying, distribution and modification are not covered by this License; they are outside
its scope. The act of running the Program is not restricted, and the output from the Program is covered only
if its contents constitute a work based on the Program (independent of having been made by running the
Program). Whether that is true depends on what the Program does.

1. You may copy and distribute verbatim copies of the Program’s source code as you receive it, in any medium,
provided that you conspicuously and appropriately publish on each copy an appropriate copyright notice
and disclaimer of warranty; keep intact all the notices that refer to this License and to the absence of any
warranty; and give any other recipients of the Program a copy of this License along with the Program.

You may charge a fee for the physical act of transferring a copy, and you may at your option offer warranty
protection in exchange for a fee.

2. You may modify your copy or copies of the Program or any portion of it, thus forming a work based on the
Program, and copy and distribute such modifications or work under the terms of Section 1 above, provided
that you also meet all of these conditions:

(a) You must cause the modified files to carry prominent notices stating that you changed the files and the
date of any change.

(b) You must cause any work that you distribute or publish, that in whole or in part contains or is derived
from the Program or any part thereof, to be licensed as a whole at no charge to all third parties under
the terms of this License.

(c) If the modified program normally reads commands interactively when run, you must cause it, when
started running for such interactive use in the most ordinary way, to print or display an announcement
including an appropriate copyright notice and a notice that there is no warranty (or else, saying that
you provide a warranty) and that users may redistribute the program under these conditions, and telling
the user how to view a copy of this License. (Exception: if the Program itself is interactive but does
not normally print such an announcement, your work based on the Program is not required to print an
announcement.)

These requirements apply to the modified work as a whole. If identifiable sections of that work are not
derived from the Program, and can be reasonably considered independent and separate works in themselves,
then this License, and its terms, do not apply to those sections when you distribute them as separate works.
But when you distribute the same sections as part of a whole which is a work based on the Program, the
distribution of the whole must be on the terms of this License, whose permissions for other licensees extend
to the entire whole, and thus to each and every part regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by you;
rather, the intent is to exercise the right to control the distribution of derivative or collective works based on
the Program.

In addition, mere aggregation of another work not based on the Program with the Program (or with a work
based on the Program) on a volume of a storage or distribution medium does not bring the other work under
the scope of this License.

3. You may copy and distribute the Program (or a work based on it, under Section 2) in object code or exe-
cutable form under the terms of Sections 1 and 2 above provided that you also do one of the following:

(a) Accompany it with the complete corresponding machine-readable source code, which must be dis-
tributed under the terms of Sections 1 and 2 above on a medium customarily used for software inter-
change; or,

(b) Accompany it with a written offer, valid for at least three years, to give any third party, for a charge no
more than your cost of physically performing source distribution, a complete machine-readable copy
of the corresponding source code, to be distributed under the terms of Sections 1 and 2 above on a
medium customarily used for software interchange; or,
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(c) Accompany it with the information you received as to the offer to distribute corresponding source
code. (This alternative is allowed only for noncommercial distribution and only if you received the
program in object code or executable form with such an offer, in accord with Subsection b above.)

The source code for a work means the preferred form of the work for making modifications to it. For an
executable work, complete source code means all the source code for all modules it contains, plus any
associated interface definition files, plus the scripts used to control compilation and installation of the ex-
ecutable. However, as a special exception, the source code distributed need not include anything that is
normally distributed (in either source or binary form) with the major components (compiler, kernel, and
so on) of the operating system on which the executable runs, unless that component itself accompanies the
executable.

If distribution of executable or object code is made by offering access to copy from a designated place, then
offering equivalent access to copy the source code from the same place counts as distribution of the source
code, even though third parties are not compelled to copy the source along with the object code.

4. You may not copy, modify, sublicense, or distribute the Program except as expressly provided under this
License. Any attempt otherwise to copy, modify, sublicense or distribute the Program is void, and will
automatically terminate your rights under this License. However, parties who have received copies, or
rights, from you under this License will not have their licenses terminated so long as such parties remain in
full compliance.

5. You are not required to accept this License, since you have not signed it. However, nothing else grants you
permission to modify or distribute the Program or its derivative works. These actions are prohibited by law
if you do not accept this License. Therefore, by modifying or distributing the Program (or any work based
on the Program), you indicate your acceptance of this License to do so, and all its terms and conditions for
copying, distributing or modifying the Program or works based on it.

6. Each time you redistribute the Program (or any work based on the Program), the recipient automatically
receives a license from the original licensor to copy, distribute or modify the Program subject to these terms
and conditions. You may not impose any further restrictions on the recipients’ exercise of the rights granted
herein. You are not responsible for enforcing compliance by third parties to this License.

7. If, as a consequence of a court judgment or allegation of patent infringement or for any other reason (not
limited to patent issues), conditions are imposed on you (whether by court order, agreement or otherwise)
that contradict the conditions of this License, they do not excuse you from the conditions of this License.
If you cannot distribute so as to satisfy simultaneously your obligations under this License and any other
pertinent obligations, then as a consequence you may not distribute the Program at all. For example, if a
patent license would not permit royalty-free redistribution of the Program by all those who receive copies
directly or indirectly through you, then the only way you could satisfy both it and this License would be to
refrain entirely from distribution of the Program.

If any portion of this section is held invalid or unenforceable under any particular circumstance, the balance
of the section is intended to apply and the section as a whole is intended to apply in other circumstances.

It is not the purpose of this section to induce you to infringe any patents or other property right claims or
to contest validity of any such claims; this section has the sole purpose of protecting the integrity of the
free software distribution system, which is implemented by public license practices. Many people have
made generous contributions to the wide range of software distributed through that system in reliance on
consistent application of that system; it is up to the author/donor to decide if he or she is willing to distribute
software through any other system and a licensee cannot impose that choice.

This section is intended to make thoroughly clear what is believed to be a consequence of the rest of this
License.

8. If the distribution and/or use of the Program is restricted in certain countries either by patents or by copy-
righted interfaces, the original copyright holder who places the Program under this License may add an
explicit geographical distribution limitation excluding those countries, so that distribution is permitted only
in or among countries not thus excluded. In such case, this License incorporates the limitation as if written
in the body of this License.

9. The Free Software Foundation may publish revised and/or new versions of the General Public License from
time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to
address new problems or concerns.
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Each version is given a distinguishing version number. If the Program specifies a version number of this
License which applies to it and “any later version”, you have the option of following the terms and conditions
either of that version or of any later version published by the Free Software Foundation. If the Program
does not specify a version number of this License, you may choose any version ever published by the Free
Software Foundation.

10. If you wish to incorporate parts of the Program into other free programs whose distribution conditions are
different, write to the author to ask for permission. For software which is copyrighted by the Free Software
Foundation, write to the Free Software Foundation; we sometimes make exceptions for this. Our decision
will be guided by the two goals of preserving the free status of all derivatives of our free software and of
promoting the sharing and reuse of software generally.

NO WARRANTY

11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR
THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTH-
ERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE
THE PROGRAM “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IM-
PLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABIL-
ITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND
PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE PROGRAM PROVE DEFEC-
TIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL
ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDIS-
TRIBUTE THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, IN-
CLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING
OUT OF THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO
LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU
OR THIRD PARTIES OR A FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER PRO-
GRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBIL-
ITY OF SUCH DAMAGES.

QGIS Qt exception for GPL

In addition, as a special exception, the QGIS Development Team gives permission to link the code
of this program with the Qt library, including but not limited to the following versions (both free
and commercial): Qt/Non-commerical Windows, Qt/Windows, Qt/X11, Qt/Mac, and Qt/Embedded
(or with modified versions of Qt that use the same license as Qt), and distribute linked combinations
including the two. You must obey the GNU General Public License in all respects for all of the code
used other than Qt. If you modify this file, you may extend this exception to your version of the file,
but you are not obligated to do so. If you do not wish to do so, delete this exception statement from
your version.

21.2 GNU Free Documentation License

Version 1.3, 3 November 2008

Copyright 2000, 2001, 2002, 2007, 2008 Free Software Foundation, Inc

<http://fsf.org/>

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not
allowed.

Preamble

The purpose of this License is to make a manual, textbook, or other functional and useful document “free” in the
sense of freedom: to assure everyone the effective freedom to copy and redistribute it, with or without modifying
it, either commercially or noncommercially. Secondarily, this License preserves for the author and publisher a
way to get credit for their work, while not being considered responsible for modifications made by others.
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This License is a kind of “copyleft”, which means that derivative works of the document must themselves be free
in the same sense. It complements the GNU General Public License, which is a copyleft license designed for free
software.

We have designed this License in order to use it for manuals for free software, because free software needs free
documentation: a free program should come with manuals providing the same freedoms that the software does.
But this License is not limited to software manuals; it can be used for any textual work, regardless of subject
matter or whether it is published as a printed book. We recommend this License principally for works whose
purpose is instruction or reference.

1. APPLICABILITY AND DEFINITIONS

This License applies to any manual or other work, in any medium, that contains a notice placed by the copyright
holder saying it can be distributed under the terms of this License. Such a notice grants a world-wide, royalty-free
license, unlimited in duration, to use that work under the conditions stated herein. The Document, below, refers
to any such manual or work. Any member of the public is a licensee, and is addressed as “you”. You accept the
license if you copy, modify or distribute the work in a way requiring permission under copyright law.

A “Modified Version” of the Document means any work containing the Document or a portion of it, either copied
verbatim, or with modifications and/or translated into another language.

A “Secondary Section” is a named appendix or a front-matter section of the Document that deals exclusively
with the relationship of the publishers or authors of the Document to the Document’s overall subject (or to related
matters) and contains nothing that could fall directly within that overall subject. (Thus, if the Document is in part
a textbook of mathematics, a Secondary Section may not explain any mathematics.) The relationship could be
a matter of historical connection with the subject or with related matters, or of legal, commercial, philosophical,
ethical or political position regarding them.

The “Invariant Sections” are certain Secondary Sections whose titles are designated, as being those of Invariant
Sections, in the notice that says that the Document is released under this License. If a section does not fit the
above definition of Secondary then it is not allowed to be designated as Invariant. The Document may contain
zero Invariant Sections. If the Document does not identify any Invariant Sections then there are none.

The “Cover Texts” are certain short passages of text that are listed, as Front-Cover Texts or Back-Cover Texts, in
the notice that says that the Document is released under this License. A Front-Cover Text may be at most 5 words,
and a Back-Cover Text may be at most 25 words.

A “Transparent” copy of the Document means a machine-readable copy, represented in a format whose specifi-
cation is available to the general public, that is suitable for revising the document straightforwardly with generic
text editors or (for images composed of pixels) generic paint programs or (for drawings) some widely available
drawing editor, and that is suitable for input to text formatters or for automatic translation to a variety of formats
suitable for input to text formatters. A copy made in an otherwise Transparent file format whose markup, or ab-
sence of markup, has been arranged to thwart or discourage subsequent modification by readers is not Transparent.
An image format is not Transparent if used for any substantial amount of text. A copy that is not “Transparent” is
called Opaque.

Examples of suitable formats for Transparent copies include plain ASCII without markup, Texinfo input format,
LaTeX input format, SGML or XML using a publicly available DTD, and standard-conforming simple HTML,
PostScript or PDF designed for human modification. Examples of transparent image formats include PNG, XCF
and JPG. Opaque formats include proprietary formats that can be read and edited only by proprietary word pro-
cessors, SGML or XML for which the DTD and/or processing tools are not generally available, and the machine-
generated HTML, PostScript or PDF produced by some word processors for output purposes only.

The “Title Page” means, for a printed book, the title page itself, plus such following pages as are needed to hold,
legibly, the material this License requires to appear in the title page. For works in formats which do not have any
title page as such, “Title Page” means the text near the most prominent appearance of the work’s title, preceding
the beginning of the body of the text.

The “publisher” means any person or entity that distributes copies of the Document to the public.

A section “Entitled XYZ” means a named subunit of the Document whose title either is precisely XYZ or contains
XYZ in parentheses following text that translates XYZ in another language. (Here XYZ stands for a specific
section name mentioned below, such as “Acknowledgements”, “Dedications”, “Endorsements”, or “History”.)
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To “Preserve the Title” of such a section when you modify the Document means that it remains a section “Entitled
XYZ” according to this definition.

The Document may include Warranty Disclaimers next to the notice which states that this License applies to the
Document. These Warranty Disclaimers are considered to be included by reference in this License, but only as
regards disclaiming warranties: any other implication that these Warranty Disclaimers may have is void and has
no effect on the meaning of this License.

2. VERBATIM COPYING

You may copy and distribute the Document in any medium, either commercially or noncommercially, provided
that this License, the copyright notices, and the license notice saying this License applies to the Document are
reproduced in all copies, and that you add no other conditions whatsoever to those of this License. You may not
use technical measures to obstruct or control the reading or further copying of the copies you make or distribute.
However, you may accept compensation in exchange for copies. If you distribute a large enough number of copies
you must also follow the conditions in section 3.

You may also lend copies, under the same conditions stated above, and you may publicly display copies.

3. COPYING IN QUANTITY

If you publish printed copies (or copies in media that commonly have printed covers) of the Document, numbering
more than 100, and the Document’s license notice requires Cover Texts, you must enclose the copies in covers
that carry, clearly and legibly, all these Cover Texts: Front-Cover Texts on the front cover, and Back-Cover Texts
on the back cover. Both covers must also clearly and legibly identify you as the publisher of these copies. The
front cover must present the full title with all words of the title equally prominent and visible. You may add other
material on the covers in addition. Copying with changes limited to the covers, as long as they preserve the title
of the Document and satisfy these conditions, can be treated as verbatim copying in other respects.

If the required texts for either cover are too voluminous to fit legibly, you should put the first ones listed (as many
as fit reasonably) on the actual cover, and continue the rest onto adjacent pages.

If you publish or distribute Opaque copies of the Document numbering more than 100, you must either include
a machine-readable Transparent copy along with each Opaque copy, or state in or with each Opaque copy a
computer-network location from which the general network-using public has access to download using public-
standard network protocols a complete Transparent copy of the Document, free of added material. If you use the
latter option, you must take reasonably prudent steps, when you begin distribution of Opaque copies in quantity, to
ensure that this Transparent copy will remain thus accessible at the stated location until at least one year after the
last time you distribute an Opaque copy (directly or through your agents or retailers) of that edition to the public.

It is requested, but not required, that you contact the authors of the Document well before redistributing any large
number of copies, to give them a chance to provide you with an updated version of the Document.

4. MODIFICATIONS

You may copy and distribute a Modified Version of the Document under the conditions of sections 2 and 3 above,
provided that you release the Modified Version under precisely this License, with the Modified Version filling the
role of the Document, thus licensing distribution and modification of the Modified Version to whoever possesses
a copy of it. In addition, you must do these things in the Modified Version:

1. Use in the Title Page (and on the covers, if any) a title distinct from that of the Document, and from those of
previous versions (which should, if there were any, be listed in the History section of the Document). You
may use the same title as a previous version if the original publisher of that version gives permission.

2. List on the Title Page, as authors, one or more persons or entities responsible for authorship of the modifi-
cations in the Modified Version, together with at least five of the principal authors of the Document (all of
its principal authors, if it has fewer than five), unless they release you from this requirement.

3. State on the Title page the name of the publisher of the Modified Version, as the publisher.

4. Preserve all the copyright notices of the Document.

5. Add an appropriate copyright notice for your modifications adjacent to the other copyright notices.

6. Include, immediately after the copyright notices, a license notice giving the public permission to use the
Modified Version under the terms of this License, in the form shown in the Addendum below.
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7. Preserve in that license notice the full lists of Invariant Sections and required Cover Texts given in the
Document’s license notice.

8. Include an unaltered copy of this License.

9. Preserve the section Entitled “History”, Preserve its Title, and add to it an item stating at least the title, year,
new authors, and publisher of the Modified Version as given on the Title Page. If there is no section Entitled
“History” in the Document, create one stating the title, year, authors, and publisher of the Document as
given on its Title Page, then add an item describing the Modified Version as stated in the previous sentence.

10. Preserve the network location, if any, given in the Document for public access to a Transparent copy of the
Document, and likewise the network locations given in the Document for previous versions it was based
on. These may be placed in the “History” section. You may omit a network location for a work that was
published at least four years before the Document itself, or if the original publisher of the version it refers
to gives permission.

11. For any section Entitled “Acknowledgements” or “Dedications”, Preserve the Title of the section, and pre-
serve in the section all the substance and tone of each of the contributor acknowledgements and/or dedica-
tions given therein.

12. Preserve all the Invariant Sections of the Document, unaltered in their text and in their titles. Section
numbers or the equivalent are not considered part of the section titles.

13. Delete any section Entitled “Endorsements”. Such a section may not be included in the Modified Version.

14. Do not retitle any existing section to be Entitled “Endorsements” or to conflict in title with any Invariant
Section.

15. Preserve any Warranty Disclaimers.

If the Modified Version includes new front-matter sections or appendices that qualify as Secondary Sections and
contain no material copied from the Document, you may at your option designate some or all of these sections
as invariant. To do this, add their titles to the list of Invariant Sections in the Modified Version’s license notice.
These titles must be distinct from any other section titles.

You may add a section Entitled “Endorsements”, provided it contains nothing but endorsements of your Modified
Version by various parties—for example, statements of peer review or that the text has been approved by an
organization as the authoritative definition of a standard.

You may add a passage of up to five words as a Front-Cover Text, and a passage of up to 25 words as a Back-Cover
Text, to the end of the list of Cover Texts in the Modified Version. Only one passage of Front-Cover Text and one
of Back-Cover Text may be added by (or through arrangements made by) any one entity. If the Document already
includes a cover text for the same cover, previously added by you or by arrangement made by the same entity you
are acting on behalf of, you may not add another; but you may replace the old one, on explicit permission from
the previous publisher that added the old one.

The author(s) and publisher(s) of the Document do not by this License give permission to use their names for
publicity for or to assert or imply endorsement of any Modified Version.

5. COMBINING DOCUMENTS

You may combine the Document with other documents released under this License, under the terms defined in
section 4 above for modified versions, provided that you include in the combination all of the Invariant Sections
of all of the original documents, unmodified, and list them all as Invariant Sections of your combined work in its
license notice, and that you preserve all their Warranty Disclaimers.

The combined work need only contain one copy of this License, and multiple identical Invariant Sections may be
replaced with a single copy. If there are multiple Invariant Sections with the same name but different contents,
make the title of each such section unique by adding at the end of it, in parentheses, the name of the original author
or publisher of that section if known, or else a unique number. Make the same adjustment to the section titles in
the list of Invariant Sections in the license notice of the combined work.

In the combination, you must combine any sections Entitled “History” in the various original documents, forming
one section Entitled “History”; likewise combine any sections Entitled “Acknowledgements”, and any sections
Entitled “Dedications”. You must delete all sections Entitled “Endorsements”.

6. COLLECTIONS OF DOCUMENTS
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You may make a collection consisting of the Document and other documents released under this License, and
replace the individual copies of this License in the various documents with a single copy that is included in the
collection, provided that you follow the rules of this License for verbatim copying of each of the documents in all
other respects.

You may extract a single document from such a collection, and distribute it individually under this License,
provided you insert a copy of this License into the extracted document, and follow this License in all other respects
regarding verbatim copying of that document.

7. AGGREGATION WITH INDEPENDENT WORKS

A compilation of the Document or its derivatives with other separate and independent documents or works, in
or on a volume of a storage or distribution medium, is called an “aggregate” if the copyright resulting from the
compilation is not used to limit the legal rights of the compilation’s users beyond what the individual works permit.
When the Document is included in an aggregate, this License does not apply to the other works in the aggregate
which are not themselves derivative works of the Document.

If the Cover Text requirement of section 3 is applicable to these copies of the Document, then if the Document
is less than one half of the entire aggregate, the Document’s Cover Texts may be placed on covers that bracket
the Document within the aggregate, or the electronic equivalent of covers if the Document is in electronic form.
Otherwise they must appear on printed covers that bracket the whole aggregate.

8. TRANSLATION

Translation is considered a kind of modification, so you may distribute translations of the Document under the
terms of section 4. Replacing Invariant Sections with translations requires special permission from their copyright
holders, but you may include translations of some or all Invariant Sections in addition to the original versions of
these Invariant Sections. You may include a translation of this License, and all the license notices in the Document,
and any Warranty Disclaimers, provided that you also include the original English version of this License and the
original versions of those notices and disclaimers. In case of a disagreement between the translation and the
original version of this License or a notice or disclaimer, the original version will prevail.

If a section in the Document is Entitled “Acknowledgements”, “Dedications”, or “History”, the requirement (sec-
tion 4) to Preserve its Title (section 1) will typically require changing the actual title.

9. TERMINATION

You may not copy, modify, sublicense, or distribute the Document except as expressly provided under this License.
Any attempt otherwise to copy, modify, sublicense, or distribute it is void, and will automatically terminate your
rights under this License.

However, if you cease all violation of this License, then your license from a particular copyright holder is reinstated
(a) provisionally, unless and until the copyright holder explicitly and finally terminates your license, and (b)
permanently, if the copyright holder fails to notify you of the violation by some reasonable means prior to 60 days
after the cessation.

Moreover, your license from a particular copyright holder is reinstated permanently if the copyright holder notifies
you of the violation by some reasonable means, this is the first time you have received notice of violation of this
License (for any work) from that copyright holder, and you cure the violation prior to 30 days after your receipt
of the notice.

Termination of your rights under this section does not terminate the licenses of parties who have received copies
or rights from you under this License. If your rights have been terminated and not permanently reinstated, receipt
of a copy of some or all of the same material does not give you any rights to use it.

10. FUTURE REVISIONS OF THIS LICENSE

The Free Software Foundation may publish new, revised versions of the GNU Free Documentation License from
time to time. Such new versions will be similar in spirit to the present version, but may differ in detail to address
new problems or concerns. See http://www.gnu.org/copyleft/.

Each version of the License is given a distinguishing version number. If the Document specifies that a particular
numbered version of this License “or any later version” applies to it, you have the option of following the terms
and conditions either of that specified version or of any later version that has been published (not as a draft) by the
Free Software Foundation. If the Document does not specify a version number of this License, you may choose
any version ever published (not as a draft) by the Free Software Foundation. If the Document specifies that a
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proxy can decide which future versions of this License can be used, that proxy’s public statement of acceptance
of a version permanently authorizes you to choose that version for the Document.

11. RELICENSING

“Massive Multiauthor Collaboration Site” (or “MMC Site”) means any World Wide Web server that publishes
copyrightable works and also provides prominent facilities for anybody to edit those works. A public wiki that
anybody can edit is an example of such a server. A “Massive Multiauthor Collaboration” (or “MMC”) contained
in the site means any set of copyrightable works thus published on the MMC site.

“CC-BY-SA” means the Creative Commons Attribution-Share Alike 3.0 license published by Creative Commons
Corporation, a not-for-profit corporation with a principal place of business in San Francisco, California, as well as
future copyleft versions of that license published by that same organization.

“Incorporate” means to publish or republish a Document, in whole or in part, as part of another Document.

An MMC is “eligible for relicensing” if it is licensed under this License, and if all works that were first published
under this License somewhere other than this MMC, and subsequently incorporated in whole or in part into the
MMC, (1) had no cover texts or invariant sections, and (2) were thus incorporated prior to November 1, 2008.

The operator of an MMC Site may republish an MMC contained in the site under CC-BY-SA on the same site at
any time before August 1, 2009, provided the MMC is eligible for relicensing.

ADDENDUM: How to use this License for your documents

To use this License in a document you have written, include a copy of the License in the document and put the
following copyright and license notices just after the title page:

Copyright © YEAR YOUR NAME. Permission is granted to copy, distribute and/or modify this
document under the terms of the GNU Free Documentation License, Version 1.3 or any later version
published by the Free Software Foundation; with no Invariant Sections, no Front-Cover Texts, and no
Back-Cover Texts. A copy of the license is included in the section entitled “GNU Free Documentation
License”.

If you have Invariant Sections, Front-Cover Texts and Back-Cover Texts, replace the “with ... Texts.” line with
this:

with the Invariant Sections being LIST THEIR TITLES, with the Front-Cover Texts being LIST, and
with the Back-Cover Texts being LIST.

If you have Invariant Sections without Cover Texts, or some other combination of the three, merge those two
alternatives to suit the situation.

If your document contains nontrivial examples of program code, we recommend releasing these examples in
parallel under your choice of free software license, such as the GNU General Public License, to permit their use
in free software.

.
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